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Preface

Welcome to the Oracle OpenScript User's Guide. Oracle OpenScript is an extensible, 
standards-based test automation platform designed to test the next generation of Web 
applications. This guide explains how to use the features and options of Oracle 
OpenScript for testing Web applications.

Audience
This document is intended for test engineers who will be developing Oracle 
OpenScript scripts for regression and performance (load and scalability) testing of a 
Web site or application. The guide does require an understanding of software or Web 
application testing concepts. Test engineers using Oracle OpenScript should be 
familiar with the concepts of regression testing, load testing, and scalability testing.

The record/playback paradigm of Oracle OpenScript does not require any 
programming experience to develop scripts for testing. However, the advanced 
programming features available in Oracle OpenScript do require experience with the 
Java programming language. The programming sections and code examples of this 
manual assume that you understand programming concepts in Java.

Using This Guide
This guide is organized as follows:

Chapter 1, "Getting Started With OpenScript" introduces OpenScript and provides an 
overview of the features and user interface.

Chapter 2, "Setting Preferences" explains the available options in the OpenScript 
Preferences categories.

Chapter 3, "Creating and Modifying Scripts" explains the procedures for creating and 
modifying basic scripts in OpenScript.

Chapter 4, "Using Databanks" explains the concepts and procedures of Data Driven 
Testing using Databanks.

Chapter 5, "Using the Web Functional Test Module" provides instructions on 
configuring and using the OpenScript Web Functional Test Module for functional 
testing of applications through the Document Object Model (DOM) of the Web 
browser.

Chapter 6, "Using the HTTP Module" provides instructions on configuring and using 
the OpenScript HTTP Module for load testing of Web applications through the 
underlying HTTP protocol traffic.
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Chapter 7, "Using the Oracle EBS/Forms Functional Test Module" provides 
instructions on configuring and using the OpenScript Oracle Forms Functional Test 
Module for functional testing of Oracle Forms web applications.

Chapter 8, "Using the Oracle EBS/Forms Load Test Module" provides instructions on 
configuring and using the OpenScript Oracle Forms Load Test Module for load testing 
of Oracle Forms web applications.

Chapter 9, "Using the Oracle Fusion/ADF Functional Test Module" provides 
instructions on configuring and using the OpenScript Oracle Fusion/ADF Functional 
Test Module, which provides support for functional testing of Oracle Application 
Development Framework (ADF)-based applications.

Chapter 10, "Using the Oracle Fusion/ADF Load Test Module" provides instructions 
on configuring and using the OpenScript Oracle Fusion/ADF Load Test Module, 
which provides support for load testing of Oracle Application Development 
Framework (ADF)-based applications.

Chapter 11, "Using the Web Services Module" provides instructions on using the 
OpenScript Web Services Module for testing Web Services.

Chapter 12, "Using the Siebel Functional Test Module" provides instructions on 
configuring and using the OpenScript Siebel Functional Test Module for testing Siebel 
applications through the Document Object Model (DOM) of the Web browser and the 
Siebel test automation framework.

Chapter 13, "Using the Siebel Load Test Module" provides instructions on configuring 
and using the OpenScript Siebel Load Test Module for load testing Siebel web 
applications through the underlying HTTP protocol traffic.

Chapter 14, "Using the Utilities Module" provides instructions on using the 
OpenScript Utilities Module, which provides commonly used testing functions.

Chapter 15, "Using the Shared Data Module" provides instructions for using the 
Shared Data Module for transferring data using message queues and hash maps.

Appendix A, "Command Line Reference" provides reference information for command 
line settings.

Appendix B, "Error Message Reference" provides reference information for error 
messages.

Appendix C, "Troubleshooting" provides basic troubleshooting information.

Appendix D, "Third-Party Licenses" contains copyright information about certain 
third-party products used with Oracle Application Testing Suite.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible to all users, including users that are disabled. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at http://www.oracle.com/accessibility/.
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Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support.  For 
information, visit http://www.oracle.com/support/contact.html or visit 
http://www.oracle.com/accessibility/support.html if you are hearing 
impaired.

Related Documents
For more information, see the following documents in the Oracle Application Testing 
Suite documentation set:

■ Oracle Application Testing Suite Release Notes

■ Oracle Application Testing Suite Getting Started Guide

■ Oracle Application Testing Suite OpenScript User’s Guide

■ Oracle Functional Testing Functional Testing User’s Guide

■ Oracle Functional Testing Job Scheduler User’s Guide

■ Oracle Functional Testing Navigation Editor User’s Guide

■ Oracle Functional Testing Application Programming Interface Reference

■ Oracle Functional Testing Result Objects Reference

■ Oracle Functional Testing Settings Manager Reference

■ Oracle Load Testing Load Testing User’s Guide

■ Oracle Load Testing Load Testing ServerStats Guide

■ Oracle Test Manager Test Manager User’s Guide

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1 Getting Started With OpenScript

OpenScript is an updated scripting platform for creating automated extensible test 
scripts in Java. Combining an intuitive graphical interface with the robust Java 
language, OpenScript serves needs ranging from novice testers to advanced QA 
automation experts.

OpenScript is built on a standards-based platform and provides the foundation for 
OpenScript Modules and Application Programming Interfaces (APIs). OpenScript 
APIs are used to build scripts for testing Web applications. The OpenScript API 
consists of a set of procedures that can be used to customize the scripts within the 
development environment. The API can also be used by advanced technical users to 
enhance scripts for unique testing needs.

1.1 OpenScript Features
OpenScript is the next generation environment for developing Oracle Application 
Testing Suite scripts for Web application testing. OpenScript provides the following 
features:

■ Scripting Workbench - OpenScript provides an Eclipse -based scripting 
Workbench where you can create and run your automated test scripts. Users can 
use the Tree View graphical scripting interface for creating and editing scripts 
through the UI. Users can also switch to the Java Code View programming 
interface and leverage the integrated Eclipse IDE for creating and editing their 
scripts programmatically.

Functional test scripts created in OpenScript can be played back to test and 
validate application functionality. Load test scripts created in OpenScript will run 
in Oracle Load Testing for application load testing, allowing users to simulate 
hundreds our thousands of users executing scripts at the same time.

■ Test Modules - The OpenScript Test Modules provide application-specific test 
automation capabilities. Each Test Module is custom built to test a specific 
application or protocol. OpenScript includes several functional and load testing 
modules for testing Web-based applications. Additional modules can be 
developed for the OpenScript platform.

OpenScript’s Test Module interface is completely open and extendable by 
end-users. Users can leverage the Test Module API to build their own modules for 
testing specific applications or can extend an existing module to add custom 
functionality.

■ Graphical/Tree View Scripting Interface - The OpenScript Tree View scripting 
interface provides a graphical representation of the test script. Multiple script 
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windows can actually be open at the same time. Within each script window, the 
Tree View is broken down into 3 main script sections:

■ Initialize: For script commands that only execute once on the first iteration

■ Run: Main body of the script for commands that will run on every iteration

■ Finish: For script commands that only execute once on the last iteration

Within each section, script Steps and Navigation nodes can be created 
automatically during script recording or manually through the Tree View user 
interface. Additional script commands will also be represented as nodes in Tree 
View including test cases, data inputs, log messages, etc. Each Tree View node has 
a corresponding representation in the Java Code View.

■ Programming/Code View Scripting Interface - The OpenScript Java Code View 
scripting interface provides a Java representation of the test script. This view 
provides full access to Eclipse IDE for creating, editing & debugging script code. 
Script commands in Java are mapped to a corresponding representation in the Tree 
View. Users can edit their script in either the code or tree view and changes will be 
automatically reflected in both views.

■ Properties View & Results View - The OpenScript Properties View allows users to 
view detailed properties for selected script nodes in the Tree View. The Results 
View shows detailed step-by-step results of script playback which are linked to the 
OpenScript display window.

■ Databanking - OpenScript allows users to parameterize script data inputs to 
perform data driven testing using Databanking. Users can select any data inputs 
for their script and then substitute a variable to drive the input from an external 
file during playback. Multiple Databank files can be attached to a single script and 
users can specify how OpenScript assigns data during script playback.

■ Correlation - The OpenScript Correlation interface allows users to create 
correlation libraries to automatically parameterize dynamic requests during 
playback. Correlation libraries contain rules for automatically handling dynamic 
request parameters such as urls, query strings and post data for the load testing 
modules.

■ OpenScript Preferences - The OpenScript Preferences interface is where users 
specify settings to control script recording, script playback, correlation and general 
preferences for the OpenScript Workbench.

■ Multi-User Execution - launch more than one OpenScript instance under separate 
named Windows user accounts. Playback for multiple scripts is supported using 
any of the following:

– OpenScript Playback button

– Command-Line Interface

– Oracle Load Testing

– Oracle Test Manager

1.2 Installing OpenScript
To install OpenScript:

Note: OpenScript requires Administrator Privileges to be installed 
and uninstalled. It does not requires Administrator Privileges to run. 
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1. Download the product Zip file from the Web site and save it to a temporary 
directory on your hard disk.

2. Unzip the file and run the openscript###.exe to install OpenScript.

3. Follow the installation prompts to do the following:

■ Accept the license agreement.

■ Specify the installation directory.

4. Click Finish when done.

1.3 Starting the OpenScript Workbench
To start the OpenScript workbench:

From the Start menu:

■ Select Programs from the Start menu and then select OpenScript from the Oracle 
Application Testing Suite menu.

From the Welcome Screen:

■ Click Goto the OpenScript Workbench.

1.4 Overview of the OpenScript Main Window (Workbench)
The OpenScript main window (Workbench) is where you perform the majority of your 
test development activities. The main window consists of the perspectives used for 
developing scripts. OpenScript includes a Tester Perspective and a Developer 
Perspective. The menu bar, toolbar, and the views and editors vary depending upon 
which perspective is being used. The following sections describe the functionality and 
various elements of the OpenScript Workbench.

Some dialogs and views require the user to hit the popup menu keyboard button in 
order to access some features in the UI that are normally accessible using the 
right-click menu. 

1.4.1 Tester Perspective
The OpenScript Tester Perspective provides a convenient way to record and edit 
scripts and view the playback results. The Tester Perspective opens the following 
views by default.

■ Script View: Shows the recorded script in two tabs: Tree View and Java Code. The 
Tree View tab shows the steps and pages and the Initialize, Run, and Finish nodes 
of each step using a graphical tree view. The Java Code tab shows the underlying 
Java code used for the script.

■ Details View: Shows the content details for URL navigations or pages added to 
the script.

■ Problems View: Shows any problems in the script code that may produce errors 
or prevent compiling the script.

■ Properties View: Shows the properties for the selected node in the script.

■ Console View: Shows the playback command output and status information for 
the script. Script log message also appear in the Console.

■ Results View: Shows the results of script playback.
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The following Error log view is also available but does not open by default:

■ Error Log View: Shows the error log information for the project and script.

The views are described in more detail in the following sections.

1.4.2 Developer Perspective
The OpenScript Developer Perspective provides advanced options for developers 
when creating and editing scripts using the advanced features of OpenScript and the 
Eclipse development platform. The Developer Perspective opens the following views 
by default:

■ Navigator and Package Explorer Views: Shows hierarchical views of the script 
project resources. You can open the resource files in an editor to view and edit the 
contents.

■ Script View: Shows the recorded script in two tabs: Tree View and Java Code. The 
Tree View tab shows the steps and pages and the Initialize, Run, and Finish nodes 
of each step using a graphical tree view. The Java Code tab shows the underlying 
Java code used for the script.

■ Debug View: Shows the debugging options and provides options for stepping 
through code.

■ Variables and Breakpoint Views: Shows the script variables and breakpoints set 
in the code.

■ Problems View: Shows any problems in the script code that may produce errors 
or prevent compiling the script.

The following views are also available but do not open by default:

■ Details View: Shows recorded page details in three tabs: HTML, Browser, and 
Header. The HTML tab shows the page HTML source. The Browser tab shows the 
page. The Header tab shows the page response header.

■ Properties View: Shows the properties for the selected node in the script.

■ Console View: Shows the playback command output and status information for 
the script. Script log message also appear in the Console.

■ Results View: Shows the results of script playback.

■ Error Log View: Shows the error log information for the project and script.

The views are described in more detail in the following sections.

1.4.3 OpenScript Menu Options
The menu options that appear change depending upon which perspective is set in the 
Workbench (Tester or Developer) and which view is the active view. Specific test 
modules may also add or remove menu options. 

1.4.3.1 File
■ New - opens the New Project wizard. You can select the type of project including 

OpenScript scripts, jobs and modules

■ Open Script - opens a window for selecting the OpenScript Repository, 
workspace, and script to open.

■ Open Object Library - opens a dialog box for selecting the object library file to 
open. This option only appears for functional test scripts.
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■ Open File - opens a window for selecting the file to open.

■ Close - closes the script editor.

■ Close All - closes all script editors.

■ Save - saves the data in the currently active editor.

■ Save As - save the data in the currently active editor using a new name.

■ Save All - saves the data in all open editors.

■ Restart - restarts the OpenScript application and the Eclipse IDE.

■ Import Script - opens a window for importing an archived OpenScript script 
project from a .zip file.

■ Export Script - opens a window for exporting the OpenScript script project to an 
archive .zip file.

■ Exit - exits OpenScript.

The following options are also available in the Developer Perspective:

■ Revert - reverts changes to the last saved file contents.

■ Move - opens a dialog box for selecting where to move the resource.

■ Rename - opens a dialog box for specifying a new name for the resource.

■ Refresh - refreshes the resources in the Navigator or Package view.

■ Convert Line Delimiters To - opens a sub menu for selecting the type of line 
delimiters for the conversion: Windows, UNIX, or Mac OS.

■ Print - prints the contents of the selected editor view.

■ Switch Workspace - opens a dialog box for selecting the workspace to use.

■ Import - opens a window for selecting the type of project to import.

■ Export - opens a window for exporting the type of project to export.

■ Properties - opens the properties information for the selected resource.

1.4.3.2 Edit
■ Undo - undoes the last action.

■ Redo - redoes the last action.

■ Cut - cuts the selected text/data to the clipboard.

■ Copy - copies the selected text/data to the clipboard.

■ Paste - pasted text/data on the clipboard to cursor location.

■ Delete - deletes the selected text/data.

■ Select All - selects all text/data in the currently active editor.

■ Find/Replace - opens a dialog box for setting the text search and replace options. 
The menu option is available when an editor is open.

■ Search - opens a dialog box for specifying the search criteria.

The following options are also available when the Java Code editor is open in the 
Script view.

■ Expand Selection To - opens a sub menu for selecting which element to use to 
expand the selection.
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■ Find Next - finds the next instance of the Find text specified in the Find/Replace 
settings.

■ Find Previous - finds the previous instance of the Find text specified in the 
Find/Replace settings.

■ Incremental Find Next - finds the next instance of the Find text specified in the 
Find/Replace settings.

■ Incremental Find Previous - finds the previous instance of the Find text specified 
in the Find/Replace settings.

■ Add Bookmark - opens a dialog box for specifying the bookmark name.

■ Add Task - opens a dialog box for defining a task to perform on a resource.

■ Smart Insert Mode - when selected, code typing aids such as automatic 
indentation and closing of brackets are enabled in the code view.

■ Show Tooltip Description - opens a description for the current selection in the 
Code View.

■ Content Assist - opens a context assist menu to bring up Java code assist 
proposals and templates. See the Templates preference page for available 
templates (Window > Preferences > Java > Editor > Templates) and go to the 
Editor preference page (Window > Preferences > Java > Editor > Code Assist) for 
configuring the behavior of code assist.

■ Word Completion - completes typing of a partial word.

■ Quick Fix - If the cursor is located at a location with problem indication this opens 
a context assist dialog at the current cursor to present possible corrections.

■ Set Encoding - opens a dialog box for setting the type of text file encoding.

1.4.3.3 Search
■ Search - opens a dialog box for specifying the search criteria.

■ File - opens a dialog box for specifying the file search criteria.

■ Text - opens a sub menu for selecting the text search location.

1.4.3.4 Script
■ Add - opens a sub menu for adding options to the script tree.

■ Record - starts the selected OpenScript script recorder.

■ Playback - plays back the currently open OpenScript

■ Iterate - plays back the script repeatedly, with or without a Databank.

■ Pause/Resume - pauses and resumes script playback. These options are only 
active during script playback.

■ Stop - stops the OpenScript script recorder.

■ Step - runs the currently selected node and moves the execution point to the next 
sibling node. If the selected node has a child node, the execution pointer is moved 
to the first child node. This option is only active during script playback and script 
execution is suspended while stepping through the script code.

■ Step Into - steps into the function or sub procedure. This option is only active 
during script playback and script execution is suspended while stepping through 
the script code. The execution pointer is moved into the beginning of the function.
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■ Configure Recorders - opens a window for pausing and restarting the current 
script recorder. This option is only available while in Record mode.

■ Switch Record Section - opens a submenu for selecting the section of the script 
where script recording will begin. The selected section will be highlight in bold in 
the script tree. The Run section is the default. The submenu has the following 
options:

– Initialize - starts script recording in the Initialize section of the script.

– Run - starts script recording in the Run section of the script.

– Finish - starts script recording in the Finish section of the script.

■ Revert all Navigations to Recorded - reverts changes back to the recorded version 
of the script.

■ Create/Update Step Groups - creates step groups in the script based on page 
navigations.

■ Correlate Script - opens a dialog box for selecting a defined correlation library to 
manually apply to the script. Correlation libraries are used to convert dynamic 
data in page navigations to variable values for script playback. Use the Correlation 
options in the in the OpenScript Preferences to define the correlation libraries and 
rules.

■ Script Properties - opens a window for setting script-related properties such as 
correlation, databanks, modules, object libraries, and step groups. Script properties 
will vary depending upon the script type.

The Script menu includes additional options for functional test scripts:

■ Inspect Path - starts the object capture mode and opens a browser for selecting the 
object path to capture. The object path is used by functional test scripts for object 
identification.

■ Add Object Test - opens a dialog box for defining an object test for a functional 
test script.

■ Add Table Test - opens a dialog box for defining a table test for a functional test 
script.

■ Add Text Matching Test - opens a dialog box for defining a Text Matching test for 
a functional test script.

■ Add Capture Page - opens a dialog box for specifying a page to capture for a 
functional test script. The Capture Page option captures a screenshot and the page 
HTML.

1.4.3.5 View
■ Tester Perspective - changes the Workbench to the Tester Perspective.

■ Developer Perspective - changes the Workbench to the Developer Perspective.

■ Reset Perspective - resets the current perspective to the default settings.

■ Error Log - toggles the Error Log View. When selected, the Error Logs view is 
displayed. When cleared, the Error Log View is hidden.

■ Properties - toggles the Properties View. When selected, the Properties view is 
displayed. When cleared, the Properties View is hidden.

■ Problems - toggles the Problems View. When selected, the Problems view is 
displayed. When cleared, the Problems View is hidden.
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■ Details - toggles the Details View. When selected, the Details view is displayed. 
When cleared, the Details View is hidden.

■ Console - toggles the Console View. When selected, the Console view is displayed. 
When cleared, the Console View is hidden.

■ Results - toggles the Results View. When selected, the Results view is displayed. 
When cleared, the Results View is hidden.

■ Script Variables - toggles the Script Variables View. When selected, the Script 
Variables view is displayed. When cleared, the Script Variables view is hidden.

■ OpenScript Preferences - opens the OpenScript Preferences dialog box for 
specifying default settings and options.

1.4.3.6 Run
■ Resume - resumes suspended code execution or script playback.

■ Suspend - suspends the current code execution or script playback.

■ Terminate - ends the current code execution or script playback.

■ Step Into - single steps code execution into the highlighted statement or method. 
The Step options are active in debug mode.

■ Step Over - single steps code execution over the current statement or method to 
the next statement or method.

■ Step Return - steps code execution out of the current method and stops after 
exiting the current method.

■ Run to Line - resumes execution until the specified line is executed. Used When a 
thread is suspended.

■ Use Step Filters - toggles step filters on and off. When set to on, all step functions 
apply step filters.

■ External Tools - opens a sub menu for selecting the external tools option.

The following options are also available in the Developer Perspective:

■ Run - runs the last launched code or script playback.

■ Debug - opens the debug configuration options for the last launched code or 
script playback. You can customize the debug configuration before launching the 
code or script playback for debugging.

■ Run History - opens a sub menu listing run configurations. Selecting a run 
configuration shows the run history in the debug view.

■ Run As - opens a sub menu listing available external run tools. External tools need 
to be configured to appear on the sub menu by selecting External Tools from the 
Run menu.

■ Run Configurations - opens the run configuration options for the last launched 
code or script playback. You can customize the run configuration before launching 
the code or script playback.

■ Debug History - opens a sub menu listing debug configurations. Selecting a 
debug configuration shows the run history in the debug view.

■ Debug As - opens a sub menu listing available external run tools. External tools 
need to be configured to appear on the sub menu by selecting External Tools from 
the Run menu.
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■ Debug Configurations - opens the debug configuration options for the last 
launched code or script playback. You can customize the debug configuration 
before launching the code or script playback.

1.4.3.7 Tools
■ Manage Scripts - opens a window for managing OpenScript scripts.

■ Manage Workspaces - opens a window for managing OpenScript Workspaces.

■ Manage Repositories - opens a window for managing OpenScript Repositories.

■ Merge Object Libraries  - opens a dialog box for specifying two Object Library 
files to merge and the resulting output file.

■ Generate XPaths - opens a dialog box for generating an XPath from an XML file.

■ Import Oracle Real User Experience Insight (REUI) Session Log - opens a dialog 
box for selecting a REUI captured user session .tab log file and specifying the 
script creation options. The imported REUI session log files record to HTTP-based 
OpenScript scripts. 

■ Migrate Scripts - opens the Script Migration Manager for migrating pre-version 
9.10 scripts to the current version. The Script Migration Manager provides options 
for migrating top-level scripts and locating all dependent child scripts. 

1.4.3.8 Help
■ Welcome opens the welcome page with links to the Workbench product 

documentation.

■ OpenScript Diagnosis Tool - opens the Diagnosis Wizard for verifying the 
connection status of the OpenScript Internet Explorer Browser Helper Object 
(BHO), Firefox extensions, and Forms Internet Explorer helper object.

■ Help Contents - opens the help table of contents.

■ Search - opens the help search view.

■ Dynamic Help - opens the available help topics for the currently active view and 
perspective.

■ Key Assist - opens the list of keyboard shortcuts.

■ Tips and Tricks - opens the help tip and tricks window.

■ Cheat Sheets - opens the Cheat Sheets view.

■ About OpenScript - provides version and copyright information and 
configuration details.

1.4.3.9 Navigate
The Navigate menu appears when the Developer perspective is open.

■ Go Into - refocuses the active view so that the current selection is at the root. This 
allows web browser style navigation within hierarchies of artifacts.

■ Go To - opens a sub menu with options for selecting the location to which to 
navigate. The sub menu options change depending upon the current view.

■ Open Type - opens a dialog box for selecting the type library to open in an editor 
view.

■ Open Type in Hierarchy - opens a dialog box for selecting the type library to open 
in a hierarchy view.
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■ Open Resource - opens a dialog box for selecting the resource file to open in an 
editor view.

■ Show In - opens a sub menu for selecting where to show the statement or method 
selected in the code view: Package Explorer, Navigator, or Outline view.

■ Next - moves the selection to the next annotation in the Code View.

■ Previous - moves the selection to the next annotation in the Code View.

■ Last Edit Location - moves the selection to the location of the last edit made in the 
Code View.

■ Back - moves the selection back through the list of locations previously selected in 
the Code view.

■ Forward - moves the selection forward through the list of locations previously 
selected in the Code view.

Additional menu options may appear depending upon the current Java Code editor 
selection.

1.4.3.10 Project
The Project menu appears when the Developer perspective is open.

■ Open Project - opens the project selected in the Navigator View.

■ Close Project - closes the project selected in the Navigator View.

■ Build All - builds all projects. This option is only available if the Build 
Automatically option is not selected.

■ Build Project - builds the current project. This option is only available if the Build 
Automatically option is not selected.

■ Build Working Set - opens a sub menu for selecting or creating a working set of 
projects. Working set projects are only available if the Build Automatically option 
is not selected.

■ Clean - opens a dialog box for selecting the project to clean of build problems.

■ Build Automatically - toggles the automatic build option on and off.

■ Generate Javadoc - opens the Generate Javadoc window.

■ Properties - opens the properties window for the current project.

1.4.3.11 Window
■ New Window opens a new OpenScript window.

■ New Editor opens a new editor view of the current file.

■ Open Perspective opens a sub menu for selecting the perspective to open.

■ Show View opens a sub menu for selecting the view to show.

■ Customize Perspective opens a window for selecting the shortcuts and commands 
to customize.

■ Save Perspective As opens a dialog box for specifying a name for the saved 
perspective.

■ Reset Perspective resets the current perspective to the default settings.

■ Close Perspective closes the currently open perspective.
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■ Close All Perspectives closes all perspectives.

■ Navigation opens a sub menu for selecting navigation options.

■ Preferences opens a window for specifying the project preferences.

1.4.4 OpenScript Tool Bar
The following toolbar buttons are available in the Tester and Developer Perspectives:

■ New - opens a Wizard for creating new OpenScript scripts or Java platform objects 
and resources.

■ Open - opens a dialog box for selecting an existing OpenScript script.

■ Save - saves the changes in the currently active editor. The button is only active if 
an editor is open with changes to be saved.

■ Print - prints the information in the currently selected editor. The button is only 
active if an editor with printable content is open.

■ Record - starts OpenScript script recording using the selected script recorder. 
Clicking the menu button opens the a menu listing the available recorder types.

■ Playback - starts playback of the currently open Visual Script.

■ Iterate - opens a dialog box for specifying the playback iterations options.

■ Pause/Resume - pauses and resumes script playback. These buttons are only 
active during script playback.

■ Stop - stops OpenScript script recording.

■ Step - runs the currently selected node and moves the execution point to the next 
sibling node. If the selected node has a child node, the execution pointer is moved 
to the first child node. This button is only active during script playback and script 
execution is suspended while stepping through the script code.

■ Step Into - steps into the function or sub procedure. This button is only active 
during script playback and script execution is suspended while stepping through 
the script code. The execution pointer is moved into the beginning of the function.

■ Configure Recorders - opens a window for pausing and restarting the current 
script recorder. This option is only available while in Record mode.

■ Switch Record Section - opens a submenu for selecting the section of the script 
where script recording will begin. The selected section will be highlight in bold in 
the script tree. The Run section is the default.

– Initialize - starts script recording in the Initialize section of the script.

– Run - starts script recording in the Run section of the script.

– Finish - starts script recording in the Finish section of the script.

■ Add Object Test - opens a dialog box for defining an object test for a functional 
test script.

■ Add Table Test - opens a dialog box for defining a table test for a functional test 
script.

■ Add Text Matching Test - opens a dialog box for defining a Text Matching test for 
a functional test script.

■ Add Capture Page - opens a dialog box for specifying a page to capture for a 
functional test script.
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■ Toolbar - opens the floating toolbar.

■ Debug - opens a dialog box for specifying a debug configuration. This button is 
only available when the Developer Perspective is open.

■ Run - Runs the selected configuration type or application. This button is only 
available when the Developer Perspective is open.

■ Run External Tools - Runs an external application. This button is only available 
when the Developer Perspective is open.

■ New Java Project - opens a window for creating a new Java project.This button is 
only available when the Developer Perspective is open.

■ New Java Package - opens a window for creating a new Java package. This button 
is only available when the Developer Perspective is open.

■ New Java Class - opens a window for creating a new Java class. This button is 
only available when the Developer Perspective is open.

■ Open Type - opens a window for specifying the type library to open. This button 
is only available when the Developer Perspective is open.

■ Search - opens a dialog box for specifying search options.

■ Next Annotation - goes to the next annotation in the Java code. This button is only 
available when the Developer Perspective is open. and a Java Code view is open.

■ Previous Annotation - goes to the previous annotation in the Java code. This 
button is only available when the Developer Perspective is open. and a Java Code 
view is open.

■ Last Edit Location - opens the edit view that was open and goes to the last edit 
location. This button is only active when a Java Code view is open.

■ Back to (location) - browses back to the last OpenScript script view. This button is 
only available when the Developer Perspective is open.

■ Forward - browses forward to the previous OpenScript script view. This button is 
only available when the Developer Perspective is open.

1.4.5 Script View
Shows the recorded script in two tabs: Tree View and Java Code. The Tree View tab 
shows the steps and pages and the Initialize, Run, and Finish nodes of each step using 
a graphical tree view. The Java Code tab shows the underlying Java code used for the 
script.

The script view is where you perform the majority of script editing actions. The Script 
view has the following tab views:

1.4.5.1 Tree View
The Tree View shows the script navigations and data as nodes in a collapsible tree 
view. The Tree View corresponds to the Java Code view. Any changes in the Tree View 
will be automatically updated in the Java Code view. The Tree View has the following 
standard nodes:

■ Initialize - specifies script actions to perform once at the beginning of script 
playback.

■ Run - specifies script actions to perform one or more times during script playback 
depending upon databanks or other custom programming.
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■ Finish - specifies script actions to perform once at the end of script playback.

Use the Record options and right-click shortcut menu to add options to script nodes or 
modify the properties of script nodes in the Tree View.

1.4.5.2 Java Code
The Java Code view shows the script navigations and data as Java programming code. 
The Java Code view corresponds to the Tree View. Any changes in the Code View will 
be automatically updated in the Tree View. The Java Code view has the following 
standard procedures:

■ initialize() - corresponds to the Initialize node of the Tree View and executes 
any custom code added once at the beginning of script playback.

■ run() - corresponds to the Run node of the Tree View and executes recorded and 
custom code one or more times during script playback depending upon databanks 
or other custom programming.

■ finish() - corresponds to the Finish node of the Tree View and executes any 
custom code added once at the end of script playback.

Use Ctrl-space to open an Intellisense window listing available procedures. See the 
API Reference in the OpenScript Platform Reference help for additional programming 
information.

1.4.6 Details View
The Details view shows the content details for URL navigations added to the script. 
The Details view may have the following tab views depending upon the selected script 
node and type of script:

■ ScreenShot - shows a screen capture of the web page.

■ Browser - shows the Browser rendered page for the script navigation selected in 
the tree view.

■ HTML - shows the HTML source for the script navigation selected in the tree view.

■ Headers - shows the Request Header and Response Header source for the script 
navigation selected in the tree view.

■ Comparison - shows the recorded and playback text for the Content, Request 
Header, or Response Header selected in the Compare list. The Comparison tab 
appears only after a script is played back and a navigation is selected in the 
Results View.

■ Results Report - shows the results report for the script playback. The Results 
Report tab appears only after a script is played back and a navigation is selected in 
the Results View.

1.4.7 Problems View
The Problems view shows any problems in the script code that may produce errors or 
prevent compiling the script. The Problems view shows the following information:

■ # error, # warnings, # infos - shows the number of errors, warning messages, and 
information messages in the problems view.

■ Description - shows a description of the errors, warning messages, and 
information messages.
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■ Resource - shows the name of the resource file where the error, warning, or 
information message was generated.

■ Path - shows the script name, workspace, and repository path where the resource 
file is located.

■ Location - shows the location/line number where the error, warning, or 
information message was generated.

The following toolbar button is available in the Problems View:

■ Configure the filters to be applied to this view - opens a dialog box for configuring 
the filters to apply to the Problems View.

1.4.8 Properties View
The Properties view shows the properties for the selected node in the script. The 
Properties view shows the following information:

■ Property - shows the names of the properties for the script node. The properties 
vary depending upon which type of script node is selected.

■ Value - shows the value of the script node properties. Property values can be 
edited in the properties view.

The following toolbar buttons are available in the Properties View:

■ Show Categories - toggles the property categories.

■ Show Advanced Properties - toggles the advanced properties.

■ Restore Default Value - restores any changed property values to the default values.

1.4.9 Console View
The Console view shows the playback command output and status information for the 
script. Script log message also appear in the Console. See the Process Console View 
topics in the reference section of the Java development user guide online help for 
additional information about console toolbar options.

1.4.10 Results View
The Results view shows the playback results for the script. The Results view shows the 
following information:

■ Name - shows the test date or navigation name.

■ Duration - shows the playback time for the page navigations.

■ Result - shows the playback result: Passed or Failed.

■ Summary - shows the data values from the Databank that are passed to 
parameters or it shows failure descriptions.

The following toolbar buttons are available in the Result View:

■ Delete Result - deletes the selected result row.

■ Delete All Results - deletes all rows from the Results View.

■ Scroll Lock - toggles scroll lock on and off for the Result View.

■ Properties - opens the Properties for the selected result.
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1.4.11 Navigator and Package Explorer Views
The Navigator and Package Explorer view shows the Java resources for the script and 
Java package. Double-click on a resource to open it in an editor view. See the Package 
Explorer View topics in the reference section of the Java development user guide 
online help for additional information about Package Explorer toolbar options.

1.4.12 Debug View
The Debug view provides options for debugging script playback. See the Debug View 
topics in the reference section of the Java development user guide online help for 
additional information about debugging toolbar options.

1.4.13 Variables and Breakpoints Views
The Variables and Breakpoints view shows variable values and breakpoints for 
debugging script playback. See the Breakpoints and Variables View topics in the 
reference section of the Java development user guide online help for additional 
information about breakpoints and variables toolbar options.

1.5 About Multi-User Execution
The Multi-User Execution feature lets multiple users run OpenScript from a single 
installation using multiple concurrent interactive desktop sessions (for example, 
Terminal Server or Remote Desktop sessions). All users must have Administrator 
privileges.

Users must login as a different, unique user accounts for each instance of OpenScript 
they want to run. One installation serves all user accounts on the machine. Users 
manage their settings and private data in their own workspaces. Any user who opens 
OpenScript creates a workspace under their "User Profile Folder", for example, 
C:\Documents and Settings\username\osworkspace. All of the user's OpenScript 
Settings and private data are stored under this workspace, including the user's Http 
Trust Stores (ostruststore).

If more than one user attempts to open the same the script in the same workspace, the 
second or subsequent users will receive a message indicating the script is in use and 
locked. The second or subsequent users can make a copy of the script and files in use.

Only load-test scripts can be played in the same desktop session. There no script type 
limitations for playback in different desktop sessions.

You configure the port range to use for each user in the OpenScript General 
Preferences. The ports within the configured port range are checked and if none are 
available, an error message will appear.

Note: Teams should enable Write access on their root Repository 
folders for all users and encourage teams to store their databanks and 
object library files in the Repository. This way, by default all newly 
created scripts, databanks, and object library files inherit the 
permissions of the Repository folder and be "Writeable" by all users.
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1.6 About Script Assets
Script assets are resources that can be used by scripts such as, databanks, generic Jar 
files, object libraries, or other scripts containing recorded steps or custom functions. 
Assets have the following characteristics:

■ They are external resources that a script can use or run.

■ They are resources that are not part of a script like the java code itself.

■ They are resources that can be shared among a team of users.

■ They are resources that can be added or removed from one or more scripts.

Script assets can be used for testing projects that include multiple users executing a 
suite of tests or any QA team that uses a complex structure of scripts and assets 
developed and used by different people. 

Script assets provide for the following:

■ Creating, editing and obtaining (discovering and assigning) assets independently 
from scripts. 

■ Assigning or removing assets from the script using the script properties GUI. 

■ Viewing all assets associated with a script, and all dependent assets using the 
script properties GUI. 

■ Viewing and editing asset properties (alias, location, etc.) from the script 
properties GUI. 

■ Creating self-contained script .zip files that include all assets referenced by a script 
and its assets. Self-contained .zip files can be used as a script export file for 
Customer support or script execution on computers other than the computer 
where script was created.

■ Importing self-contained script .zip files and running them without having to 
manually resolve file locations of assets.

■ Running self-contained .zip files from the Command line or Oracle Load Testing

■ Notification of missing assets before a script run starts. 

■ Storing scripts inside subfolders X levels deep in a workspace. 

■ Loading object libraries and/or databanks into a script without concern about 
modifying the behavior of a parent script because of conflicting object libraries 
and/or databanks.

■ Understanding the order in which assets are loaded to know which object in 
which library has precedence.

Note: As of OpenScript Version 9.10, scripts can be stored anywhere 
in the file system. However, any scripts you plan to run, along with 
any associated assets, in the Oracle Load Testing application must be 
stored in a repository/workspace that can be accessed by the Oracle 
Load Testing Controller.
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2 Setting Preferences

The OpenScript Preferences let you specify default values and settings to use for 
OpenScript options. This chapter explains the available options in the OpenScript 
Preferences categories. The OpenScript preferences are under the OpenScript node. 
The available preferences may vary depending upon installed modules.

2.1 Setting OpenScript Preferences
To set OpenScript preferences:

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu.

3. Expand the OpenScript node and select the preference category.

4. Specify the preferences as necessary for the selected category.

The following sections explain the available options for each category.

2.2 Correlation Category
The OpenScript Correlation interface allows users to create correlation libraries to 
automatically parameterize dynamic requests during playback. Correlation libraries 
contain rules for automatically handling dynamic request parameters such as urls, 
query strings and post data for the specific modules.

This category lets you specify libraries and rules for transforming dynamic data in 
recorded script URLs and related parameters (headers, post data, etc.) to variable 
names that will be recognized by the script playback engine (OpenScript or Oracle 
Load Testing). Correlation rules must be defined within OpenScript modules and are 
not available with the basic platform.

2.2.1 Module Correlation Preferences
Selected Module: Shows the names of the defined correlation libraries. Use the Add 
button to define libraries. After you define a library you can use the Add Rule button 
to specify the rules to include in the library.

■ Add Library: Opens a dialog box for adding a correlation library name.

■ Add Rule: Opens a dialog box for adding a correlation rule to the selected library.

■ Edit: Opens a dialog box for editing the selected correlation library name.
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■ Delete: Deletes the selected correlation library from the Preferences list. The 
defined rules for the library are also removed from the preferences. The correlation 
library .XML file is not deleted from disk.

■ Up: Moves the correlation rule up in the priority list.

■ Down: Moves the correlation rule down in the priority list.

■ Import: Opens a dialog box for selecting the correlation library file to import.

■ Export: Opens a dialog box for selecting the location where you want to export the 
selected correlation library .XML file.

■ Revert: Reverts the library to the default values.

Tab view: Shows the library or rule details for the selected correlation library or rule. 
The tab view information changes depending upon whether a library or rule node is 
selected and which type of correlation rule is selected. See the module chapters for 
details about specific correlation libraries.

2.2.2 Add Library
This dialog box lets you specify a new correlation library for transforming dynamic 
data in recorded script URLs and related parameters (headers, post data, etc.) to 
variable names that will be recognized by the script playback engine (OpenScript or 
Oracle Load Testing).

■ Name: Specifies the name of the correlation library. After you define a library you 
can use the Add Rule button to specify the rules to include in the library. The 
name is required. You can also select Copy rules to copy correlation rules from an 
existing library.

■ Copy rules from existing library: Lets you copy correlation rules from an existing 
library to a new library.Specifies the name of the correlation library. After you 
define a library you can use the Add Rule button to specify the rules to include in 
the library. The name is required. You can also select Copy rules to copy 
correlation rules from an existing library.

– Copy Rules: When selected, a list of existing correlation rule libraries will be 
enabled for copying.

– Library: Lists the correlation rule libraries available for copying.

2.2.3 Add/Edit Rule
This dialog box lets you specify or edit a correlation rule for transforming dynamic 
data in recorded script URLs and related parameters (headers, post data, etc.) to 
variable names that will be recognized by the script playback engine (OpenScript or 
Oracle Load Testing).

■ Type: Specifies the type of correlation rule. The available Source and Target 
options change depending upon the rule type. 

■ Name: Specifies the name of the correlation rule. The name is required.

■ Source: Specifies which object(s) to substitute as dynamic data.

■ Target: Specifies which object(s) to use as the target location of the transform.

2.3 General Category
This category lets you specify general preferences. 
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2.3.1 General Preferences
These preferences set the default general preferences. The resulting dialog presents the 
following fields:

Confirm exit when closing last window: When selected, a confirmation message 
appears when closing the OpenScript workbench.

Remove script from workbench on close: When selected, any opens scripts will be 
removed from the workbench when OpenScript is closed.

Maximum Number of Results to Save: Specifies the maximum number of script 
playback session results to save. The script playback session results appear in the 
Results view and are saved to the results subdirectory under the script directory. 
When the maximum number has been reached, subsequent playback sessions delete 
the oldest playback results.

■ Results: Specifies the number of results to save. 

Record and Playback Port Range: Specifies the range of ports to use to avoid port 
conflicts when multiple users run OpenScript from a single installation using multiple 
concurrent interactive desktop sessions (for example, Terminal Server or Remote 
Desktop sessions).

■ Minimum: Specifies the port number to use as the minimum. 

■ Maximum: Specifies the port number to use as the maximum. 

2.3.2 Browser Preferences
The Browser preferences specify the browser and any additional arguments. The 
resulting dialog presents the following fields:

Browser Type: Select which browser to use. 

■ Internet Explorer: When selected, OpenScript uses the Internet Explorer browser.

– Path Override: Specifies the path and file name to use to override the default 
Internet Explorer browser location.

– Additional Arguments: Specifies any additional command arguments to 
include when starting the browser.

■ Firefox: When selected, OpenScript uses the Firefox browser.

– Path Override: Specifies the path and file name to use to override the default 
Firefox browser location.

– Additional Arguments: Specifies any additional command arguments to 
include when starting the browser.

Start Up: Specifies the browser start up settings. 

■ Startup Timeout: Specifies the amount of time, in seconds, to use for the browser 
startup timeout.

2.3.3 Encryption Preferences
These preferences set the default encryption preferences. The resulting dialog presents 
the following fields:

Do not encrypt script data: When selected, passwords are stored and displayed as 
plain text in the script.
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Obfuscate script data: When selected, passwords are obfuscated before storing and 
displaying in the script. Obfuscated passwords are hidden but not securely encrypted.

Encrypt script data: When selected, passwords are encrypted in the script. Specify an 
encryption password to use.

■ Password: Specifies the password to use when encrypting and decrypting data 
strings using the encrypt() and decrypt() functions. Only users who use the 
same encryption password in their copy of OpenScript will be able to decrypt 
script passwords. This same encryption password must be used for authentication 
on all agent machines that will run or open the script in Oracle Load Testing 
Authentication Manager or Oracle Test Manager.

2.3.4 Repository Preferences
These preferences lets you specify the name and location of the repository to use to 
store script files. The resulting dialog presents the following fields:

Name: Shows the names of the defined repositories. Use the Add button to define 
repositories and locations.

Location: Shows the location of defined repositories.

Add: Opens a dialog box for specifying a repository and location.

Edit: Opens a dialog box for editing the selected repository and location. The Default 
repository location can be changed but it cannot be renamed.

Delete: Deletes the selected repository and location from the Preferences list. The 
script files and directory are not deleted. The Default repository cannot be deleted.

2.4 Playback Category
This category lets you specify script playback preferences. 

2.4.1 General Playback Preferences
This category lets you specify general playback preferences. The resulting dialog box 
displays the following sections and fields:

2.4.1.1 General
This section lets you specify general playback preferences and displays the following 
fields:

VU Pacing (Think Time): Specifies the script playback delay between pages for each 
virtual user. This is the amount of time the user looks at a page before making the next 
request and is commonly referred to as "think time." There are four options:

■ Recorded: Uses the delay times that were recorded in the Script. You can set 
minimum and maximum delay times (in seconds) that override the script delay 
times in the Minimum and Maximum edit boxes.

■ Recorded/Random: Uses random delay times based upon the recorded user delay. 
The low end of the random range as the actual recorded user delay minus the 
Lower percentage setting. The high end of the random range as the actual 
recorded user delay plus the Upper percentage setting. For example, if the actual 

Caution: HTTP scripts do not automatically obfuscate/encrypt 
sensitive script passwords.
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recorded delay time was 100 seconds and the Lower and Upper settings are 10% 
and 25% respectively, Oracle Load Testing uses random delay times between 90 
and 125 seconds.

■ Random: Uses random times for Virtual User pacing. You can set minimum and 
maximum delay times for random delay in the Minimum and Maximum edit 
boxes.

■ No Delay: Plays back the Visual Scripts at the fastest possible speed with no time 
between page requests.

Preserve variables between iterations: Used to preserve or automatically clear 
variables defined in the Run section between successive iterations of the Run section.

Variables defined in the Initialize section will be preserved forever, unless explicitly 
removed in script code.

Variables set in the Run section will always be preserved between the final iteration of 
the Run section and the Finish section.

Variables include all items that are added into the script variables collection (see: 
getVariables() script method). This includes variables for elements such as HTTP 
form fields defined using http.solve(...) and http.solveXPath(...).

Additional Arguments: Used to specify custom OpenScript script.java code 
arguments. You can create your own settings in OpenScript scripts. For example, you 
can create custom settings in OpenScript script.java code, as follows.

if (getSettings().get("MyCustomSetting").equals("abc")) {
info("We're running in ABC mode.");

}

You can then set the additional arguments in the Additional Arguments field as 
follows:

-MyCustomSetting abc

2.4.1.2 Error Handling
This section specifies the default playback error handling settings.

On iteration failure, do not run more iterations: When selected, virtual user playback 
is stopped if an error occurs between playback iterations.

Use recorded value if variable is not found: When selected, the recorded data value 
will be used if a variable is not found. Databank variables will always use the recorded 
value if the databank attached to the script cannot be found. If the databank cannot be 
found and Use recorded value if variable is not found is not selected, the recorded 
data value will still be used.

2.4.1.3 System
This section specifies the default playback system settings.

Maximum JVM Heap Size: Specifies the maximum size of the JVM heap. This value 
cannot be more than 90% of the total memory size.

JVM Arguments: Used to specify additional Java Virtual Machine (JVM) or program 
arguments to pass to a script upon playback. It can accept all standard JVM 
arguments. For example, if you specify a custom argument -Dmyvariable=myvalue 
in the Additional Arguments, the argument will be passed to the script upon playback. 
Within the script code you can use System.getProperty("myvariable") to get 
"myvalue".



Playback Category

2-6 Oracle Application Testing Suite OpenScript User's Guide

If the specified argument conflicts with existing OpenScript playback setting, (for 
example the "Maximum Heap Size" playback setting) the playback setting replaces the 
setting being specified in the JVM Arguments.

Debug logging: When selected, debug logging is enabled and DEBUG messages 
appear in the Console view during script playback. When cleared, debug logging is 
disabled and DEBUG messages do not appear in the console view during script 
playback.

2.4.2 Debug Preferences
This category lets you specify the default playback debug settings. The resulting 
dialog presents the following options:

■ Enable Tree View Debugger: When selected, the tree view debugger is enabled. 
During script playback, tree view nodes in the script are highlighted as they are 
executed. Script execution stops at any Breakpoints set. Use the Resume toolbar 
button to continue script execution or use the Step options to step into or over 
script functions. When cleared, the tree view debugger is disabled. If Breakpoints 
are set in the script, the script execution stops and the Java code view opens.

■ Pause on exceptions: When selected, script playback is paused if an 
AbstractScriptException occurs during playback. You can use the Execute debug 
option to run actions after an error occurs. You may also be able to modify the 
script and save it to reposition execution pointer at start of the function where the 
exception occurred. 

■ Activate the workbench when a breakpoint is hit: When selected, the OpenScript 
workbench becomes the active window when a breakpoint is reached during 
script execution. When cleared, The OpenScript workbench does not become the 
active window. 

■ Activate the debug view when a breakpoint is hit: When selected, the Debug 
view becomes the active view when a breakpoint is reached during script 
execution. When cleared, the Debug view remains in its current state.

2.4.3 Error Recovery Preferences
This category lets you specify error recovery actions for exceptions that occur during 
playback. You can set the error recovery action for individual playback exceptions. 
Expand specific sections and set the error recovery action. You can set the action as 
Fail, Warn, or Ignore, as follows: 

■ Fail: Report the error as failure and stop script execution.

■ Warn: Report the error as a warning and continue script execution.

■ Ignore: Ignore the error and continue script execution. 

■ ReportErrorAndContinue: Report the error to the results log and continue script 
execution. . 

Error Recovery playback preferences specified in the OpenScript Preferences are 
stored on the local machine and only apply when the script is played back from inside 
OpenScript on that machine. If you upload your script to Oracle Load Testing on 
another server and your script depends on an error recovery setting being a certain 
way in order for it to work, then you can set the error recovery setting in the 
OpenScript script Java code.
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In OpenScript scripts, error settings can be turned on and off at any time, overriding 
the default Oracle Load testing and OpenScript Preferences using script Java code. For 
example: 

getSettings().setErrorRecovery("http.zeroLengthDownloads", "IGNORE");
// user code executed in script, such as http.get(), http.post(), ...
getSettings().setErrorRecovery("http.zeroLengthDownloads", "FAIL");

2.4.3.1 General
This section lets you specify the default General error recovery actions, as follows:

Variable Not Found - specifies the error recovery action if a variable cannot be found 
when parsing transformed strings.

Create Variable Failed - specifies the error recovery action if a script fails to create a 
variable.

File Not Found - specifies the error recovery action if a file is not found.

Segment Parser Failed - specifies the error recovery action if the XPath Segment 
Parser cannot verify the correctness of an XPath.

Binary Decode Failed - specifies the error recovery action if a binary post data 
parameter error occurs.

Encryption Service Not Initialized - specifies the error recovery action when the 
password encryption service was not initialized.

Unexpected Script Error - specifies the error recovery action if any unexpected script 
error occurs.

Child Script Failed - specifies the error recovery action if a child (a script called from 
another script) script fails during playback.

Function Failed - specifies the error recovery action if a called function fails during 
playback.

2.4.3.2 Functional Test
This section lets you specify the default Functional Test error recovery actions, as 
follows:

Text Matching Failed - specifies the error recovery action if a text matching test fails.

Object Test Failed - specifies the error recovery action if an object test fails.

Table Test Failed - specifies the error recovery action if a table test fails.

2.4.3.3 HTTP
This section lets you specify the default HTTP error recovery actions, as follows:

Zero Length Downloads - specifies the error recovery action if a server response 
indicates zero bytes length.

Text Matching Failed - specifies the error recovery action if a text matching test fails.

Response Time Error - specifies the error recovery action if a Server Response Time 
test fails.

Solve Variable Failed - specifies the error recovery action if a table test fails.

HTML Parsing Error - specifies the error recovery action if an HTML parsing error 
occurs.
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Invalid URL - specifies the error recovery action if the server returns an Invalid URL 
response code.

Invalid HTTP Response Code - specifies the error recovery action if the sever returns 
an invalid HTTP response code.

Client Certificate Keystore Error - specifies the error recovery action if the Client 
Certificate Keystore indicates and error.

2.4.3.4 Oracle Forms Functional Test
This section lets you specify the default Oracle Forms Functional test error recovery 
actions, as follows:

Oracle Forms Error - specifies the error recovery action if any Oracle Forms Functional 
test error occurs.

2.4.3.5 Oracle Forms Load Test
This section lets you specify the default Oracle Forms Load test error recovery actions, 
as follows:

Form Connect Error - specifies the error recovery action if a server connection error 
occurs.

Forms Input/Output Communication Error - specifies the error recovery action if a 
read or write error occurs with an Oracle Forms message.

Forms Content Match Failed - specifies the error recovery action if the content of a 
form does not match on playback.

Forms Playback Error - specifies the error recovery action if there is an error playing 
back a form.

Forms Component Not Found - specifies the error recovery action if a component of a 
form is not found.

2.4.3.6 Utilities
This section lets you specify the default Utilities error recovery actions, as follows:

SQL Execute Error - specifies the error recovery action if an SQL execute error occurs.

XML Parsing Error - specifies the error recovery action if any XML parsing error 
occurs.

CSV Loading Error - specifies the error recovery action if an error occurs while 
loading a CSV file.

2.4.3.7 Web Functional Test
This section lets you specify the default Web Functional Test error recovery actions, as 
follows:

Response Time Error - specifies the error recovery action if a Server Response Time 
test fails.

Solve Variable Failed - specifies the error recovery action if the value of any variable 
cannot be solved.

Wait for Page Timeout - specifies the error recovery action if a page timeout error 
occurs.

Object Not Found - specifies the error recovery action if a web page object is not 
found.
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Playback Failed - specifies the error recovery action if script playback fails.

2.4.4 Functional Test Preferences
This category lets you specify playback preferences that apply to all Functional Test 
scripts. The resulting dialog box displays the following sections and fields:

2.4.4.1 Object Enumeration
This section lets you specify the default Match Format and Object Enumeration 
setting.

Match Format: Specifies which format to use to match attributes in an object path. The 
match format can be a wildcard-formatted or a regular-expression-formatted 
expression. format is one of the following settings:

■ wildcard: (default) Attributes in the given path may contain wildcards for 
unknown characters. For example, title="Welcome, user *". An asterisk "*" matches 
any number of characters. A question mark "?" matches any single character.

■ wildcardThenRegex: Attributes in the given path may contain a 
wildcard-formatted expression, or a regular-expression-formatted expression. 
During playback, an attempt is first made to find the object assuming a wildcard 
format, then an attempt is made to find the object assuming a regular-expression 
format.

■ regex: Attributes in the given path may contain a regular expression.

Object Identification: specifies which Object Identification method to use. Select one 
of the following options:

■ Use XPath:  When selected, the OpenScript object identification uses the standard 
XPath query language to find an object within a page by searching for it in the 
HTML based on its tag + attributes.

■ Use XPath with Smart Match: When selected, the OpenScript uses an XPath with 
OpenScript Smart Match, which provides additional functionality to rank the 
choices in cases where XPath alone returns multiple matches. The following 
example explains how the Smart Match ranking feature enhances object 
identification in an XPath. With the following XPath,

/web:a[@text='Search' OR @href='search.jsp' OR @index='0'] 

it is possible for multiple links on a page to match the XPath criteria. For example:

link A: text='Logout', href='logout.jsp', index=0 
link B: text='Search', href='search.jsp', index=3 
link C: text='Search', href='doNotSearch.jsp', index=15 
link D: text='Find', href='search.jsp', index=22 

When Smart Match is not enabled, OpenScript returns the first result found on the 
page (Link A in the above example). 

When Smart Match is enabled, OpenScript ranks all the results based on how well 
they match the specified attributes in the XPath. OpenScript evaluates the XPath 
from left-to-right and produce a list of attribute name=value pairs. For example: 

Attribute 1: text=Search 
Attribute 2: href=search.jsp 
Attribute 3: index=0 
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OpenScript then builds a table and assigns a score to each attribute for each result. 
OpenScript assigns a 0 or a 1 based on whether or not each result matches a 
particular attribute name=value pair. The result with the highest numerical 
ranking will be used during playback. For example: 

Logical operators (AND, OR) in the XPath are ignored when Smart Match is 
enabled during playback. In Smart Match mode, all attributes are matched as one 
group in left-highest priority.

You can specify required attributes by using the Logical AND operator. All 
attributes joined together using the Logical OR operator are optional. The AND 
operator has a higher priority than the OR operator when both operators are used 
in a single XPath. Parenthetical groups of attributes are also permitted. For 
example:

/web:a[@text='Search' AND (@alt='Find' OR @title='Find')]

In this XPath, the text attribute is required, and the alt and title attributes are 
ranked using the Smart Match ranking system. 

You can turn on/off Smart Mode for an individual action(s) by using the 
getSettings().set() API. 

2.4.4.2 Browser
This section lets you specify the browser settings for functional tests.

Hide browser during playback: Specifies if the browser appears or is hidden during 
script playback. However, the browser will be changed to be visible automatically 
when focus is set to an element inside of that browser by a mouse click or key press 
event.

Close browser after playback: Specifies if the browser automatically closes after 
playback.

2.4.5 HTTP Preferences
This category lets you specify HTTP playback preferences. The resulting dialog box 
displays the following sections and fields:

2.4.5.1 Proxy
This section lets you specify HTTP playback preferences and displays the following 
fields:

Proxy Host: Specifies the host name of the proxy server.

Proxy Port: Specifies the port to use on the proxy server.

Username: Specify the user name to use for authentication.

Password: Specify the password to use for authentication.

Link
Attr 1 
text=Search

Attr 2 
href=search.jsp Attr 3 index=0

Smart Mode 
Score 

A 0 0 1 001

B 1 1 0 110 (Best Match)

C 1 0 0 100

D 0 1 0 010
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Non-Proxy Hosts: Specifies the host name of the non-proxy servers.

2.4.5.2 Compression
This section lets you specify specifies the default HTTP compression playback settings.

Enable GZIP: When selected, the GZIP compression format is enabled.

Enable Deflate: When selected, deflate is enabled.

2.4.5.3 Headers
This section specifies the default HTTP header playback settings.

Browser Emulation: Specifies which browser to emulate for script playback. The 
Default is the recorded browser.

Language: Specifies which language to use for script playback. The default is English.

HTTP Version: Specifies which HTTP version to use for script playback.

Accept String: Specifies the Accept string to use in the Request header for script 
playback.

Global Headers: Specifies any custom "Global Headers: string to use in the Request 
header for script playback. The format is in the form: 
name1:value1;name2:value2;name3:value3. For example: x-oracle-slm-message-id: 
bcn=<beacon_name>; svc=<service_name>.

2.4.5.4 Connections
This section specifies the default HTTP playback connections settings.

Enable Keep Alive: When selected, keep alive is enabled.

Max Number of Keep Alive Requests: Specifies the maximum number of requests to 
make on a keep alive connection before closing it or select Unlimited for an unlimited 
number.

Max HTTP Connections Per User: Specifies the maximum number of server 
connections per process per server. Each VU makes multiple connections to request 
additional resources for images and additional frames for example. Setting this option 
specifies a limit on the total number of connections that the VUs can make to the 
server. The default setting is 'Default', which means use the default connection limits 
as configured on the agent machine. (See Microsoft KBase article Q183110 for more 
information.) 

2.4.5.5 SSL
This section specifies the default HTTP playback Secure Sockets Layer (SSL) settings.

SSL Version: Specifies the SSL version to use.

2.4.5.6 Other
This section specifies the default miscellaneous HTTP playback settings.

Do not request URLs ending in: Specifies the URLs that will not be requested when 
the URL ends with one of the specified patterns or file types. Specify the ending 
pattern or file type separated by commas.

Ignore URLs that Match Regex: Specifies the Regular Expression(s) string to use to 
ignore specific resources. For example, the expression Login_Banner(.+?) would 
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not download resources such as Login_Banner1.gif and Login_Banner2.gif. Multiple 
Regular Expressions can be separated using a comma (,).

Cache Emulation: Specifies the type of user to simulate. This is useful for simulating 
different profiles of virtual users. A first time user places more of a load on the Web 
server because pages and image are not yet cached. A repeat user places less of a load 
on the server as only newer pages are requested and brought down from the Web 
server. There are three options:

■ Do Not Cache: cache is not used. When using WinInet, selecting Do Not Cache 
has the same effect as selecting 1st Time as the Cache Emulation method. In this 
case, document cache is not created and not cleared.

■ 1st Time User: The virtual users are considered to be using the Web site or 
application for the first time for each iteration so no cache is used. The cache is 
used during the iteration.

■ Repeat User: The virtual users are considered to have visited or used the Web site 
or application previously. Pages and images are retrieved from the cache.

Enable Cookies: When selected, the virtual user profiles will use cookies. Use this 
setting if your Web application uses cookies to manage session and other context 
information.

Download Local Files: When selected, the Java Agent retrieves the requested local file 
contents.

Preserve Cookies between iterations: Used to preserve or automatically clear cookies 
added to the browser in the Run section between successive iterations of the Run 
section.

■ Cookies added to the browser in the Initialize section will be preserved forever, 
unless explicitly removed in script code.

■ Cookies added to the browser in the Run section will always be preserved 
between the final iteration of the Run section and the Finish section.

Preserve Connections Between Iterations: Used to preserve connections between 
OpenScript and the browser between successive iterations of the script.

Max Content Size (KB): Specifies the maximum number of KB to download from a 
server for a given request. The default value of this option is "Unlimited". However, 
the maximum Virtual User Display Size is set to 1024KB, which may cause content in 
the Details view to be truncated if the content size exceeds the Virtual User Display 
Size. You can configure the Maximum Virtual User Display Size by adding the 
following setting in the Additional Arguments field of the General Playback 
Preferences:

-MAX_VUDATA_BYTES xxxxxxxx

Where xxxxxxxx is the size in KB to set as the Maximum Virtual User Display Size. 
For example: 

-MAX_VUDATA_BYTES 10000000

See Section 2.4.1, "General Playback Preferences" for additional information about 
specifying Additional Arguments.

Socket Timeout: Specifies the maximum number of seconds to wait for a socket 
connection before timing out.
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2.4.5.7 Download Manager
This section lets you specify the default settings for which resources (embeded objects, 
images, css, js, jars, etc.) to download for a page during playback of a script.

The Download Manager does the following:

■ Parses resource URLs embeded in an html page during playback.

■ Simplifies scripts by filtering out resource URLs from scripts.

■ Provides user control over which resource URLs are downloaded or executed 
during playback.

The resource downloads will be included in the playback results in the Results view 
and the HTML Results report. Each downloaded resource counts as a hit in the Hits 
per Second and Total Hits reports. The size in kilobytes for each resource is included in 
the Kilobytes per Second and Total Kilobytes reports.

The Download Manager section has the following options:

Use Download Manager: When selected, the Download Manager is enabled during 
playback. When cleared, the Download Manager is not enabled during playback.

Ignored Resources (Use RegEx): Specifies the Regular Expression(s) string to use to 
ignore specific resources. For example, the expression Login_Banner(.+?) would 
not download resources such as Login_Banner1.gif and Login_Banner2.gif. Multiple 
Regular Expressions can be separated using a comma (,).

CSS Resource: When selected, css resources in <Link> tags are downloaded during 
playback. When cleared, css resources are not downloaded during playback.

Image Resource: When selected, image resources in <Img> tags, in the "background" 
attribute of a tag, or in <style> tags with "background:url" patterns are downloaded 
during playback. When cleared, image resources are not downloaded during 
playback.

Embeded Object Resource: When selected, object resources in <Embed> tags or in 
<Object> tags are downloaded during playback. When cleared, object resources are 
not downloaded during playback.

Script Resource: When selected, script resources in <Script> tags are downloaded 
during playback. When cleared, script resources are not downloaded during playback.

Applet Resources: When selected, applet resources in <Applet> tags are downloaded 
during playback. When cleared, applet resources are not downloaded during 
playback.

Note: Certain resource URLs that do not appear directly in the 
HTML page contents are not parsed by the Download Manager. For 
example, an HTML page that imports a '.css' file. When the browser 
loads the HTML page, it automatically loads the '.css' file and 
downloads any '.gif' resources.

Certain resource URLs that are not inside an HTML tag are not parsed 
by the Download Manager. For example, a resource URL that is 
dynamically composed by Javascript cannot be parsed by Download 
Manager.
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2.4.6 Oracle EBS/Forms Functional Test Preferences
This category lets you specify playback preferences for Oracle EBS/Forms Functional 
Tests. The resulting dialog box displays the following sections and fields:

2.4.6.1 Event Timeout
This section lets you specify the default forms event timeout setting.

Forms Startup Timeout: Specifies the maximum number of seconds OpenScript 
should wait for a form to appear before considering the form not found. This is the 
default timeout when waiting for a form to appear before invoking an action against it. 
This is also the default timeout when waiting for a form to appear before continuing 
the script.

Forms Action Timeout: Specifies the maximum number of seconds OpenScript should 
wait for forms action playback until success.

Forms Response Timeout: Specifies the maximum number of seconds OpenScript 
should wait for forms response before timing out.

2.4.6.2 Miscellaneous
This section lets you specify screenshot capture preferences.

Capture screenshots: Specifies the amount of time to wait before capturing a 
screenshot of the page.

2.4.7 Oracle EBS/Forms Load Test Preferences
This category lets you specify playback preferences for Oracle EBS/Forms Load Tests. 
The resulting dialog box displays the following sections and fields:

2.4.7.1 Miscellaneous
This section lets you specify playback log preferences.

Capture Message Details: Specifies if forms message details are captured during 
playback. When selected, OpenScript captures and stores Forms message requests, 
responses, and information about all loaded Forms components during playback. This 
information is useful to have when debugging the script.

OpenScript displays captured details in the "Messages" and "Object Details" tabs of the 
Details view. Oracle Load Testing displays this information in the Virtual User Display 
based on the "Virtual User Display" settings.

Capturing message details is a memory-intensive operation. During heavy load 
testing, it is recommended to clear this setting to reduce the amount of heap space 
required by the agent.

Show Message Log In the Console: Specifies if forms message log details are shown it 
the Console tab. When selected, the message log details are shown in the console. 
When cleared, the message log details are not shown in the console.

2.4.8 Shared Data Service Preferences
This category lets you specify playback preferences for the agent Shared Data Service. 
The resulting dialog box displays the following fields:

OATS Credential: Specifies the authentication credentials to use to establish the 
communication between the shared queue and the Virtual User.
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■ Enable global shared data access credentials: When selected, when selected, the 
shard data access credentials are enabled. Specify the Address, User Name, and 
Password.

■ Address: Specifies the address of the Oracle Load Testing for Web Application 
server to use for the shared data service.

■ User name: Specifies the user name to use for authentication. The default name is 
oats unless changed in the Oracle Application Testing Suite configuration.

■ Password: Specifies the password to use for authentication. This should be the 
same password specified in the Encryption setting of the General preferences if the 
Encrypt script data setting is selected.

Actions on Shared Data: Specifies actions on shared data.

■ Timeout: Specifies the maximum number of seconds to wait for actions on shared 
data to occur before timing out.

2.4.9 Web Functional Test Preferences
This category lets you specify the default preferences for Web Functional Test script 
playback. The resulting dialog box displays the following sections and fields:

2.4.9.1 Object Timeout
This section lets you specify the default object playback timeout setting.

Timeout: Specifies the maximum number of seconds OpenScript should wait for an 
object to appear before considering the object not found. This is the default timeout 
when waiting for an object to appear before invoking an action against it. This is also 
the default timeout when waiting for an object to appear before continuing the script.

You can override individual object wait timeouts in waitForPage() or 
object.waitFor() by editing their "timeout" properties. Action timeouts cannot be 
overridden. 

2.4.9.2 Miscellaneous
This section lets you specify the default playback settings for Web functional test-type 
scripts.

Capture HTML: When selected, the page HTML will be captured.

Capture screenshots: When selected, a screen image of the page will be captured.

Capture URLs: When selected, the page URL will be captured.

Capture frames: When selected, the HTML frames on the page will be captured.

Clear session cookies between iterations: When selected, session cookies are cleared 
from cache between playback iterations.

Clear persistent cookies between iterations: When selected, persistent cookies are 
cleared from cache between playback iterations.

Clear cache between iterations: When selected, pages are cleared from cache between 
playback iterations.

Clear session cookies before playing back: When selected, session cookies are cleared 
from cache before playback.

Clear persistent cookies before playing back: When selected, persistent cookies are 
cleared from cache before playback.
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Clear cache before playing back: When selected, pages are cleared from cache before 
playback.

2.4.9.3 Capture Screenshot Interval
This section lets you specify the default screen capture delay setting.

Delay time for capture screenshot: Specifies the amount of time to wait before 
capturing a screenshot of the page.

2.4.9.4 Object Tests
This section lets you specify the default date format.

Date Format: Specifies the month, day, year, and time format. The Date Pattern follows 
standard Java SimpleDateFormat string conventions. The default value is MMM d, 
yyyy h:mm:ss a (month, day, year, hour, minutes, seconds, am/pm). 

2.5 Record Category
This category lets you specify recording preferences.

2.5.1 General Preferences
Selecting the Record preferences node let you specify the following general recording 
preference:

■ Show external toolbar while recording: When selected, the floating recording 
toolbar will be shown while recording. When cleared the floating toolbar is not 
shown.

2.5.2 HTTP Preferences
This dialog box lets you specify recording preferences for the HTTP module. The 
resulting dialog box displays the following sections and fields:

2.5.2.1 General
This tab lets you specify the general browser recorder settings.

Setup: Specifies the network settings for proxy recording.

■ Network Interface: Enter or select the network IP address of the proxy server.

■ Port: Specify the port to use on the proxy server.

■ Additional Arguments: Specify any additional command line arguments to use 
when starting the proxy server.

■ Maximum Download Size (MB): Specify the file size for file downloads.

■ Only record requests originating from the local machine: When selected, only 
requests originating from the local machine are recorded by the HTTP proxy 
recorder.

Client-Side Digital Certificate File: Enter the name of a .PFX-formatted digital 
certificate file or use the Browse button to select a file.

■ File: Specifies the name of the setup file. Enter the name or use the Browse to 
select the file from a drive and directory location.
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■ Choose above pfx file to store: Specifies the private-key password defined for the 
client certificate PFX file when the certificate was exported from Internet Explorer. 
Click Store and enter the private-key password for the client certificate.

SSL Version: Specifies the SSL version to use.

■ SSL Version: Select SSL version to use for the proxy server.

Close browser when stopping recorder: Specify the browser options that will be used 
during HTTP recording.

■ Close browser: When selected, the browser closes automatically when recording is 
stopped.

Always Launch a new browser when starting recorder: Specify the browser options 
that will be used during HTTP recording.

■ Launch browser: When selected, the browser launches automatically when 
recording is started.

Error Handling: Specify the error handling options that will be used during HTTP 
recording.

■ Record navigations that return error code 404: When selected, the HTTP recorder 
records navigations that return a Server Status Code 404: Not Found.

2.5.2.2 Proxy Settings
This tab lets you specify the default Proxy recorder settings.

Chain Proxy: Specifies if the OpenScript proxy is chained to another proxy.

■ Use browser's proxy: When selected, the HTTP recorder uses the proxy 
configuration specified by the browser.

■ Use specified proxy: When selected, OpenScript uses the specified proxy.

– Use proxy configuration script: When selected, the specified configuration 
scripts will be used.

– Address: Specify the URL to the JavaScript file containing the 
FindProxyForURL JavaScript function supplied by the system administrator 
for the intranet environment.

– Use proxy server: When selected, the specified proxy server will be used. 

– Address: specify the network IP address of the proxy server to which to chain 
the OpenScript proxy.

– Port: Specify the port to use on the chained proxy server. 

Proxy Authentication: Specifies the log in credentials for authentication.

■ Username: Specify the user name to use for authentication.

■ Password: Specify the password to use for authentication.

2.5.2.3 URL Filters
This tab lets you specify the URL type(s) to filter during recording.

Name: Shows the name(s) of the defined filters. Select the checkbox to enable the filter. 
Clear the checkbox to disable the filter.

Pattern: Shows the pattern(s) specified for the defined filters.
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Match by: Shows the match setting(s) (Content Type or URL) specified for the defined 
filters.

Add: Opens a dialog box for specifying a URL filter.

Edit: Opens a dialog box for editing the selected URL filter.

Delete: Deletes the selected URL filter.

Automatically filter download manager resources: When selected, the proxy recorder 
automatically filters the URL resources based upon the settings specified in the 
Download Manager section of the HTTP Playback preferences. When cleared, the 
Download Manager settings are not used during recording.

2.5.3 Oracle EBS/Forms Functional Test Preferences
This dialog box lets you specify recording preferences for the Oracle Forms Functional 
Test module. The resulting dialog box displays the following sections and fields:

2.5.3.1 General
This tab lets you specify the general browser recorder settings.

Miscellaneous: Specifies if screenshots are captured.

■ Capture screenshots: When selected, screenshots are captured during recording.

2.5.3.2 Object Identification
This tab lets you specify the Oracle Forms object identification attributes.

Name: Shows the name(s) of the defined Oracle Forms object identifiers.

Attributes: Shows the pattern(s) specified for the defined Oracle Forms object 
identifiers.

Add: Opens a dialog box for specifying a new Oracle Forms object identifier.

Edit: Opens a dialog box for editing the selected Oracle Forms object identifier.

Delete: Deletes the selected Oracle Forms object identifier.

2.5.4 EBS/Forms Load Test Preferences
This dialog box lets you specify recording preferences for the Oracle Forms Load Test 
module. The resulting dialog box displays the following section and fields:

Applet Parameters: Specifies the Forms Applet Class property to use to record Forms 
applications.

■ EBS Forms: When selected, the OpenScript Applet Class property 
oracle.forms.engine.main is used to record EBS/Forms applications.

■ Custom Forms: When selected, the specified Applet Class property is used to 
record custom non-Web deployed Forms applications.

Miscellaneous: Specifies the miscellaneous record preferences.

■ Force HTTP Recording: When selected, recording communicates over HTTP 
disregarding the connection parameter values of the Applet page. This setting may 
be necessary if the site has an Applet loading page that is set to communicate over 
a socket instead of using HTTP. If the contents of the Applet loading page are set 
to Socket, OpenScript cannot record the socket traffic.
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2.5.5 Siebel Functional Test Preferences
This dialog box lets you specify recording preferences for the Siebel Functional Test 
module. The resulting dialog box displays the following sections:

2.5.5.1 General
This tab lets you specify the Siebel general preferences.

SI Elements Paths:  Specifies if the Siebel script recorder uses Siebel specific object 
identifier paths for the webdom elements that are marked in the Siebel application as 
Standard Interactivity (SI) controls instead of normally recorded attributes such as text, 
href, and index.

■ Use special paths for SI elements: When selected, the Siebel script recorder 
records only the Siebel tag attributes when normal html elements (A, TD, INPUT, 
DIV, etc.) are used as SI controls in a Siebel application.

■ Path: Specifies the object identifier path to use for Siebel SI controls. The Siebel 
attributes are RN (repository name), OT (object type) and UN (unique name).

■ Edit: Opens a dialog box for editing the object identifier path.

Sitemap Links: Specifies if the Siebel script recorder uses Siebel site map page specific 
object identifier paths when recording actions on links within the Siebel site map page 
instead of normally recorded object identifier paths that use the standard path. The 
standard path includes a particular document index or frame name, which may 
change dynamically on playback of the script.

■ Use global paths for Sitemap link: When selected, the Siebel script recorder 
records only a site map page specific path for the object identifier path.

■ Path: Specifies the object identifier path to use for Siebel site map page links. The 
Siebel attributes are RN (repository name), OT (object type) and UN (unique 
name).

■ Edit: Opens a dialog box for editing the object identifier path.

Miscellaneous: Specifies the miscellaneous Siebel record preferences.

■ Record "waitForPage actions: When selected, the script recorder generates "wait 
for page" actions for test steps that generate a page transition in the browser. When 
cleared, the script recorder generates a "capture page" action for test steps in Siebel 
applications. Some Siebel actions may not generate the page transition needed to 
reliably play back "wait for page" actions. Clearing this setting for Siebel 
Functional test scripts allows scripts to record the "capture page" action instead of 
the "wait for page" action for more accurate script playback.

2.5.5.2 Object Identification
This tab lets you specify the Siebel object identification attributes.

Name: Shows the name(s) of the defined Siebel object identifiers.

Attributes: Shows the pattern(s) specified for the defined Siebel object identifiers.

Add: Opens a dialog box for specifying a new Siebel object identifier.

Edit: Opens a dialog box for editing the selected Siebel object identifier.

Delete: Deletes the selected Siebel object identifier.
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2.5.6 Web Functional Test Preferences
This dialog box lets you specify recording preferences for the Web Functional Test 
module. The resulting dialog box displays the following sections and fields:

2.5.6.1 General
This tab lets you specify the general Web Functional test recorder settings.

Browser: Specify the browser options that will be used during Web Functional test 
recording.

■ Always launch a new browser when recording a different script: When selected, 
a new instance of the Internet Explorer browser is launched for each new script 
recording. When cleared, a new browser is launched only for the first script 
recording of the OpenScript session. The general case is to launch a new browser 
instance for each specific script. However, when chaining scripts using a shell 
script where each script needs to use the same instance of the browser, clearing 
this setting will cause subsequent scripts recordings to use the same browser 
instance as the first recording.

Miscellaneous: Specifies the miscellaneous record settings.

■ Capture screenshots: When selected, screen images are captured during 
recording.

■ Capture HTML: When selected, page source HTML is captured during recording.

■ Capture URLs: When selected, the page URL will be captured.

■ Capture Frames: When selected, the HTML frames on the page will be captured.

■ Ignore Auto Page: When selected, server-side auto pages are ignored during 
recording.

■ Action Cache Interval(s): Specifies how often to cache page actions during 
recording. The following cases are determined by this setting: 

If while recording, the text on the same Web page element is changed within the 
Action Cache Interval time setting, the previously recorded value will be replaced 
by the changed value. In the Java code, the setText action will be replaced with 
the changed value.

If while recording, a browser window closes within the Action Cache Interval after 
a user performs an action on a web page (for example, a button click) the window 
close event will not be recorded, as the window close event is considered to be 
caused by the previously performed action.

■ Record "waitForPage actions: When selected, the script recorder generates "wait 
for page" actions for test steps that generate a page transition in the browser. When 
cleared, the script recorder generates a "capture page" action for test steps that 
generate a page transition in the browser. For Web functional test scripts, the "wait 
for page" action is the normal record option. See the Siebel Functional test record 
preferences for additional information.

2.5.6.2 Object Identification
This tab lets you specify recording preferences for the Web Functional Test module.

Name: Shows the name(s) of the defined Web object identifiers.

Attributes: Shows the pattern(s) specified for the defined Web object identifiers.

Add: Opens a dialog box for specifying a new Web object identifier.
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Edit: Opens a dialog box for editing the selected Web object identifier.

Delete: Deletes the selected Web object identifier.

2.5.7 Web Services Preferences
This tab lets you specify recording preferences for the Web Services module. The 
resulting dialog box displays the following sections and fields:

2.5.7.1 General
This tab lets you specify the general browser recorder settings.

Request Timeout: Specifies the amount of time in seconds to wait for a response to a 
request before timing out.

Generate default values for requests: When selected, the OpenScript XML parser 
generates the specified values for the primitive data types by default. The values may 
be empty. (For other Axis or Oracle parsers the parameters of the methods must be 
specified.)

■ xsd:string: Specifies the default value for String data type parameters.

■ xsd:int: Specifies the default value for Integer data type parameters.

■ xsd:long: Specifies the default value for Long data type parameters.

■ xsd:float: Specifies the default value for Float data type parameters.

■ xsd:double: Specifies the default value for Double data type parameters.

■ xsd:boolean: Specifies the default value for Boolean data type parameters.

2.5.7.2 Parser Tools
This tab lets you specify additional Apache AXIS parsers to use with the Web Services 
module.

Apache AXIS 1.X: Specifies the root folder of the Apache AXIS 1.X implementation of 
the SOAP ("Simple Object Access Protocol") parser. Download "AXIS 1.4 Final" binary 
ZIP file (axis-bin-1_4.zip) from http://ws.apache.org/axis/, unpack the zip file, 
and then specify the AXIS 1.X root folder using the Browse button.

Apache AXIS 2: Specifies the root folder of the Apache AXIS 2 implementation of the 
SOAP ("Simple Object Access Protocol") parser. Download the AXIS 2 Standard Binary 
Distribution ZIP file (axis2-1.3-bin.zip) from http://ws.apache.org/axis2/, 
unpack the zip file, and specify the AXIS 2 root folder using the Browse button.

2.5.7.3 Proxy Configuration
The Web Services module uses the integrated HTTP Proxy recorder to record 
SOAP/HTTP protocol requests. Specify the proxy settings for the parsers to be able to 
parse the internet WSDL file from an internal network using the HTTP Record 
Preferences Proxy Settings tab. 

2.6 Step Group Category
This category lets you specify script step group creation, naming, and numbering 
preferences. Step groups allow you to optionally organize your OpenScript script 
commands into logical groupings based on the type of script you are creating. If step 
groups are enabled during recording, your script commands will be listed within a 
step group node (or sections) in the tree view (or code view) of the script. Step groups 
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can also be added or modified manually or completely disabled if you prefer not to 
use them. 

2.6.1 ADF Functional Test Preferences
This dialog box lets you specify how step groups are created for ADF Functional Tests. 
See the Basic module Step Group preferences on  on page 2-22 for additional 
information. The resulting dialog box displays the following options:

Step Creation: Specifies if step groups are created or not by default during script 
recording.

■ Based on time threshold: When selected, step groups are created based upon the 
specified recording time threshold. Specify the Threshold time value in seconds. 

■ ADF Functional: When selected, step groups will be created based on the ADF 
component. Groups are created whenever an ADF component is changed.

■ Do not create steps: When selected, step groups will not be created automatically 
during script recording.

Step Naming: Specifies if step groups are named or not by default during script 
recording. 

■ By page title: When selected, step groups are named based upon the title of the 
Web page as defined in the HTML <Title> tag for the main page and the page URL 
will also be shown in parentheses in the step group name. If a title is not specified 
then the step group will be named "No Title" but URL will still be displayed.

■ ADF Component: When selected, step groups are named based upon the 
component title specified by the ADF JavaScript. If no title is found in the ADF 
Javascript, step groups are named based upon the title of the Web page as defined 
in the HTML <Title> tag. If no is title found, step groups are named based upon 
the subsequent child elements.

■ Do not name steps: When selected, step groups will not be named automatically 
during script recording.

Step Numbering: Specifies if step groups are numbered or not by default during script 
recording. 

■ Auto number: When selected, step groups are numbered sequentially starting 
with step 1.

■ Do not number steps: When selected, step groups will not be numbered 
automatically during script recording.

2.6.2 Basic Module Preferences
This dialog box lets you specify how step groups are created. The resulting dialog box 
displays the following options:

Step Creation: Specifies if step groups are created or not by default during script 
recording.

■ Based on time threshold: When selected, step groups are created based upon the 
specified recording time interval threshold. Specify the Threshold time value in 
seconds. Script commands that occur within the specified time interval relative to 
each other, will be organized into the same step group. For example, if a user 
performs multiple actions on a page within the specified time interval would 
result in those action commands being grouped into the same step group. This 
may be useful for grouping commands into step groups for AJAX applications 
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where full Web page transitions may not occur which would allow you to group 
commands by page.

■ Do not create steps: When selected, step groups will not be created automatically 
during script recording.

Step Naming: Specifies if step groups are named or not by default during script 
recording. Step names will be displayed in the step nodes of the tree view and also 
shown in the code view. Step names can also be edited manually in either view.

■ Do not name steps: When selected, step groups will not be named automatically 
during script recording.

Step Numbering: Specifies if step groups are numbered or not by default during script 
recording. 

■ Auto number: When selected, step groups are numbered sequentially starting 
with step 1.

■ Do not number steps: When selected, step groups will not be numbered 
automatically during script recording.

2.6.3 HTTP Preferences
This dialog box lets you specify how step groups are created, named, and numbered 
for HTTP scripts. See the Basic module Step Group preferences on  on page 2-22 for 
additional information. The resulting dialog box displays the following options:

Step Creation: Specifies if step groups are created or not by default during script 
recording.

■ Based on time threshold: When selected, step groups are created based upon the 
specified recording time threshold. Specify the Threshold time value in seconds. 

■ Do not create steps: When selected, step groups will not be created automatically 
during script recording.

Step Naming: Specifies if step groups are named or not by default during script 
recording.

■ By page title: When selected, step groups include the title of the web page.

■ Do not name steps: When selected, step groups will not be named automatically 
during script recording.

Step Numbering: Specifies if step groups are numbered or not by default during script 
recording.

■ Auto number: When selected, step groups are numbered sequentially starting 
with step 1.

■ Do not number step: When selected, step groups will not be numbered 
automatically during script recording.

2.6.4 Oracle EBS/Forms Functional Test Preferences
This dialog box lets you specify how step groups are created for EBS Forms Functional 
Tests. See the Basic module Step Group preferences on  on page 2-22 for additional 
information. The resulting dialog box displays the following options:

Step Creation: Specifies if step groups are created or not by default during script 
recording.
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■ Based on time threshold: When selected, step groups are created based upon the 
specified recording time threshold. Specify the Threshold time value in seconds. 

■ Forms Functional Test: When selected, step groups will be created based on the 
windows in which the actions occur. Groups are created whenever a Window 
Activate action is recorded. 

■ Web Functional: When selected, step groups are created based upon the loading 
of a new Web page being loaded in the browser. When a new page is finished 
loading, the page and subsequent user actions performed on that page prior to the 
next page load will be grouped into the same step group.

■ Do not create steps: When selected, step groups will not be created automatically 
during script recording.

Step Naming: Specifies if step groups are named or not by default during script 
recording. 

■ Forms Functional Test: When selected, step groups will be named the same as the 
window titles. Groups will be named the same as the window that is active.

■ Web Functional: When selected, step groups are named based upon the title of the 
Web page as defined in the HTML <Title> tag for the main page and the page URL 
will also be shown in parentheses in the step group name, If a title is not specified 
then the step group will be named "No Title" but the URL will still be displayed.

■ Do not name steps: When selected, step groups will not be named automatically 
during script recording.

Step Numbering: Specifies if step groups are numbered or not by default during script 
recording.

■ Auto number: When selected, step groups are numbered sequentially starting 
with step 1.

■ Do not number steps: When selected, step groups will not be numbered 
automatically during script recording.

2.6.5 Oracle EBS/Forms Load Test Preferences
This dialog box lets you specify how step groups are created for EBS Forms Load Tests. 
See the Basic module Step Group preferences on  on page 2-22 for additional 
information. The resulting dialog box displays the following options:

Step Creation: Specifies if step groups are created or not by default during script 
recording.

■ Based on time threshold: When selected, step groups are created based upon the 
specified recording time threshold. Specify the Threshold time value in seconds. 

■ Oracle EBS/Forms Load: When selected, step groups will be created based on the 
windows in which the actions occur. Groups are created whenever a Window 
Activate action is recorded.

■ Do not create steps: When selected, step groups will not be created automatically 
during script recording.

Step Naming: Specifies if step groups are named or not by default during script 
recording. 

■ By page title: When selected, step groups are named based upon the title of the 
Web page as defined in the HTML <Title> tag for the main page and the page URL 
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will also be shown in parentheses in the step group name. If a title is not specified 
then the step group will be named "No Title" but URL will still be displayed.

■ Oracle EBS/Forms Load: When selected, step groups will be named the same as 
the window titles. Groups will be named the same as the window that is active.

■ Do not name steps: When selected, step groups will not be named automatically 
during script recording.

Step Numbering: Specifies if step groups are numbered or not by default during script 
recording. 

■ Auto number: When selected, step groups are numbered sequentially starting 
with step 1.

■ Do not number steps: When selected, step groups will not be numbered 
automatically during script recording.

2.6.6 Siebel Functional Test Preferences
This dialog box lets you specify how step groups are created for Siebel Functional 
Tests. See the Basic module Step Group preferences on  on page 2-22 for additional 
information. The resulting dialog box displays the following options:

Step Creation: Specifies if step groups are created or not by default during script 
recording.

■ Based on time threshold: When selected, step groups are created based upon the 
specified recording time threshold. Specify the Threshold time value in seconds. 

■ Web Functional: When selected, step groups are created based upon the loading 
of a new Web page being loaded in the browser. When a new page is finished 
loading, the page and subsequent user actions performed on that page prior to the 
next page load will be grouped into the same step group.

■ Do not create steps: When selected, step groups will not be created automatically 
during script recording.

Step Naming: Specifies if step groups are named or not by default during script 
recording.

■ Siebel Functional: When selected, step groups will be named based upon the 
Siebel URL pattern. OpenScript uses a heuristic to evaluate the recorded URL of 
pages to determine a meaningful title.

■ Web Functional: When selected, step groups are named based upon the title of the 
Web page as defined in the HTML <Title> tag for the main page and the page URL 
will also be shown in parentheses in the step group name, If a title is not specified 
then the step group will be named "No Title" but the URL will still be displayed.

■ Do not name steps: When selected, step groups will not be named automatically 
during script recording.

Step Numbering: Specifies if step groups are numbered or not by default during script 
recording.

■ Auto number: When selected, step groups are numbered sequentially starting 
with step 1.

■ Do not number steps: When selected, step groups will not be numbered 
automatically during script recording.
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2.6.7 Siebel Load Test Preferences
This dialog box lets you specify how step groups are created, named, and numbered 
for Siebel scripts. See the Basic module Step Group preferences on  on page 2-22 for 
additional information. The resulting dialog box displays the following options:

Step Creation: if step groups are created or not by default during script recording.

■ Based on time threshold: When selected, step groups are created based upon the 
specified recording time threshold. Specify the Threshold time value in seconds. 

■ Do not create steps: When selected, step groups will not be created automatically 
during script recording.

Step Naming: Specifies if step groups are named or not by default during script 
recording.

■ By Siebel URL Pattern: When selected, step groups will be named based upon the 
Siebel URL pattern. OpenScript uses a heuristic to evaluate the recorded URL of 
pages to determine a meaningful title.

■ By page title: When selected, step groups include the title of the web page.

■ Do not name steps: When selected, step groups will not be named automatically 
during script recording.

Step Numbering: Specifies if step groups are numbered or not by default during script 
recording.

■ Auto number: When selected, step groups are numbered sequentially starting 
with step 1.

■ Do not number step: When selected, step groups will not be numbered 
automatically during script recording.

2.6.8 Web Functional Test Preferences
This dialog box lets you specify how step groups are created for Web Functional Tests. 
See the Basic module Step Group preferences on  on page 2-22 for additional 
information. The resulting dialog box displays the following options:

Step Creation: Specifies if step groups are created or not by default during script 
recording.

■ Based on time threshold: When selected, step groups are created based upon the 
specified recording time threshold. Specify the Threshold time value in seconds. 

■ Web Functional: When selected, step groups are created based upon the loading 
of a new Web page being loaded in the browser. When a new page is finished 
loading, the page and subsequent user actions performed on that page prior to the 
next page load will be grouped into the same step group.

■ Do not create steps: When selected, step groups will not be created automatically 
during script recording.

Step Naming: Specifies if step groups are named or not by default during script 
recording.

■ Web Functional: When selected, step groups are named based upon the title of the 
Web page as defined in the HTML <Title> tag for the main page and the page URL 
will also be shown in parentheses in the step group name, If a title is not specified 
then the step group will be named "No Title" but the URL will still be displayed.
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■ Do not name steps: When selected, step groups will not be named automatically 
during script recording.

Step Numbering: Specifies if step groups are numbered or not by default during script 
recording.

■ Auto number: When selected, step groups are numbered sequentially starting 
with step 1.

■ Do not number steps: When selected, step groups will not be numbered 
automatically during script recording.

2.7 Setting Project Preferences
To set Project preferences:

1. Start OpenScript.

2. Switch to the Developer Perspective.

3. Select Preferences from the Window menu.

4. Expand the desired node and select the Preferences category.

5. Specify the preferences as necessary for the selected category.
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3 Creating and Modifying Scripts

This chapter explains the procedures for creating and modifying basic scripts in 
OpenScript. The module chapters provide additional information about creating 
scripts using the features and capabilities provided within specific modules. 

3.1 Creating Repositories and Workspaces
Repositories and workspaces store project related script files and results log files. You 
can use repositories and workspaces to organize your various testing projects. 
OpenScript lets you create multiple workspaces.You can create repositories to organize 
the storage of your script projects.

A repository is the directory location where you store workspaces. Workspaces are 
user-specified subdirectories of the repository. As of version 9.10, OpenScript no 
longer uses an exclamation point at the end of the directory name to identify the 
directory as a Workspace directory. Any folder (directory) below the specified 
repository can be a workspace folder.

When you record and save scripts, or play back a script and save the log file, 
OpenScript stores the script or log file in the specified Workspace.

The OpenScript installation creates a default repository in C:\Documents and 
Settings\username\osworkspace\Repositories\<machinename>.<usernamename>.Defa
ult. You can create your own repositories and workspaces using OpenScript.

3.1.1 Creating a Repository
To create a repository:

1. Select OpenScript Preferences from the View menu.

2. Expand the OpenScript node.

3. Expand the General node.

4. Select the Repository node.

5. Click Add.

Note: As of OpenScript Version 9.10, scripts can be stored anywhere 
in the file system. However, any scripts you plan to run, along with 
any associated assets, in the Oracle Load Testing application must be 
stored in a repository/workspace.
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This dialog box lets you specify the name and location of the repository to use to 
store script files.

6. Enter a repository name. The name is required.

Name: Enter any name to identify the repository.

7. Enter the drive and directory location or click Browse to select the location to use 
for the repository.

Location: Enter the drive and directory path to the repository or use the Browse 
button to select a location. The location must be a valid drive and directory path.

8. Click OK to add the new repository to the list of repositories.

9. Click OK to close the preferences.

When you create new a script project, you can select the repository to use to store the 
project.

3.1.2 Managing Repositories
To add, edit, or delete repositories:

1. Select Manage Repositories from the Tools menu.

2. Select the repository where you want to create the workspace.

3. Click the Add, Edit or Delete buttons to manage repositories.

4. Click Close when finished.

3.1.3 Managing Folders
When starting a new testing project, you should create a project-specific Workspace or 
file folder to store related files. 

To create, rename, or delete workspaces or file folders:

1. Select Manage Folders from the Tools menu. OpenScript opens a dialog box for 
managing file folders and workspaces in repositories.

2. Expand the tree and select the workspace or file folder to manage.

3. Click New, Rename, or Delete buttons to manage workspaces or file folders.

4. Click Close when finished.

3.1.4 Managing Scripts
To rename or delete scripts:

1. Select Manage Scripts from the Tools menu.

2. Select the script.

3. Click the Rename or Delete buttons to manage script files.

4. Click Close when finished.

Note: If you plan to use OpenScript scripts with Oracle Load Testing, 
the repository names you specify should match the repository name 
specified in Oracle Load Testing (including case).
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3.2 Creating a Script Project
You must create a script project to generate the basic structure that you can then 
customize.

To create a script project:

1. Select New from the File menu.

2. Expand a group node and select the type of asset or script to create:

Functional Testing (Browser/GUI Automation): The Functional Testing group 
contains the following script types:

■ Oracle Fusion/ADF: This option lets you create a new script for automated 
functional testing of Oracle Application Development Framework 
(ADF)-based applications and other applications that utilize Web and ADF 
components at the browser/gui level. The resulting script will contain the 
Initialize, Run, and Finish nodes. The Run node will contain recorded Web 
navigations based upon the defined Step Group preferences and the Web 
navigations and ADF actions performed during recording. You can edit the 
script tree or Java code to customize the script.

■ Oracle EBS/Forms: This option lets you create a new script for automated 
functional testing of Oracle E-Business Suite and other applications that utilize 
Web and Oracle Forms components at the browser/gui level. The resulting 
script will contain the Initialize, Run, and Finish nodes. The Run node will 
contain recorded Web navigations based upon the defined Step Group 
preferences and the Web navigations and Forms actions performed during 
recording. You can edit the script tree or Java code to customize the script.

■ Siebel: This option lets you create a new script for automated functional 
testing of Siebel applications that utilize Siebel High Interactivity and 
Standard Interactivity/Web controls at the browser/gui level. The resulting 
script will contain the Initialize, Run, and Finish nodes. The Run node will 
contain recorded Web navigations based upon the defined Step Group 
preferences and the Web navigations performed during recording. You can 
edit the script tree or Java code to customize the script. 

■ Web: This option lets you create a new script for automated functional testing 
of Web applications at the browser/gui level. The resulting script will contain 
the Initialize, Run, and Finish nodes. The Run node will contain recorded Web 
navigations based upon the defined Step Group preferences and the Web 
navigations performed during recording. You can edit the script tree or Java 
code to customize the script.

General: The General group contains the following script types:

■ Java Code Script: This option lets you create a new automated test script 
using your own custom Java code through the OpenScript Eclipse IDE. A basic 
script structure contains only the Initialize, Run, and Finish nodes. You can 
edit the script tree or Java code to develop your own custom script.

■ Web Services: This option lets you create the basic structure of a Web Services 
script a new script for automated testing of Web Services at the SOAP/HTTP 
protocol level. A Web Services script structure contains only the Initialize, 
Run, and Finish nodes. You can use the WSDL Manager to add WSDL files 
and edit the script tree or Java code to customize the script. If you have a Web 
Services client application written already that communicates over HTTP and 
which communicates through a proxy, you can record the traffic using the 
OpenScript HTTP recorder.
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Load Testing (Protocol Automation): The Load Testing group contains the 
following script types:

■ Oracle Fusion/ADF: This option lets you create a new script for load testing of 
Oracle Application Development Framework (ADF)-based applications and 
other applications that utilize HTTP and ADF protocols at the protocol level. 
The resulting script will contain the Initialize, Run, and Finish nodes. The Run 
node will contain recorded HTTP protocol navigations based upon the defined 
Step Group preferences and the navigations and ADF protocol for actions 
performed during recording. You can edit the script tree or Java code to 
customize the script.

■ Oracle EBS/Forms: This option lets you create a new script for load testing of 
Oracle E-Business Suite and other applications that utilize HTTP and Oracle 
Forms (NCA) protocols at the protocol level. The resulting script will contain 
the Initialize, Run, and Finish nodes. The Run node will contain recorded 
HTTP protocol navigations based upon the defined Step Group preferences 
and the navigations and Forms protocol for actions performed during 
recording. You can edit the script tree or Java code to customize the script.

■ Siebel This option lets you create a Siebel script structure of a new OpenScript 
script project. A Siebel script lets you record Siebel Web navigations using a 
browser for load testing Siebel applications. The resulting script will contain 
the Initialize, Run, and Finish nodes. The Run node will contain recorded 
HTTP protocol navigations based upon the defined Step Group preferences 
and the Web and Siebel navigations performed during recording. You can edit 
the script tree or Java code to customize the script.

■ Web/HTTP This option lets you create a new script for load testing of Web 
Applications at the HTTP protocol level. The resulting script will contain the 
Initialize, Run, and Finish nodes. The Run node will contain recorded Web 
navigations based upon the defined Step Group preferences and the Web 
navigations performed during recording. You can edit the script tree or Java 
code to customize the script.

Script Asset: The Script Asset group contains the following script asset types:

■ Databank: This option lets you create a new databank or open an existing 
databank file. The new asset wizard lets you navigate to the databank file 
location of an existing databank file or enter the name of a new databank file. 
When you click Finish in the wizard, the existing or new databank file opens 
in a text editor view. 

■ Object Library: This option lets you create a new Object Library or open an 
existing Object Library. The new asset wizard lets you navigate to the Object 
Library file location of an existing Object Library file or enter the name of a 
new Object Library file. When you click Finish in the wizard, the existing or 
new Object Library file opens in the Object Library editor view. 

3. Click Next.

4. Select the location where you want to store the script project. As of OpenScript 
version 9.10, scripts can be stored in repositories and workspaces or anywhere else 
in the file system. However, load test scripts developed for use with Oracle Load 
Testing must be stored in a repository/workspace. 

■ Path: Shows the file path of the selected repository/workspace or file folder.

■ My Repositories: Specifies the repository where the script project will be 
saved. Select a repository and workspace from the tree. Repositories can be 
managed using Manage Repositories on the Tools menu.
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■ My Computer: Specifies the file folder location on the computer where the 
script project will be saved. Select a drive and folder from the tree.

■ [file list]: List the names of the existing files or scripts in the selected 
repository/workspace or file folder.

■ Script: Specify a name for the script project. The script name is required and 
must be unique.

5. Enter a script name.

6. Click Finish. For Java Code Scripts, a basic script tree will be created in the script 
view. You can edit the Java code in the code view. For module scripts, a script tree 
will be created in the script view. After you record the script, the tree view will 
contain the navigations and actions depending upon the type script. 

3.2.1 Opening Existing Scripts
The introduction of Script Assets (in Script Properties) requires pre-version 9.10 scripts 
to be migrated to the current version of 9.10 or higher. This section provides 
information about backwards compatibility of OpenScript scripts and upgrading 
OpenScript scripts.

Scripts created in older versions of OpenScript will always run in new versions of the 
product without modification from the command-line, Oracle Load Testing, and 
Oracle Test Manager.

Older OpenScript scripts may not be opened or played back in the newer version of 
the OpenScript User Interface without upgrading them first. 

Previously published script API functions are supported in the latest release. Some 
published API may be marked as deprecated, but will still work in the new release in 
order to maintain backwards compatibility.

3.2.1.1 Opening Older Scripts in OpenScript
OpenScript requires that scripts be upgraded to the latest release in order to open them 
in the OpenScript User Interface. You are not required to upgrade a script to the new 
version unless you want to open the script in the OpenScript User Interface. Older 
versions of OpenScript scripts can be run without modification from the 
command-line, Oracle Load Testing, and Oracle Test Manager.

OpenScript automatically prompts you to upgrade older version scripts to the current 
version whenever the script is opened in the OpenScript User Interface. When opening 
an older script, you can choose not to open the script and the script will not be 
upgraded. 

When prompted to upgrade a script, if the script depends on any child scripts or 
function libraries, OpenScript provides an option to upgrade the child scripts or 
function libraries to the new version also.

Caution: Version 9.10 and higher scripts cannot be played back in 
earlier versions of OpenScript, Oracle Load Testing, and Oracle Test 
Manager. If you want to maintain pre-version 9.10 scripts, you should 
make a back up copy of your scripts before opening and saving them in 
version 9.10 or higher. OpenScript automatically migrates any 
pre-version 9.10 scripts when the script is opened and saved in 
OpenScript version 9.10 or higher. 
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Once a script is upgraded to a new release, the script cannot be opened or run using 
older versions of Oracle Application Testing Suite (OpenScript, Oracle Load Testing, or 
Oracle Test Manager).

3.2.1.2 Migrating Older Scripts in OpenScript
If you wish to upgrade scripts without opening them individually in OpenScript, you 
can use the Migrate Scripts upgrade option on the Tools menu. The Migrate Scripts 
tool lets you migrate pre-version 9.10 scripts to the current version without having to 
open scripts individually. 

The Migrate Scripts tool provides options for migrating top-level scripts and locating 
all dependent child scripts. The Migrate Scripts tool lets you select which scripts to 
migrate to the current version and find any child scripts that also need to be migrated.

Version 9.10 does not permit absolute paths for repositories or script assets in scripts 
that will be used with Oracle Load Testing. However, version 9.0x scripts permitted 
absolute paths. If your version 9.0x scripts use absolute paths, you can run the version 
9.0x scripts, unmodified, in version 9.10 Oracle Load Testing. As soon as you upgrade 
the 9.0x scripts to 9.10 in the OpenScript User Interface or the Migrate Script tool, the 
script will not playback in Oracle Load Testing until the absolute paths are changed to 
relative paths. The Migrate Scripts tool does not migrate absolute paths to relative 
paths or to repository paths. The absolute paths must be changed in the scripts.

3.2.1.3 Running Mixed Versions of Scripts
You are advised not to run mixed versions of "job" scripts where a parent script calls 
child scripts or function libraries. This may happen in cases where you may have 9.1x 
"parent" scripts that run 9.0x "child" scripts or function libraries. Although this 
configuration has been tested and is supported, the combination of mixed versions 
scripts may lead to unpredictable results and some confusion as to which scripts are 
the latest version. In addition, mixed version job scripts may not be able to take 
advantage of certain new version 9.10 improvements, such as:

■ Version 9.10 provides an option to visually inspect and add child script functions 
into a parent script. If child scripts are not upgraded to 9.10, OpenScript will not 
display their available functions in the user interface options.

■ Version 9.10 scripts no longer require that parent scripts add all child script 
databanks as their own databanks. If child scripts are not upgraded to 9.10, then 
parent scripts still must have child script databanks added as their own databanks.

3.2.1.4 Multiple Users Opening Scripts
For existing scripts, the file concurrency control prevents multiple users from editing 
the same script. If you try to open a script that is in use by another user, The script 
copy wizard opens and you will be asked if you want to make a copy of the script and 
additional files. 

3.2.2 Migrating Scripts
To migrate scripts to the current version:

1. Select Migrate Scripts from the Tools menu.

This dialog box lets you migrate pre-version 9.10 OpenScript scripts to the current 
version. The Prompt on the top of the dialog box shows if the selected script is 
current or should be migrated and prompts for the appropriate action. The Script 
Migration Manager has the following options:
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■ Path: Shows the file path of the selected repository/workspace or file folder.

■ My Repositories: Specifies the repository for selecting scripts to migrate or 
search. Select a repository and workspace from the tree. 

■ My Computer: Specifies the file folder location on the computer for selecting 
scripts to migrate or search. Select a drive and folder from the tree.

■ [file list]: List the names of the existing files or scripts in the selected 
repository/workspace or file folder.

■ Script: Specify a name of a script to migrate or search.

■ Migrate: When enabled, the selected script is a pre-version 9.10 script and can 
be migrated to the current version. When disabled, the script is already a 
version 9.10 or higher script and doe not require migration.

■ Find child scripts: When enabled, the selected script is a pre-version 9.10 
script and can be migrated to the current version. When disabled, the script is 
already a version 9.10 or higher script and does not require migration.

2. Expand the My Repositories or My Computer trees to navigate to a folder 
containing the script files.

3. Select the script.

If Migrate is enabled, the script is a pre-version 9.10 and can be migrated. If 
Migrate is disabled, the script is already a version 9.10 or higher script and does 
not require migration.

If Find child scripts is enabled, the script is already a version 9.10 or higher script 
and you can use the Find child scripts feature to locate any child scripts that may 
be assets for the currently selected script. If child scripts are located, you can use 
the Migrate Child Scripts options to migrate child scripts or search for additional 
child scripts. If Find child scripts is disabled, the script is a pre-version 9.10 script 
and must be migrated to the current version.

4. Click Migrate or Find child scripts as required for the selected script file.

5. Click Close when finished.

3.2.3 Setting Script Properties
Script properties specify the property settings for a specific script. You can set script 
properties at any time when a script is open. Script properties include the following:

■ Script assets including Databanks, Object Libraries, Generic Jar files, and other 
scripts to run as child scripts.

■ Correlation properties for Load Testing (protocol automation)-type scripts.

■ Module properties specifying which module services to include with a script.

■ Step Group properties specifying how step groups are created during recording.

To set Script Properties:

1. Open or a create a script project.

2. Select Script Properties from the Script menu.

3. Select the property type in the left pane.

4. Use the options in the right pane to set specific properties.

5. Click OK when finished.
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The script property panes are described in the following sections.

3.2.3.1 Correlation
This dialog box lets you specify correlation properties for Load Testing (protocol 
automation)-type scripts. The Correlation pane has the following options:

■ Module: Specifies the module type the script will use for the correlation rules.

■ Selected Module's Settings: Shows the current script's Correlation library and 
rules settings. Expand the tree view to view the selected libraries and rules.

– Edit: Opens the correlation properties window for the specified module type.

3.2.3.2 Modules
This dialog box lets you specify which module services to include with a script. The 
Modules pane has the following options:

■ Modules: Shows which module services are included with the current script. The 
Basic and Utilities modules are common to all script types. The Shared Data 
module can also be used with all script types. The HTTP module is common to all 
load testing (protocol automation)-type scripts. The Functional Test and Web 
Functional Test modules are common to functional test-type script. Other modules 
are specific to a script type.

3.2.3.3 Script Assets
This dialog box lets you specify assets to a script. The Script Assets pane has the 
following options:

■ Asset: Lists the Assets added to a script by type in a tree view. Script Assets can be 
Databanks, Object Libraries, Generic Jar files, and other scripts.

■ File: Shows the files added as Assets to the current script. Expand the tree view in 
the Assets column to view the files.

■ Add: Opens a file selection dialog box for selecting the file to add as an asset. 
Expand the My Repositories or My Computer trees to navigate to a folder 
containing the file. 

■ Edit: Opens a file selection dialog box for changing which files is added as an 
asset.

■ Open: Opens the selected asset file in the appropriate editor.

■ Remove: Removes the selected asset file from the Assets tree. The file still exists in 
the file system or repository/workspace.

3.2.3.4 Step Groups
This dialog box lets you specify Step Group properties for the current script. The Step 
Group pane has the following options:

■ Module: Specifies the module type the script will use for the step group rules.

Note: As of OpenScript Version 9.10, scripts can be stored anywhere 
in the file system. However, any scripts you plan to run, along with 
any associated assets, in the Oracle Load Testing application must be 
stored in a repository/workspace that can be accessed by the Oracle 
Load Testing Controller.
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■ Selected Module's Settings: Shows the current script's Step Group settings. The 
settings are specific to the script type.

– Edit: Opens the Step Group properties window for the specified module type.

3.2.4 Importing Oracle Real User Experience Insight (REUI) Session Logs
You can import a REUI captured user session log file to generate an HTTP-based 
OpenScript load testing script. The REUI User Session log must be generated using 
REUI version 6 or higher. 

To create a script from REUI user session log: 

1. Select New from the File menu.

2. Expand the Load Testing (Protocol Automation) group. and select the Web/HTTP 
script type.

3. Click Next.

4. Select the repository and workspace where you want to store the script.

5. Enter a script name and click Finish. A new HTTP protocol script project is created 
in the Script tree.

6. Select Import Oracle Real User Experience Insight (REUI) Session Log from the 
Tools menu.

7. Enter the file path and name of the REUI User Session log (.tab file extension) or 
click Browse to select the file.

8. Set the Correlate script and Create step groups options.

9. Click OK. 

The REUI Session log import recorder parses the log file and generates an HTTP-based 
OpenScript script using the specified Correlate script and Create step groups settings. 
The script creation time can vary depending upon the size of the log file and if the 
Correlate script and Create step groups settings are set or not. Generally, when 
Correlate script and Create step groups are set, the script creation time increases. 

The REUI User Session Log consists of the following files and folder: 

■ data.tab file: This file contains the url, host and port, method, postdata, etc.

■ version.txt: This files contains the export version number which determines the 
version of the OpenScript REUI User Session Log importer to use.

■ content folder: This folder contains text content that corresponds to the entries in 
the data.tab file.

3.3 Modifying Scripts
Once you have created a script project, you can customize the script for your specific 
testing purposes using the available menu options or editing your own code in the 
Java Code view.

3.3.1 Adding Step Groups to a Script
Step groups provide a way to group multiple procedures into a single reporting step.

To add a manual step group to a script:

1. Open or create a script project.
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2. Select the script node where you want to add the step group.

3. Select the Script menu and then select Step Group from the Add sub menu.

This dialog box lets you specify or modify a step group node in a script tree.

4. Enter a name for the Step Group.

Title: Specify the title text of the step group. The title text will appear in the script 
tree.

5. Enter any think time delay to add to the Step Group.

Think time: Specify the amount of time in milliseconds to use as a think time 
delay for the step group.

6. Click OK. The Step Group is added to the script tree.

To add a step groups to a script based upon preferences:

1. Open or create a script project.

2. Select OpenScript Preferences from the View menu.

3. Expand the OpenScript node.

4. Expand the Record node.

5. Select the Step Groups node.

6. Specify the Step Group preferences and click OK.

7. Select Create Step Groups from the Script menu. The Step Groups will be 
automatically added to the script tree.

8. In the Java Code view, the step group consists of the code executed between 
beginStep and endStep:

beginStep("Step Group 1", 10);
{
        /**
         * Add code to be executed for the step group.
         */
        getLogger().info("Step Group 1");
}
endStep();

3.3.2 Adding a Delay to a Script
To add a delay to a script:

1. Open or create a script project.

2. Select the script node where you want to add the delay.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the General node and select Think Time.

This dialog box lets you specify or modify a delay time in seconds.

5. Enter a valid integer to use as the think time in seconds.

6. Click OK. The Think node is added to the script tree.

7. In the Java Code view, the think(time;) (the time is in seconds) statement will 
be added to the script code:

think(10.0);
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3.3.3 Adding a Log Message to a Script
To add a log message to a script:

1. Open or create a script project.

2. Select the script node where you want to add the log message.

3. Select the Script menu and then select Message from the Add sub menu.

This dialog box lets you specify or modify a log message in a script tree.

4. Enter the message text.

Message: Specify the text of the log message. The text will appear in the Console 
view on script playback.

5. Click OK. The log message node is added to the script tree.

6. In the Java Code view, the type("log message") method will be added to the 
script code:

info("Message");
warn("Message");
fail("Message");

The log message text appears in the Console View when the script is played back.

3.3.4 Adding a For Statement to a Script
To add a For statement to a script:

1. Open or create a script project.

2. Select the script node where you want to add the For statement.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Control Statements node and select For.

This dialog box lets you specify or modify the For statement loop count.

5. Enter a valid integer to use as the loop count.

Loop Count: Specify the number of times to loop though the For statement. 

6. Click OK. The For node is added to the script tree.

7. In the Java Code view, the for (int i=0; i < loop count; i++) statement 
will be added to the script code:

for (int i=0; i < 10; i++)

3.3.5 Adding a Function to a Script
You can add your own custom functions to your script and specify the arguments to 
pass to the function. Custom functions can be in the current script or in another script 
that has been added to the current script’s Scripts Assets Properties.

To add a function to a script:

1. Create a script project.

2. Record a complete script.

3. Select the Run node in the script tree.

4. Select the Script menu and then select Other from the Add sub menu.
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5. Expand the General node and select Function.

This dialog box lets you specify a custom function name with multiple arguments.

Name: Specifies the name of the custom function. Click Add to define the names 
and data type of an argument. 

Description: Specifies a user-defined description for the custom function.

Argument: Lists the defined function arguments for the custom function. 

Type: Lists the data type for the defined argument for the custom function. 

Description: Lists the user-defined description for the argument defined for the 
custom function.

Add: Opens a dialog box for defining a new argument for the custom function. 

Edit: Opens a dialog box for editing the selected argument. 

Delete: Removes the selected argument from the list. 

Up: Moves the selected argument up one place in the list. 

Down: Moves the selected argument down one place in the list. 

6. Enter the function name.

7. Enter a description for the function.

8. Click Add.

This dialog box lets you specify a custom function argument to use to pass data to 
the function.

Name: Specify a name of the custom function argument.

Type: Select the data type: String, Integer, Double, Long, or Boolean. 

Description: Specify a description for the argument (you may want to include the 
data type in the description so that it is indicated in the Substitute Variable list).

9. Enter an argument name.

10. Select the data type for the argument.

11. Click OK.

12. Click Add and add more arguments or click OK to add the function to the script. 
The function name node is added to the script tree.

13. In the Java Code view, the public void function name statement will be 
added to the script code followed by the arguments with the data types:

/**
* My custom Function
* @param argString Description of argString
* @param argInt Description of argInt
* @param argDouble Description of argDouble
* @param argLong Description of argLong
* @param argBool Description of argBool
*/
public void MyFunction(@Arg("argString") String argString,

@Arg("argInt") int argInt,
@Arg("argDouble") double argDouble,
@Arg("argLong") long argLong,
@Arg("argBool") boolean argBool)

throws Exception {
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14. Add items into the Function. You can use the Tree View drag/drop or cut/paste 
features to move Tree View items to the function. You can use the Script Add 
option to add variable items to the function. You can also use the Code View to 
add custom code to the function.

To pass arguments into a function:

Define the variables to use to pass values to the custom function arguments 
somewhere in the script before where the Call Function statement will be placed in the 
script:

1. Select the script node where you want to add variables.

2. Select the Script menu and then select Other from the Add sub menu.

3. Expand the Variables node and select Set Variable.

This dialog box lets you define a variable in a script.

4. Enter the variable name and value.

■ Name: Specify the name of the variable.

■ Value: Specify the value to assign to the variable.

5. Enter a value or click the Substitute Variable icon to select a variable value to 
assign to the variable.

6. Click OK.

7. In the Java Code view, the getVariables().set() statement will be added to 
the script code followed by the variable name and value for each variable:

getVariables().set("MyString", "String");
getVariables().set("MyInt", "1");
getVariables().set("MyDouble", "1234");
getVariables().set("MyLong", "1234560");
getVariables().set("MyBool", "True");

The following is an example of a variable set to a Databank value:

getVariables().set("MyString", "{{db.customer.FirstName,String}}");

8. Select the Function node (your custom function name) in the script.

9. Select the Script menu and then select Other from the Add sub menu.

10. Expand the tree and select the item to add. For example Message under the 
General node or Set Variable under the Variables node.

11. Click the Substitute Variable icon to select a custom variable or function argument. 
The Select Variable tree lists the custom function with all of is defined arguments.

12. Select an argument for the custom function.

13. Click OK.

14. In the Java Code view, the message statement (info, warn or fail) or 
getVariables().set() statement will be added to the script code followed by 
the variable name and value for each variable:

public void MyFunction(@Arg("argString") String argString,
@Arg("argInt") int argInt,
@Arg("argDouble") double argDouble,
@Arg("argLong") long argLong,
@Arg("argBool") boolean argBool)
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throws Exception {
info("{{arg.argString}}");
getVariables().set("MyArgString", "{{arg.argString}}");
getVariables().set("MyArgInt", "{{arg.argInt}}");
getVariables().set("MyArgDouble", "{{arg.argDouble}}");
getVariables().set("MyArgLong", "{{arg.argLong}}");
getVariables().set("MyArgBool", "{{arg.argBool}}");

}

To call a custom function in a script:

1. Select the node in the script tree here you want to call the function.

2. Select the Script menu and then select Other from the Add sub menu.

3. Expand the Script Function Calls node and the sub node where the custom 
function is located. Custom functions can be in the local (currently open) script or 
in another script added to the Script Assets Properties (select Script Properties 
from the Script menu to add other scripts to the Script Assets Properties).

4. Select the function to call and click OK.

This dialog box lets you specify a custom function to call and specify the argument 
values.

5. Enter the argument data to pass to the custom function or click the Substitute 
Variable icon to select a custom variable or databank variable.

■ Function: Select the name of the custom function. The names of custom 
functions that were added to the script will appear in this list.

■ Arguments: A field for each custom function argument will appear for the 
selected function. Enter the argument value or click the Substitute Variable 
icon to select a custom variable or databank variable.

6. Click OK.

7. In the Java Code view, the callFunction or getScript().callFunction() 
statement will be added to the script code followed by the function name and 
arguments as String data types. If the function is in the same script the 
callFunction statement is added:

callFunction("MyFunction", "MyStringArg");

To pass data types other than String, enclose a defined variable name in double 
curly braces as follows, "{{VarName}}".

callFunction("MyFunction", "{{MyString}}", "{{MyInt}}", "{{MyDouble}}", 
"{{MyLong}}", "{{MyBool}}");

If the function is in a child script (a script asset script), the 
getScript().callFunction() statement is added:

getScript("myAlias").callFunction("MyFunction", "myString", "myInt", 
"myDouble", "myLong", "myBool"); 

3.3.6 Adding Script Assets
You can add assets to a script such as, databanks, generic Jar files, object libraries, or 
other scripts containing recorded steps or custom functions. The asset must exist 
before it can be added. Select New from the File menu to record scripts or create 
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databanks and object libraries. You also use the Create option in the Script Properties 
to create databanks and object libraries.

To add assets to a script:

1. Open or create a script project. 

2. Select a script node and select Script Properties from the Script menu.

3. Select Assets in the property type list. The Assets pane has the following options:

■ Asset: Lists the Assets added to a script by type in a tree view. Assets can be 
databanks, object libraries, generic Jar files, and other scripts.

■ File: Shows the files added as Assets to the current script. Expand the tree 
view in the Assets column to view the files.

■ Add: Opens a file selection dialog box for selecting the file to add as an asset. 
Expand the My Repositories or My Computer trees to navigate to a folder 
containing the file. 

■ Edit: Opens a file selection dialog box for changing which files is added as an 
asset.

■ Open: Opens the selected asset file in the appropriate editor.

■ Remove: Removes the selected asset file from the Assets tree. The file still 
exists in the file system or repository/workspace.

4. Select the type of asset to add and click Add.

5. Select the asset to add from a repository or the file system.

6. Set the Save path relative to current script option. The Save path relative to current 
script option specifies how the current script will locate the specified script asset. 
When cleared, the current script locates the script asset by a repository path such 
as, [Repository: Default] Default!/WebTutor, if the asset is selected 
from a repository or full file path such as, 
C:\OracleATS\OFT\Default!\WebTutor, if the asset is selected from the file 
system. When selected, the current script locates the script asset by a relative path 
such as ../WebTutor. Selecting the Save path relative to current script option is 
not recommended as script-relative paths are more brittle than repository-relative 
paths if scripts are moved or shared.

The following are guidelines when using script assets in a team or distributed 
environment:

■ Do not use Absolute Paths when referring to assets or saving assets. Oracle 
Load Testing does not support absolute paths.

■ OpenScript, Oracle Test Manager, Oracle Load Testing, and all command-line 
agents should all use the same shared repository names and paths.

■ Do not refer to an asset in another repository by a relative path.

7. Click OK to add the asset to the script properties.

Note: As of OpenScript Version 9.10, scripts can be stored anywhere 
in the file system. However, any scripts you plan to run, along with 
any associated assets, in the Oracle Load Testing application must be 
stored in a repository/workspace that can be accessed by the Oracle 
Load Testing Controller.
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8. Click OK when finished adding script assets to close the script properties.

Script asset information is stored in the assets.xml file located in the script project 
directory.

3.3.7 Adding a Script to Run from a Script
To add a script to run to a script:

1. Open or create a script project.

2. Select the script node where you want to add the script to run.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Expand the General node and select Run Script.

5. Click OK.

This dialog box lets you specify the script to run from within another script.

Script: Specifies the OpenScript script to run.

New: Opens the script properties for selecting the script asset to run.

Sections of script to run: Specifies which script sections to run during playback. 

■ Initialize Section: When selected, the code in the Initialize section of the 
selected script to run is executed during playback. When cleared, the code in 
the Initialize section is skipped.

■ Run Section: When selected, the code in the Run section of the selected script 
to run is executed during playback. When cleared, the code in the Run section 
is skipped.

■ Finish Section: When selected, the code in the Finish section of the selected 
script to run is executed during playback. When cleared, the code in the Finish 
section is skipped.

Iterations: Specify the number of script iterations to run.

6. Select the script using New next to the Script field.

7. Select the next script to run from the available script assets in the Script properties. 
Use the Add button to add scripts to the script assets properties.

8. Select or clear the Sections of script to run option.

9. Set the iteration count.

10. Click OK. The script name node is added to the script tree.

11. In the Java Code view, the getScript().run(); statement will be added to the 
script code:

getScript(alias=String).run(interation count = int, initialize = true|false, 
run = true|false, finish = true|false);

Example

getScript("Web1").run(1, true, true, true);

3.3.8 Adding a Set Variable to a Script
To add a Set Variable to a script:

1. Open or create a script project.
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2. Select the script node where you want to add the set variable.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Variable node and select Set Variable.

This dialog box lets you set a variable value in a script.

5. Enter the variable name and value.

■ Name: Specify the name of the variable.

■ Value: Specify the value to assign to the variable.

6. Click OK. The Set variable = value node is added to the script tree.

7. In the Java Code view, the getVariables().set("variable name", 
"value"); method will be added to the script code:

getVariables().set("sVar_MyVar", "My_Value");

If you want to set the variable with a value from an Oracle Functional Testing 
transform variable (i.e. a variable value contained in {{}} syntax), use the 
Transforms.transform method with the getVariables().set, as follows (requires 
HTTP module):

http.solve("varTitle", "<TITLE>(.+)</TITLE>", "Page Title Error", false, 
Source.Html, 0);

getVariables().set("sVar_MyVar", Transforms.transform("{{varTitle}}", 
getVariables()));

3.3.9 Adding Comments to Script Results
To add comments to script results:

1. Open or create a script.

2. Click the Code view tab.

3. Add comments or warnings using one of the following code examples:

■ Using a step group:

beginStep("Any comment string", 0);
{
//The comment string appears in the Name column of the Results view.
}
endStep();

■ Using the getStepResult().addComment method:

//The comment string appears in the Summary column of the Results view
getStepResult().addComment("Any comment string");

■ Using the getStepResult().addWarning method:

//The warning string appears in the Summary column of the Results view. 
//addWarning overides addcomment.
getStepResult().addWarning("Any warning string");

3.3.10 Adding Error Recovery to a Script
To add error recovery to a script:

1. Open or create a script project.
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2. Select the script node where you want to add the log message.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the General node and select Error Recovery Action.

Exception: Select the type of exception error. The list will vary depending upon 
the script type.

Action: Select the error recovery action: Fail, Warn or Ignore.

5. Click OK. The log message node is added to the script tree.

6. In the Java Code view, the setErrorRecovery(scriptType.constant, 
ErrorRecoveryAction.action); method will be added to the script code:

setErrorRecovery(BasicErrorRecovery.ERR_VARIABLE_NOT_FOUND, 
ErrorRecoveryAction.Fail);

3.3.10.1 Script Types
The following are the possible values for scriptType in the Java code statements:

BasicErrorRecovery (Basic module)

FormsErrorRecovery (EBS/Forms Functional module)

FTErrorRecovery (Generic functional module)

HttpErrorRecovery (HTTP module)

NcaErrorRecovery (EBS/Forms Load module)

UtilitiesErrorRecovery (Generic Utilities)

WebErrorRecovery (Web Functional module)

3.3.10.2 Constants
The following are the possible values for constant in the Java code statements:

BasicErrorRecovery (Basic module)

ERR_VARIABLE_NOT_FOUND
ERR_CREATE_VARIABLE_ERRORCODE
ERR_FILE_NOT_FOUND
ERR_SEGMENT_PARSER_ERROR
ERR_BINARY_DECODE
ERR_ENCRYPTION_SERVICE_NOT_INITIALIZED
ERR_GENERIC_ERROR_CODE

FormsErrorRecovery (EBS/Forms Functional module)

ERR_FORMS_FT_ERROR

FTErrorRecovery (Generic Functional Module)

ERR_FT_MATCH_ERROR
ERR_OBJECT_TEST_ERROR
ERR_TABLE_TEST_ERROR

HttpErrorRecovery (HTTP Module)

ERR_ZERO_LENGTH_DOWNLOAD
ERR_MATCH_ERROR
ERR_RESPONSE_TIME_ERROR
ERR_SOLVE_ERROR
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ERR_HTML_PARSING_ERROR
ERR_INTERNET_INVALID_URL
ERR_INVALID_HTTP_RESPONSE_CODE
ERR_KEYSTORE_LOAD_ERROR

NcaErrorRecovery (EBS/Forms Load Module)

CONNECT_ERROR
MESSAGE_IO_ERROR
CONTROL_INITIALIZE_ERROR

UtilitiesErrorRecovery (Generic Utilities)

ERR_SQL_EXECUTE_ERROR
ERR_XML_PARSING_ERROR
ERR_CSV_LOADING_ERROR

WebErrorRecovery (Web Functional module)

ERR_RESPONSE_TIME_ERROR
ERR_WEBDOM_SOLVE_ERROR
ERR_WAIT_FOR_PAGE_TIMEOUT_ERROR

3.3.10.3 Actions
The following are the possible values for action in the Java code statements:

Fail
Ignore
Warn

3.3.11 Verifying Script Actions
You can verify script actions to check the result of a script action and adjust the 
behavior of the script based on the result of the action.

The basic process to use verify script actions is as follows:

1. Add an Error Recovery Action before the script node where you want to verify the 
result code. You can add the Error Recovery Action from the script Add sub menu 
or in the Java Code view. Set the error recovery action to Warn or Ignore to ensure 
that the Has Error block gets executed. This allows script execution to continue 
past the code where an exception occurred to the next statement in the script code.

2. Add a 'Has Error' Control Statement after the script node where you want to verify 
the result code. You can add the Has Error Control Statement from the script Add 
sub menu or in the Java Code view. The if(hasLastError()) block is added to 
the script code directly after the script node where you want to verify the result 
code.

3. Add your custom code into the if(hasLastError()) block in the Java Code 
view. 

4. Add Results Object messages to return the result values. The Result Code 
Verification features provide access to a Results object. The Result Object provides 
Result Code, Summary, Error Message, and Duration information.

The following sections explain the steps in more detail.

3.3.11.1 Adding an Error Recovery Action
To add an Error Recovery Action:
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1. Select the script node before the script node where you want to verify the result 
code.

2. Select the Script menu and then select Other from the Add sub menu.

3. Expand the General node.

4. Select Error Recovery Action and click OK.

5. Select the Exception type. See Section 3.3.10, "Adding Error Recovery to a Script" 
for additional information.

6. Select Warn or Ignore as the Action type and click OK.

7. Add the Has Error condition to the script. See Section 3.3.11.2, "Adding a Has 
Error Control Statement" for additional information.

3.3.11.2 Adding a Has Error Control Statement
The Has Error Control Statement can be added to the script using the Tree view. 
However, the conditional behavior must be specified in the Java Code view.

To add a Has Error condition:

1. Select the script node after the script node where you want to verify the result 
code.

2. Select the Script menu and then select Other from the Add sub menu.

3. Expand the Control Statements node.

4. Select Has Error? and click OK. The if (hasLastError()) node is added to 
the script tree.

5. Add a Result Object or add your custom code in the if (hasLastError()) 
block in the Java Code view. See Section 3.3.11.3, "Adding a Result Object 
Message" for additional information.

3.3.11.3 Adding a Result Object Message
The Result Object can be used to return result values. 

To add a Result Object message:

1. Select the if (hasLastError()) node in the script tree.

2. Right-click the  if (hasLastError()) node and then select Other from the 
Add sub menu.

3. Expand the General node.

4. Select Message and click OK.

5. Select Info or Warn as the Message Type.

6. Click Substitute Variable.

7. Expand Last Result.

8. Expand All Actions or assertions and Verifications.

9. Select the Result to add to the message and click Finish.

10. Click OK to add the message to the script. 

In the Java Code view, the message code with the result type is added to the if 
(hasLastError()) block:

info("{{result.summary}}");
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You can customize the message string in the Java Code view. For example:

info("Summary of last action: {{result.summary}}");

11. If necessary drag the message node into the  if (hasLastError()) node so the 
message is a child node of the if (hasLastError()) block. For example:

if (hasLastError()) {
info("Summary of last action: {{result.summary}}");

}

3.3.11.4 Actions That Can Be Verified
Only specific OpenScript actions provide the ability to verify their results. In general, 
all actions that are available for adding from the tree view UI, including all 
verifications and assertions, support verification.

The following types of actions typically do not support verification:

■ Java methods that are only available from code and not from the UI

■ Deprecated methods

■ "Get" methods

■ Methods that interact with OpenScript internal code such as Logger, VUDisplay, 
Settings, Counters

■ Methods that don't throw any exceptions, such as http.removeCookie

3.3.12 Chaining Multiple Scripts
You can run multiple scripts from within a single script to chain playback of scripts 
together.

The procedure involves the following major steps:

■ Setting the browser preferences

■ Recording scripts

■ Creating a shell script

3.3.12.1 Setting the Browser Preferences
The browser preferences specify if a new browser will launch when recording a 
different script. Because the navigation sequence between multiple scripts is 
important, the same instance of the browser should run all scripts if the scripts are a 
continuation of each other. If each script is self-contained and there is no navigation 
between scripts, each script can launch its own browser and you can skip the Browser 
Preferences steps.

1. Select Preferences from the View menu.

2. Expand the General category and select Browsers.

3. Clear the Always launch a new browser when recording a different script 
option.

4. Click OK.
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3.3.12.2 Recording Scripts
When recording scripts for chained playback, it is important to plan the start and stop 
points between scripts. This is especially true if session state needs to be maintained 
between scripts. All of the scripts must be of the same type.

1. Create and record the first script, for example a Web Functional test log in script.

2. Stop the recording but do not close the browser.

3. Save the script.

4. Create and record the next script. The navigation in this script should start from 
the point in the browser where the first script stopped.

5. Stop the recording and save the script.

6. Create and record any additional scripts to chain. The navigation in these script 
should start from the point in the browser where the previous script stopped.

3.3.12.3 Creating a Shell Script
The shell script is used to run the previously recorded scripts in sequence.

1. Create a new script to use as the shell script.

2. Select the script node where you want to add the first script. This could be either 
the Initialize or Run nodes.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the General node and select Run Script.

5. Click OK.

6. Click New.

7. Select the script to run from the available script assets in the Script properties. Use 
the Add button to add scripts to the script assets properties.

8. Click OK.

9. Select or clear the script sections to run and the iteration count.

10. Click OK.

11. Select the script node where you want to add the next script. This could be either 
the Initialize, Run, or Finish nodes.

12. Select the Script menu and then select Other from the Add sub menu.

13. Expand the General node and select Run Script.

14. Click OK.

15. Click New.

16. Select the next script to run from the available script assets in the Script properties. 
Use the Add button to add scripts to the script assets properties.

17. Click OK.

18. Select or clear the script sections to run and the iteration count.

19. Click OK.

20. Repeat the Add script steps for each additional script to run.

21. Save and playback the shell script to verify the script navigations work together 
correctly.
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22. In the Java Code view, the getScript().run() methods will be added to the 
script code:

getScript("Web1").run(1, true, true, true);
getScript("Web2").run(1, true, true, true);

3.3.13 Moving Nodes in a Script
You can click and drag a node in the script tree view to move the node to another 
location in the script tree. For example, you move a step group node from the Run 
section to the Initialize section or move a navigation node.

To move script nodes in the script tree:

1. Open or create a script project.

2. Select the script node to move in the Tree View tab of the Script View.

3. Click and drag the mouse to move the node in the script tree. The script tree shows 
an indicator line that points to the location in the script tree where the node will be 
moved.

4. Release the mouse button when the indicator line is at the location where you 
want to move the script node.

When moving Step Groups between script sections (i.e. between Run and Initialize, 
etc.) you may need to move the node to the section node.

You can also switch to the code view and move lines of code manually.

3.4 Changing Text File Encoding
Before recording sites with international characters on an English OS, users should 
change the default character set encoding to a character set that supports the desired 
character set.

To change the text file encoding:

1. Start OpenScript and select Developer Perspective from the View menu.

2. Select Preferences from the Windows menu.

3. Expand the General node.

4. Select the Workspace node.

5. Select the Other option under Text file encoding.

6. Select desired text file encoding (i.e. UTF-8 for Japanese language Web sites, etc.).

7. Click Close when finished.

3.5 Debugging Scripts
You can use features of the Eclipse IDE to debug scripts. For debugging purposes, it is 
not always necessary to switch to the Debug Perspective to debug a script. You can 
add views to the Tester Perspective, such as Breakpoints, Debug, and Expressions 
views. In most cases, you do not need to use the Outline, Variables, and Tasks views. 
This section provides tips for basic script debugging techniques. 
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3.5.1 Adding Views to the Tester Perspective
In some cases, you may want to add additional views to the Tester Perspective for 
debugging purposes. You select the view to open using the shortcut keys to get to the 
Show View window.

To open the Show View window:

1. Press and hold the Shift and Alt keys, then press the Q key (Shift+Alt+Q).

2. Press the Q key again. The Show View window opens.

3. If necessary, expand the Debug tree.

4. Select the View(s) you want to open:

■ Press and hold the Shift key and click to select multiple contiguous view 
names.

■ Press and hold the Ctrl key and click to select multiple non-contiguous view 
names.

5. Click OK.

The selected views open in the Tester Perspective.

3.5.2 Adding Breakpoints to a Script
You can add breakpoints to the script tree view or in the Java Code to halt script 
execution at a specific line of code in the script.

To add a breakpoint to the script tree view:

1. Create a script project.

2. Record the script.

3. In the Script view, click the Tree View tab.

4. Expand the script tree and select the node where you want to add a breakpoint.

5. Click the right mouse button and select Add Breakpoint from the shortcut menu. 
The "[Breakpoint]" indicator appears at the end of the script node text.

6. Play back the script.

When you play back the script, code execution will stop at the breakpoint. The 
Confirm Perspective Switch message appears the when the code execution 
arrives at a breakpoint. Select the Remember my decision option if you do not 
want the message to appear again during future script playback.

7. Click No to stay in the Tester perspective or Yes to switch to the Debug 
Perspective. You can use the following Script menu options to debug scripts:

■ Step - runs the currently selected node and moves the  execution pointer to the 
next sibling node. If the selected node has a child node, the execution pointer 
is moved to the first child node. This option is only active during script 
playback and script execution is suspended while stepping through the script 
code.

Note: If you are in the Developer Perspective, you can add a view by 
selecting Show View from the Window menu and then selecting 
Other.
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■ Step Into - steps into the function or sub procedure. This option is only active 
during script playback and script execution is suspended while stepping 
through the script code. The execution pointer is moved into the beginning of 
the function.

■ Pause/Resume - pauses and resumes script playback. These options are only 
active during script playback.

8. You can use the following right-click shortcut menu options to debug scripts

■ Skip/Unskip - set the code to skip or unskip.

■ Playback to Here - starts playback from the beginning of the script and halts 
playback at selected node in the script tree.

■ Playback from Here - starts playback from the selected node in the script tree 
and plays to the end or the next breakpoint.

■ Add Breakpoint/Remove Breakpoint - adds or removes a breakpoint in the 
script tree view. Script tree nodes with a breakpoint set show the 
"[Breakpoint]" indicator at the end of the script node text.

■ Execute - executes the code for the selected node in the script tree. This option 
is only active during script playback and the script is paused. Execute 
compiles the highlighted code in the editor or tree view and runs it in the 
currently paused thread. However, the original running program code isn't 
changed and the current execution pointer does not move when using 
Execute. You can use Execute to test changes to a script while debugging. For 
changes to be permanent, you must save the script which recompiles the code 
and returns the execution pointer back to the beginning of the run() section. 

■ Step - runs the currently selected node and moves the execution pointer to the 
next sibling node. If the selected node has a child node, the execution pointer 
is moved to the first child node. This option is only active during script 
playback and script execution is suspended while stepping through the script 
code. 

■ Step Into - steps into the function or sub procedure. This option is only active 
during script playback and script execution is suspended while stepping 
through the script code. The execution pointer is moved into the beginning of 
the function.

To add a breakpoint to the script code:

1. Create a script project.

2. Record the script.

3. In the Script view, click the Java Code tab.

4. Double-click in the right-most column of the code view frame next to the code line 
where you want to add a breakpoint. The breakpoint indicator appears as a round 
dot in the frame. You can add as many breakpoints as needed.

5. Play back the script.

When you play back the script, code execution will stop at the breakpoint. The 
Confirm Perspective Switch message appears the when the code execution 
arrives at a breakpoint. Select the Remember my decision option if you do not 
want the message to appear again during future script playback.

6. Click No to stay in the Tester perspective or Yes to switch to the Debug 
Perspective. You can use the following keyboard debug features to execute code 
while in debugging mode:
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■ Single-step (F6) - executes the next line of code.

■ Step-into (F5) - opens the method/function class file. 

■ Resume (F8) - resumes code execution to the script end or to the next 
breakpoint.

3.5.3 Adding a Java Exception Breakpoint
 You can pause a script when any error occurs by adding a "Java Exception Breakpoint" 
to the Breakpoints list.

To add a Java Exception Breakpoint:

1. Create a script project.

2. Record the script.

3. Open the Breakpoints view.

4. Click the Add Java Exception Breakpoint icon on the Breakpoints View toolbar.

5. Type "AbstractScriptException" and click OK to add this exception to the 
breakpoint list.

6. Right-click on the breakpoint in the Breakpoints view and select Breakpoint 
Properties.

7. Select the Suspend on Subclasses of this Exception option in the breakpoint 
properties and click OK.

During script playback, if an exception occurs, you can correct the problem and then 
continue script playback.

3.5.4 Pausing and Resuming Script Playback in Debug Mode
You can pause and resume script playback using the Tree view or the Debug view.

To pause and resume play back in the Tree view:

1. Create a script project.

2. Record the script.

3. Play back the script.

4. Click the Pause toolbar button to pause playback.

5. Click the Resume toolbar button to resume playback of a paused script.

To pause and resume play back in Debug mode:

1. Create a script project.

2. Record the script.

3. In the Script view, click the Java code tab.

Note: Source code for the JRE or for the Eclipse IDE is not included 
with the product. When stepping into code, an editor may appear that 
does not contain source code. In this case, close the editor and resume 
script playback. You can use the Step-into feature to step into your 
own custom functions that you have added to a script. 
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4. If necessary, add a Debug view to the Tester Perspective. If the Developer 
Perspective is open the Debug view should already be open.

5. Play back the script.

6. In the Debug view tree, select the Thread [Iterating Agent 1] thread and 
click the Pause toolbar button. The Thread [Iterating Agent 1] thread is 
the Virtual User's thread. You can ignore the others.

7. In the Debug view tree, select script.run()  and click the Resume toolbar 
button to resume playback.

If you want to resume from a specific point in a script, comment out all lines 
before the current one, save the script, and then resume.

You can also execute portions of the script without having to comment out lines and 
restart the playback.

1. Insert a breakpoint at the first line of the run() section.

2. Playback the script. You can execute or inspect any line when playback halts a the 
breakpoint.

3. Select the specific line(s) of code you want to playback, right-click and select 
Execute. You can modify the code and re-execute without having to save the 
script.

4. Repeat the select code, right-click, Execute process until the script works the way 
you want it to work.

5. Stop playback, or select the Resume button on the Debug view to replay from the 
breakpoint.

3.5.5 Inspecting and Changing Script Variable Values
You can inspect or watch script variable values to debug scripts. The script must be 
running or stopped at a breakpoint.

There is a difference between Java local variables and script variables. Java local 
variables are declared using standard Java syntax, such as String x or int i. Script 
variables are set using the OpenScript API methods, such as 
getVariables().set("someVariable", "123" or http.solve().

To inspect the value of a script variable:

1. Create a script project.

2. Record the script.

3. Add a breakpoint to the script. 

4. Play back the script.

5. At the breakpoint highlight the script code containing the variable or type the 
following code and highlight the code:

getVariables().get("someVariable")

6. Right-click and select Inspect or Watch.

■ Inspect opens a pane that shows the variable (Shift-Alt-I adds the variable to 
the Expressions view).

■ Watch copies the variable to the Expressions view.

7. To change the value of a script variable, type the following code:
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getVariables().set("someVariable", "newValue")

8. Highlight the code.

9. Right-click and select Execute.

3.6 Enabling Debug Logging
OpenScript provides debug logging capability using Jakarta Log4j.

To enable debug logging:

1. Close OpenScript.

2. Open the file log4j.xml located in C:\OracleATS\OpenScript.

3. Locate the following section at the end of the file:

<!-- ======================= -->
  <!-- Setup the Root category -->
  <!-- ======================= -->

        <!-- For production  -->
  <root>
   <priority value="WARN"/>
   <appender-ref ref="AGENTFILE" />
  </root>
        
        <!-- For debugging
  <root>
   <priority value="DEBUG"/>
   <appender-ref ref="AGENTFILE" />
   <appender-ref ref="CONSOLE" />
  </root>
        -->

4. Move the ending comment brackets from:

<!-- For production  -->
  <root>
   <priority value="WARN"/>
   <appender-ref ref="AGENTFILE" />
  </root>
        
        <!-- For debugging
  <root>
   <priority value="DEBUG"/>
   <appender-ref ref="AGENTFILE" />
   <appender-ref ref="CONSOLE" />
  </root>
        -->

to:

<!-- For production
  <root>
   <priority value="WARN"/>

Note: You can also test individual web actions by pausing the script, 
selecting the code for the action to test, then right-clicking and 
selecting Execute (or pressing Ctrl+U).
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   <appender-ref ref="AGENTFILE" />
  </root>
        -->
        
        <!-- For debugging -->
  <root>
   <priority value="DEBUG"/>
   <appender-ref ref="AGENTFILE" />
   <appender-ref ref="CONSOLE" />
  </root>
        

5. Save the file log4j.xml and restart OpenScript.

6. Run scripts.

The debug messages are stored in the file OpenScript.log located in 
<installdir>\OpenScript.

To turn off debugging, move the ending comment braces back to the original locations.
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4
Using Databanks

OpenScript allows users to parameterize script data inputs to perform data driven 
testing using Databanking. Users can select any data inputs for their script and then 
substitute a variable to drive the input from an external file during playback. Multiple 
Databank files can be attached to a single script and users can specify how OpenScript 
assigns data during script playback.

4.1 Understanding Data Driven Testing (Parameterization)
Data Driven Testing, or parameterization, allows you to quickly and efficiently create 
automated data-driven tests. 

The OpenScript Modules record parameters defined by each page of the Web 
application to a script. Databanks are used to hold unlimited amounts of input data 
that can be automatically fed as parameters into your Web application when the script 
is run. You can use the OpenScript Databanking features to define variable values in 
script parameters and substitute values from Databank files for the variable values.

During playback, the parameters in the Web page are filled with values from the 
Databank file. Databank files can be easily created or modified using any simple text 
editor, spreadsheet, word processor, or database application. Users can create 
sophisticated unattended regression tests to thoroughly exercise a Web application by 
using varied input data from Databank files.

Data Input Parameterization enables users to parameterize recorded script inputs to 
perform data driven testing in either the script GUI view or code view. These inputs 
could be form field inputs for Web applications but could also be other types of script 
inputs that users may parameterize. Types of inputs users may parameterize include:

■ Any user entered input data (i.e. parameterize the data I entered for the search 
field)

■ Test case values (i.e. parameterize a text string for validation so I can use different 
inputs for comparison during playback)

■ Recorded navigations (i.e. parameterize a starting navigation so I can navigate to 
different host servers during playback)

■ Recorded user actions/object identified (i.e. parameterize a link object path so I 
can click on different links during playback)

Data Input Sources enables users to drive input values from an external CSV file or 
other external data source such as a database (i.e. using a database query to pull inputs 
from a database table).

Data Parameterization GUI View enables users to configure the inputs they want to 
parameterize and the data source they want to drive the inputs from through a 
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substitute variable GUI interface. For example, the "ticker" query string parameter for 
"Page [4] Ticker List" in the following Tree View is set to the variable value 
"{{fmstocks_data.ticker,ter}}".

Within the variable "{{fmstocks_data.ticker,ter}}", "fmstocks_data" is the name of the 
Databank file, ".ticker" identifies the field name within the Databank file, and "ter" is 
the recorded value.

Data Parameterization Code View Commands enable users to specify the inputs they 
want to parameterize and the data source they want to drive the inputs from through 
data parameterization in the code view.

For example, the "ticker" query string parameter for "Page [4] Ticker List" in the above 
Tree View appear as http.querystring(http.param("ticker", 
"{{fmstocks_data.ticker,ter}}") in the http.get method code in the Code 
View, as follows (line breaks and spacing added for clarity):

beginStep("[4] Ticker List", 3422);
{
   http.get(6, "http://testserver2/fmstocks/{{LINK_1_3,TickerList.asp}}", 
        http.querystring(http.param("ticker", "{{fmstocks_data.ticker,ter}}"), 
             http.param("company", "")),  null, true, "ASCII", "ASCII");
}
endStep()

4.2 Using Script Databanks
Databanks are used to hold unlimited amounts of input data that can be automatically 
fed into your Web application. During playback, the parameters in the Web page are 
filled with values from the Databank file. The Databank and script parameter shortcut 
menu options allow you to map parameters in a script to fields in a Databank file as 
variable names.

Scripts must be configured to use Databanks. Use the Script Properties option on the 
Script menu to specify the Databank file(s) to use with a script in the Assets 
properties. Scripts can be configured to use more than one Databank file.

When you record a script that has a navigation that uses parameters, the parameter 
nodes appear under the Query String node:

In the Code View, the parameters appear in the http.param parameters of the 
http.querystring parameter:

When you configure the Databank(s) to use with the script, the Get next Databank 
record from databank name node and Java code are added to the script.

Select the script parameter node to map to a Databank and use the Substitute Variable 
option on the right-click shortcut menu to select the Databank field name to map to the 
parameter. The Databank file and field name appear in the parameter node of the 
script tree.

The variable appears in the Code view in the http.param parameters of the 
http.querystring parameter:

Use the Playback iterations to playback using the records in the Databank. You can 
also use custom code to loop through Databank records and assign values to variables.

4.3 Configuring Databanks
You must configure the Databank to use with a script before you can get records from 
the Databank to use in a script.
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To configure Databanks to use with a script:

1. Open or create a Script project.

2. Select Script Properties from the Script menu.

3. Select the Assets type.

4. Select Databanks.

5. Click Add.

6. Select the Repository from the My Repositories tree or file location from the My 
Computer tree.

7. Select the Databank file from the repository or file folder.

8. Enter an alias name to use for the Databank or leave the default alias name. The 
default alias name is the name of the .CSV Databank file.

Alias: Specifies an alias name to use for the Databank. The Databank file name is 
the default. The Databank alias name is the name that appears when you add a 
Databank record retrieval node to a script tree.

9. Click OK.

10. Click OK to add the Databank file.

Databank files are comma-separated value files. The field names are on the first line of 
the file separated by commas (no spaces). The field data is on subsequent lines 
separated by commas (different line for each record, no spaces around commas). The 
following shows an example:

FirstName,LastName,Mail,Phone

John,Smith,JohnS@company.com,x993

Mary,Ellen,MaryE@company.com,x742

If a data value contains a comma, place quotation marks around the value, as follows:

John,Smith,"Anytown, MA","(603) 993-0000"

4.4 Getting Databank Records
To get Databank records to use with a script:

1. Open or create a script project.

2. Configure the Databank to use with a script in the Assets Script Properties.

3. Select the script node where you want to use the Databank record.

4. Select the Script menu and then select Other from the Add sub menu.

5. Expand the General node and select Get Next Databank Record.

6. Click OK.

7. Select the Databank alias to specify the Databank file to get the record from.

8. Click OK. A GetNextDatabankRecord: databank alias node will be added to the 
script.

In the Java Code view, the getDatabank("databank 
alias").getNextDataBankRecord() method will be added to the script 
code:
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getDatabank("customer").getNextDatabankRecord();

9. Right click the parameter node in the script tree that you want to substitute with a 
Databank variable and select Substitute Variable.

10. If necessary expand the Databanks node and select the Databank field you want to 
use as the input parameter data.

11. Click Finish.

12. The script node name/value pair changes to show the Databank alias name, field 
name, and recorded value as a variable value. For example:

login = {{db.customer,login,ta906}}

In the Java Code view, the parameter code changes to show the Databank alias 
name, field name, and recorded value as a variable value. For example:

http.postdata(http.param("login", "{{db.customer,login,ta906}}")

13. Click the Playback toolbar button to playback the script once to verify the it plays 
back correctly.
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5Using the Web Functional Test Module

This chapter provides instructions on configuring and using the OpenScript Web 
Functional Test Module, which tests Web-based applications by accessing objects 
through the Document Object Model (DOM) of the Web browser.

5.1 About the Web Functional Test Module
The OpenScript Web Functional Test Module is an application module that supports 
functional testing of Web-based applications that uses the Web Document Object 
Model (DOM). OpenScript provides a flexible and easy-to-use scripting interface for 
both Technical Testers and Non-Technical Testers. The OpenScript Functional Test 
Module enables script creation from both the code view and GUI view scripting 
interfaces.

The Functional Test Module extends the OpenScript platform with Document Object 
Model (DOM) recording and playback capabilities. The DOM recorder automatically 
captures Web page objects, actions, and navigations and records them as tree view 
nodes (with the underlying code in the Code View) in the script. The Functional Test 
Module also provides additional GUI script modification options. Web Functional Test 
Scripts differ from HTTP Scripts. Even though both are used to test web applications, 
HTTP scripts automate the underlying HTTP network protocol, whereas Web 
Functional Test scripts automate the browser UI.

The Web Functional Test Module is an extension module to the Oracle OpenScript 
platform that extends the platform with Web Functional Test recording and playback 
capabilities. The Web Functional Test Module is fully integrated with the OpenScript 
platform including the Results view, Details view, Properties view, Console/Problems 
views, Preferences, Step Groups, Script Manager, and Workspace Manager. 

The Web Functional Test recorder displays commands in the Tree View in 
easy-to-understand commands. By default, script commands are grouped into Steps 
Groups by the Web page on which they were performed. Each Step Group contains 
one or more script commands corresponding to recorded actions that were performed 
on the page. The default name for the Step Group is the Web page Title (as specified in 
the "Title" tag). 

OpenScript shows the results of Web Functional Test script playback in the Results 
view. The Results view shows results for each script command (including duration 
and summary for failures). The Results Report compiles the same information into an 
HTML Results Report. Results can be exported from the OpenScript GUI in standard 
format (CSV / HTML). Results are also generated for unattended playback through 
the command line. 

The Web Functional Test Module API includes a "Web" class that provides additional 
programming functionality. 
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5.1.1 Key Features of the Web Functional Test Module
The Web Functional Test Module provides the following functionality:

■ Records Document Object Model objects and actions for playback automation. The 
objects and actions can be generated by a Web browser (i.e. IE or Firefox).

■ Plays back functional testing scripts to validate proper functionality. Playback runs 
interactively in the OpenScript user interface. Playback runs interactively in the 
OpenScript user interface and is also supported in Oracle Test Manager.

■ Provides full script code view integration to support script generation for the Web 
Functional Test Module. The Web Functional Test Module includes an additional 
API to support Web Functional Test protocol code scripting.

■ Allows users to parameterize user inputs to Functional Test scripts and drive those 
inputs from an external data file (Databank). 

■ Allows users to insert test cases for validation of objects and actions. 

■ Provides additional options/settings that are specific to Functional Test scripts 
within the Functional Test categories in the preferences interface.

■ Reports playback results for Functional Test scripts in the Results and Console 
views.

5.2 Recording Web Functional Tests
The Web Functional Test Module records Document Object Model objects and actions 
in a Web browser for playback automation. The Recorder creates functional and 
regression test scripts for automating GUI applications in a browser. 

OpenScript records standard Web DOM objects (links, images, forms, form elements, 
etc.) and events (click, mousedown, focus, etc.) for playback. Web DOM objects are 
identified by one or more attribute as configured through the Web Functional Test 
Record Preferences under Object Identification. Object Identification attributes can 
later be modified by users through the Preferences global settings for new scripts or 
for already recorded commands in the tree view or code view. All Web DOM objects, 
events and attributes should be supported. Recording can be configured through 
Internet Explorer or Firefox. You can set the browser type in the Preferences.

The Web Functional Test Module provides a record toolbar button that lets you initiate 
the Web DOM recorder and capture Web page actions to the script view. The record 
toolbar includes start and stop recording toolbar buttons. OpenScript recorders also 
open a floating toolbar that can be used while recording without having to switch 
between the browser and OpenScript.

5.2.1 Setting Web Functional Test Record Preferences
Before recording Web Functional Test scripts, set Web record preferences.

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu. 

3. Expand the OpenScript node and the Record category.

4. Select Web Functional Test.

5. Click the General tab and set the general recording preferences as follows: 

■ Browser: Specify the browser options that will be used during Web Functional 
test recording.
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– Always launch a new browser when recording a different script: When 
selected, a new browser opens each time a new script is recorded.

■ Miscellaneous: Specifies the miscellaneous record settings.

– Capture Screen Shots: When selected, screen images are captured during 
recording.

– Capture HTML: When selected, page source HTML is captured during 
recording.

– Capture URLs: When selected, the page URL will be captured.

– Capture Frames: When selected, the HTML frames on the page will be 
captured.

– Ignore Auto Page: When selected, server-side auto pages are ignored 
during recording.

– Action Cache Interval(s): Specifies how often to cache page actions during 
recording. The following cases are determined by this setting: 

If while recording, the text on the same Web page element is changed 
within the Action Cache Interval time setting, the previously recorded 
value will be replaced by the changed value. In the Java code, the set-
Text action will be replaced with the changed value.

If while recording, a browser window closes within the Action Cache 
Interval after a user performs an action on a web page (for example, a but-
ton click) the window close event will not be recorded, as the window 
close event is considered to be caused by the previously performed action.

– Record "waitForPage actions: When selected, the script recorder generates 
"wait for page" actions for test steps that generate a page transition in the 
browser. When cleared, the script recorder generates a "capture page" 
action for test steps that generate a page transition in the browser. For Web 
functional test scripts, the "wait for page" action is the normal record 
option. See the Siebel Functional test record preferences for additional 
information.

6. Click the Object Identification tab and use Add or Edit to customize the object 
identification elements or attributes. 

7. Click OK when finished.

5.2.2 Adding/Editing Object Identifiers
The Web Functional Module uses object identification to specify attributes used to 
identify Web objects. The Web Functional Test Module includes predefined path 
attributes for common Web objects. Object paths are specified in XPath format. For 
example, for web objects, the object identification path appears as follows in Java code 
commands:

/web:window[@index='0']
/web:document[@index='0']
/web:form[@index='0']
/web:input_text[@id='ticker' or @name='ticker' or @index='0']

You can set the default object attributes in the Web Functional Test Module Record 
Preferences. You can also edit object attributes in recorded scripts in the tree view or 
the code view.
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In addition to the predefined object identification, you can add an Object Library to the 
script to record paths into a library file. Object Library files may be shared and reused 
across other scripts. The Object Library files provide a more convenient "short name" 
for objects to provide for more convenient programming.

The Web Functional Test Module includes object identifiers that specify how the 
recorder identifies Browser objects. You can add object identifiers or edit the existing 
object identifiers in the Record preferences.

To add or edit an object identifier:

1. Select the OpenScript Preferences from the View menu.

2. Expand the Record node and select Web Functional Test.

3. Click the Object Identification tab.

4. Click Add or select an existing object identifier and click Edit.

The Object Element dialog box lets you define an object identifier for a Web 
Functional Test recorder. The object identifier specifies how the OpenScript Web 
Functional Test recorder module identifies web objects in the Document Object 
Model on a Web page.

Name: Specify the name of the object identifier. 

Attributes: Shows the attributes defined for the object identifier. The attributes can 
consist of an object attributes group and specific object element attributes.

Add: Opens a dialog box for specifying a new Web object identifier.

Edit: opens a dialog box for editing the selected Web object identifier.

Delete: Deletes the selected Web object identifier.

Up: Moves the selected Web object identifier up in the priority order.

Down: Moves the selected Web object identifier down in the priority order.

For each object element, you specify a name (typically a Web object attribute), an 
operator, a value and a value type. As you add object elements, OpenScript builds 
the object identifier using logical OR between each object identifier element. Click 
Edit to change between logical OR and AND.

5. If adding a new object identifier, click Add and specify the path segments for the 
object identifier.

The Path Segment dialog box lets you define a segment of an object identifier for a 
Web Functional Test recorder. The object identifier specifies how the OpenScript 
Web Functional Test recorder module identifies web objects in the Document 
Object Model on a Web page.

Attribute: When selected, specify the name, operator, value, and value type for the 
object identifier. 

■ Name: Specify the name of the Web object attribute to use to identify the 
object.

■ Operator: Specify the logical operator to use to identify the object value.

■ Value: Specify the value of the Web object attribute to use to identify the 
object. 

■ Value Type: Specify the value type to use to identify the object. The value type 
can be a string, a number, or by variable reference. Set the Value type to match 
the specified value.
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– String: The value in the Value field will be matched as a text string to 
identify the Web object.

– Number: The value in the Value field will be matched as a numeric value 
to identify the Web object.

– Reference: The value in the Value field will be matched as a variable 
name to identify the Web object.

Group: when selected the Web object identifier can be specified as a string 
representing a logical group of Names, Operators, and Values.

6. If editing an existing segment, click Edit and specify the path attributes for the 
object identifier.

The Path Attribute dialog box lets you edit an element of an object identifier. 

Name: Specify the name of the Web object attribute to use to identify the object.

Operator: Specify the logical operator to use to identify the object value.

Value: Specify the value of the Web object attribute to use to identify the object. 

Value Type: Specify the value type to use to identify the object. The value type can 
be a string, a number, or by variable reference. Set the Value type to match the 
specified value.

■ String: The value in the Value field will be matched as a text string to identify 
the Web object.

■ Number: The value in the Value field will be matched as a numeric value to 
identify the Web object.

■ Reference: The value in the Value field will be matched as a variable name to 
identify the Web object.

And/Or: specifies logical OR or AND between object elements. This option does 
not appear if the object element being edited is the last object element in the object 
identifier group.

7. If editing an existing path, click Edit and specify the path attributes for the object 
identifier.

The Path Attribute Group dialog box lets you edit an object identifier group as a 
string value. 

Group: A text string of the object identifier group. The object identifier group 
syntax follows the @name operator value/type format. Values by reference 
are enclosed in double curly braces {{}}. String values are enclosed in single 
quotation marks. Numeric values are not enclosed. Logical OR or AND are used 
between object elements. Parenthesis are used for logical grouping of multiple 
object elements. Object identifiers can use the wildcard characters * (asterisk) for 
multiple characters and ? (question mark) for single characters. For example, 
@text="Login*". The following are examples of object identifier group syntax:

@index={{index}} or @title='title' or @number=5

@text={{text}} or @href={{href}} or @index={{index}}

(@id={{id}} or @name={{name}} or @index={{index}}) and multiple mod 
{{multiple}}

8. Click OK when finished adding or editing segments or attributes. The object 
identifier is added to the record preferences.
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9. If you have the browser open when adding or editing object identifiers, close and 
restart the browser.

5.2.2.1 Available Attributes for Web DOM Elements
The following table lists the attributes available for Web Document Object Model 
objects.

5.2.3 Recording Web Functional Test Scripts
To record Web Functional Test scripts:

1. Start OpenScript.

2. Set the Web Functional Test Recording preferences.

3. Select New from the File menu. 

4. Expand the Functional Testing group.

5. Select Web.

6. Click Next.

7. Select the Repository and Workspace.

8. Enter a script name.

Element Attributes

Common attributes for all web DOM elements tag, id, index, title, style, class, html, _
adftrueval, rn, un, ot 

web:window index, title 

web:document index, url

web:a disabled, text, href

web:button type, name, value, disabled, text

web:input_button type, name, value, disabled, text

web:input_file type, name, value, index, disabled, size

web:input_hidden type, name, value, index, disabled

web:input_image type, name, disabled, alt, align, border, height, 
hspace, src, lowsrc

web:input_submit type, name, value, disabled, text

web:input_text type, name, value, defaultValue, disabled, 
maxlength, readOnly, size

web:input_check type, name, value, disabled, checked, 
defaultChecked, readOnly, size

web:input_radio type, name, value, disabled, checked, 
defaultChecked, readOnly, size

web:img alt, height, longdesc, name, src, width

web:option value, text, optionIndex(index in the select), 
defaultSelected, selected

web:select name, disabled, value, selectedIndex 

web:textarea name, disabled, value, defaultValue, readonly, 
cols, rows
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9. Click Finish. A new Script tree is created in the Script View.

10. Select Record from the Script menu. The browser automatically opens when you 
start recording.

11. Load the web page where you want to start recording into the browser.

12. Navigate the web site to record page objects, actions, and navigations. The page 
objects, actions, and navigations will be added to the Run node of the script tree.

13. When finished navigating pages, close the browser.

14. Select Stop from the Script menu or click the Stop button on the OpenScript 
toolbar.

15. Expand the Run node of the script to view the page objects, actions, and 
navigation nodes in the script tree.

You can customize the script using the menu options or the Code View for specific 
testing requirements.

5.3 Playing Back Scripts
OpenScript plays back recorded Web actions/commands which consist of an event 
plus an object identified by its attributes (for example: click 
link(text="Home")). The actions used for playback will either be those that are 
recorded or are specified manually in the Java Code view. Playback can be configured 
through Internet Explorer or Firefox. Unattended playback is supported through 
Oracle Test Manager or third-party tools using OpenScript's command line interface. 
Web Functional Test scripts do not play in Oracle Load Testing.

The Web Functional Test Module provides playback and iterate toolbar buttons that 
allows users to start the script playback for either a single playback through the script 
or multiple iterations using data from a databank file. Playback results for Web 
Functional scripts can be viewed in the Results and Console views.

5.3.1 Setting Web Functional Test Playback Preferences
To set Web Functional Test Playback preferences:

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu. 

3. Expand the OpenScript node and the Playback category.

4. Select Web Functional Test.

5. Expand the Object Timeout group and set the preferences as follows:

■ Timeout(S): Specifies the maximum number of seconds OpenScript should 
wait for an object to appear before considering the object not found. This is the 
default timeout when waiting for an object to appear before invoking an 
action against it. This is also the default timeout when waiting for an object to 
appear before continuing the script. 

Note: Do not close the script editor view or script project while 
recording or playing back scripts. Doing so could result in 
unpredictable behavior in the OpenScript application.
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You can override individual object wait timeouts in waitForPage() or 
object.waitFor() by editing their "timeout" properties. Action timeouts 
cannot be overridden. 

6. Expand the Miscellaneous group and set the preferences as follows:

■ Capture HTML: When selected, the page HTML will be captured. 

■ Capture ScreenShot: When selected, the a screen image of the page will be 
captured. 

7. Expand the Agent Port group and set the preferences as follows:

■ Port: Specifies the port number to use to communicate with the agent 
machine.

8. Expand the Capture Screenshot Interval group and set the preferences as follows:

■ Delay time for capture screenshot: Specifies the amount of time to wait before 
capturing a screenshot of the page.

9. Click OK when finished.

5.3.2 Playing Back Web Functional Scripts
To play back Web Functional scripts:

1. Start OpenScript.

2. Open the Web Functional script to play back.

3. Select Playback from the Script menu or click the toolbar button.

You can view the progress of the script playback in the Console View. You can 
review the results of script playback in the Results View.

5.3.3 Playing Back Web Functional Scripts with Iterations
To play back Web Functional scripts with iterations:

1. Start OpenScript.

2. Open the Web Functional script to play back.

3. Select Iterate from the Script menu or click the toolbar button. 

4. Set the iteration count.

5. Select which databank file to use, if necessary.

6. Set the starting record and data usage.

7. Click OK.

You can view the progress of the script playback in the Console View. You can 
review the results of script playback in the Results View.

5.4 Modifying Scripts
Once a script has been created/recorded, you can make modifications to customize the 
script for your specific testing needs.

5.4.1 Adding Browser Navigation to a Script
To add a Browser Navigation to a Script:
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1. Record a Web Functional Test script.

2. Select the script node where you want to add the navigation.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Web Actions node.

5. Expand the Browser node and select Navigate.

6. Click OK.

7. Enter the object identification path for the browser. You can use the Capture or 
Select buttons to capture or select an object path.

8. Enter the URL.

9. Click OK. The navigate node is added to the script tree.

In the Java Code view, the web.window(objectId).navigate method will be 
added to the script code:

web.window(1, 
"/web:window[@index='0']").navigate("http://testserver2/fmstocks");

The Browser web actions includes additional options for browser navigation such 
as Back, Forward, Close, Refresh, Wait for Page, etc. Additional browser actions 
have corresponding Java code methods:

web.window(1, 
"/web:window[@index='0']").waitForPage("http://testserver2/fmstocks/", 
"Stocks", true, null)
web.window("/web:window[@index='0']").close();
web.window("/web:window[@index='0']").back();
web.window("/web:window[@index='0']").forward();
web.window("/web:window[@index='0']").refresh();
web.window("/web:window[@index='0']").capturePage();
web.window("/web:window[@index='0']").solve("MyVariable", "(.+?)", true, 1);
web.window("/web:window[@index='0']").storeResponseTime("MyRespTime");
web.window("/web:window[@index='0']").waitFor(10);
web.window("/web:window[@index='0']").storeAttribute("MyAttribVar", 
"MyAttribute");

5.4.2 Adding Web Actions on Browser Objects
The Web Functional Test Module includes actions for Browser objects that can be 
added to a script. 

To add Web actions on Browser objects to a script:

1. Record a Web Functional Test script.

2. Select the script node where you want to add the action.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Web Actions node.

5. Expand an action node and select the action.

6. Click OK.

7. Enter the object identification path for the object. You can use the Capture or 
Select menu options to capture or select an object path.

8. Click OK. The action node is added to the script tree.
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In the Java Code view, a web.object(objectId).action() method will be 
added to the script code:

web.button("/web:window[@index='0']
/web:document[@index='0']
/web:form[@index='0' 
or @id='loginform' 
or @name='loginform']

/web:input_submit[@name='LoginButton' 
or @value='Login' 
or @index='0']").click()

The Web Actions node includes actions for objects such as buttons, check boxes, 
dialogs, images, links, tables, etc. Other object actions have corresponding Java 
code methods:

web.link("/web:window[@index='0']
/web:document[@index='0']
/web:a[@text='Open a new account.' 
or @href='http://testserver2/fmstocks/_NewAccount.asp' 
or @index='0']").click()

or

web.select("/web:window[@index='0']
/web:document[@index='0']
/web:form[@index='0']
/web:select[(@id='namespace' 
or @name='namespace' 
or @index='0') 
and multiple mod 'False']").selectOptionByText("[select product]");

or

web.clearSessionCookies();
web.clearAllPersistentCookies();
web.clearPersistentCookies("domain");
web.clearCache("domain");

5.4.3 Adding Object Libraries to a Script
To add Object Libraries to a script:

1. Open or create a Web Functional Test script project.

2. Select the Script menu and then select Script Properties.

3. Select the Test Assets category and select  Object Libraries.

4. Click Add.

5. Specify the library file and alias:

■ If you have already created an Object library file, select the file in a repository 
or file path. 

Note: As of OpenScript Version 9.10, scripts can be stored anywhere 
in the file system. However, any scripts you plan to run, along with 
any associated assets, in the Oracle Load Testing application must be 
stored in a repository/workspace that can be accessed by the Oracle 
Load Testing Controller.
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■ If you have not created a library file, enter a file name, and click OK. A new 
file will be created. When you record a Web Functional Test script, the browser 
actions will be automatically added to the object library file.

6. Click OK. The Object Library file is added as a script test asset under the Object 
Libraries tree. Script test assets are referenced in the assets.xml file located in the 
script directory of the repository or file path.

7. Click OK. 

8. Record a Web Functional Test script to use the object library.

The object identification paths for browser objects will be automatically added to 
the object library file during recording. You can open and edit the object library file 
using the Object Library Editor. Select Script Properties from the Script menu, 
select the Object Library Test Asset in the tree and click Open. The Object Library 
editor view opens in the Workbench with the objects and details included in the 
selected Object Library. You can add objects to and delete objects from the Object 
list. You edit the object attributes in the object string or in the tree hierarchy of the 
Details section. The tree hierarchy lets you move attributes up or down in the 
priority order. 

9. Save the script when finished.

5.4.4 Adding a Server Response Test
You can use Server Response Tests to report an error and/or abort the script if a Web 
page does not return back to the client within a specified time range.

To add a Server Response Test to a script:

1. Record a Web Functional Test script.

2. Expand the Run node.

3. Select the script node where you want to add the Server Response test.

4. Select the Script menu and then select Other from the Add sub menu.

5. Expand the Web Actions group.

6. Expand the Test group.

7. Select Server Response Test and click OK.

8. Enter the window path.

9. Enter a name for the test.

10. Enter the minimum and maximum time values.

11. Set the Stop Iteration on Failure option.

12. Click OK to add the Server Response node to the script tree.

In the Java Code view, the Server Response Test consists of the code executed in 
the web.window(objectId).verifyResponseTime() or 
web.window(objectId).assertResponseTime()method:

web.window("/web:window[@index='0']").verifyResponseTime("MyserverResp", 10.0, 
20.0);

or

web.window("/web:window[@index='0']").assertResponseTime("MyserverResp2", 10.0, 
50.0)
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In the above code examples, verify means "do not stop on failure" and assert 
means "stop on failure".

5.4.5 Adding Text Matching Tests to a Script
To add a Text Matching Test to a Script:

1. Open or create a Web Functional Test script project.

2. Select the script node where you want to add the Text Matching Test.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Web Actions node.

5. Expand the Tests node and select Text Matching Test.

6. Click OK.

7. Select the Look in location:

■ All Browsers: When selected, the Text Matching Test looks for the text to 
match in all open browsers.

■ Specified Browser: When selected, the Text Matching Test looks for the text to 
match by the browser ID specified in the Path.

■ Specified Document: When selected, the Text Matching Test looks for the text 
to match in the document specified by the object ID in the Path.

8. If you selected Specified Browser or Specified Document, enter the object 
identification path for the browser, document, or frame in the Path.

9. Enter a name for the test.

10. Enter the text string or Regular Expression to match or click the Substitute Variable 
icon to select a databank or script variable to find in the source.

11. Select the source location that will be searched for the matching text:

■ HTML Display Contents: Search the browser rendered text of the page.

■ Raw HTML: Search HTML source of the page.

12. Select the Pass when setting.

■ Selected text is present: The test case passes if the Text to Match string is 
found in the selected source.

■ Selected text is absent: The test case passes if the Text to Match string is not 
found in the selected source.

13. Select the Match type.

■ Exact: Matches the Text to Match string exactly.

Note: The pound (#) character and double brace ({{ and }}) 
character sequences need to be escaped with a preceding pound (#) 
character if used in the Text Matching Test as a literal string (not a 
string specifying an OpenScript databank or script variable). For 
example, the pound character should be doubled (##) and double 
braces should be preceded by a pound character (#{{ and #}}).
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■ Regular Expression: Matches using the Regular Expression specified in Text 
to Match.

■ Wildcard: Matches using the wildcard characters specified in Text to Match.

14. Set the Verify only, never fail option.

15. Click OK. The Text Matching Test node is added to the script tree.

In the Java Code view, the web.assertText or 
web.document(specifiedDoc).assertText method will be added to the 
script code if the Verify only, never fail option is not selected:

web.assertText("MyTextMatchTest", "Home", TextPresence.PassIfPresent, 
MatchOption.Exact)

web.document("Main").assertText("MyTextMatchTest2", "Home", 
TextPresence.PassIfPresent, MatchOption.RegEx);

In the Java Code view, the web.verifyText or 
web.document(specifiedDoc).verifyText method will be added to the 
script code if the Verify only, never fail option is selected:

web.verifyText("MyTextMatchTest", "Home", TextPresence.PassIfPresent, 
MatchOption.Exact)

web.document("Main").verifyText("MyTextMatchTest2", "Home", 
TextPresence.PassIfPresent, MatchOption.RegEx);

5.4.6 Adding Object Tests
The Web Functional Test Module includes an object test case for Browser objects that 
can be added to a script. 

To add an object test to a script:

1. Record a Web Functional Test script.

2. Select the script node where you want to add the object test.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Web Actions node.

5. Expand the Tests node and select Object Test.

6. Click OK.

7. Enter the object identification path for the object. You can use the Capture or 
Select menu options to capture or select an object path.

■ Substitute Variable: Opens a dialog box for selecting the variable to use for 
the object ID.

■ Capture Object: Opens a capture object dialog box and starts the capture 
mode. Navigate to the object to capture and use options in the capture dialog 
box to capture the object path.

■ Edit Object Path: Opens a dialog box for editing the currently selected object 
path.

■ View Object Path: Opens a dialog box for editing the currently selected object 
path.

■ Select from Object Library: Opens a dialog box for selecting an object from a 
saved library.
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■ Save to Object Library: Opens a dialog box for saving the current object to a 
library.

8. Enter a test name.

9. Select an Attribute/Value pair and specify the test details.

Attributes: Shows the attributes of the selected object. Select an attribute and 
specify the test details.

■ Attribute: Shows the name of the attribute. When selected, the attribute is 
included in the object test. When cleared, the attribute is not included in the 
object test.

■ Value: Shows either the recorded value or the test criteria for the attribute 
depending upon which Display option is selected.

■ Enable All: Enables all properties for inclusion in the test criteria.

■ Disable All: Disables all properties for exclusion from the test criteria.

■ Add Row: Adds a new row to the table.

■ Display: Selects which values appear in the properties list.

– Test: When selected, the Value list shows the test criteria defined for each 
attribute.

– Recorded Values: When selected, the Value list shows the recorded value 
for each attribute.

Test Details: Specifies the test criteria for the selected attribute. 

■ Recorded Value: Shows the recorded value of the attribute.

■ Enable: When selected, the attribute is included in the object test. When 
cleared, the attribute is not included in the object test.

■ Value Type: Specifies the data type to use as the test criteria for the attribute. 
The available options in the Operator list depend upon the selected value type 
to test: String, Boolean, Date, or Numeric. 

■ Operator: Specifies the operator to use for the playback test criteria. The list of 
operators changes depending upon the selected Value Type.

The following options are available for String values:

– Exact: The test passes if the text or attribute value matches exactly the 
current value of the text string during playback of the script.

– Wildcard: The test passes if the text or attribute value matches the current 
value of the Like operator pattern during playback of the script.

– Regular Expression: The test passes if the text or attribute value matches 
the current value of the Regular Expression pattern during playback of the 
script.

The following options are available for Numeric and Date values:

– [Relational Operators]: Lists the relational operators. Select the type of 
comparison to use during playback of the script. If you select the Range 
operator, the Object Test adds a field for specifying the range. Specify the 
from-to range.

The following option is available for Boolean values:
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– Exact: The test passes if the text or attribute value matches the True or 
False value specified in the Value field during playback of the script.

■ Value: Specifies the value to use for the test criteria for the attribute.

■ [Substitute Variable]: Opens a window for selecting a databank variable to 
substitute as the value to use for the test criteria for the attribute.

10. Specify the test details for each Attribute/Value pair as required for the test.

11. Click OK. The object test node is added to the script tree.

In the Java Code view, a web.element(objectId).verifyAttributes 
method will be added to the script code:

web.element(15, "/web:window[@index='0']
/web:document[@index='0']
/web:form[@index='0' 
or @id='loginform' 
or @name='loginform']

/web:input_password[@name='password' or @index='0']").verifyAttributes(
"MyObjectTest", web.attributes(web.attribute("index", "0", 

TestOperator.StringExact), 
web.attribute("tag", "INPUT", TestOperator.StringExact), 
web.attribute("name", "password", TestOperator.StringExact), 
web.attribute("value", "ta", TestOperator.StringExact), 
web.attribute("type", "password", TestOperator.StringExact), 
web.attribute("checked", "False", TestOperator.StringExact), 
web.attribute("disabled", "False", TestOperator.StringExact)));

5.4.7 Adding Table Tests
The Web Functional Test Module includes a table test case for HTML tables that can be 
added to a script.

To add a table test to a script:

1. Record a Web Functional Test script.

2. Select the script node where you want to add the table test.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Web Actions node.

5. Expand the Tests node and select Table Test.

6. Click OK.

7. Enter the object identification path for the table. You can use the Capture or Select 
menu options to capture or select an object path.

■ Substitute Variable: Opens a dialog box for selecting the variable to use for 
the object ID.

■ Capture Object: Opens a capture object dialog box and starts the capture 
mode. Navigate to the object to capture and use options in the capture dialog 
box to capture the object path.

■ Edit Object Path: Opens a dialog box for editing the currently selected object 
path.

■ View Object Path: Opens a dialog box for editing the currently selected object 
path.
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■ Select from Object Library: Opens a dialog box for selecting an object from a 
saved library.

■ Save to Object Library: Opens a dialog box for saving the current object to a 
library.

8. Enter a test name.

9. Select a row and column cell and specify the test details.

Test Details: Specifies the test to perform for each value. Select a value in the row 
and column list to set the details for that specific value.

■ Row: Shows the row number of the selected table value.

■ Column: Shows the column number of the selected table value.

■ Enable: When selected, the table value is included in the comparison test.

■ Recorded value: Shows the selected attribute's recorded value.

■ Value Type: Specifies the data type of the selected value: String, Numeric, 
Date, or Boolean.

■ Operator: Specifies how to compare the value. The Operator options change 
depending upon the selected value type. For relational operators, if you select 
the Range operator, a field is added for specifying the numeric or date range. 
Specify the from-to range.

■ Value: Specifies the value to test.

■ [Substitute Variable] - opens a dialog box for selecting the variable to use as 
the value to test.

10. Specify the test details for each table cell as required for the test.

11. Click OK. The table test node is added to the script tree.

In the Java Code view, a web.table(objectId).verifyCells method will be 
added to the script code:

web.table(24, "/web:window[@index='0']
/web:document[@index='0']
/web:table[@index='6']").verifyCells("MyTableTest", 
web.cells(web.cell(1, 1, "Ticker ", TestOperator.StringExact), 
web.cell(1, 2, "Company ", TestOperator.StringExact), 
web.cell(2, 1, "ORCL ", TestOperator.StringExact), 
web.cell(2, 2, "Oracle Corporation ", TestOperator.StringExact)))

5.4.8 Adding a Wait for Page
You can use the Wait for Page browser option to cause the script playback to wait until 
a page is returned by the server before continuing playback.

To add a Wait for Page command to a script:

1. Record a Web Functional Test script.

2. Expand the Run node.

3. Select the script node where you want to add the Wait for Page node.

4. Select the Script menu and then select Other from the Add sub menu.

5. Expand the Web Actions group.

6. Expand the Browser group.
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7. Select Wait For Page and click OK.

8. Enter the document ID in XPath format.

9. Select or clear the Wait for any page option.

10. If you clear the Wait for any page option, specify the URL and Match option.

11. Set the Timeout value.

12. Click OK to add the Server Response node to the script tree.

In the Java Code view, a web.window(objectId).waitForPage() method 
will be added to the script code: 

web.window(6, 
"/web:window[@index='0']").waitForPage("http://testserver2/fmstocks/home.asp", 
null, null)

5.4.9 Inspecting Object Paths
To inspect a Web object path:

1. Record a Web Functional Test script.

2. Select the Script menu and then select Inspect Path. OpenScript opens the capture 
mode. This dialog box lets you capture the object path for an object on a Web page. 

■ Path: Shows the Object Identification path of the object highlighted with the 
mouse cursor.

The following options are available on the pulldown menu after you press F10 
to capture an object path:

– Capture Object: Opens a capture object dialog box and starts the capture 
mode. Navigate to the object to capture and use options in the capture 
dialog box to capture the object path.

– View Object Path: Opens a dialog box for viewing the currently selected 
object path.

– Save to Object Library: Opens a dialog box for specifying the Object 
Library in which to save the object path.

■ Position: Shows the x, y coordinates for the entire screen. The upper left 
coordinate of entire screen is {0,0}. This position coordinate is used with 
Functional tests that include object types, such as Flash, where screen 
positions are required to perform mouse actions on the object. The position 
coordinates are used with the functional test methods, ft.mouseClick(), 
ft.mouseDown(), and ft.mouseUp().

■ Offset: Shows the x, y coordinates relative to the currently highlighted object. 
The upper left coordinate of highlighted object is {0,0}. This offset coordinate is 
used with Web Functional tests that include object types, such as Flash, where 
screen positions are required to perform a mouse click on the object. The 
position coordinates are used with the Web functional test method, 
web.element().mouseClick().

3. Navigate to the Web object and place the mouse cursor on the object.

4. Press F10 to capture the path.

5. Highlight the path with the mouse cursor and press the Ctrl+C keys to copy the 
path to the clipboard.
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6. Click OK when finished.

5.4.10 Setting Script Properties
To set script properties:

1. Record a Web Functional Test script.

2. Select the Script menu and then select Script Properties. 

3. Select the properties category.

4. Specify the properties for the category.

5. Click OK when finished.

5.4.11 Substituting Databank Variables
To substitute a databank variable for a query string parameter in a script:

1. Record a Web Functional test script that has text string parameters.

2. Expand the Run node.

3. Expand the node containing text parameters.

4. Right-click a text parameter node and select Properties from the shortcut menu.

5. If you have already configured the script with one or more databanks, select the 
click the [Substitute Variable] icon and select the databank field to substitute for 
the text parameter from the desired databank file and click Finish.

6. If you have not already configured the script with a databank, select Add new 
databank and click Next.

a. Click the Browse button and select the databank file to use.

b. Select the column (field name) to substitute for the text parameter and click 
Finish.

In the Tree View, the databank variable appears in place of the recorded value as 
{{db.databankFileName.field,recordedValue}}.

In the Java Code view, the databank variable appears as 
{{db.databankFileName.field,recordedValue}} in the 
web.text(objectId).setText method:

web.text(1, "/web:window[@index='0']
/web:document[@index='0']
/web:form[@index='0']
/web:input_text[@id='ticker' 
or @name='ticker' 
or @index='0']").setText("{{db.fmstocks_data.ticker,orcl}}")

5.5 Editing Object Libraries
To edit an object library:

1. Create a Web Functional Test script project.

2. Add an Object Library to the script and record the Web application under test.

3. Select the Load Object Library node in the script tree and then select Open Object 
Library from the right-click shortcut menu.
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4. If necessary, click the Object Library tab.

5. Select an object in the Objects list.

6. Edit the object attributes in the Details section.

You can add objects to and delete objects from the Object list. You edit the object 
attributes in the object string or in the tree hierarchy of the Details section. The tree 
hierarchy lets you move attributes up or down in the priority order. 

You can click the libraryName.properties tab to view or edit the object/object 
attribute text strings in the object library file source.

7. Select Save from the File menu or click the Save toolbar button to save changes to 
the object library file.

5.5.1 Using the Web Functional Test Module API
The Web Functional Module includes a script Application Programming Interface 
(API) specific to Web DOM functional testing. The Web Functional Test Module 
recorder creates the Java code that corresponds to the Tree View and displays the Web 
Functional Test commands in the Java Code view using easy-to-understand function 
names. The Java Code view commands correspond to the Tree View and you can edit 
your scripts in either view.

You can use the Web Functional Test API to enhance recorded scripts with additional 
testing functionality. Commands that are specific to the Web Functional Testing 
Module are part of the "web" class. Additional functional test methods are available in 
the "ft" class. You can also leverage other commands from other enabled classes 
(services) or general Java commands in your scripts.

Some examples of the Web Testing Module API include:

■ Adding control statements

■ Adding think time

■ Launching and closing the Browser

■ Navigating to a URL

■ Performing actions on Web objects (click, double click, etc.)

■ Setting text fields

■ Waiting for a page to load

Many API methods can be added using the Web Functional Test Module Tree View. 
Additional methods can be added using the Java Code view. 
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6 Using the HTTP Module

This chapter provides instructions on configuring and using the OpenScript HTTP 
Module, which tests Web-based applications by automating the underlying HTTP 
protocol traffic.

6.1 About the HTTP Module
The OpenScript HTTP Module is an application/protocol module that supports load 
testing of Web-based applications that communicate via http(s) protocol. OpenScript 
provides a flexible and easy-to-use scripting interface for both Technical Testers and 
Non-Technical Testers. The OpenScript HTTP Module enables script creation from 
both the code view and GUI view scripting interfaces.

The HTTP Module extends the OpenScript platform with HTTP Proxy recording and 
playback capabilities. The proxy recorder automatically captures Web page 
navigations and records them as tree view nodes (with the underlying code in the 
Code View) in the script. The HTTP Module also provides additional GUI script 
modification options for HTTP navigation.

6.1.1 Key Features of the HTTP Module
The HTTP module provides the following functionality:

■ Records HTTP protocol requests for playback automation. The requests can be 
generated by a Web browser (i.e. IE) or by a plug-in (i.e. AJAX XMLHTTP 
plug-in).

■ Plays back HTTP scripts to validate proper functionality. Playback runs 
interactively in the OpenScript user interface and is also supported in the Oracle 
Load Testing Agents (i.e. Java Agent).

■ Provides full script code view integration to support script generation for the 
HTTP Module. The commands include (but are not limited to) methods to 
generate GET requests, POST requests, correlation substitutions, validation, etc. 
The HTTP Module includes an additional API to support HTTP protocol code 
scripting.

■ Allows users to parameterize user inputs to HTTP scripts and drive those inputs 
from an external data file (Databank).

■ Provides additional options/settings that are specific to HTTP scripts within the 
HTTP categories in the preferences interface.

■ Reports playback results for HTTP scripts in the Results and Console views.
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6.2 Navigation Editing (Correlation) 
The HTTP Module enables users to view and edit all recorded navigations and related 
parameters (headers, post data, etc.) in either the script GUI Tree view or Code View. It 
also enables them to view and edit any default correlation/parameterization of 
dynamic navigations and apply their own correlation to handle dynamic navigations. 

■ Navigation Editing GUI View: Configures the navigations they want to 
parameterize and the correlation rules they want to apply through a navigation 
editing GUI view interface. The GUI allows viewing and editing properties for 
different types of navigations (for both Web/HTTP applications and 
non-Web/HTTP applications) and data inputs. This GUI View includes: 

– Display & Editing for Recorded Navigations: Includes recorded navigations 
and any navigation parameters like headers, etc. and a mechanism for users to 
edit/add/delete navigations including dynamic parameter sources/targets.

– Display & Editing for Correlation Rules Library & Editing: Includes a list of 
all default correlation rules included in the module(s) (listed by application 
type) and a mechanism for users to add/edit/delete correlation rules.

■ Navigation Editing Code View Commands: Users are able to specify the 
navigations they want to parameterize and the data source they want to drive the 
inputs from through navigation editing commands in the code view. These 
commands map to the navigation editing GUI view. 

beginStep("[2] Home", 3266);
{

http.post(4, "http://testserver2/fmstocks/{{FORMACTION_0,default.asp}}",
null,
http.postdata(http.param("login", "{{INPUT_0,ta616}}"),

http.param("password", "{{INPUT_1,ta}}"),
http.param("LoginButton", "{{INPUT_2,Login}}")),

null, true, "ASCII", "ASCII");
{
http.solveXpath("LINK_1_3", ".//A[text()='research a company']

/@href", "TickerList.asp", 0);
http.solveXpath("LINK_1_2", ".//A[text()='Logout']

/@href", "logout.asp", 0);
}

}
endStep();

6.2.1 Setting Correlation Preferences
To set correlation preferences:

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu.

3. Expand the OpenScript node and the Correlation category.

4. Select HTTP.

5. Select or clear the check boxes for defined rules.

6. Select Add Library, Add Rule, or Edit Rule to define custom correlation rules.

7. Click OK.
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6.2.2 Adding Correlation Libraries
Selecting Add Library in the Correlation Rules Preferences opens the Add Library 
dialog box. This dialog box lets you specify a new correlation library for transforming 
dynamic data in recorded script URLs and related parameters (headers, post data, etc.) 
to variable names that will be recognized by the script playback engine (OpenScript or 
Oracle Load Testing). The dialog box has the following options:

■ Name: Specifies the name of the correlation library. After you define a library you 
can use the Add Rule button to specify the rules to include in the library. The 
name is required. You can also select Copy rules to copy correlation rules from an 
existing library.

■ Copy rules from existing library: Lets you copy correlation rules from an existing 
library to a new library.

– Copy Rules: When selected, a list of existing correlation rule libraries will be 
enabled for copying.

– Library: Lists the correlation rule libraries available for copying.

6.2.3 Adding and Editing Correlation Rules
Selecting Add Rule or Edit Rule in the Correlation Rules Preferences opens the Add 
Rule or Edit Rule dialog box. This dialog box lets you specify or edit a correlation rule 
for transforming dynamic data in recorded script URLs and related parameters 
(headers, post data, etc.) to variable names that will be recognized by the script 
playback engine (OpenScript or Oracle Load Testing). The dialog box has the 
following options:

■ Type: Specifies the type of correlation rule. The available Source and Target 
options change depending upon the rule type. The following rule types are 
available:

– Client Set Cookie: This rule type automatically transforms web page cookie 
objects with dynamic data.

– Correlate Cookie Header: This rule type automatically transforms web page 
cookie header objects with dynamic data.

– Correlate Header: This rule type automatically transforms web page header 
objects with dynamic data.

– Correlate Referer Header: This rule type automatically transforms web page 
referer header objects with dynamic data.

– DOM Correlation: This rule type automatically transforms web page 
Document Object Model (DOM) objects with dynamic data.

– Function/Text Substitution: This rule type lets you specify a used-defined 
function to replace a specific parameter or parameters.

– Substitute Recorded Date: This rule type lets you specify a Regular Expression 
pattern to find and replace a date parameters with a variable value.

– Variable Substitution: This rule type lets you specify a Regular Expression 
pattern to find and replace a specific parameter or parameters with a variable 
value.

– XML DOM Correlation: This rule type automatically transforms XML page 
Document Object Model (DOM) objects with dynamic data.

■ Name: Specifies the name of the correlation rule. The name is required.
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The following sections describe the rule types.

6.2.3.1 Client Set Cookie
When Client Set Cookie is selected, the Source and Target show the following options:

■ Source: Always cookies.

■ Target: Specifies which document object(s) to use as the target location of the 
transform.

– Replace all locations: When selected, the correlation rule applies to any object 
matching the source criteria.

– Replace specified location: When selected, the correlation rule applies only to 
the object matching the Location criteria.

– Location: Specifies the cookie parameter(s) to which to apply the correlation 
rule using a Regular Expression. (See Variable Substitution Rules below for 
examples.)

6.2.3.2 Correlate Cookie Header
When Correlate Cookie Header is selected, the Source and Target show the following 
options:

■ Source: Always cookie header.

■ Target: Specifies which document object(s) to use as the target location of the 
transform.

– Replace all locations: When selected, the correlation rule applies to any object 
matching the source criteria.

– Replace specified location: When selected, the correlation rule applies only to 
the object matching the Location criteria.

– Location: Specifies the cookie parameter(s) to which to apply the correlation 
rule using a Regular Expression. (See Variable Substitution Rules below for 
examples.)

6.2.3.3 Correlate Header
When Correlate Header is selected, the Source and Target show the following options:

■ Source: Always web page headers.

■ Target: Specifies which header object(s) to use as the target location of the 
transform.

– Replace all locations: When selected, the correlation rule applies to any object 
matching the source criteria.

– Replace specified location: When selected, the correlation rule applies only to 
the object matching the Location criteria.

– Location: Specifies the header parameter(s) to which to apply the correlation 
rule using a Regular Expression. (See Variable Substitution Rules below for 
examples.)

6.2.3.4 Correlate Referer Header
When Correlate Referer Header is selected, the Source and Target show the following 
options:
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■ Source: Always web page referer headers.

■ Target: Specifies which referer header object(s) to use as the target location of the 
transform.

– Replace all locations: When selected, the correlation rule applies to any object 
matching the source criteria.

– Replace specified location: When selected, the correlation rule applies only to 
the object matching the Location criteria.

– Location: Specifies the referer header parameter(s) to which to apply the 
correlation rule using a Regular Expression. (See Variable Substitution Rules 
below for examples.)

6.2.3.5 DOM Correlation Rules
When DOM Correlation Rules is selected, the Source and Target show the following 
options:

■ Source: Specifies which document object(s) to substitute as dynamic data.

– Links: When selected, web page link objects with dynamic data will 
automatically transformed to variable values.

– Action: When selected, web page action objects with dynamic data will 
automatically transformed to variable values.

– Input: When selected, web page input objects with dynamic data will 
automatically transformed to variable values.

– TextArea: When selected, web page TextArea objects with dynamic data will 
automatically transformed to variable values.

– JavaScript: When selected, web page JavaScript objects with dynamic data 
will automatically transformed to variable values.

– Frame: When selected, web page Frame objects with dynamic data will 
automatically transformed to variable values.

– Option: When selected, web page Option objects with dynamic data will 
automatically transformed to variable values.

■ Target: Specifies which referer header object(s) to use as the target location of the 
transform.

– Replace all locations: When selected, the correlation rule applies to any object 
matching the source criteria.

– Replace specified location: When selected, the correlation rule applies only to 
the object matching the Location criteria.

– Location: Specifies the web page object(s)/parameter(s) to which to apply the 
correlation rule using a Regular Expression. (See Variable Substitution Rules 
below for examples.)

6.2.3.6 Function/Text Substitution Rules
When Function/Text Substitution Rules is selected, the Source and Target show the 
following options:

■ Source: Specifies the function name or text to use as the substitute for dynamic 
data.
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– Function/Text: Specifies the name of the function to use to search the source 
location. The following functions are available:.

* {{@decode({{myVariable}})}}: Searches the source using the 
specified Target Regular Expression and replaces the data with the script 
variable {{@decode({{myVariable}})}}. The value is the encoded 
text string specified by the Target Regular Expression.

* {{@decrypt({{myVariable}})}}: Searches the source using the 
specified Target Regular Expression and replaces the data with the script 
variable {{@decrypt({{myVariable}})}}. The value is the 
encrypted text string specified by the Target Regular Expression.

* {{@deobfuscate({{myVariable}})}}: Searches the source using the 
specified Target Regular Expression and replaces the data with the script 
variable {{@deobfuscate({{myVariable}})}}. The value is the 
obfuscated text string specified by the Target Regular Expression.

* {{@encode({{myVariable}})}}: Searches the source using the 
specified Target Regular Expression and replaces the data with the script 
variable {{@encode({{myVariable}})}}. The value is the text string 
specified by the Target Regular Expression.

* {{@encrypt({{myVariable}})}}: Searches the source using the 
specified Target Regular Expression and replaces the data with the script 
variable {{@encrypt({{myVariable}})}}. The value is the text 
string specified by the Target Regular Expression.

* {{@file({{myVariable}})}}: Searches the source using the specified 
Target Regular Expression and replaces the data with the script variable 
{{@file({{myVariable}})}}. The value is the text string contained in 
the file specified by myVariable or a hard coded path such as 
{{@file(c:\\OpenScript_Sample.txt)}}.

* {{@getAndIncrement({{myVariable}},delta)}}: Searches the 
source using the specified Target Regular Expression and replaces the data 
with the script variable {{@getAndIncrement({{myVariable}}, 
delta)}}. The value is the numeric value specified by the Target 
Regular Expression. delta is the amount to increment the value by each 
time.

* {{@hostip}}: Searches the source using the specified Target Regular 
Expression and replaces the data with the script variable {{@hostip}}. 
The value is the host IP address.

* {{@hostname}}: Searches the source using the specified Target Regular 
Expression and replaces the data with the script variable 
{{@hostname}}. The value is the host name.

* {{@iterationnum}}: Searches the source using the specified Target 
Regular Expression and replaces the data with the script variable 
{{@iterationnum}}. The value is the script playback iteration number.

* {{@jstr({{myVariable}})}}: Searches the source using the specified 
Target Regular Expression and replaces the data with the script variable 
{{@jstr({{myVariable}})}}. The value is a serialized Java string 
that specifies a Hexadecimal length value followed by the string contained 
in myVariable in the format \00\09var_value.

* {{@len({{myVariable}})}}: Searches the source using the specified 
Target Regular Expression and replaces the data with the script variable 
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{{@len({{myVariable}})}}. The value is the length of the string 
contained in myVariable.

* {{@obfuscate({{myVariable}})}}: Searches the source using the 
specified Target Regular Expression and replaces the data with the script 
variable {{@obfuscate({{myVariable}})}}. The value is the text 
string specified by the Target Regular Expression.

* {{@random(max)}}: Searches the source using the specified Target 
Regular Expression and replaces the data with the script variable 
{{@random(max)}}. The value is the numeric value specified by the 
Target Regular Expression. The default minimum value is 0. max is the 
maximum value limit for the random number. The generated random 
number is a uniformly distributed pseudorandom integer value between 0 
(inclusive) and max value (exclusive), drawn from this random number 
generator's sequence. For example, {{@random(2)}} will return a 
number between 0 (inclusive) and 2 (exclusive). The random value is an 
integer from the formula randomValue = min + m_
random.nextInt(max - min), where m_random.nextInt uses the 
java.util.Random.nextInt method.

* {{@random(min,max)}}: Searches the source using the specified Target 
Regular Expression and replaces the data with the script variable 
{{@random(min, max)}}. The value is the numeric value specified by 
the Target Regular Expression. min is the minimum value limit for the 
random number. max is the maximum value limit for the random number. 
The generated random number is a uniformly distributed pseudorandom 
integer value between min value (inclusive) and max value (exclusive), 
drawn from this random number generator's sequence. For example, 
{{@random(1,4)}} will return a number between 1 (inclusive) and 4 
(exclusive). The random value is an integer from the formula 
randomValue = min + m_random.nextInt(max - min), where m_
random.nextInt uses the java.util.Random.nextInt method.

* {{@sessionname}}: Searches the source using the specified Target 
Regular Expression and replaces the data with the script variable 
{{@sessionname}}. The value is the script playback session number.

* {{@timestamp}}: Searches the source using the specified Target Regular 
Expression and replaces the data with the script variable 
{{@timestamp}}. The timestamp value is the difference, measured in 
milliseconds, between the current time and Midnight, January 1, 1970 
UTC.

* {{@timestampsecs}}: Searches the source using the specified Target 
Regular Expression and replaces the data with the script variable 
{{@timestampsecs}}. The value is the current timestamp in seconds 
instead of milliseconds.

Note:  For @jstr, @file, and @len functions, myVariable is an 
OpenScript script variable defined using the http.solve or 
http.solveXpath methods. The variable name must be enclosed in 
double {{ }} braces within the function parenthesis. For example:

{{@len({{myVariable}})}}
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* {{@today(MM/dd/yyyy)}}: Searches the source using the specified 
Target Regular Expression and replaces the data with the script variable 
{{@today(MM/dd/yyyy)}}. The value is the current date in 
month/day/year format.

* {{@topLevelStepName}}: Searches the source using the specified 
Target Regular Expression and replaces the data with the script variable 
{{@topLevelStepName}}. The value is the top level step group name.

* {{@urlEncode({{myVariable}})}}: Searches the source using the 
specified Target Regular Expression and replaces the data with the script 
variable {{@urlEncode({{myVariable}})}}. The value is the text 
string specified by the Target Regular Expression. For example, the string, 
'the file "abc" is in \root\etc', would be encoded as: 
the+file+%22abc%22+is+in+%5Croot%5Cetc. 

* {{@vuid}}: Searches the source using the specified Target Regular 
Expression and replaces the data with the script variable {{@vuid}}. 
The value is the virtual user ID specified by the Target Regular Expression.

* {{@xmlDecode({{myVariable}})}}: Searches the source using the 
specified Target Regular Expression and replaces the data with the script 
variable {{@xmlDecode({{myVariable}})}}. The value is the 
encoded text string specified by the Target Regular Expression.

* {{@xmlEncode({{myVariable}})}}: Searches the source using the 
specified Target Regular Expression and replaces the data with the script 
variable {{@xmlEncode({{myVariable}})}}. The value is the text 
string specified by the Target Regular Expression.

■ Target: Specifies which referer header object(s) to use as the target location of the 
transform.

– Replace all locations: When selected, the correlation rule applies to any object 
matching the source criteria.

– Replace specified location: When selected, the correlation rule applies only to 
the object matching the Location criteria.

– Location: Specifies the web page object(s)/parameter(s) to which to apply the 
correlation rule using a Regular Expression. (See Variable Substitution Rules 
below for examples.)

6.2.3.7 Substitute Recorded Date
When Substitute Recorded Date is selected, the Source and Target show the following 
options:

■ Source: Specifies the attribute to use as the substitute for dynamic data.

– Attribute Name: for internal use only and should only be set to "value" 
(without quotations).

– Date Pattern: Specifies the date pattern in the form M/dd/yyyy. The Date 
Pattern follows standard Java Date format string conventions. When 
correlating scripts, the time that the navigation was recorded is converted to a 
date using the specified Date Pattern. If the current date is found in a request, 
it is replaced with: {{@today(date_pattern)}}.

■ Target: Specifies which referer header object(s) to use as the target location of the 
transform.
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– Replace all locations: When selected, the correlation rule applies to any object 
matching the source criteria.

– Replace specified location: When selected, the correlation rule applies only to 
the object matching the Location criteria.

– Location: Specifies the referer header parameter(s) to which to apply the 
correlation rule using a Regular Expression. (See Variable Substitution Rules 
below for examples.)

6.2.3.8 Variable Substitution Rules
When Variable Substitution Rules is selected, the Source and Target show the 
following options:

■ Source: Specifies the attribute to use as the substitute for dynamic data.

– Variable Name: Specifies the name of the variable to use as the substitute for 
dynamic data.

– Pattern: Specifies the Regular Expression to use to locate the dynamic data to 
replace.

– Error Message: Specifies an error message to report if the source data is not 
found on playback.

– Source: Specifies where to search for the dynamic data to replace: HTML 
Display Contents, Raw HTML or Response Header.

– Encoding: Specifies if encoding should be used for the search and the type.

■ Target: Specifies which referer header object(s) to use as the target location of the 
transform.

– Replace all locations: When selected, the correlation rule applies to any object 
matching the source criteria.

– Replace specified location: When selected, the correlation rule applies only to 
the object matching the Location criteria.

– Location: Specifies the web page object(s)/parameter(s) to which to apply the 
correlation rule using a Regular Expression. Specify a regular expression to 
narrow down which part of a target request may be replaced with the 
correlated variable. All or part of a url, query string, and/or postdata may be 
substituted. Use ((.+?)) to indicate where the variable should be 
substituted.

* The expression may be used to substitute a variable into a specific 
name=value pair. For example, to substitute the session ID in this post 
data: Post Data: sessionId=123456&color=blue.

Specify the following expression: sessionId=((.+?)). 

Using the above expression, if the correlation rule's variable is found on a 
page and its value matches "123456", then the post data will become: ses-
sionId={{correlationRuleVariable-
Name,123456}}&color=blue.

* If the name=value pair appears URL-encoded in the post data or query 
string, do NOT URL-encode the expression. For example, to substitute the 
"file/folder" parameter in this post data: Post Data: 
file%2Ffolder=folderXYZ%2FfileABC&session=ABC%2FDEF.

Specify the following expression: file/folder=((.+?)). 
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* If substituting a variable into a non-URL-encoded postdata or querystring, 
do not URL-encode the expression. For example, to substitute the "id" 
value of the following unencoded XML post data: Post Data: 
<xml><session id="12345"/></xml>.

Specify the following expression: <session id="((.+?))"/>. 

Using the above expression, if the correlation rule's variable is found on a 
page and its value matches "12345", then the entire post data will become: 
<xml><session id="{{correlationRuleVariable-
Name,12345}}"/></xml> .

* If substituting a variable into a range of URL-encoded Name=Value pairs, 
then URL-encode the expression. For example, to replace all but the first 
parameter of the following URL-encoded query string data with one 
value: Query String: 
file=root%2Fdata.txt&sessionId=123%2Fxyz&color=blue.

Specify the following expression: file=root%2Fdata.txt((.+?)).

Using the above expression, if the correlation rule's variable is found on a 
page and its value matches "&sessionId=123%2Fxyz&color=blue", 
then the entire query string will become: 

file=root%2Fdata.txt{{correlationRuleVariableName,&ses-
sionId=123%2Fxyz&color=blue}} 

6.2.3.9 XML DOM Correlation Rules
When XML DOM Correlation Rules is selected, the Source and Target show the 
following options:

■ Source: Specifies all XML document object(s) to substitute as dynamic data.

■ Target: Specifies which referer header object(s) to use as the target location of the 
transform.

– Replace all locations: When selected, the correlation rule applies to any object 
matching the source criteria.

– Replace specified location: When selected, the correlation rule applies only to 
the object matching the Location criteria.

– Location: Specifies the XML page object(s)/parameter(s) to which to apply the 
correlation rule using a Regular Expression. (See Variable Substitution Rules 
for examples.)

6.3 Recording Scripts
The OpenScript HTTP Module records parameters defined by each page of the Web 
application to a script which can then be played back, with parameters in the Web 
page filled in with values from a Databank file.

The HTTP Module records HTTP protocol requests generated by a Web browser for 
playback automation. The HTTP Recorder records Web browser events for playback 
correlation which allows users to correlate dynamic HTTP requests based on 
knowledge of the GUI events which generated the navigation (i.e. dynamic GET 
request originated from click on link "x").The HTTP Module provides a Record toolbar 
button that allows users to initiate the HTTP proxy recorder and captures Web page 
navigations to the script view. The toolbar includes start and stop recording toolbar 
buttons.
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6.3.1 Setting HTTP Record Preferences
Before recording HTTP scripts, first set the HTTP record preferences.

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu.

3. Expand the OpenScript node, then expand the Record category.

4. Select HTTP.

5. Click the General tab and set the general recording preferences as follows: 

■ Setup - specifies the network settings for proxy recording.

– Network Interface: enter or select the network IP address of the proxy 
server.

– Port: specify the port to use on the proxy server.

– Additional arguments: specify any additional command line arguments 
to use when starting the proxy server.

– Maximum Download Size (MB): specify the file size for file downloads.

– Only record requests originating from the local machine - when selected, 
only requests originating from the local machine are recorded by the 
HTTP proxy recorder.

■ Client-Side Digital Certificate File: enter the name of a .PFX-formatted 
digital certificate file or use the Browse button to select a file.

– File: specifies the name of the PFX file. Enter the name or use the Browse 
to select the file from a drive and directory location.

– Choose above pfx file to store: specifies the private-key password defined 
for the client certificate PFX file when the certificate was exported from 
Internet Explorer. Click Store and enter the private-key password for the 
client certificate.

■ SSL Version: specifies the SSL version to use.

– SSL Version: select SSL version to use for the proxy server.

■ Close browser when stopping recorder: specify the browser options that will 
be used during HTTP recording.

– Close browser: when selected, the browser closes automatically when 
recording is stopped.

■ Always Launch a new browser when starting recorder: Specify the browser 
options that will be used during HTTP recording.

– Launch browser: When selected, the browser launches automatically 
when recording is started.

■ Error Handling: specifies the error handling options that will be used during 
HTTP recording as follows.

– Record navigations that return error code 404: When selected, the HTTP 
recorder records navigations that return a Server Status Code 404: Not 
Found.

6. Click the Proxy Settings tab and configure the default Proxy recorder settings as 
follows: 

■ Chain Proxy: specifies if the OpenScript proxy is chained to another proxy.
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– Use Browser's proxy: when selected, the HTTP recorder uses the proxy 
configuration specified by the browser. 

– Use specified proxy: when selected, OpenScript uses the specified proxy.

Use proxy configuration script: when selected, the specified configura-
tion scripts will be used. 

Address: specify the URL to the JavaScript file containing the FindProxy-
ForURL JavaScript function supplied by the system administrator for the 
intranet environment.

Use proxy server: when selected, the specified proxy server will be used. 

Address: specify the network IP address of the proxy server to which to 
chain the OpenScript proxy.

Port: specify the port to use on the chained proxy server.

■ Proxy Authentication: specifies the log in credentioals for authentication.

– Username: specify the user name to use for authentication.

– Password: specify the password to use for authentication.

7. Click the URL Filters tab to create a new Proxy URL filter or to select a 
pre-defined filter.

To use a pre-defined filter, select the checkbox for the filter in the list. Clear the 
checkbox to disable the filter.

To create a new filter or edit an existing filter:

■ Click Add or Edit.

■ Specify the filter name.

■ Specify the URL filter wild card or Regular Expression pattern to match 
against. Wild card characters include the asterisk (*) to represent a string of 
characters and the question mark (?) to represent a single character.

■ Select what to apply the filter against as the value for Match:

– Content type: When selected, the filter applies to the page content type.

– URL: When selected, the filter applies to the page URL.

■ Select the type of filtering method to use as the value for Method:

– Wild card: If selected, the filter uses wild card characters to filter the 
content. 

– Regular expression: If selected, the filter uses the regular expression 
provided to filter the content.

8. Click OK when finished.

6.3.2 Recording a New HTTP Script
To create a new HTTP script, you essentially record the script.

1. Start OpenScript.

2. Set the HTTP Recording preferences if you haven’t already.

3. Select New from the File menu.

4. Select HTTP Script.
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5. Click Next.

6. Select the Repository and Workspace. 

7. Enter a script name.

8. Click Finish. A new Script tree is created in the Script View.

9. Select Record from the Script menu or click the arrow on the Record toolbar 
button and select Proxy Recorder.

10. If you set the Launch browser option in the HTTP Record preferences, the browser 
automatically opens when you start recording with the HTTP Proxy recorder. If 
you did not set the Launch browser option, you will have to open a browser 
manually.

11. Load the web page where you want to start recording into the browser.

12. Navigate the web site to record page navigations. The page navigations will be 
added to the Run node of the script tree.

13. When finished navigating pages, stop the script by selecting Stop from the Script 
menu or clicking the Stop button on the OpenScript toolbar.

14. If you set the Close browser option in the HTTP Record preferences, the browser 
automatically closes when you stop recording. If you did not set the Close 
browser option, you will have to close the browser manually.

15. Expand the Run node of the script to view the page navigation nodes in the script 
tree. 

You can customize the script using the menu options or the Code View for specific 
testing requirements.

Note: Do not close the script editor view or script project while recording or 
playing back scripts. Doing so could result in unpredictable behavior in the 
OpenScript application.

6.4 Playing Back Scripts
Once HTTP scripts have been recorded, you can play them back to validate 
functionality. Playback runs interactively in the OpenScript user interface and is also 
supported in the Oracle Load Testing.

The HTTP Module provides playback and iterate toolbar buttons that allows users to 
start the HTTP script playback for either a single playback through the script, or run 
through multiple iterations using data from a databank file. Playback results for HTTP 
scripts can be viewed in the Results and Console views.

6.4.1 Setting HTTP Playback Preferences
Before playing back scripts, you should set the playback preferences.

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu.

3. Expand the OpenScript node, then select the Playback category.

4. Select HTTP Module.

5. Expand the Proxy group and set the preferences as follows: 

■ Proxy Host: The host name of the HTTP proxy server.
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■ Proxy Port: The port to use on the proxy server.

■ Proxy Username: The use name to use for authentication.

■ Proxy Password: The password to use for authentication.

■ Non-Proxy Hosts: The host name of the non-proxy servers.

6. Expand the Compression group and set the preferences as follows: 

■ Enable GZIP: When selected, the GZIP compression format is enabled.

■ Enable Deflate: When selected, deflate is enabled.

7. Expand the Headers group and set the preferences as follows: 

■ Browser Emulation: The browser to emulate for script playback. By default 
the recorded browser is used.

■ Language: The language to use for script playback. The default is English.

■ HTTP Version: The HTTP version to use for script playback.

■ Accept String: The Accept string to use in the Request header for script 
playback.

8. Expand the Connections group and set the preferences as follows: 

■ Enable Keep Alive: If selected, keep alive is enabled on the connection.

■ Max Number of Keep Alive Requests: The maximum number of requests to 
make on a keep alive connection before closing it. Select Unlimited for an 
unlimited number of requests. 

9. Expand the SSL group to specify the default HTTP playback Secure Sockets Layer 
(SSL) settings: 

■ SSL Version: The SSL version to use.

10. Expand the Other group and set the preferences as follows: 

■ Do not request URLs ending in: URLs ending with any of the specified 
patterns or file types will not be requested. Specify the ending pattern or file 
type separated by commas.

■ Cache Emulation: The type of user to simulate when playing back the script. 
This is useful for simulating different profiles of virtual users. 

A first time user places more of a load on the Web server because pages and 
image are not yet cached. A repeat user places less of a load on the server as 
only newer pages are requested and brought down from the Web server.

Select one of the following options:

– Do not request URLs ending in: Virtual users are considered to be using 
the Web site or application for the first time for each iteration so no cache 
is used. The cache is used during the iteration.

– Do Not Cache: Select to not use the cache. 

Note: When using WinInet, selecting Do Not Cache has the same effect as 
selecting 1st Time as the Cache Emulation method. In this case, document 
cache is not created and not cleared. 

– 1st Time User: Virtual users are considered to be using the Web site or 
application for the first time for each iteration so no cache is used. The 
cache is used during the iteration.
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– Repeat User: Virtual users are considered to have visited or used the Web 
site or application previously. Pages and images are retrieved from the 
cache.

■ Enable Cookies: If selected, the virtual user profiles will use cookies. Use this 
setting if your Web application uses cookies to manage session and other 
context information.

■ Download Local Files: When selected, the Java Agent retrieves the requested 
local file contents.

■ Preserve Cookies Between Iterations: Used to preserve or automatically clear 
cookies added to the browser in the Run section between successive iterations 
of the Run section.

Cookies added to the browser in the Initialize section will be preserved 
forever, unless explicitly removed in script code.

Cookies added to the browser in the Run section will always be preserved 
between the final iteration of the Run section and the Finish section.

■ Preserve Connections Between Iterations: Used to preserve connections 
between OpenScript and the browser between successive iterations of the 
script.

■ Max Content Size (KB): Specifies the maximum number of KB to download 
from a server for a given request. The default value of this option is 
"Unlimited". However, the maximum Virtual User Display Size is set to 
1024KB, which may cause content in the Details view to be truncated if the 
content size exceeds the Virtual User Display Size. You can configure the 
Maximum Virtual User Display Size by adding the following setting in the 
Additional Arguments field of the General Playback Preferences:

-MAX_VUDATA_BYTES xxxxxxxx

Where xxxxxxxx is the size in KB to set as the Maximum Virtual User 
Display Size. For example: 

-MAX_VUDATA_BYTES 10000000

See Section 2.4.1, "General Playback Preferences" for additional information 
about specifying Additional Arguments.

11. Expand the Download Manager group and set the preferences as follows: 

■ Use Download Manager: When selected, the Download Manager is enabled 
during playback. When cleared, the Download Manager is not enabled during 
playback.

■ Ignored Resources (Use RegEx): Specifies the Regular Expression(s) string to 
use to ignore specific resources. For example, the expression Login_
Banner(.+?) would not download resources such as Login_Banner1.gif and 
Login_Banner2.gif. Multiple Regular Expressions can be separated using a 
comma (,).

■ CSS Resource: When selected, css resources in <Link> tags are downloaded 
during playback. When cleared, css resources are not downloaded during 
playback.

■ Image Resource: When selected, image resources in <Img> tags, in the 
"background" attribute of a tag, or in <style> tags with "background:url" 
patterns are downloaded during playback. When cleared, image resources are 
not downloaded during playback.
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■ Embeded Object Resource: When selected, object resources in <Embed> tags 
or in <Object> tags are downloaded during playback. When cleared, object 
resources are not downloaded during playback.

■ Script Resource: When selected, script resources in <Script> tags are 
downloaded during playback. When cleared, script resources are not 
downloaded during playback.

■ Applet Resources: When selected, applet resources in <Applet> tags are 
downloaded during playback. When cleared, applet resources are not 
downloaded during playback.

12. Click OK when finished.

6.4.2 Playing Back HTTP Scripts
Once an HTTP script has been recorded, you can play it back.

1. Start OpenScript.

2. Open the HTTP script to play back.

3. Select Playback from the Script menu or click the toolbar button.

4. You can view the progress of the script playback in the Console View. You can 
review the results of script playback in the Results View. 

See"Viewing Script Playback Results" on page 6-16 for more information.

6.4.3 Playing Back HTTP Scripts With Iterations
OpenScript allows repetitive playback of navigations in a script. The iterations can be 
performed with or without databanks.

1. Start OpenScript.

2. Open the HTTP script to play back.

3. Select Iterate from the Script menu or click the toolbar button.

4. Set the iteration count to the desired number of playback iterations.

5. Select which databank file to use, if desired.

■ Name: Lists the alias name(s) for the databank file(s).

■ Starting Row: The starting record for the databank. You can specify the 
starting row for the selected databank in the Databank Settings section.

■ Data: Shows the data in the specified starting row.

6. Set the starting record for the selected databank in the Databank Settings section:

■ Name: Shows the alias name of the selected databank file.

■ Starting Record: The starting record for the selected databank. The starting 
record will be updated in the Databanks section.

7. Click OK. 

You can view the progress of the script playback in the Console View. You can 
review the results of script playback in the Results View.

6.4.4 Viewing Script Playback Results
To view HTTP script play back results:
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1. Start OpenScript.

2. Open the HTTP script to play back.

3. Select Playback from the Script menu or click the toolbar button.

4. When playback is finished, click the Results view. If necessary, select Results from 
the View menu to open the Results View.

5. In the Name column, expand the results node to view the results.

6.4.5 Resetting Encoding
The Reset Encoding menu option changes the character set used when displaying the 
recorded HTML. Use this option to reset the encoding for non-English web sites where 
the correct character encoding may not be set automatically.

To reset encoding:

1. Start OpenScript.

2. Open the HTTP script.

3. Expand the HTTP script and select a navigation node.

4. Right-click on the navigation node and select Reset Encoding from the shortcut 
menu.

5. Enter the encoding value for the recorded HTML page and click OK.

6.4.6 Comparing Recorded/Playback Results
To compare HTTP script play back results with the recorded navigations:

1. Start OpenScript.

2. Switch to the Tester Perspective and make sure the Details View is open. If not, 
select Details from the View menu to open the Details View.

3. Open the HTTP script to play back.

4. Select Playback from the Script menu or click the toolbar button.

5. When playback is finished, view the results. If necessary, select Results from the 
View menu to open the Results View.

6. In the Name column, expand the results node to view the results.

7. In the Name column, click a navigation node for a page.

8. In the Detail View, click the Comparison tab.

9. In the Comparison tab, select Content, Request Headers or Response Headers to 
view the Recorded and Playback text to compare in the lower panes.

6.4.7 Playing Back HTTP Scripts In Oracle Load Testing
Once recorded, you can play back HTTP scripts in Oracle Load Testing.

If OpenScript and Oracle Load Testing are on the same machine:

1. Start Oracle Load Testing.

2. Select the Repository and Workspace where the OpenScript scripts are located.

3. Select the script to play back.
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4. Set the User Mode to Java Client.

5. Configure the scenario parameters as required for the test.

6. Run the scenario in the Autopilot mode.

If OpenScript and Oracle Load Testing are on the different machines:

1. Select Export Script from the File menu.

2. Select the additional files to export to a Zip file and click OK.

3. Copy the exported Zip file to the Oracle Load Testing machine.

4. Start Oracle Load Testing.

5. Select Upload File from the Tools menu.

6. Select OpenScript Zip as the file type.

7. Enter the name and location of the exported OpenScript Zip file.

8. Select the Repository and Workspace where the OpenScript scripts is to be 
uploaded.

9. Click Upload to upload the file.

10. In the Build Scenarios tab, select the script to play back.

11. Set the User Mode to Java Client.

12. Configure the scenario parameters as required for the test.

13. Run the scenario in the Autopilot.

Note: Any external files, such as databanks files, must available to Oracle Load Testing 
(i.e. located in the path in specified in script file).

6.4.8 Posting Binary or XML File Data
To post Binary or XML File Data:

1. Record an HTTP script as described in "Recording a New HTTP Script" on 
page 6-12.

2. Open the Java Code view.

3. Use the following code to specify a binary data variable and the 
http.navigate() method to post the data:

byte[] data = 
oracle.oats.utilities.FileUtil.readBytesFromFile("c:\\image.jpg");
http.navigate(0, "http://www.mysite.com/", null, data, null, true);

The same solution works for an XML file:

byte[] data = oracle.oats.utilities.FileUtil.readBytesFromFile("c:\\file.xml");
http.navigate(0, "http://www.mysite.com/", null, data, null, true);

If you want to store your binary or XML file inside the script itself:

1. Switch to the Developer perspective.

2. In the Navigator View, create a folder in the script project called "resources".

3. Add your jpg or XML file into the new "resources" folder.

4. Change the first line of the above code sample to this:
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byte[] data = 
getScriptPackage().getResourceFile("resources/yourfile.jpg").getData();

By storing the file locally with the script, the file will always be available to the 
agent, even if it is run on a remote agent machine through Oracle Load Testing.

6.5 Modifying Scripts
Once a script has been created/recorded, you can make modifications to customize the 
script for your specific testing needs. 

6.5.1 Understanding the HTTP Module Script View
The default display for an HTTP proxy recorded script is the Tree View GUI in the 
Script View. The HTTP Recorder generates the Tree View and code based upon the 
Step Group preferences set in OpenScript. The default Step Group settings will 
generate Step Groups based upon page navigations in the HTTP web application.

Figure 6–1 Script Tree View

Below each navigation will be child nodes for additional information about a page 
navigation, such as query strings and form action inputs. The right-click shortcut 
menu includes additional script modification options specific to the script generated 
using the HTTP Module.The Tree View is a graphical representation of the underlying 
code in the Code View. For example, "Page [4] Ticker List" in the above Tree View 
appears as Step Group and http.get method code in the Code View, as follows 
(line breaks and spacing added for clarity):

beginStep("[4] Ticker List", 3422);
{
   http.get(6, "http://testserver2/fmstocks/{{LINK_1_3,TickerList.asp}}", 
        http.querystring(http.param("ticker", "ter"), 
             http.param("company", "")), 
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             null, true, "ASCII", "ASCII");
}
endStep();

Changes made in the Tree View are automatically updated in the Code View. Changes 
made in the Code View are automatically updated in the Tree View. The HTTP Module 
includes an API with HTTP protocol-specific methods. The commands include (but are 
not limited to) methods to generate GET requests, POST requests, correlation 
substitutions, validation, etc.

6.5.2 Using Script Variables
OpenScript scripts use variables to pass dynamic data between navigations. The 
navigation can be in step groups or another code sequence. You can use the Tree view 
and Script menu options to add custom variables to a script or code them manually 
using the Code view. The HTTP Proxy recorder also defines variables when recording. 
The following example shows how the HTTP Proxy recorder's default settings record 
Step Groups, navigations and variables for form inputs and links.

The script is a three page script. the first page is a login page. The second page is the 
page returned after login which includes links to other pages. The page in the script is 
the page returned by a click on a link.

Step Group 1 (beginStep("[1] Stocks", 0);) gets the page navigation and form 
input parameters. The http.solveXpath method assigns the input values to script 
variables using XPaths (for example, ".//INPUT[@name='login']/@value") to 
find the input value in the page source.

beginStep("[1] Stocks", 0);
{
  http.get(2, "http://testserver2/fmstocks/", null, null, true, "ASCII", "ASCII");
  {
  http.solveXpath("FORMACTION_0", ".//FORM[@name='loginform']/@action",
      "default.asp", 0);
  http.solveXpath("INPUT_0", ".//INPUT[@name='login']/@value", "ta496", 0);
  http.solveXpath("INPUT_1", ".//INPUT[@name='password']/@value", "ta", 0);
  http.solveXpath("INPUT_2", ".//INPUT[@name='LoginButton']/@value", "Login", 0);
  }
}
endStep();
beginStep("[2] Home", 3246);
{
   http.post(4, "http://testserver2/fmstocks/{{FORMACTION_0,default.asp}}",
      null,       http.postdata(http.param("login", "{{INPUT_0,ta496}}"),
      http.param("password", "{{INPUT_1,ta}}"), 
      http.param("LoginButton", "{{INPUT_2,Login}}")), 
      null, true, "ASCII", "ASCII");
  {
  http.solveXpath("LINK_1_3", ".//A[text()='research a company']/@href",
     "TickerList.asp", 0);
  }
}
endStep();
beginStep("[3] Ticker List", 1703);
{
   http.get(13, "http://testserver2/fmstocks/{{LINK_1_3,TickerList.asp}}", null,
      null, true, "ASCII", "ASCII");
}
endStep();
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In step Group 2 (beginStep("[2] Home", 3264);), the page navigation uses the 
variables defined in Step Group 1 to pass the data values as parameters to the 
http.post method. The he http.solveXpath method assigns links HREF values 
to variables using XPaths.

beginStep("[1] Stocks", 0);
{
   http.get(2, "http://testserver2/fmstocks/", null, null, true, "ASCII",
       "ASCII");
   {
      http.solveXpath("FORMACTION_0", ".//FORM[@name='loginform']/@action",
          "default.asp", 0);
      http.solveXpath("INPUT_0", ".//INPUT[@name='login']/@value", "ta496", 0);
      http.solveXpath("INPUT_1", ".//INPUT[@name='password']/@value", "ta", 0);
      http.solveXpath("INPUT_2", ".//INPUT[@name='LoginButton']/@value", 
        "Login", 0);
   }
}
endStep();
beginStep("[2] Home", 3246);
{
  http.post(4, "http://testserver2/fmstocks/{{FORMACTION_0,default.asp}}",
     null,      http.postdata(http.param("login", "{{INPUT_0,ta496}}"),
          http.param("password", "{{INPUT_1,ta}}"), 
          http.param("LoginButton", "{{INPUT_2,Login}}")), 
          null,  true, "ASCII", "ASCII");
  {
   http.solveXpath("LINK_1_3", ".//A[text()='research a company']/@href",
   "TickerList.asp", 0);
  }
}
endStep();
beginStep("[3] Ticker List", 1703);
{
   http.get(13, "http://testserver2/fmstocks/{{LINK_1_3,TickerList.asp}}", 
      null, null, true, "ASCII", "ASCII");
}
endStep();

In Step Group 3 (beginStep("[3] Ticker List", 1703);), the page navigation 
uses a variable defined in Step Group 2 to pass the data values as parameters to the 
http.get method.

beginStep("[1] Stocks", 0);
{
   http.get(2, "http://testserver2/fmstocks/", null, null, true, "ASCII",
     "ASCII");
   {
     http.solveXpath("FORMACTION_0", ".//FORM[@name='loginform']/@action",
       "default.asp", 0);
     http.solveXpath("INPUT_0", ".//INPUT[@name='login']/@value", "ta496", 0);
     http.solveXpath("INPUT_1", ".//INPUT[@name='password']/@value", "ta", 0);
     http.solveXpath("INPUT_2", ".//INPUT[@name='LoginButton']/@value", 
         "Login", 0);
   }
}
endStep();
beginStep("[2] Home", 3246);
{
   http.post(4, "http://testserver2/fmstocks/{{FORMACTION_0,default.asp}}",
      null,      http.postdata(http.param("login", "{{INPUT_0,ta496}}"),
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     http.param("password", "{{INPUT_1,ta}}"), 
     http.param("LoginButton", "{{INPUT_2,Login}}")), 
        null, true, "ASCII", "ASCII");
  {
   http.solveXpath("LINK_1_3", ".//A[text()='research a company']/@href",
      "TickerList.asp", 0);
  }
}
endStep();
beginStep("[3] Ticker List", 1703);
{
   http.get(13, "http://testserver2/fmstocks/{{LINK_1_3,TickerList.asp}}", 
      null, null, true, "ASCII", "ASCII");
}
endStep();

6.5.3 Adding a Variable to a Script
The following describes how to add a variable to a script. A regular expression is used 
to search a specified location for a value to set for the variable.

1. Open or create a script project.

2. Select the script node in which you want to add the variable.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Variable node and select Variable.

5. Enter the variable name.

6. Enter the variable value.

7. Click OK. The Set: variableName = value node is added to the script tree.

8. In the Java Code view, the getVariables().set("varName", "value"); 
method will be added to the script code.

6.5.4 Adding a Solve XPath to a Script
To add a SolveXpath to a script:

1. Open or create a script project.

2. Select the script node where you want to add the XPath value.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Variable node and select Solve XPath.

5. Enter the variable name.

6. Enter the XPath to use to search for the value for the variable.

7. Enter the Result index value to use for the variable method.

8. Click OK. The SolveXpath: name node is added to the script tree.

9. In the Java Code view, the http.solveXpath(); method will be added to the 
script code:

http.solveXpath("var_MyDomVar", ".//INPUT[@name='login']/@value", "ta610", 0);

Example:
http.solveXpath("FORMACTION_0", ".//FORM[@name='loginform']/@action", 
"default.asp", 0);
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getLogger().info("Form Name: {{FORMACTION_0}}");

6.5.5 Finding a Variable in a Script
To find a variable in a script:

1. Open or create a script.

2. Right-click on a post data or query string parameter containing {{ }} syntax and 
select Find Variable Source.

The variable referenced inside the {{ }} will be selected in the script tree node.

If more than one variable exists inside the given parameter, OpenScript will display a 
dialog box from which to pick which variable to find.

6.5.6 Deleting Variables from a Script
Deleting a variable from the tree view causes references to the variable using {{ }} 
notation in any string in the script to be reverted to their recorded values. Variable 
references in the Java code are also reverted. 

To delete a variable from a script:

1. Open or create a script.

2. Right-click on a post data or query string parameter containing {{ }} syntax and 
select Delete. 

The variable referenced inside the {{ }} syntax will be reverted to its recorded value. 

To delete similar variables from a script:

1. Open or create a script.

2. Right-click on a post data or query string parameter containing {{ }} syntax and 
select Delete all type_ Variables. This menu option appears for any variables 
whose name is prefixed with a word followed by an underscore (_) character.

All variables of type_ referenced inside the {{ }} syntax will be reverted to their 
recorded values.

6.5.7 Adding Authentication to a Script
To add authentication to an HTTP script:

1. Record an HTTP script as described in "Recording a New HTTP Script" on 
page 6-12.

2. Select the Run node.

3. Select the Script menu and then select Other from the Add sub menu.

4. Select the Authentication node and click OK.

5. Enter the URL to access for authentication.

6. Enter a username.

7. Enter the password for the user. Passwords are encrypted using the Base-64 Crypt 
algorithm.

8. Click OK to add the Authentication node to the script tree.
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9. In the Java Code view, the Authentication consists of the code executed in the 
http.addAuthentication procedure:

http.addAuthentication("http://testserver2", "username", 
decrypt("KRT|J|xJPDP"));

6.5.8 Adding Text Matching Tests to a Script
You can use Text Matching Tests to report an error and/or abort the script if a single 
HTTP request does not match the Text Matching Test criteria.

To add a Text Matching Test to an HTTP script:

1. Record an HTTP script as described in "Recording a New HTTP Script" on 
page 6-12.

2. Expand the Run node.

3. Select the HTTP navigation node where you want to add the Text Matching test.

4. Select the Script menu and then select Text Matching Test from the Add menu.

5. Enter a name for the test.

6. Enter tthe text string or Regular Expression to match or click the Substitute 
Variable icon to select a databank or script variable to find in the source.

7. Select the source location that will be searched for the matching text:

■ HTML Display Contents: Search the browser rendered text of the page.

■ Raw HTML: Search HTML source of the page.

■ Response Header: Search the page Response Header.

8. Select the Pass when setting.

■ Selected text is present: The test case passes if the Text to Match string is 
found in the selected source.

■ Selected text is absent: The test case passes if the Text to Match string is not 
found in the selected source.

9. Select the Match type.

■ Exact: Matches the Text to Match string exactly.

■ Regular Expression: Matches using the Regular Expression specified in Text 
to Match.

■ Wildcard: Matches using the wildcard characters specified in Text to Match.

10. Set the Verify only, never fail option.

11. Click OK. The Text Matching Test node is added to the script tree.

In the Java Code view, the http.assertText method will be added to the script 
code if the Verify only, never fail option is not selected:

Note: The pound (#) character and double brace ({{ and }}) 
character sequences need to be escaped with a preceding pound (#) 
character if used in the Text Matching Test as a literal string (not a 
string specifying an OpenScript databank or script variable). For 
example, the pound character should be doubled (##) and double 
braces should be preceded by a pound character (#{{ and #}}).
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http.assertText("MyTextMatchTest", "Home", TextPresence.PassIfPresent, 
MatchOption.Exact)

In the Java Code view, the http.verifyTextmethod will be added to the script 
code if the Verify only, never fail option is selected:

http.verifyText("MyTextMatchTest", "Home", TextPresence.PassIfPresent, 
MatchOption.Exact)

6.5.9 Adding Server Response Tests to a Script
You can use Server Response Tests to report an error and/or abort the script if a single 
HTTP request does not return back to the client within a specified time range.

To add a Server Response Test to an HTTP script:

1. Record an HTTP script as described in "Recording a New HTTP Script" on 
page 6-12.

2. Expand the Run node.

3. Select the HTTP navigation node where you want to add the Server Response test.

4. Select the Script menu and then select Other from the Add sub menu.

5. Select Server Response Test from the Validation group.

6. Enter a name for the test.

7. Enter the minimum and maximum time values.

8. Enter any error message text to log if the test fails.

9. Set the Stop Iteration on Failure option.

10. Click OK to add the Server Response node to the script tree.

6.5.10 Substituting Databank Variables
During playback, the parameters in the Web page are filled with values from the 
Databank file. However, you can substitute a databank variable for a query string 
parameter in an HTTP script.

1. Record an HTTP script as described in "Recording a New HTTP Script" on 
page 6-12 that has query string parameters.

2. Expand the Run node.

3. Expand the node containing query string parameters.

4. Right-click a query string parameter node and select Substitute Variable from the 
shortcut menu.

■ If you have already configured the script with one or more databanks, select 
the databank field to substitute for the query string parameter from the 
desired databank file and click Finish.

■ If you have not already configured the script with a databank, select Add new 
databank and click Next.

– Click the Browse button and select the databank file to use.

– Select the column (field name) to substitute for the query string parameter 
and click Finish.
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In the Tree View, the databank variable appears in place of the recorded value as 
{{databankFileName.field,recordedValue}}.

In the Java Code view, the databank variable appears as 
{{databankFileName.field,recordedValue}} in the 
http.querystring(http.param() parameter of the http.get method:

http.get(6, "http://testserver2/fmstocks/TickerList.asp", 
       http.querystring(http.param("ticker", "{{fmstocks_data.ticker,ter}}"), 
       http.param("company", "")), 
       null, true, "ASCII", "ASCII");

6.5.11 Substituting Post Data Variables
To substitute a variable for a Post Data parameter in an HTTP script:

1. Record an HTTP script that has Post Data parameters.

2. Expand the Run node.

3. Expand the node containing Post Data parameters.

4. Right-click a Post Data parameter node and select Substitute Variable from the 
shortcut menu.

■ If you have already defined custom variables in the script, select the variable 
name to substitute for the Post Data parameter and click Finish.

■ If you have not already defined custom variables in the script, select Create 
new script variable and click Next.

The Search for Value panel lists the navigation(s) that contain the post data 
value. If there are more than one navigation that contain the post data value, 
select the navigation were you want to substitute a variable. When you select a 
navigation, the data for that navigation appears below with the specific source 
highlighted along with a suggested Regular Expression.

– Specify the Regular Expression to use for the substitute variable for the 
Post Data parameter and click Next.

– Click Test to verify the Regular Expression locates the correct data value to 
substitute.

– If the Regular Expression locates the correct data value to substitute, click 
Next to continue. If the Regular Expression does not return the correct 
data value, modify and test the Regular Expression until the desired data 
value is located and click Next to continue.

– Enter a name for the substitute variable.

– If you want to add the variable as a variable rule in a correlation library, 
click Add to library and specify the rule information. If not, click Finish to 
insert the substitute script variable into the script

In the Tree View, the script variable appears in place of the recorded value as 
{{variableName,recordedValue}}.

In the Java Code view, the script variable appears as variableName,Regular 
Expression parameters in the http.solve method:

http.solve("MY_VAR", "<INPUT id=login name=login value=\"(.+?)\">", null, 
false, Source.Html, 0);
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6.5.12 Adding a Cookie to a Script
To add a cookie to a script:

1. Open or create a script project.

2. Select the script node where you want to add the cookie.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Cookie node and select Add Cookie.

This dialog box lets you add a cookie to a script.

5. Enter a valid cookie string.

■ Cookie String: Specifies the cookie string to add

■ Cookie String Charset: Specifies the character set to use for the cookie string

6. Click OK. The Cookie node is added to the script tree.

7. In the Java Code view, the http.addCookie method will be added to the script 
code:

http.addCookie("cookieString", "charset");

Example:

http.addCookie("username=testCookie", "ASCII");
java.util.List <Cookie> cookies = 
http.getBrowser().getCookieJar().getAllCookies();
for (Cookie cookie : cookies) {
   getLogger().info(cookie.getUrl());
   getLogger().info(cookie.getCookieString());
   }

6.5.13 Removing a Cookie From Script
To remove a cookie from a script:

1. Open or create a script project.

2. Select the script node where you want to place the remove cookie node.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Cookie node and select Remove Cookie.

5. Enter the cookie string to remove.

6. Click OK. The Remove Cookie node is added to the script tree.

7. In the Java Code view, the http.removeCookie method will be added to the 
script code:

http.removeCookie("cookieString");

6.5.14 Adding a User Agent to a Script
To add a user agent to a script:

1. Open or create a script project.

2. Select the script node where you want to add the user agent.

3. Select the Script menu and then select Other from the Add sub menu.
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4. Expand the HTTP node and select Set User Agent.

5. Enter the user agent details. 

6. Click OK. The user agent node is added to the script tree.

7. In the Java Code view, the http.setUserAgent("agent"); method will be 
added to the script code:

http.setUserAgent("Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; SV1; .NET 
CLR 1.1.4322; InfoPath.1; .NET CLR 2.0.50727)");

6.6 Adding Navigation
The HTTP Module allows you to view and edit all recorded navigations and related 
parameters (headers, post data, etc.) in either the script GUI Tree view or the Code 
View. It also enables you to view and edit any default correlation/parameterization of 
dynamic navigations and apply your own correlation to handle dynamic navigations. 

6.6.1 Understanding Navigation Editing (Correlation)
You can use the Navigation Editing GUI View to configure the navigations you want 
to parameterize and the correlation rules you want to apply. The GUI allows viewing 
and editing properties for different types of navigations (for both Web/HTTP 
applications and non-Web/HTTP applications) and data inputs. 

The Display & Editing for Recorded Navigations view includes recorded navigations 
and any navigation parameters like headers, etc. It also provides a mechanism for 
users to edit/add/delete navigations including dynamic parameter sources/targets.

Figure 6–2 Display & Editing for Recorded Navigations view
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The Display & Editing for Correlation Rules Library & Editing view includes a list of 
all default correlation rules included in the module(s), listed by application type. It 
also provides a mechanism for adding, editing or deleting correlation rules.

Figure 6–3 The Display & Editing for Correlation Rules Library & Editing view

You can specify the navigations you want to parameterize and the data source you 
want to drive the inputs from through navigation editing commands in the code view. 
These commands map to the navigation editing GUI view.

beginStep("[2] Home", 3266);
{
   http.post(4, "http://testserver2/fmstocks/{{FORMACTION_0,default.asp}}", 
        null,         http.postdata(http.param("login", "{{INPUT_0,ta616}}"), 
             http.param("password", "{{INPUT_1,ta}}"), 
             http.param("LoginButton", "{{INPUT_2,Login}}")), 
             null, true, "ASCII", "ASCII");
             {
             http.solveXpath("LINK_1_3", ".//A[text()='research a
                  company']/@href", "TickerList.asp", 0);
             http.solveXpath("LINK_1_2", ".//A[text()='Logout']/@href",
                  "logout.asp", 0);
             }
}
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endStep();

6.6.2 Adding HTTP Get Navigation
To add an HTTP Get Navigation to an HTTP script:

1. Record an HTTP script as described in "Recording a New HTTP Script" on 
page 6-12.

2. Select the Run node.

3. Select the Script menu, then select HTTP Get Navigation from the Add sub menu.

4. On the Base URL tab, specify the following:

■ Path: The base URL path to use for the navigation.

■ Request charset: The character set to use for the request.

■ Response charset: The character set to use for the response.

■ Encode strings: When selected, control and special characters in string are 
encoded to the Character entity references. When cleared, control and special 
characters in string are not encoded.

5. On the Query String tab, use the Add button to add the requested name/value 
pairs to the Base URL. Note that you can use the Up and Down buttons to move 
the selected query string parameter up or down one place in the search order.

6. On the Headers tab, use the Add button to add name/value pairs and actions to 
the Base URL.

7. Click OK to add the HTTP Get Navigation node to the script tree.

8. In the Java Code view, the HTTP Get Navigation consists of the code executed in 
the http.Get method (line breaks and spacing added for clarity):

http.Get(1, "http://testserver2",
       http.querystring(http.param("QueryString1", "QueryValue1"),
            http.param("QueryString2", "QueryValue2"),
                   http.param("QueryString3", "QueryValue3")),
       http.headers(http.header("HeaderString1", "HeaderValue1NoActions",
                    Header.HeaderAction.Add),
       http.header("HeaderString2", "HeaderValue2SetifNotSet",
                    Header.HeaderAction.SetIfNotSet),
       http.header("HeaderString3", "HeaderValue3ApplytoAll",
                    Header.HeaderAction.GlobalAdd),
       http.header("HeaderString4", "HeaderValue4BothActions",
                    Header.HeaderAction.GlobalSetIfNotSet)),
       false, "ASCII", "ASCII");

6.6.3 Adding HTTP Post Navigation
To add an HTTP Post Navigation to an HTTP script:

1. Record an HTTP script as described in "Recording a New HTTP Script" on 
page 6-12.

2. Select the Run node.

3. Select the Script menu and then select Other from the Add sub menu.

4. Select the HTTP Post Navigation node and click OK.

5. On the Base URL tab, specify the following:
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■ Path: The base URL path to use for the navigation.

■ Request charset: The character set to use for the request.

■ Response charset: The character set to use for the response.

■ Encode strings: When selected, control and special characters in string are 
encoded to the Character entity references. When cleared, control and special 
characters in string are not encoded.

6. On the Query String tab, use the Add button to add the requested name/value 
pairs to the Base URL. Note that you can use the Up and Down buttons to move 
the selected query string parameter up or down one place in the search order.

7. On the Post Data tab, use the Add button to add name/value pairs to the Base 
URL.

8. On the Headers tab, use the Add button to add name/value pairs and actions to 
the Base URL.

9. Click OK to add the HTTP Post Navigation node to the script tree.

10. In the Java Code view, the HTTP Post Navigation consists of the code executed in 
the http.Post method (line breaks and spacing added for clarity):

http.Post(12, "http://testserver2",
     http.querystring(http.param("QueryString1", "QueryValue1"),
                  http.param("QueryString2", "QueryValue2"), 
                  http.param("QueryString3", "QueryValue3")), 
     http.postdata(param("PostString1", "PostValue1"), 
                  http.param("PostString2", "PostValue2"), 
                  http.param("PostString3", "PostValue3")), 
     http.headers(http.header("HeaderString1", "HeaderValue1NoActions",
                         Header.HeaderAction.Add), 
                  http.header("HeaderString2", "HeaderValue2SetifNotSet",
                         Header.HeaderAction.SetIfNotSet), 
                  http.header("HeaderString3", "HeaderValue3ApplytoAll",
                         Header.HeaderAction.GlobalAdd), 
                  http.header("HeaderString4", "HeaderValue4BothActions",
                         Header.HeaderAction.GlobalSetIfNotSet)), 
     true, "ASCII", "ASCII");

6.6.4 Adding an HTTP Multipart Post Navigation
To add an HTTP Multipart Post Navigation to an HTTP script:

1. Record an HTTP script as described in "Recording a New HTTP Script" on 
page 6-12.

2. Select the Run node.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the HTTP Multipart Navigation node and select the Multipart Post 
Navigation node and click OK.

5. On the Base URL tab, enter the following:

■ Path: The base URL path to use for the navigation.

■ Boundary: Specify the boundary to use to identify parts of a multipart form 
input navigation (file navigations). The boundary is used within the 
Content-Type: multipart/form-data; boundary="" response sent by the user 
agent. The specified boundary should not occur in any of the file data.
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■ Request charset: The character set to use for the request.

■ Response charset: The character set to use for the response.

■ Encode strings: Select this option so that control and special characters in 
string are encoded to the Character entity references. When cleared, control 
and special characters in string are not encoded

6. On the Query String tab, use the Add button to add name/value pairs to the Base 
URL.

7. On the Post Data tab, use the Add button to add postdata to the Base URL. You 
can specify standard Postdata name/value pairs or postdata files. If you select 
File, specify the path, filename, and content type for each postdata file parameter.

8. On the Headers tab, use the Add button to add name/value pairs and actions to 
the Base URL.

9. Click OK to add the HTTP Multipart Post Navigation node to the script tree.

10. In the Java Code view, the HTTP Multipart Post Navigation consists of the code 
executed in the http.multipartPost method (line breaks and spacing added 
for clarity):

http.multipartPost(13, "http://testserver2", 
        http.querystring(http.param("QueryString1", "QueryValue1"), 
                    http.param("QueryString2", "QueryValue2"), 
                    http.param("QueryString3", "QueryValue3")), 
        http.postdata(http.param("PostDataString1", "PostDataValue1Standard"), 
                    http.param("PostDataString2", "PostDataValue2FilePath",
                          "PostDataValue2FileName", "ASCII"), 
                    http.param("PostDataString3",
                      "C:\\Oracle\\OFT\\DataBank\\fmstocks_data.csv",
                      "C:\\Oracle\\OFT\\DataBank\\fmstocks_data.csv", "CSV")),
        http.headers(http.header("HeaderString1", "HeaderValue1NoActions",
                          Header.HeaderAction.Add), 
                    http.header("HeaderString2", "HeaderValue2IfNotSet",
                          Header.HeaderAction.SetIfNotSet), 
                    http.header("HeaderString3", "HeaderValue3ApplytoAll",
                          Header.HeaderAction.GlobalAdd), 
                    http.header("HeaderString4", "HeaderValue4Both",
                          Header.HeaderAction.GlobalSetIfNotSet)), 
        "boundary", false, "ASCII", "ASCII");

6.6.5 Adding an HTTP XML Post Navigation
To add an HTTP XML Post Navigation to an HTTP script:

1. Record an HTTP script as described in "Recording a New HTTP Script" on 
page 6-12.

2. Select the Run node.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the XML Post Navigation node and select the XML Post Navigation node 
and click OK.

5. On the Base URL tab, specify the following:

■ Path: The base URL path to use for the navigation.

■ Request charset: The character set to use for the request.

■ Response charset: The character set to use for the response.
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■ Encode strings: When selected, control and special characters in string are 
encoded to the Character entity references. When cleared, control and special 
characters in string are not encoded.

6. On the Query String tab, use the Add button to add the requested name/value 
pairs to the Base URL. Note that you can use the Up and Down buttons to move 
the selected query string parameter up or down one place in the search order.

7. On the Post Data tab, enter the XML post data to add to the Base URL.

8. On the Headers tab, use the Add button to add name/value pairs and actions to 
the Base URL.

9. Click OK to add the HTTP XML Post Navigation node to the script tree.

10. In the Java Code view, the HTTP XML Post Navigation consists of the code 
executed in the http.xmlPost method (line breaks and spacing added for 
clarity):

http.xmlPost(0, "http://xmltest2", 
        http.querystring(http.param("xmlQueryString1", "xmlQueryValue1"), 
                  http.param("xmlQueryString2", "xmlQueryValue2"), 
                  http.param("xmlQueryString3", "xmlQueryValue3")),  
                         "xmlPostDataString", 
        http.headers(http.header("xmlHeaderString1", "xmlHeaderValue1NoAction",
                           Header.HeaderAction.Add), 
                  http.header("xmlHeaderString2", "xmlHeaderValue2IfNotSet",
                           Header.HeaderAction.SetIfNotSet), 
                  http.header("xmlHeaderString3",
                   "xmlHeaderValue3ApplytoAll", Header.HeaderAction.GlobalAdd),
                  http.header("xmlHeaderString4", "xmlHeaderValue4Both",
                           Header.HeaderAction.GlobalSetIfNotSet)), 
        false, "ASCII", "ASCII");
        

6.6.6 Using the HTTP Module API 
The Web Functional Module includes a script Application Programming Interface 
(API) specific to Web HTTP protocol testing. The HTTP Module recorder creates the 
Java code that corresponds to the Tree View and displays the HTTP commands in the 
Java Code view using easy-to-understand function names. The Java Code view 
commands correspond to the Tree View and you can edit your scripts in either view.

You can use the HTTP API to enhance recorded scripts with additional testing 
functionality. Commands that are specific to the HTTP Module are part of the "http" 
class. You can also leverage other commands from other enabled classes (services) or 
general Java commands in your scripts.

Some examples of the HTTP Module API include:

■ Adding authentication

■ Adding and removing cookies

■ Adding HTTP navigation (Get and Post)

■ Adding HTTP Multipart Post navigation

■ Adding HTTP Multipart name/value pairs

■ Adding name/value pairs

■ Adding XML Post navigation
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■ Setting the user agent

Many API methods can be added using the HTTP Module Tree View. Additional 
methods can be added using the Java Code view. 
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7Using the Oracle EBS/Forms Functional Test
Module

This chapter provides instructions on configuring and using the OpenScript Oracle 
EBS/Forms Functional Test Module, which provides support for functional testing of 
Oracle EBS/Forms web applications.

7.1 About the Oracle EBS/Forms Functional Test Module
The Oracle EBS/Forms Functional Test Module provides support for functional testing 
of Oracle EBS/Forms web applications. The Oracle EBS/Forms Functional Test 
Module is an extension to the Web Functional Test Module. 

The Oracle EBS/Forms Functional Test Module is an extension module to the 
OpenScript Web Functional Test Module that extends the Web testing with Oracle 
EBS/Forms Functional Test recording and playback capabilities. The Oracle 
EBS/Forms Functional Test Module is fully integrated with the OpenScript platform 
including the Results view, Details view, Properties view, Console/Problems views, 
Preferences, Step Groups, Script Manager, and Workspace Manager. 

The Oracle EBS/Forms Functional Test recorder displays commands in the Tree View 
in easy-to-understand commands. By default, script commands are grouped into Steps 
Groups by the Web page on which they were performed. Each Step Group contains 
one or more script commands corresponding to recorded actions that were performed 
on the page. The default name for the Step Group is the Web page Title (as specified in 
the "Title" tag). 

OpenScript shows the results of Oracle EBS/Forms Functional Test script playback in 
the Results view. The Results view shows results for each script command (including 
duration and summary for failures). The Results Report compiles the same 
information into an HTML Results Report. Results can be exported from the 
OpenScript GUI in standard format (CSV / HTML). Results are also generated for 
unattended playback through the command line. 

The Oracle EBS/Forms Functional Test Module API includes a "forms" class that 
provides additional programming functionality. 

7.1.1 Key Features of the Oracle EBS/Forms Functional Test Module
■ Supports Oracle E-Business Suite Release 12 (Forms 10g) running on Sun JRE and 

E-Business Suite Release 11i (Forms 6i) running on Jinitiator.

■ Records Forms actions in the applet.
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■ Plays back recorded Forms actions/commands which consist of an event plus 
object identified by its attributes (for example: forms.textField(28, 
"//forms:textField[(@name='DIST_LIST_NAME_0')]").input("LOREM 
IPSUM")).

■ Provides full script code view integration to support script generation for the 
Oracle EBS/Forms Functional Test Module. The Oracle EBS/Forms Functional 
Test Module includes an additional API to support Oracle EBS/Forms Functional 
Test protocol code scripting.

■ Allows users to parameterize user inputs to Oracle EBS/Forms Functional Test 
scripts and drive those inputs from an external data file (Databank). 

■ Allows users to insert Tests to validate Oracle EBS/Forms content on playback. 

■ Provides additional automation of all Oracle EBS/Forms GUI components using 
options/settings that are specific to Oracle EBS/Forms Functional Test scripts 
within the Oracle EBS/Forms Functional Test categories in the preferences 
interface.

■ Reports playback results for Oracle EBS/Forms Functional Test scripts in the 
Results and Console views.

■ The Oracle EBS/Forms Functional Test Script Module API. The Oracle EBS/Forms 
Functional Test Application Programming Interface include Java code methods 
specific to functional testing of Oracle EBS/Forms applications.

The New Project wizard (Select New from the File menu) includes an "Oracle 
EBS/Forms " option in the Functional Test group to use when creating Oracle 
EBS/Forms functional testing projects in OpenScript. The Oracle EBS/Forms 
Functional Test Script Module records Oracle EBS/Forms applications using Object 
Identification. OpenScript captures user actions and records them to the OpenScript 
script nodes in a highly readable sequence of navigations and actions.

7.1.2 Prerequisites
The Oracle EBS/Forms Functional Test Module recorder has the following 
prerequisites:

■ Before recording any script in Forms Functional Test Module, you must run the 
Forms/EBS application at least once before attempting to record a script with 
OpenScript on that machine. This ensures that required JRE/Jinitiator has been 
installed and also verifies that forms applications can run successfully on that 
machine inside of Internet Explorer.

7.2 Recording Oracle EBS/Forms Functional Tests
The Oracle EBS/Forms Functional Test Module records standard Oracle EBS/Forms 
components for Oracle E-Business Suite Release 12 (Forms 10g) running on Sun JRE 
and E-Business Suite Release 11i (Forms 6i). The Recorder creates functional and 
regression test scripts for automating testing of Oracle EBS/Forms applications. 

Oracle EBS/Forms are applet based controls and the Oracle EBS/Forms Functional 
Test Module provides the object/attribute information for OpenScript to record 
interactions with those controls. Actions will be captured in the test script as 
OpenScript "forms" commands. Other components are standard Web controls which 
are captured as standard OpenScript "web" commands using Web Functional Test 
object attributes. Object Identification attributes can later be modified by users through 
the Preferences global settings for new scripts or for already recorded commands in 
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the tree view or code view. Recording can be configured through Internet Explorer 
only as the Oracle EBS/Forms Functional Test Module does not support Firefox.

The Oracle EBS/Forms Functional Test Module provides a record toolbar button that 
lets you initiate the Oracle EBS/Forms recorder and capture Web/Oracle EBS/Forms 
page actions to the script view. The record toolbar includes start and stop recording 
toolbar buttons. OpenScript recorders also open a floating toolbar that can be used 
while recording without having to switch between the browser and OpenScript.

7.2.1 Setting Oracle EBS/Forms Functional Test Record Preferences
To set Oracle EBS/Forms Functional Test record preferences:

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu. 

3. Expand the OpenScript node and the Record category.

4. Select Oracle EBS/Forms Functional.

5. Click the General tab and set the general recording preferences as follows: 

■ Miscellaneous: Specifies if screenshots are captured.

– Capture screenshots: When selected, screenshots are captured during 
recording.

6. Click the Object Identification tab and use Add or Edit to customize the object 
identification elements or attributes. 

7. Click OK.

7.2.2 Adding/Editing Object Identifiers
The Oracle EBS/Forms Functional Test Module uses object identification to specify 
attributes used to identify Oracle EBS/Forms objects. The Oracle EBS/Forms 
Functional Test Module uses the same predefined path attributes for common Web 
objects as the Web Functional Test Module; however, Oracle EBS/Forms Test 
Automation provides additional attributes to identify forms controls. Object paths are 
specified in XPath format. For example the object identification path appears as 
follows in Java code commands:

//forms:textField[(@name='DIST_LIST_NAME_0')]

You can set the default Web object attributes in the Oracle EBS/Forms Functional Test 
Module Record Preferences. You can also edit object attributes in recorded scripts in 
the tree view or the code view.

In addition to the predefined object identification, you can add an Object Library to the 
script to record paths into a library file. Object Library files may be shared and reused 
across other scripts. The Object Library files provide a more convenient "short name" 
for objects to provide for more convenient programming.

The Oracle EBS/Forms Functional Test Module includes object identifiers that specify 
how the recorder identifies Browser objects. You can add object identifiers or edit the 
existing object identifiers in the Record preferences.

To add or edit an object identifier:

1. Select the OpenScript Preferences from the View menu.

2. Expand the Record node and select Forms Functional Test.
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3. Click the Object Identification tab. This tab lets you specify the Oracle 
EBS/Forms object identification attributes, as follows:

Name: shows the name(s) of the defined Oracle EBS/Forms object identifiers.

Attributes: shows the pattern(s) specified for the defined Oracle EBS/Forms object 
identifiers.

Add: opens a dialog box for specifying a new Oracle EBS/Forms object identifier.

Edit: opens a dialog box for editing the selected Oracle EBS/Forms object 
identifier.

Delete: deletes the selected Oracle EBS/Forms object identifier.

For each object element, you specify a name (typically a Oracle Form object 
attribute), an operator, a value and a value type. As you add object elements, 
OpenScript builds the object identifier using logical OR between each object 
identifier element. Click Edit to change between logical OR and AND.

4. Click Add or select an existing object identifier and click Edit.

5. If adding a new object identifier, enter a name for the object identifier.

6. Add or edit object elements for the object identifier.

See the Web Functional Test Module for additional information about adding and 
editing Object Identifiers.

7. Click OK. The object identifier is added to the record preferences.

7.2.3 Recording Oracle EBS/Forms Functional Test Scripts
To record Oracle EBS/Forms Functional Test scripts:

1. Start OpenScript.

2. Set the Oracle EBS/Forms Functional Test Recording preferences.

3. Select New from the File menu. 

4. Expand the Functional Testing group.

5. Select Oracle EBS/Forms (The Oracle EBS/Forms script combines both Web and 
Oracle EBS/Forms technologies as part of the same script).

6. Click Next.

7. Select the Repository and Workspace.

8. Enter a script name.

9. Click Finish. A new Script tree is created in the Script View.

10. Select Record from the Script menu. The browser automatically opens when you 
start recording.

11. Load the web page where you want to start recording into the browser.

12. Navigate the web site to record page objects, actions, and navigations. The page 
objects, actions, and navigations will be added to the Run node of the script tree.

13. When finished navigating pages, close the browser.

14. Select Stop from the Script menu or click the Stop button on the OpenScript 
toolbar.
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15. Expand the Run node of the script to view the page objects, actions, and 
navigation nodes in the script tree.

You can customize the script using the menu options or the Code View for specific 
testing requirements.

7.3 Playing Back Scripts
OpenScript plays back recorded Oracle EBS/Forms actions/commands which consist 
of an event plus an object identified by its attributes (for example: 
forms.textField(28, "//forms:textField[(@name='DIST_LIST_NAME_
0')]").input("LOREM IPSUM")). The actions used for playback will either be 
those that are recorded or specified manually in the Java Code view. Playback can be 
configured through IE only as the Oracle EBS/Forms Functional Test Module does not 
support Firefox. Unattended playback is supported through Oracle Test Manager or 
third-party tools using OpenScript's command line interface. Oracle EBS/Forms 
Functional Test scripts do not play in Oracle Load Testing.

The Oracle EBS/Forms Functional Test Module provides playback and iterate toolbar 
buttons that allows users to start the script playback for either a single playback 
through the script or multiple iterations using data from a databank file. Playback 
results for Oracle EBS/Forms Functional scripts can be viewed in the Results and 
Console views.

7.3.1 Setting Oracle EBS/Forms Functional Test Playback Preferences
To set Oracle EBS/Forms Functional Test Playback preferences:

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu. 

3. Expand the OpenScript node and the Playback category.

4. Select Forms Functional Test.

5. Expand the Event Timeout group and set the preferences as follows:

■ Forms Startup Timeout(S): specifies the maximum number of seconds 
OpenScript should wait for a form to appear before considering the form not 
found. This is the default timeout when waiting for a form to appear before 
invoking an action against it. This is also the default timeout when waiting for 
a form to appear before continuing the script.

6. Expand the Action Settings group and set the preferences as follows:

■ Retry Times: specifies how many times to retry an action before timing out or 
reporting a failure.

7. Expand the Replay Port group and set the preferences as follows:

■ Port: specifies the port number to use to communicate with the agent machine.

8. Click OK.

Note: Do not close the script editor view or script project while 
recording or playing back scripts. Doing so could result in 
unpredictable behavior in the OpenScript application.
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7.3.2 Playing Back Oracle EBS/Forms Functional Scripts
To play back Oracle EBS/Forms Functional scripts:

1. Start OpenScript.

2. Open the Oracle EBS/Forms Functional script to play back.

3. Select Playback from the Script menu or click the toolbar button. 

You can view the progress of the script playback in the Console View. You can 
review the results of script playback in the Results View.

7.3.3 Playing Back Oracle EBS/Forms Functional Scripts with Iterations
To play back Oracle EBS/Forms Functional scripts with iterations:

1. Start OpenScript.

2. Open the Oracle EBS/Forms Functional script to play back.

3. Select Iterate from the Script menu or click the toolbar button. 

4. Set the iteration count.

5. Select which databank file to use, if necessary.

6. Set the starting record for the selected databank in the Databank Settings section.

7. Click OK.

You can view the progress of the script playback in the Console View. You can 
review the results of script playback in the Results View.

7.4 Modifying Scripts
Once a script has been created/recorded, you can make modifications to customize the 
script for your specific testing needs.

7.4.1 Adding Forms Actions
The Oracle EBS/Forms Module includes actions for Oracle EBS/Forms objects that can 
be added to a script. 

To add Forms actions to a script:

1. Record a EBS/Forms Functional Test script.

2. Select the script node where you want to add the action.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Forms Action node.

5. Expand an action node and select the action.

6. Click OK.

7. Enter the object identification path for the object. You can use the Capture or 
Select menu options to capture or select an object path.

8. Enter any required values to use for the object action.

9. Click OK. The action node is added to the script tree.

In the Java Code view, a forms.object(objectId).action() method will be 
added to the script code:
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forms.textField(27, "//forms:textField[(@name='DIST_LIST_APPLICATION_
0')]").openDialog();

The Forms Action node includes actions for objects such as BlockScroller, Button, 
Calendar, CheckBox, ChoiceBox, EditBox, EditorDialog, FlexWindow, HelpDialog, 
InfoBox, List, ListOfValues, Notification, Calculator, RadioGroup, ResponseBox, 
TabbedRegion, TextField, Tree, TreeList, SpreadTable, SchedulingDataClient. Other 
object actions have corresponding Java code methods.

7.4.2 Using the Oracle EBS/Forms Functional Test Module API
The Oracle EBS/Forms Functional Test Module includes a script Application 
Programming Interface (API) specific to Oracle EBS/Forms functional testing. The 
Oracle EBS/Forms Functional Test Module recorder creates the Java code that 
corresponds to the Tree View and displays the Oracle EBS/Forms Functional Test 
commands in the Java Code view using easy-to-understand function names. The Java 
Code view commands correspond to the Tree View and you can edit your scripts in 
either view.

You can use the Oracle EBS/Forms Functional Test API to enhance recorded scripts 
with additional testing functionality. Commands that are specific to the Oracle 
EBS/Forms Functional Testing Module are part of the "forms" class. Additional 
functional test methods are available in the "web" and "ft" classes. You can also 
leverage other commands from other enabled classes (services) or general Java 
commands in your scripts.

Some examples of the Oracle EBS/Forms Testing Module API include:

■ Forms Action

■ Button

■ Calendar

■ Checkbox

■ Choice Box

■ Edit Box

■ Editor Dialog

■ Flex Window

■ Form Window

■ HelpDialog

■ Info Box

■ List

■ ListOfValues

■ Notification

■ RadioGroup

■ ResponseBox

■ TabbedRegion

■ TextField

■ Tree
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■ TreeList

■ SpreadTable

■ SchedulingDataClient

Many API methods can be added using the Oracle EBS/Forms Functional Test Module 
Tree View. Additional methods can be added using the Java Code view. 
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8Using the Oracle EBS/Forms Load Test
Module

This chapter provides instructions on configuring and using the OpenScript Oracle 
EBS/Forms Load Test Module, which provides support for load testing of Oracle 
EBS/Forms web applications.

8.1 About the Oracle EBS/Forms Load Test Module
The Oracle EBS/Forms Load Test Module is an extension module to the OpenScript 
HTTP Module that extends the Web testing with Oracle EBS/Forms Load Test 
recording and playback capabilities. The Oracle EBS/Forms Load Test Module is fully 
integrated with the OpenScript platform including the Results view, Details view, 
Properties view, Console/Problems views, Preferences, Step Groups, Script Manager, 
and Workspace Manager. 

The Oracle EBS/Forms Load Test recorder displays commands in the Tree View in 
easy-to-understand commands. By default, script commands are grouped into Steps 
Groups by the Web page on which they were performed. Each Step Group contains 
one or more script commands corresponding to recorded actions that were performed 
on the page. The default name for the Step Group is the Web page Title (as specified in 
the "Title" tag). 

OpenScript shows the results of Oracle EBS/Forms Load Test script playback in the 
Results view. The Results view shows results for each script command (including 
duration and summary for failures). The Results Report compiles the same 
information into an HTML Results Report. Results can be exported from the 
OpenScript GUI in standard format (CSV / HTML). Results are also generated for 
unattended playback through the command line. 

The Oracle EBS/Forms Load Test Module API includes a "nca" class that provides 
additional programming functionality. 

8.1.1 Key Features of the Oracle EBS/Forms Load Test Module
■ The Oracle EBS/Forms Load Test Script Module. The New Project wizard (New 

from the File menu) includes an "Oracle EBS/Forms" option in the Load Test 
Group to use when creating Oracle EBS/Forms load testing projects in OpenScript. 
The Oracle EBS/Forms Load Test Script Module records Oracle EBS/Forms 
applications at the protocol level. OpenScript captures user actions and records 
them to the OpenScript script based upon HTTP requests and post data or query 
strings.



Recording Oracle EBS/Forms Load Tests

8-2 Oracle Application Testing Suite OpenScript User's Guide

■ Correlation Library. The Oracle EBS/Forms Load Test Module includes an Oracle 
EBS/Forms-specific library of correlation rules for parameterizing scripts.

■ Test Cases (Validation). The Oracle EBS/Forms Load Test Module includes a 
Status Bar test for validating validate Oracle EBS/Forms application content on 
playback.

■ Oracle EBS/Forms-Specific Application Programming Interface (API). The Oracle 
EBS/Forms Load Test Module includes a Oracle EBS/Forms Load Test Module 
API Specification that can be used to customize Oracle EBS/Forms-specific scripts. 

8.1.2 Prerequisites
The Oracle EBS/Forms Load Test Module recorder has the following prerequisites:

■ Before recording any script in Forms Functional Test Module, you must run the 
Forms/EBS application at least once before attempting to record a script with 
OpenScript on that machine. This ensures that required JRE/Jinitiator has been 
installed and also verifies that forms applications can run successfully on that 
machine inside of Internet Explorer.

■ You must set Use Browser Settings (selected) in the control panel proxy for all 
installed JVMs. Depending upon the Java version, the Use Browser Settings is 
either here:

– Control Panel - Select JInitiator/Sun Java - Proxies tab

or here:

– Control Panel - Select Java - General tab - Network Settings

8.2 Recording Oracle EBS/Forms Load Tests
The Oracle EBS/Forms Load Test Module records standard Oracle EBS/Forms 
components for Oracle E-Business Suite Release 12 (Forms 10g) running on Sun JRE 
and E-Business Suite Release 11i (Forms 6i). The Recorder creates load test scripts for 
automating testing of Oracle EBS/Forms applications. 

Oracle EBS/Forms are applet based controls and the Oracle EBS/Forms Load Test 
Module provides the object/attribute information for OpenScript to record 
interactions with those controls. Actions will be captured in the test script as 
OpenScript "nca" commands. Other components are standard Web controls which are 
captured as standard OpenScript "http" navigation commands. Correlation rules can 
be modified by users through the Preferences settings for new scripts. Recording can 
be configured through Internet Explorer only as the Oracle EBS/Forms Load Test 
Module does not support Firefox.

The Oracle EBS/Forms Load Test Module provides a record toolbar button that lets 
you initiate the Oracle EBS/Forms recorder and capture Web/Oracle EBS/Forms page 
actions to the script view. The record toolbar includes start and stop recording toolbar 
buttons. OpenScript recorders also open a floating toolbar that can be used while 
recording without having to switch between the browser and OpenScript.

When an recording Oracle EBS/Forms script determining the type of communication 
is important. Oracle EBS/Forms client can communicate with the server using the 
following modes:

■ Socket Mode: All the communication exchanged between the server and client is 
performed at a socket level therefore the proxy recorder will not capture any 
transactions that occur between the server and client. 
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■ HTTP Mode: All the communication happens over the HTTP protocol and gets 
captured by both the proxy recorder and the Oracle EBS/Forms Load Test module. 
The duplication of HTTP requests is filtered out by the Oracle EBS/Forms Load 
Test module and the message log only retains the requests captured by Oracle 
EBS/Forms Load Test module and not the request captured by proxy recorder. 

■ HTTPS Mode: This mode the communication is very similar to that of HTTP 
except the connection is made over the HTTP protocol on port 443 using SSL.

8.2.1 Setting Oracle EBS/Forms Load Test Record Preferences
To set Oracle EBS/Forms Load Test record preferences:

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu. 

3. Expand the OpenScript node and the Record category.

4. Select Oracle EBS/ Forms Load Test.

5. Set the Applet parameters as follows:

■ Applet Parameters: Specifies the Forms Applet Class property to use to record 
Forms applications.

– EBS Forms: When selected, the OpenScript Applet Class property 
oracle.forms.engine.main is used to record EBS/Forms applications.

– Custom Forms: When selected, the specified Applet Class property is 
used to record custom non-Web deployed Forms applications.

Miscellaneous: Specifies the miscellaneous record preferences.

– Force HTTP Recording: When selected, recording communicates over 
HTTP disregarding the connection parameter values of the Applet page. 
This setting may be necessary if the site has an Applet loading page that is 
set to communicate over a socket instead of using HTTP. If the contents of 
the Applet loading page are set to Socket, OpenScript cannot record the 
socket traffic.

6. Click OK.

8.2.2 Recording Oracle EBS/Forms Load Test Scripts
To record Oracle EBS/Forms Load Test scripts:

1. Start OpenScript.

2. Set the Oracle EBS/Forms Load Test Correlation preferences.

3. Set the Oracle EBS/Forms Load Test Recording preferences.

4. Select New from the File menu. 

5. Expand the Load Testing group.

6. Select Oracle EBS/Forms (The Oracle EBS/Forms script combines both HTTP and 
Oracle EBS/Forms technologies as part of the same script).

7. Click Next.

8. Select the Repository and Workspace.

9. Enter a script name.
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10. Click Finish. A new Script tree is created in the Script View.

11. Select Record from the Script menu. The browser automatically opens when you 
start recording.

12. Load the web page where you want to start recording into the browser.

13. Navigate the web site to record page objects, actions, and navigations. The page 
objects, actions, and navigations will be added to the Run node of the script tree.

14. When finished navigating pages, close the browser.

15. Select Stop from the Script menu or click the Stop button on the OpenScript 
toolbar.

16. Expand the Run node of the script to view the page objects, actions, and 
navigation nodes in the script tree.

You can customize the script using the menu options or the Code View for specific 
testing requirements.

8.3 Playing Back Scripts
OpenScript plays back recorded Oracle EBS/Forms actions/commands which consist 
of an object identified by its attributes (for example: 
nca.treeList("handlerName").selectByIndex(0);). The actions used for 
playback will either be those that are recorded or specified manually in the Java Code 
view. Playback can be configured through IE only as the Oracle EBS/Forms Load Test 
Module does not support Firefox. Unattended playback is supported through Oracle 
Test Manager or third-party tools using OpenScript's command line interface. 

The Oracle EBS/Forms Load Test Module provides playback and iterate toolbar 
buttons that allows users to start the script playback for either a single playback 
through the script or multiple iterations using data from a databank file. Playback 
results for Oracle EBS/Forms Load scripts can be viewed in the Results and Console 
views.

8.3.1 Setting Oracle EBS/Forms Load Test Playback Preferences
To set Oracle EBS/Forms Load Test playback preferences:

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu. 

3. Expand the OpenScript node and the Playback category.

4. Select Oracle EBS/Forms Load Test.

5. Select or clear the capture playback log option:

■ Capture Message Details: Specifies if forms message details are captured 
during playback. When selected, OpenScript captures and stores Forms 
message requests, responses, and information about all loaded Forms 
components during playback. This information is useful to have when 
debugging the script.

Note: Do not close the script editor view or script project while 
recording or playing back scripts. Doing so could result in 
unpredictable behavior in the OpenScript application.
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OpenScript displays captured details in the "Messages" and "Object Details" 
tabs of the Details view. Oracle Load Testing displays this information in the 
Virtual User Display based on the "Virtual User Display" settings.

Capturing message details is a memory-intensive operation. During heavy 
load testing, it is recommended to clear this setting to reduce the amount of 
heap space required by the agent.

■ Show Message Log In the Console: Specifies if forms message log details are 
shown it the Console tab. When selected, the message log details are shown in 
the console. When cleared, the message log details are not shown in the 
console.

6. Click OK.

8.3.2 Playing Back Oracle EBS/Forms Load Scripts
To play back Oracle EBS/Forms Load scripts:

1. Start OpenScript.

2. Open the Oracle EBS/Forms Load script to play back.

3. Select Playback from the Script menu or click the toolbar button. 

You can view the progress of the script playback in the Console View. You can 
review the results of script playback in the Results View.

8.3.3 Playing Back Oracle EBS/Forms Load Scripts with Iterations
To play back Oracle EBS/Forms Load scripts with iterations:

1. Start OpenScript.

2. Open the Oracle EBS/Forms Load script to play back.

3. Select Iterate from the Script menu or click the toolbar button. 

4. Set the iteration count.

5. Select which databank file to use, if necessary.

6. Set the starting record for the selected databank in the Databank Settings section.

7. Click OK.

You can view the progress of the script playback in the Console View. You can 
review the results of script playback in the Results View.

8.4 Modifying Scripts
Once a script has been created/recorded, you can make modifications to customize the 
script for your specific testing needs.

8.4.1 Adding Forms Actions
The Oracle EBS/Forms Module includes actions for Oracle EBS/Forms objects that can 
be added to a script. 

To add Forms actions to a script:

1. Record a EBS/Forms Functional Test script.

2. Select the script node where you want to add the action.
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3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Forms Load Action node.

5. Expand an action node and select the action.

6. Click OK.

7. Enter the object identification path for the object. You can use the Capture or 
Select menu options to capture or select an object path.

8. Enter any required values to use for the object action.

9. Click OK. The action node is added to the script tree.

In the Java Code view, a nca.object(handlerName).action() method will 
be added to the script code:

nca.treeList("handlerName").selectByIndex(0);

The Forms Load Action node includes actions for objects such as Application, 
Button, CheckBox, ChoiceBox, List Item, List of Values, Pop List Item, Radio 
Button, Tab, Text Field, Window, Generic Client, and Alert Dialog. Other object 
actions have corresponding Java code methods.

8.4.2 Converting Forms Actions to XML Messages
In some cases, you may want to convert EBS/Forms actions recorded to the script into 
the raw XML client messages to troubleshoot playback issues. For example, the script 
recorder creates actions in the script tree such as Activate window 
("WindowName"). The Java code for the action would be similar to 
nca.window(id, "WindowName").activate().

However, the actual XML message traffic between the application server and the Web 
client is more verbose. For example, the message traffic for a window activate action 
could be similar to the following: 

<Messages> 
<ClientMessage Object="HEADER">
<Message mActionString="MSG_UPDATE" mActionCode="2" mHandlerClassId="0" 

mHandlerId="170">
<Property actionString="WINDOW_ACTIVATED" action="247" 

type="java.lang.Boolean" value="true"/>
</Message>

</ClientMessage> 
<ClientMessage Object="HEADER_ORIGINATING_BAL_SEG_VALUE_0">
<Message mActionString="MSG_UPDATE" mActionCode="2" mHandlerClassId="0" 

mHandlerId="566">
<Property actionString="CURSOR_POSITION" action="193" 

type ="java.lang.Integer" value="0"/>
</Message>

</ClientMessage> 
</Messages>

If you need to troubleshoot specific script actions, you can convert the script action to 
the raw XML messages and try playing back the script again to see if the XML 
messages resolve the issue. 

To convert EBS/Forms actions to XML client messages:

1. Right-click the script node you want to convert and select Properties. The Form 
Window opens with the following options:
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■ Automatically generate the Forms client messages: When selected, the script 
uses the recorded Forms action on playback.

– Path: Shows the recorded Forms action path.

■ Send recorded Forms client messages: When selected, the script uses the 
recorded raw XML client messages on playback.

– Description: Shows a description of the client messages. 

■ Recorded Messages: Shows the raw XML client and server messages 
generated between the application server and the web client during recording.

2. Select the Send recorded Forms client messages option. If necessary, you can edit 
the raw XML messages.

3. Click OK.

The script node changes to a Send Message action action. The Java Code for 
the action will change to a method in the following form: 

nca.sendMessages(id,"description","<Messages>XML string</Messages>");

The raw XML message string can be very long and can increase script size.

8.4.3 Using the Oracle EBS/Forms Load Test Module API
The Oracle EBS/Forms Load Test Module includes a script Application Programming 
Interface (API) specific to Oracle EBS/Forms load testing. The Oracle EBS/Forms Load 
Test Module recorder creates the Java code that corresponds to the Tree View and 
displays the Oracle EBS/Forms Load Test commands in the Java Code view using 
easy-to-understand function names. The Java Code view commands correspond to the 
Tree View and you can edit your scripts in either view.

You can use the Oracle EBS/Forms Load Test API to enhance recorded scripts with 
additional testing functionality. Commands that are specific to the Oracle EBS/Forms 
Functional Testing Module are part of the "nca" class. Additional functional test 
methods are available in the "http" class. You can also leverage other commands from 
other enabled classes (services) or general Java commands in your scripts.

Some examples of the Oracle EBS/Forms Testing Module API include:

■ Application

■ Alert Dialog

■ Button

■ CheckBox

■ ChoiceBox

■ Generic Client

■ List Item

■ List of Values

■ Pop List Item

■ Radio Button

Note: Converting the script action to XML messages cannot be 
undone unless you close the script without saving. 
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■ Tab

■ Text Field

■ Window

Many API methods can be added using the Oracle EBS/Forms Load Test Module Tree 
View. Additional methods can be added using the Java Code view. 

8.5 Setting Oracle EBS/Forms Load Test Correlation Preferences
To set Setting Oracle EBS/Forms Load Test Correlation preferences:

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu. 

3. Expand the OpenScript node and the Correlation category.

4. Expand the Oracle EBS/Forms Load Test library.

5. Select or clear the check boxes to enable or disable specific rules.

6. Click the Add or Edit buttons to modify rules in the library.

7. Click OK.

8.6 Oracle EBS/Forms Load Test Correlation Library
The Oracle EBS/Forms correlation library defines the correlation rules for Oracle 
EBS/Forms-based applications. The correlation rules specify the variable names and 
regular expressions to use to replace dynamic data in Oracle EBS/Forms applications 
and navigations. The default Oracle EBS/Forms correlation library provided with the 
OpenScript Oracle EBS/Forms Load Test Module includes the following correlation 
rules: 

■ formsload.location - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern document.location='(.+?)' and 
replaces it with the variable name formsload.location in all locations.

■ Link and Form Action - DOM Correlation - this rule implements the Web 
Document Object Model correlation rules for Links and Form actions for Oracle 
EBS/Forms applications.

■ ICX Ticket 11i - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern icx_ticket='(.+?)' and replaces it 
with the variable name formsload:icx_ticket_11i in all locations.

■ ICX Ticket R12 - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern icx_ticket&gv15=(.+?)& and 
replaces it with the variable name formsload:icx_ticket_r12 in all locations.

■ ICX Ticket R12s - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern gv15\s*=\s*"(.+?)" and replaces it 
with the variable name formsload.icx_ticket_r12s in all locations.

■ formsload.module - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern <PARAM 
(?:name|NAME)=(?:|'|")serverArgs(?:|'|")\s+(?:value|VALUE)="m
odule=(.+?) and replaces it with the variable name formsload.module in all 
locations.
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■ formsload.config - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern config='(.+?)' and replaces it with 
the variable name formsload.config in all locations.

■ SSO FormsID - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern sso_formsid=(.+?) and replaces it 
with the variable name formsload.ssoformsId in all locations.

■ formsload.objectCategoryId - Variable Substitution - this rule locates text in the 
HTML matching the Regular Expression pattern 
,\{'ObjectCategoryId':'(.+?)','DetailObjectId':'.+?' and 
replaces it with the variable name formsload.objectCategoryId in all 
locations.

■ formsload.detailObjectId - Variable Substitution - this rule locates text in the 
HTML matching the Regular Expression pattern 
,\{'ObjectCategoryId':'.+?','DetailObjectId':'(.+?)' and 
replaces it with the variable name formsload.detailObjectId in all locations.

■ formsload.HzPuiCustAccountId - Variable Substitution - this rule locates text in 
the HTML matching the Regular Expression pattern 
'HzPuiCustAccountId':'(.+?)' and replaces it with the variable name 
formsload.HzPuiCustAccountId in all locations.

■ formsload.evtSrcRowIdx - Variable Substitution - this rule locates text in the 
HTML matching the Regular Expression pattern 'evtSrcRowIdx':'(.+?)' 
and replaces it with the variable name formsload.evtSrcRowIdx in all 
locations.

■ formsload.evtSrcRowId - Variable Substitution - this rule locates text in the 
HTML matching the Regular Expression pattern 'evtSrcRowId':'(.+?)' and 
replaces it with the variable name formsload.evtSrcRowId in all locations.

■ formsload.value - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern 
'DefaultFormName','goto','OIENavBar',0,'(.+?)' and replaces it with 
the variable name formsload.value in all locations.

■ Correlate Headers - Correlate Headers - this rule implements the default 
Correlate Headers correlation rules for Oracle EBS/Forms applications that use 
dynamic headers. 

■ Correlate Referer Headers - Correlate Headers - this rule implements the default 
Correlate Headers correlation rules for Oracle EBS/Forms applications that use 
dynamic Referer Headers. This rule adds a http.solveRefererHeader method 
to store the requested url for referer headers in later navigations to use.

■ formsload.loginsave - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern 
submitForm\('DefaultFormName',1,\{'_FORM_SUBMIT_
BUTTON':'(.+?)' and replaces it with the variable name 
formsload.loginsave in all locations.

■ formsload.loginsubmit - Variable Substitution - this rule locates text in the 
HTML matching the Regular Expression pattern FORM_SUBMIT_
BUTTON':'(.+?)' and replaces it with the variable name 
formsload.loginsubmit in all locations.

■ formsload.submit backslash - Variable Substitution - this rule locates text in the 
HTML matching the Regular Expression pattern \{\\'_FORM_SUBMIT_
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BUTTON\\':\\'(.+?)\\'\} and replaces it with the variable name 
formsload.submit.backslash in all locations.

■ FormsLT Global Substitution - Oracle EBS/Forms Variable Substitution - this 
rule adds the appropriate Connect Statement for Forms implementations running 
in HTTP mode. Substitute Forms URL transform and ICX Ticket transform.

■ formsload.oas - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern oas=(.+?\.\.) and replaces it with 
the variable name formsload.oas in all locations.

■ formsload.ti - Variable Substitution - this rule locates text in the HTML matching 
the Regular Expression pattern &_ti=(.+?)& and replaces it with the variable 
name formsload.ti in all locations.

■ formsload.resultsVOName - Variable Substitution - this rule locates text in the 
HTML matching the Regular Expression pattern 
'ResultsVOName':'(.+?)','ItemKey' and replaces it with the variable 
name formsload.resultsVOName in all locations.

■ formsload.ItemKey - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern 
'ResultsVOName':'.+?','ItemKey':'(.+?)','evtSrcRowId':'','evt
SrcRowIdx' and replaces it with the variable name formsload.ItemKey in all 
locations.

■ formsload.SDP_RLID - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern &SDP_RLID=(.+?)& and replaces it 
with the variable name formsload.SDP_RLID in all locations.

■ formsload.SDP_RHID - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern &SDP_RHID=(.+?)& and replaces it 
with the variable name formsload.SDP_RHID in all locations.

■ formsload.SDP_RHID - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern &SDP_RHID=(.+?)& and replaces it 
with the variable name formsload.SDP_RHID in all locations.

■ formsload.QotFrmEvtVal - Variable Substitution - this rule locates text in the 
HTML matching the Regular Expression pattern 'QotFrmEvtVal':'(.+?)', 
and replaces it with the variable name formsload.QotFrmEvtVal in all 
locations.

■ formsload.QotFrmEvt - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern 'QotFrmEvt':'(.+?)', and replaces 
it with the variable name formsload.QotFrmEvt in all locations.

■ formsload.QotFrmEvtVal2 - Variable Substitution - this rule locates text in the 
HTML matching the Regular Expression pattern 'QotFrmEvtVal2':'(.+?)', 
and replaces it with the variable name formsload.QotFrmEvtVal2 in all 
locations.

■ formsload.serverValidate - Variable Substitution - this rule locates text in the 
HTML matching the Regular Expression pattern 'serverValidate':'(.+?)', 
and replaces it with the variable name formsload.serverValidate in all 
locations.

■ formsload.QotFrmSvMdlFg - Variable Substitution - this rule locates text in the 
HTML matching the Regular Expression pattern 'QotFrmSvMdlFg':'(.+?)', 
and replaces it with the variable name formsload.QotFrmSvMdlFg in all 
locations.
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■ Web Default Correlation - DOM Correlation - this rule implements the default 
Web Document Object Model correlation rules for Oracle EBS/Forms applications.

8.7 Troubleshooting Oracle EBS/Forms Load Test Scripts
The following are key concepts, tools, and functions you can use when debugging 
Oracle EBS/Forms Load Test scripts recorded during recording as well as playback. 

8.7.1 Debugging Using the Message Log
This section explains how to use the Message Log for debugging Oracle EBS/Forms 
Load Test Scripts.

8.7.1.1 During Recording
When recording EBS/Forms Load scripts, the Oracle EBS/Forms Load Test module 
generates a complete log of messages that were exchanged between the forms server 
and the client browser. The log is generated for all types of communication (See 
Recording Oracle EBS/Forms Load Tests):

■ Socket Connection - numerically identified by a 0

■ HTTP Connection - numerically identified by a 1

■ HTTPS Connection - numerically identified by a 2 

This recorded log is located in 
<installdir>/OFT/<ScriptName>/recordedData/FormsLT_Recorded_
FormsMessage_Logs/RecordedMessages.log. 

8.7.1.2 Format of the Recorded Log
The format in the log is as follows:

■ MESSAGE FROM CLIENT: indicates a Message sent from client to server, 
followed by an XML string representation of the message object.

■ TERMINAL MESSAGE FROM CLIENT: indicates a Terminal Message sent from 
client to server, followed by an XML string representation of the terminal message 
object.

■ MESSAGE FROM SERVER: indicates a response message sent from the server to 
client, followed by an XML string representation of the message object.

■ TERMINAL MESSAGE FROM SERVER: indicates a Terminal Message indicating 
the end of a response sent from the server to the client, followed by an XML string 
representation of the terminal message object.

8.7.1.3 During Playback
If a script fails during playback, you can enable the message log for debug purposes.

To enable the message log:

1. Open the Oracle EBS/Forms load test script.

2. Enable the Capture Playback Log option in the EBS/Forms Playback Preferences.

After enabling message logging, click the play button to run the script. During script 
play back, all forms messages exchanged between server and the client are printed to 
the console window in OpenScript. 
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This is a rather large log of messages and using the recorded log as a reference, 
compare the messages being sent to the server by OpenScript. Check for messages that 
appear in the recorded log but not in the playback log. It is normal to have messages 
such as OUTERSIZE, LOCATION missing. The reason for this is because the 
EBS/Forms load script recorder was designed keeping in mind that the user should 
see actions being recorded in the script instead of messages. 

8.7.1.4 After Playback
Message playback logs can be used to compare the recorded vs. played back forms 
messages to troubleshoot script problems. Select a result in the Results view and 
compare the recorded vs. playback messages in the Comparison tab of the Details 
view. 

The Details view for EBS/Forms load scripts can have the following tabs:

■ Object Details Tree: Shows a text-based representation of the property names and 
values of an EBS/Forms object in a tree hierarchy. You can right click a property to 
add a Text Matching test.

■ Screenshot: Shows an image of the EBS/Forms window for visual identification. 
The Screenshot is taken on Window Activate actions.

■ Messages: Shows the raw XML EBS/Forms messages recorded for the selected 
script node.

■ Message Tree: Shows the XML EBS/Forms message parameters and values for the 
selected script node in a tree hierarchy.

■ Comparison: Shows a comparison of the recorded vs. playback XML EBS/Forms 
messages or object details for the selected item in the Results view. Select the 
comparison type from the Compare list.

8.7.2 Analyzing Message Logs
Messages to check for when analyzing recorded and playback logs are as follows:

■ FOCUS messages: Make sure the correct component has focus. The script cannot 
execute an action on a component without correctly setting a focus on it. For 
example, a text field component contains a button which displays a list of values 
dialog when pressed. This button is not enabled until the focus is correctly set on 
the text field. In this case, if OpenScript tries to execute a press button action and 
the focus in not correct, you will encounter an error such as "Component not 
available".

■ WINDOW_ACTIVATED messages: Make sure the correct window is the currently 
active windows for the script action on a component. If the correct window is not 
currently active, the script will not be able to execute any actions on the 
components within that window. 

8.7.3 Resolving "Component does not exist" Errors
"Component {0} does not exist" error messages (error code COMPONENT_DOES_
NOT_EXIST) may occur when initially creating an Oracle Forms Load Testing script. 
This error is reported Possible causes:

1. If the error appears on the first action of the script, it could be indicative of "Issue 
1. Connection Failures and ICX_Ticket Correlation" above.

2. The object specified in the script truly does not exist in the application at the time 
the action was performed on it.
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For example, when recording the script, if the tester searches for an order and 
deletes it, then during playback the script will fail because the order number no 
longer exists to delete. In some situations it may be helpful to insert status bar text 
validations, in cases where a status bar text message is expected.

In other cases, the Forms application may display an unexpected dialog box error 
message indicating some validation failure or other business flow error in the 
application itself. If such a dialog did not appear during recording, then any 
subsequent actions will fail. Check the error log in the script to see if any error 
dialog messages appeared. Check that all data inputs in the script are valid, and 
carefully review the actions specified in the script.

3. In other cases, it may be difficult to diagnose the root cause of the problem without 
technical support. For example, it could be that the application being tested is 
using a custom forms object that sends a custom message to the server that the 
Forms playback engine does not recognize.

8.7.4 Troubleshooting Forms ifError Messages
When playing the script in HTTP mode, the server can respond with error messages in 
plain/text which would require special handling by the VU. The following are the 
most common types of ifError messages returned by the server.

IfError Messages
These messages are returned as a response of any forms request against the server 
when playing the script in HTTP mode. The response content type for these messages 
is 'plain/text' and the response code is '200 OK' 

ifError:3
The client does not handle cookies. Enable cookie handling for that virtual user. 

ifError:4
The server was unable to create an Oracle EBS/Forms process. Problem exists on the 
server-side. 

ifError:5
The server was unable to start the Oracle EBS/Forms process. Problem exists on the 
server-side. 

ifError:6
The Oracle EBS/Forms session was aborted and the VU is unable to communicate 
with the server. In most cases this would occur when the server is experiencing a 
heavy load or if there is a problem with the script. 

ifError:7
The server is currently busy, re-try the request later. The VU will re-try this request 
<n> number of times where <n> is a value specified in Forms Load Test playback 
preferences before it throws an error/stops playback. 

ifError:11/<n>
The server is busy, re-try the request in <n> milliseconds. This type of message will not 
be displayed to the user, the VU will automatically re-try this request after <n> 
milliseconds.
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9Using the Oracle Fusion/ADF Functional Test
Module

This chapter provides instructions on configuring and using the OpenScript Oracle 
Fusion/ADF Functional Test Module, which provides support for functional testing of 
Oracle Application Development Framework (ADF)-based applications.

9.1 About the Oracle Fusion/ADF Functional Test Module
The Oracle Fusion/ADF Functional Test Module provides support for functional 
testing of Oracle Application Development Framework (ADF) applications. The Oracle 
Fusion/ADF Functional Test Module is an extension to the Web Functional Module. 
The Oracle Fusion/ADF Functional Test Module is fully integrated with the 
OpenScript platform including the Results view, Details view, Properties view, 
Console/Problems views, Preferences, Step Groups, Script Manager, and Workspace 
Manager. 

The Oracle Fusion/ADF Functional Test recorder displays commands in the Tree View 
in easy-to-understand commands. By default, script commands are grouped into Steps 
Groups by the Web page on which they were performed. Each Step Group contains 
one or more script commands corresponding to recorded actions that were performed 
on the page. The default name for the Step Group is the ADF component name.

OpenScript shows the results of Oracle Fusion/ADF Functional Test script playback in 
the Results view. The Results view shows results for each script command (including 
duration and summary for failures). The Results Report compiles the same 
information into an HTML Results Report. Results can be exported from the 
OpenScript GUI in standard format (CSV / HTML). Results are also generated for 
unattended playback through the command line.

The Oracle Fusion/ADF Functional Test Module API includes a "adf" class that 
provides additional programming functionality. 

9.1.1 Prerequisites
The Oracle Fusion/ADF Functional Test Module recorder has the following 
prerequisite:

■ Before recording any script in Oracle Fusion/ADF Functional Test Module, you 
must configure the ADF Server so that the ADF application uses uncompressed 
class names.
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9.1.2 Key Features of the Oracle Fusion/ADF Functional Test Module
■ The Oracle Fusion/ADF Functional Test Script Module. The New Project wizard 

(Select New from the File menu) includes an "Oracle Fusion/ADF" option in the 
Functional Test Group to use when creating Oracle Fusion/ADF functional testing 
projects in OpenScript. The Oracle Fusion/ADF Functional Test Script Module 
records functional scripts against ADF Faces applications (Oracle Application 
Development Framework 11g Release 1 (11.1.1)).

■ ADF Functional-Specific Application Programming Interface (API). The Oracle 
Fusion/ADF Functional Test Module includes an ADF Functional Test Module 
API Specification that can be used to customize ADF Functional test-specific 
scripts. 

9.2 Configuring the ADF Server
The Oracle Fusion/ADF Fusion Test Module recorder requires that the ADF 
application use uncompressed class names. You must configure the application server 
to specify that uncompressed class names are used for testing purposes.

There are three settings that must be configured in the following files on the ADF 
server:

■ WEB-INF/web.xml

■ trinidad-config.xml

9.2.1 Configuring the WEB-INF/web.xml File
This section explains the settings that must be specified in the ADF server web.xml 
file.

In the ADF server's WEB-INF/web.xml file, set the oracle.adf.view.rich. 
automation.ENABLED parameter to true. This is required in order for the Oracle 
Fusion/ADF Functional Test Module to find objects using scope IDs (also known as 
test IDs or Sub IDs).

The following XML shows how the oracle.adf.view.rich. 
automation.ENABLED parameter must be specified in the web.xml file before 
recording Oracle Fusion/ADF Functional Test scripts:

<context-param>
<param-name>oracle.adf.view.rich.automation.ENABLED</param-name>
<param-value>true</param-value>
</context-param>

In the ADF server's WEB-INF/web.xml file, set the  org.apache.myfaces. 
trinidad.DISABLE_CONTENT_COMPRESSION parameter to true. This is required 
in order for the Oracle Fusion/ADF Functional Test Module to identify ADF 
component class names.

The following XML shows how the org.apache.myfaces.trinidad.DISABLE_
CONTENT_COMPRESSION parameter must be specified in the web.xml file before 
recording Oracle Fusion/ADF Functional Test scripts:

<context-param>
<param-name>org.apache.myfaces.trinidad.DISABLE_CONTENT_COMPRESSION</param-name>
<param-value>true</param-value>
</context-param>
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9.2.2 Configuring the trinidad-config.xml File
This section explains the settings that must be specified in the ADF server 
trinidad-config.xml file.

In the ADF server's trinidad-config.xml, set the animation-enabled element to 
false.

The following XML shows how the animation-enabled element must be specified in 
the trinidad-config.xml file before recording Oracle Fusion/ADF Functional Test 
scripts: 

<animation-enabled>false</animation-enabled>

9.3 Recording Oracle Fusion/ADF Functional Tests
The Oracle Fusion/ADF Functional Test Module records standard ADF components 
for Oracle Application Development Framework 11g Release 1 (11.1.1). The Recorder 
creates functional test scripts for automating testing of Oracle Fusion/ADF 
applications. 

ADF components are applet based controls and the Oracle Fusion/ADF Functional 
Test Module provides the object/attribute information for OpenScript to record 
interactions with those controls. Actions will be captured in the test script as 
OpenScript "adf" commands. Other components are standard Web controls which are 
captured as standard OpenScript "web" and "ft" navigation commands. Correlation 
rules can be modified by users through the Preferences settings for new scripts.

OpenScript plays back recorded ADF actions/commands which consist of an event 
plus an object identified by its attributes (for example: 
adf.inputText(11,"/web:window[@index='0' or @title='inputText 
Demo']/web:document[@index='0']/web:ADFInputText[@id='dmoTpl:idI
nputText' and @label='String value']").setValue("String"). The 
actions used for playback will either be those that are recorded or specified manually 
in the Java Code view. Playback can be configured through IE only as the Oracle 
Fusion/ADF Functional Test Module does not support Firefox. Unattended playback 
is supported through Oracle Test Manager or third-party tools using OpenScript's 
command line interface. Oracle Fusion/ADF Functional Test scripts do not play in 
Oracle Load Testing.

The Oracle Fusion/ADF Functional Test Module provides a record toolbar button that 
lets you initiate the ADF recorder and capture Web/ADF page actions to the script 
view. The record toolbar includes start and stop recording toolbar buttons. OpenScript 
recorders also open a floating toolbar that can be used while recording without having 
to switch between the browser and OpenScript.

9.3.1 Recording Oracle Fusion/ADF Functional Test Scripts
To record ADF Functional Test scripts:

1. Start OpenScript.

2. Set the Oracle Fusion/ADF Functional Test Correlation preferences.

3. Select New from the File menu. 

4. Expand the Functional Testing group.

5. Select ADF (The Oracle Fusion/ADF script combines both Web and ADF 
technologies as part of the same script).
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6. Click Next.

7. Select the Repository and Workspace.

8. Enter a script name.

9. Click Finish. A new Script tree is created in the Script View.

10. Select Record from the Script menu. The browser automatically opens when you 
start recording.

11. Load the web page where you want to start recording into the browser.

12. Navigate the web site to record page objects, actions, and navigations. The page 
objects, actions, and navigations will be added to the Run node of the script tree.

13. When finished navigating pages, close the browser.

14. Select Stop from the Script menu or click the Stop button on the OpenScript 
toolbar.

15. Expand the Run node of the script to view the page objects, actions, and 
navigation nodes in the script tree.

You can customize the script using the menu options or the Code View for specific 
testing requirements.

9.4 Playing Back Scripts
OpenScript plays back recorded ADF actions/commands which consist of an object 
identified by its attributes. The actions used for playback will either be those that are 
recorded or specified manually in the Java Code view. Unattended playback is 
supported through Oracle Test Manager or third-party tools using OpenScript's 
command line interface. 

The Oracle Fusion/ADF Functional Test Module provides playback and iterate toolbar 
buttons that allows users to start the script playback for either a single playback 
through the script or multiple iterations using data from a databank file. Playback 
results for Oracle Fusion/ADF Functional scripts can be viewed in the Results and 
Console views.

9.4.1 Playing Back Oracle Fusion/ADF Functional Scripts
To play back Oracle Fusion/ADF Functional scripts:

1. Start OpenScript.

2. Open the Oracle Fusion/ADF Functional script to play back.

3. Select Playback from the Script menu or click the toolbar button. 

You can view the progress of the script playback in the Console View. You can 
review the results of script playback in the Results View.

9.4.2 Playing Back Oracle Fusion/ADF Functional Scripts with Iterations
To play back Oracle Fusion/ADF Functional scripts with iterations:

Note: Do not close the script editor view or script project while 
recording or playing back scripts. Doing so could result in 
unpredictable behavior in the OpenScript application.
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1. Start OpenScript.

2. Open the Oracle Fusion/ADF Functional script to play back.

3. Select Iterate from the Script menu or click the toolbar button. 

4. Set the iteration count.

5. Select which databank file to use, if necessary.

6. Set the starting record for the selected databank in the Databank Settings section.

7. Click OK.

You can view the progress of the script playback in the Console View. You can 
review the results of script playback in the Results View.

9.5 Modifying Scripts
Once a script has been created/recorded, you can make modifications to customize the 
script for your specific testing needs.

9.5.1 Adding Fusion/ADF Actions
The Oracle Fusion/ADF Module includes actions for Oracle Fusion/ADF objects that 
can be added to a script. 

To add Fusion/ADF actions to a script:

1. Record a Fusion/ADF Functional Test script.

2. Select the script node where you want to add the action.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the ADF Action node.

5. Expand an action node and select the action.

6. Click OK.

7. Enter the object identification path for the object. You can use the Capture or 
Select menu options to capture or select an object path.

8. Enter any required values to use for the object action.

9. Click OK. The action node is added to the script tree.

In the Java Code view, an adf.object(objectId).action() method will be 
added to the script code:

adf.inputText("/web:window[@index='0' or @title='inputText 
Demo']/web:document[@index='0' or 
@name='w0']/web:ADFInputText[@id='dmoTpl:idInputText' and 
@label='']").setValue("My Text Input");

The ADF Action node includes actions for objects such as Calendar, Command 
Button, Command Image Link, Command Link, Command Menu Item, Command 
Toolbar, Dialog, Go Menu Item, Input Color, Input Combobox List of Values, Input 
dateSelect ManyChoice, Input List of Values, Input Number Slider, Input Number 
Spinbox, Input Range Slider, Input Text, Menu, Navigation Page, Page, Panel 
Accordion, Panel Box, Panel, Splitter, Panel Tabbed, Panel window, Query, Quick 
Query, Reset Button, Rich Text Editor, Select Boolean Checkbox, Select Boolean 
Radio, Select Many Checkbox, Select Many Choice, Select Many Listbox, Select 
Many Shuttle, Select One Choice, Select One Listbox, Select One Radio, Select 
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Order Shuttle, Show Detail, Show Detail Header, Table, Toolbar, Train, Train 
Button Bar, Tree, Tree Table. Other object actions have corresponding Java code 
methods.

9.6 Oracle Fusion/ADF Functional Test Module API
The Oracle Fusion/ADF Functional Test Module includes a script Application 
Programming Interface (API) specific to ADF functional testing. The Oracle 
Fusion/ADF Functional Test Module recorder creates the Java code that corresponds 
to the Tree View and displays the Oracle Fusion/ADF Functional Test commands in 
the Java Code view using easy-to-understand function names. The Java Code view 
commands correspond to the Tree View and you can edit your scripts in either view.

You can use the Oracle Fusion/ADF Functional Test API to enhance recorded scripts 
with additional testing functionality.  Commands that are specific to the Oracle 
Fusion/ADF Functional Testing Module are part of the "adf" class. Additional test 
methods are available in the "web" or "ft" classes. You can also leverage other 
commands from other enabled classes (services) or general Java commands in your 
scripts.

Some examples of the Oracle Fusion/ADF Testing Module API include:

■ Calendar

■ Command Button

■ Command Image Link

■ Command Link

■ Command Menu Item

■ Command Toolbar

■ Dialog

■ Go Menu Item

■ Input Color

■ Input Combobox List of Values

■ Input dateSelect ManyChoice

■ Input List of Values

■ Input Number Slider

■ Input Number Spinbox

■ Input Range Slider

■ Input Text

■ Menu

■ Navigation Page

■ Page

■ Panel Accordion

■ Panel Box

■ Panel Splitter

■ Panel Tabbed
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■ Panel window

■ Query

■ Quick Query

■ Reset Button

■ Rich Text Editor

■ Select Boolean Checkbox

■ Select Boolean Radio

■ Select Many Checkbox

■ Select Many Choice

■ Select Many Listbox

■ Select Many Shuttle

■ Select One Choice

■ Select One Listbox

■ Select One Radio

■ Select Order Shuttle

■ Show Detail

■ Show Detail Header

■ Table

■ Toolbar

■ Train

■ Train Button Bar

■ Tree

■ Tree Table
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10Using the Oracle Fusion/ADF Load Test
Module

This chapter provides instructions on configuring and using the OpenScript Oracle 
Fusion/ADF Load Test Module, which provides support for load testing of Oracle 
Application Development Framework (ADF)-based applications.

10.1 About the Oracle Fusion/ADF Load Test Module
The Oracle Fusion/ADF Load Test Module provides support for load testing of Oracle 
Application Development Framework (ADF) applications. The Oracle Fusion/ADF 
Load Test Module is an extension to the HTTP Module. The Oracle Fusion/ADF Load 
Test Module is fully integrated with the OpenScript platform including the Results 
view, Details view, Properties view, Console/Problems views, Preferences, Step 
Groups, Script Manager, and Workspace Manager. 

The Oracle Fusion/ADF Load Test recorder displays commands in the Tree View in 
easy-to-understand commands. By default, script commands are grouped into Steps 
Groups by the Web page on which they were performed. Each Step Group contains 
one or more script commands corresponding to recorded actions that were performed 
on the page. The default name for the Step Group is the ADF component name.

OpenScript shows the results of Oracle Fusion/ADF Load Test script playback in the 
Results view. The Results view shows results for each script command (including 
duration and summary for failures). The Results Report compiles the same 
information into an HTML Results Report. Results can be exported from the 
OpenScript GUI in standard format (CSV / HTML). Results are also generated for 
unattended playback through the command line.

The Oracle Fusion/ADF Load Test Module API includes a "adfload" class that 
provides additional programming functionality. 

10.1.1 Key Features of the Oracle Fusion/ADF Load Test Module
■ The Oracle Fusion/ADF Load Test Script Module. The New Project wizard (New 

from the File menu) includes an "Oracle Fusion/ADF" option in the Load Test 
Group to use when creating Oracle Fusion/ADF load testing projects in 
OpenScript. The Oracle Fusion/ADF Load Test Script Module records load scripts 
against ADF Faces applications (Oracle Application Development Framework 11g 
Release 1 (11.1.1)). OpenScript captures user actions and records them to the 
OpenScript script based upon HTTP requests and post data or query strings.
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■ Correlation Library. The Oracle Fusion/ADF Load Test Module includes an Oracle 
ADF-specific library of correlation rules for parameterizing scripts that allows 
playback of standard ADF Faces applications without manual correlation.

■ ADF Load-Specific Application Programming Interface (API). The Oracle 
Fusion/ADF Load Test Module includes an ADF Load Test Module API 
Specification that can be used to customize ADF Load test-specific scripts. 

10.2 Recording Oracle Fusion/ADF Load Tests
The Oracle Fusion/ADF Load Test Module records standard ADF components for 
Oracle Application Development Framework 11g Release 1 (11.1.1). The Recorder 
creates load test scripts for automating testing of Oracle Fusion/ADF applications. 

ADF components are applet based controls and the Oracle Fusion/ADF Load Test 
Module provides the object/attribute information for OpenScript to record 
interactions with those controls. Actions will be captured in the test script as 
OpenScript "adfload" commands. Other components are standard Web controls which 
are captured as standard OpenScript "http" navigation commands. Correlation rules 
can be modified by users through the Preferences settings for new scripts.

The Oracle Fusion/ADF Load Test Module provides a record toolbar button that lets 
you initiate the ADF recorder and capture Web/ADF page actions to the script view. 
The record toolbar includes start and stop recording toolbar buttons. OpenScript 
recorders also open a floating toolbar that can be used while recording without having 
to switch between the browser and OpenScript.

10.2.1 Recording Oracle Fusion/ADF Load Test Scripts
To record ADF Load Test scripts:

1. Start OpenScript.

2. Set the Oracle Fusion/ADF Load Test Correlation preferences.

3. Select New from the File menu. 

4. Expand the Load Testing group.

5. Select ADF (The Oracle Fusion/ADF script combines both HTTP and ADF 
technologies as part of the same script).

6. Click Next.

7. Select the Repository and Workspace.

8. Enter a script name.

9. Click Finish. A new Script tree is created in the Script View.

10. Select Record from the Script menu. The browser automatically opens when you 
start recording.

11. Load the web page where you want to start recording into the browser.

12. Navigate the web site to record page objects, actions, and navigations. The page 
objects, actions, and navigations will be added to the Run node of the script tree.

13. When finished navigating pages, close the browser.

14. Select Stop from the Script menu or click the Stop button on the OpenScript 
toolbar.
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15. Expand the Run node of the script to view the page objects, actions, and 
navigation nodes in the script tree.

You can customize the script using the menu options or the Code View for specific 
testing requirements.

10.3 Playing Back Scripts
OpenScript plays back recorded ADF actions/commands which consist of an object 
identified by its attributes. The actions used for playback will either be those that are 
recorded or specified manually in the Java Code view. Unattended playback is 
supported through Oracle Test Manager or third-party tools using OpenScript's 
command line interface. 

The Oracle Fusion/ADF Load Test Module provides playback and iterate toolbar 
buttons that allows users to start the script playback for either a single playback 
through the script or multiple iterations using data from a databank file. Playback 
results for Oracle Fusion/ADF Load scripts can be viewed in the Results and Console 
views.

10.3.1 Playing Back Oracle Fusion/ADF Load Scripts
To play back Oracle Fusion/ADF Load scripts:

1. Start OpenScript.

2. Open the Oracle Fusion/ADF Load script to play back.

3. Select Playback from the Script menu or click the toolbar button. 

You can view the progress of the script playback in the Console View. You can 
review the results of script playback in the Results View.

10.3.2 Playing Back Oracle Fusion/ADF Load Scripts with Iterations
To play back Oracle Fusion/ADF Load scripts with iterations:

1. Start OpenScript.

2. Open the Oracle Fusion/ADF Load script to play back.

3. Select Iterate from the Script menu or click the toolbar button. 

4. Set the iteration count.

5. Select which databank file to use, if necessary.

6. Set the starting record for the selected databank in the Databank Settings section.

7. Click OK.

You can view the progress of the script playback in the Console View. You can 
review the results of script playback in the Results View.

10.4 Setting Oracle Fusion/ADF Load Test Correlation Preferences
To set Setting Oracle Fusion/ADF Load Test Correlation preferences:

Note: Do not close the script editor view or script project while 
recording or playing back scripts. Doing so could result in 
unpredictable behavior in the OpenScript application.
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1. Start OpenScript.

2. Select OpenScript Preferences from the View menu. 

3. Expand the OpenScript node and the Correlation category.

4. Expand the ADF Load Test library.

5. Select or clear the check boxes to enable or disable specific rules.

6. Click the Add or Edit buttons to modify rules in the library.

7. Click OK.

10.5 Oracle Fusion/ADF Load Test Correlation Library
The Oracle Fusion/ADF correlation library defines the correlation rules for ADF-based 
applications. The correlation rules specify the variable names and regular expressions 
to use to replace dynamic data in ADF applications and navigations. The default 
Oracle Fusion/ADF correlation library provided with the OpenScript Oracle 
Fusion/ADF Load Test Module includes the following correlation rules: 

■ Correlate ADF Headers - Correlate Headers - this rule implements the default 
Correlate Headers correlation rules for ADF applications that use dynamic 
headers. 

■ Substitute ADFViewState - Variable Substitution - this rule locates text in the 
HTML matching the Regular Expression pattern <input type="hidden" 
name="javax\.faces\.ViewState" value="(.+?)"> and replaces it with 
the variable name javax.faces.ViewState in all locations.

■ Substitute _afrLoop - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern _afrLoop=(\d{10,16}) and replaces 
it with the variable name _afrLoop in all locations.

■ Substitute _afPfm - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern _afPfm=(.+?)& and replaces it with 
the variable name _afPfm in all locations.

■ Substitute _rtrnId - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern _rtrnId=(\d+) and replaces it with 
the variable name _rtrnId in all locations.

■ Substitute _adf.ctrl-state - Variable Substitution - this rule locates text in the 
HTML matching the Regular Expression pattern \?_
adf\.ctrl-state=(.+?)"> and replaces it with the variable name _
adf.ctrl-state in all locations.

■ Substitute ADFvDlg_adf.ctrl-state - Variable Substitution - this rule locates text 
in the HTML matching the Regular Expression pattern __ADFvDlg__\?_
adf\.ctrl-state=(.+?)& and replaces it with the variable name ADFvDlg_
adf.ctrl-state in all locations.

■ ADF Web Correlation - DOM Correlation - this rule implements the default Web 
Document Object Model correlation rules for ADF applications.

■ XML Dom - DOM Correlation - this rule implements the default XML Document 
Object Model correlation rules for XML applications.
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10.6 Oracle Fusion/ADF Load Test Module API
The Oracle Fusion/ADF Load Test Module includes a script Application Programming 
Interface (API) specific to ADF load testing. The Oracle Fusion/ADF Load Test 
Module recorder creates the Java code that corresponds to the Tree View and displays 
the Oracle Fusion/ADF Load Test commands in the Java Code view using 
easy-to-understand function names. The Java Code view commands correspond to the 
Tree View and you can edit your scripts in either view.

You can use the Oracle Fusion/ADF Load Test API to enhance recorded scripts with 
additional testing functionality.  Commands that are specific to the Oracle 
Fusion/ADF Load Testing Module are part of the "adfload" class. Additional test 
methods are available in the "http" class. You can also leverage other commands from 
other enabled classes (services) or general Java commands in your scripts.
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11Using the Web Services Module

This chapter provides instructions on using the OpenScript Web Services Module, 
which supports testing of Web Services.

11.1 About the Web Services Module
The Web Services Module is an application module that supports testing of Web 
Services. The Web Services Module is an extension to the HTTP Module. The 
OpenScript Web Services module includes the following features:

■ The Web Services Module. The New Project wizard (select New from the File 
menu) includes a "Web Services Script" option to use when creating Web Services 
scripts in OpenScript.

■ Support for SOAP Protocols. The Web Service Module supports the SOAP 1.1 and 
1.2 protocols.

■ Support for multiple parsers. The Web Service Module supports the multiple 
WSDL parsers. In addition to the default OpenScript and Oracle parsers, 
OpenScript can also be configure to use apache AXIS and .Net parsers.

■ WSDL Manager. The OpenScript WSDL Manager lets you import and store Web 
Services Definition files for creating Web Services scripts. Using the WSDL 
Manager, you add Web Services methods to the OpenScript tree.

■ XML Editor. The OpenScript XML Editor lets you edit Web Services requests to 
include either static values or variables.

■ Web Services-specific Application Programming Interface (API). The Web Services 
Module includes a Web Services Module API Specification that can be used to 
customize Web Services scripts.

11.1.1 Key Features of the Web Services Module
The Web Services Module is an extension module to HTTP Module that extends the 
platform with Web Services testing capabilities. The Web Services Module is fully 
integrated with the OpenScript platform including the Results view, Details view, 
Properties view, Console/Problems views, Preferences, Step Groups, Script Manager, 
and Workspace Manager.

The Web Services methods are added to the Script tree using the WSDL Manager. Web 
Services method postdata parameters can be edited using the XML Editor features of 
the Details View. 

OpenScript shows the results of Web Services script playback in the Results view. The 
Results view shows results for each script command (including duration and 
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summary for failures). The Results Report compiles the same information into an 
HTML Results Report. Results can be exported from the OpenScript GUI in standard 
format (CSV / HTML). Results are also generated for unattended playback through 
the command line. 

The Web Services Module API includes a "ws" class that provides additional 
programming functionality. 

11.2 Creating Web Services Scripts Using WSDL Manager
Creating Web Services scripts using WSDL Manager involves the following major 
steps:

1. Create a Web Services script tree.

2. Add WSDL files to the WSDL Manager view.

3. Add methods from the WSDL Manager to the script tree.

4. Edit method parameters in the Details view.

The following sections explain each of the major steps.

11.2.1 Creating the Web Services Script Tree
To create a Web Services script tree:

1. Start OpenScript.

2. Select New from the File menu. 

3. Expand the General group and select Web Services.

4. Click Next.

5. Select the Repository and Workspace.

6. Enter a script name.

7. Click Finish. A new Script tree is created in the Script View and the WSDL 
Manager view appears.

11.2.2 Adding WSDL Files to the WSDL Manager View
To add files to the WSDL Manager view:

1. Click the Add icon in the WSDL Manager view.

2. Enter the URL to a the WSDL file or click Browse to select a local file.

3. Select the parser to use and set the Roll over option.

4. Click Next. The parsed methods appear.

5. Click Finish to add the parsed methods to the WSDL Manager view.

11.2.3 Adding Methods to the Script Tree
To add WSDL file methods from the WSDL Manager view to the script tree:

1. Expand the WSDL file tree in the WSDL Manager view.

2. Right-click the method to add and select Add to script from the shortcut menu. 
The method will be added to the Run node of the script tree.
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In the Java Code view, a ws.method(method)/ws.endMethod() group with a 
ws.post() method will be added to the script code, as follows:

ws.method("findApprovedPatientsByLastName");
{
ws.post(2, "http://server:7011/medrec-jaxws-services/PatientFacadeService", 
"<?xml version=\"1.0\" encoding=\"UTF-8\" standalone=\"no\"?>
<soapenv:Envelope 
xmlns:soapenv=\"http://schemas.xmlsoap.org/soap/envelope/\"
xmlns:med=\"http://www.oracle.com/medrec\">\r\n
<soapenv:Header/>\r\n
<soapenv:Body>\r\n
<med:findApprovedPatientsByLastName>\r\n
<!--Optional:-->\r\n
<arg0>String</arg0>\r\n
</med:findApprovedPatientsByLastName>\r\n

</soapenv:Body>\r\n
</soapenv:Envelope>", null, true, null, null);

}
ws.endMethod();

11.2.4 Editing Method Parameters in the Details View
To edit WSDL file methods in the Details View:

1. Expand the Run node in the Script tree view.

2. Expand the WSDL method node in the Script tree view.

3. Select an XML post data node in the Script tree view.

4. Open the Details view and select the XML Tree tab.

5. Click a value in the right column of the XML Tree tab to edit the value. 

or

Right-click a parameter in the left column of the XML Tree tab and select 
Substitute Variable to select a variable name or Databank value to substitute for 
the parameter value. If you parameterize a value with a Databank, the databank 
variable appears as {{db.databankFileName.field,recordedValue}} in 
the SOAP parameters. For example, the optional argument <arg0> in the above 
postdata example would appear as 
<arg0>{{db.customer.LastName,String}}</arg0>\r\n.

The XML source in the XML tab is not decoded by default. Right-click the XML 
source in the XML tab and select Format to format the contents. When you format 
the xml contents, the inner text of an element will be decoded. The following is an 
example of the inner text of an element before formatting:

<soapenv name="google&quot;">google&quot;</soapenv>

 The following is an example of the inner text of an element after formatting:

<soapenv name="google&quot;">google"</soapenv>

11.3 Modifying Scripts
Once a script has been created/recorded, you can make modifications to customize the 
script for your specific testing needs.
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11.3.1 Adding a Web Services Post Navigation
To add a Web Services Post Navigation to a script:

1. Create a Web Services script.

2. Select the Run node.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the HTTP node.

5. Select the Web Services Post Navigation node from the Web Services group and 
click OK.

6. On the Base URL tab, enter the URL, request and response charsets, and set the 
Encode strings option.

7. On the Post Data tab, enter the SOAP protocol postdata XML.

8. On the Headers tab, use the Add button to add name/value pairs and actions to 
the Base URL.

9. Click OK to add the Web Services Post Navigation node to the script tree.

In the Java Code view, the Web Services Post Navigation consists of the code 
executed in the ws.Post method (line breaks and spacing added for clarity):

ws.post(2, "http://testserver2/EmployeeLookup/EmployeeLookup.asmx",
"<?xml version=\"1.0\" encoding=\"utf-8\"?>\r\n\r\n
<soapenv:Envelope 

xmlns:soapenv=\"http://schemas.xmlsoap.org/soap/envelope/\" 
xmlns:xsi=\"http://www.w3.org/2001/XMLSchema-instance\" 
xmlns:xsd=\"http://www.w3.org/2001/XMLSchema\" 
xmlns:web=\"http://oracle.com/webservices\"> \r\n

<soapenv:Header/> \r\n
<soapenv:Body> \r\n
<web:findEmployee soapenv:
encodingStyle=\"http://schemas.xmlsoap.org/soap/encoding/\"> \r\n
<criteria xmlns:enc=\"http://oracle.com/webservices/encodedTypes\"
xsi:type=\"enc:SearchCriteria\"> \r\n
<FirstName xsi:type=\"xsd:string\">string</FirstName> \r\n
<LastName xsi:type=\"xsd:string\">string</LastName> \r\n
<EmployeeID xsi:type=\"xsd:int\">3</EmployeeID> \r\n

</criteria> \r\n
</web:findEmployee> \r\n

</soapenv:Body> \r\n
</soapenv:Envelope>",

http.headers(http.header("Content-Type", "text/xml", 
Header.HeaderAction.Modify),
http.header("SOAPAction","\"http://oracle.com/webservices/findEmployee\"",
Header.HeaderAction.Add)),

false, "UTF-8", "UTF-8");

11.3.2 Adding a Text Matching Test
You can use Text Matching Tests to report an error and/or abort the script if a request 
does not match the Text Matching Test criteria.

To add a Text Matching Test to a Web Services script:

1. Create a Web Services script.

2. Expand the Run node.
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3. Select the Web Services postdata node where you want to add the Text Matching 
test.

4. Select the Script menu and then select Other from the Add menu.

5. Select Text Matching Test from the Validation group.

6. Enter a name for the test.

7. Enter the Text to Match.

8. Enter any error message text to log if the test fails.

9. Select the source location to look for the text to match: HTML or Response Header.

10. Select the Pass when setting.

■ Selected text is present: the test case passes if the Text to Match string is 
found in the selected source.

■ Selected text is absent: the test case passes if the Text to Match string is not 
found in the selected source.

11. Select the Regular Expression option if the Text to Match is a Regular Expression. 
Clear the Regular Expression option if the Text to Match is plain text. 

12. Click OK to add the Text Matching Test node to the script tree.

In the Java Code view, the Text Matching Test consists of the code executed in the 
http.match method (line breaks and spacing added for clarity):

http.match("Test name", "Text to Match", "Error Message", 
Source location = Source.Html | Source.ResponseHeader, 
pass when present = false | pass when absent = true, 
is not RegExp = false | is RegExp = true);

Example:

http.match("MyTXTMatch", "Login", "Could not find login", Source.Html, false, 
false);

Set the default Error recovery setting for the HTTP Text Matching test in the 
OpenScript playback preferences.

11.3.3 Adding Security Extensions
You can add security extensions to Web Services scripts.

To add security extensions to a Web Services script:

1. Create a Web Services script.

2. Expand the Run node.

3. Select the Web Services method node where you want to add the security and 
attachments.

4. Select the Script menu and then select Other from the Add menu.

5. Expand the HTTP node.

6. Select Web Services Security Attachments from the Web Services group and click 
OK.

7. If necessary click the WS-Security tab.



Modifying Scripts

11-6 Oracle Application Testing Suite OpenScript User's Guide

8. Enter a URL. If you selected a Web Services navigation node in the script tree, the 
URL will be automatically entered. 

9. Select User Username Token

10. Enter the user name and password.

■ Username: specifies the user name to use for the Username Token in the XML 
request.

■ Password: specifies the password to use for the Username Token in the XML 
request.

■ Confirm Password: confirms the password.

11. Select the password type: Password Text or Password Digest.

■ Password Text: when selected, the password in the XML request is included as 
plain text. The URI attribute for the <wsse:Password> element is set to 
#PasswordText.

■ Password Digest: when selected, the password is encrypted. The URI attribute 
for the <wsse:Password> element is set to #PasswordDigest.

12. Select or clear the Add Created Header, Add Nonce and Add Timestamp options.

■ Add Created Header: when selected, a creation timestamp is included in the 
Username Token of the XML request for use in setting the server cache limit of 
used nonces.

■ Add Nonce: when selected, a cryptographically random nonce value is 
included in the Username Token of the XML request to provide a 
countermeasure for replay attacks.

■ Add Timestamp: when selected, a timestamp value is included in the Web 
Services security element of the XML request. The timestamp includes both 
Created and Expires elements. Specify the Valid For number of seconds.

13. Click OK to add the Security Attachment node to the script tree.

In the Java Code view, the Security Attachment consists of the code executed in the 
ws.addSecurityAttachments method (line breaks and spacing added for 
clarity), as follows:

ws.addSecurityAttachments("url",
ws.security("userName", deobfuscate("password"),addCreatedHeader, 
addNonce, addTimestamp, validFor), null);

If you add security and file attachments together, the 
ws.addSecurityAttachments method includes both the ws.security and 
ws.attachments methods (line breaks and spacing added for clarity), as follows:

ws.addSecurityAttachments("url",
ws.security("userName", deobfuscate("password"),true, true, true, 10),
ws.attachments(AttachmentMechanism.transferType,
ws.attachment("filename","attachmentPart")));

11.3.4 Adding Attachments
You can add file attachments to Web Services scripts.

To add file attachments to a Web Services script:

1. Create a Web Services script.
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2. Expand the Run node.

3. Select the Web Services method node where you want to add the security and 
attachments.

4. Select the Script menu and then select Other from the Add menu.

5. Select Web Services Security Attachments from the Web Services group.

6. If necessary click the WS-Security tab.

7. Enter a URL. If you selected a Web Services navigation node in the script tree, the 
URL will be automatically entered. 

8. Click the Attachments tab.

9. Select the Transfer Type.

■ DEFAULT - uses the default transfer type specified by the Content-Type 
header.

■ SWA - Security SOAP Messages with Attachments

■ MTOM - SOAP Message Transmission Optimization Mechanism

■ DIME - Direct Internet Message Encapsulation

10. Click Add.

11. Enter the path and file name or click Browse to select a file.

12. If the Web Services method includes any Attachment Part object identifiers, select 
an Attachment Part from the list. If the Web Services method does not include any 
Attachment Part object identifiers, the list will be empty.

13. Click OK to add the Security Attachment node to the script tree.

In the Java Code view, the Security Attachment consists of the code executed in the 
ws.addSecurityAttachments method (line breaks and spacing added for 
clarity) as follows:

ws.addSecurityAttachments("url", null, 
ws.attachments(AttachmentMechanism.transferType, 
ws.attachment("filename","attachmentPart")));

If you add security and file attachments together, the 
ws.addSecurityAttachments method includes both the ws.security and 
ws.attachments methods (line breaks and spacing added for clarity), as follows:

ws.addSecurityAttachments("url", 
ws.security("userName", deobfuscate("password"),true, true, true, 10), 
ws.attachments(AttachmentMechanism.transferType, 
ws.attachment("filename","attachmentPart")));

The following example Web Services script method shows the 
ws.addSecurityAttachments method with a ws.post postdata method used 
to upload a file. The ws.post method specifies the SOAP Envelope postdata, 
Content-Type, and SOAP Action.

ws.method("upload");
{
ws.addSecurityAttachments("http://myurl.com:8080/services/MTOMService",
ws.security("username",deobfuscate("5blNah5kX/XuZnepYwInFw=="), 
true, true, true, 20), 

ws.attachments(AttachmentMechanism.MTOM, 
ws.attachment("C:\\OracleATS\\OFT\\test.txt", "<upload>776598931581")));
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ws.post(15, "http://myurl.com:8080/services/MTOMService",
"<soapenv:Envelope 

xmlns:soapenv=\"http://schemas.xmlsoap.org/soap/envelope/\" 
xmlns:ser=\"http://service.interop.mtom.sample\">\r\n

<soapenv:Header/>\r\n
<soapenv:Body>\r\n
<ser:upload>\r\n
<!--Optional:-->\r\n
<ser:fileName>string</ser:fileName>\r\n
<!--Optional:-->\r\n
<ser:contents>cid:776598931581</ser:contents>\r\n

</ser:upload>\r\n
</soapenv:Body>\r\n

</soapenv:Envelope>",
http.headers(http.header("Content-Type", "text/xml;charset=UTF-8",

Header.HeaderAction.Modify), 
http.header("SOAPAction", "\"urn:upload\"",
Header.HeaderAction.Modify)), 

true, null, null);
}
ws.endMethod();

11.4 Recording Web Services Scripts
If you have a Web Services client application written already that communicates over 
HTTP and which communicates through a proxy, you can record the traffic using thee 
OpenScript HTTP recorder.

11.4.1 Setting Web Services Record Preferences
To set Web Functional Test record preferences:

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu. 

3. Expand the OpenScript node and the Record category.

4. Select Web Services.

5. Click the tabs and set the preferences.

6. Click OK.

11.4.2 Recording Web Services Scripts
To record Web Services script:

1. Start OpenScript.

2. Set the Web Services Recording preferences.

3. Select New from the File menu. 

4. Expand the General group and select Web Services.

5. Click Next.

6. Select the Repository and Workspace.

7. Enter a script name.
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8. Click Finish. A new Script tree is created in the Script View and the WSDL 
Manager view appears.

9. Select Record from the Script menu. The browser automatically opens when you 
start recording.

10. Load the web page where you want to start recording into the browser.

11. Navigate the web site to record navigations. The navigations will be added to the 
Run node of the script tree.

12. When finished navigating pages, close the browser.

13. Select Stop from the Script menu or click the Stop button on the OpenScript 
toolbar.

14. Expand the Run node of the script to view the page navigation nodes in the script 
tree.

You can customize the script using the menu options or the Code View for specific 
testing requirements.

Note: Do not close the script editor view or script project while recording or 
playing back scripts. Doing so could result in unpredictable behavior in the 
OpenScript application.
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12Using the Siebel Functional Test Module

This chapter provides instructions on configuring and using the OpenScript Siebel 
Functional Test Module, which tests Siebel applications by accessing objects through 
the Document Object Model (DOM) of the Web browser and the Siebel test automation 
framework. 

12.1 About the Siebel Functional Test Module
The Siebel Functional Test Module provides support for functional testing of Siebel 
web applications. The Siebel Functional Test Module is an extension module to the 
OpenScript Web Functional Test Module that extends the Web testing with Siebel 
Functional Test recording and playback capabilities. The Siebel Functional Test Module 
is fully integrated with the OpenScript platform including the Results view, Details 
view, Properties view, Console/Problems views, Preferences, Step Groups, Script 
Manager, and Workspace Manager.

12.1.1 Key Features of the Siebel Functional Test Module
The Siebel Functional Test Module includes the following features: 

■ Records Standard Siebel High Interactivity (HI) and Standard Interactivity (SI) 
components for Siebel versions 7.7, 7.8, 8.0 and 8.1 through integration with Siebel 
Test Automation CAS Library.

■ Plays back recorded Siebel actions/commands which consist of an event plus 
object identified by its attributes (for example: GotoScreenlink 
pageTabs("SiebePageTabs") Accounts Screen).

■ Provides full script code view integration to support script generation for the 
Siebel Functional Test Module. The Siebel Functional Test Module includes an 
additional API to support Siebel Functional Test protocol code scripting.

■ Allows users to parameterize user inputs to Siebel Functional Test scripts and 
drive those inputs from an external data file (Databank). 

■ Allows users to insert Tests to validate Siebel HI and SI content on playback. 

■ Provides additional options/settings that are specific to Siebel Functional Test 
scripts within the Siebel Functional Test categories in the preferences interface.

■ Reports playback results for Siebel Functional Test scripts in the Results and 
Console views.

■ The Siebel Functional Test Script Module API. The Siebel Functional Test 
Application Programming Interface include Java code methods specific to 
functional testing of Siebel applications.
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The New Project wizard (select New from the File menu) includes a "Siebel Functional 
Test Script" option to use when creating Siebel functional testing projects in 
OpenScript. The Siebel Functional Test Script Module records Siebel applications using 
the Siebel test automation framework. OpenScript captures user actions and records 
them to the OpenScript script nodes in a highly readable sequence of navigations and 
actions.

12.2 Functional Testing Siebel Applications
The following is an outline of the procedures and best practices used to perform 
functional testing of Siebel applications with the OpenScript application.

12.2.1 Prerequisites
The instructions in this document assume the following prerequisites:

■ Testing hardware/environment is available.

■ The Siebel applications are installed on a Siebel Server.

■ The Oracle Application Testing Suite applications have been installed on a testing 
machine.

■ The test machine can access the Siebel applications.

■ Some steps may require system administrator level privileges for the Siebel Server.

■ License for Siebel Test Automation required.

12.2.2 Setting up the Siebel Test Environment
The functional test environment should approximate as closely as possible a working 
Siebel deployment environment. However, hardware cost constraints may be a 
limiting factor. This section provides recommendations about the basic test system 
configuration. Additional test system configurations can be used based upon 
hardware and network availability.

The basic n-tier configuration should consist of the following systems:

■ Web Server

■ Siebel Server

■ Database Server

■ Database Storage

See the Siebel Installation Guide in the in the Siebel document bookshelf for information 
about hardware and Siebel installation requirements.

Notes:

■ Siebel applications can contain High-Interactivity (HI) components, which use 
ActiveX controls, and Standard-Interactivity (SI) applications, which use standard 
HTML. Applications may also use a combination of HI and SI components. 
Testing methods vary depending upon the type of components being tested. See 
the "Automating Functional Tests" chapter in the Testing Siebel eBusiness 
Applications document in the Siebel document bookshelf for a description of the 
component types.
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■ In general, Siebel applications are more memory intensive than CPU intensive. If 
trade-offs need to be made in test hardware decisions, memory should be given 
higher consideration than CPU speed.

■ Siebel web applications use Cookies to maintain the state information.

12.2.3 Enabling Siebel Test Automation
The Siebel test automation framework must be activated on the Siebel server for 
OpenScript to access it. Changing the Siebel configuration file may require system 
administrator level privileges for the Siebel server. A license is also required to use the 
Siebel Test Automation framework. Contact your account representative for additional 
information about licence requirements.

12.2.3.1 Siebel 7.x
To enable the test automation framework in Siebel 7.x:

1. Open the .CFG file for the Siebel application on the Siebel server.

2. Set the EnableAutomation and AllowAnonUsers switches in the [SWE] 
section as follows:

[SWE]
EnableAutomation = TRUE
AllowAnonUsers = TRUE
...

See the Siebel Testing Siebel eBusiness Applications documentation if you need to set 
up secure access to the Siebel Test Automation framework.

3. Restart the Siebel Server.

12.2.3.2 Siebel 8.x
To enable the test automation framework in Siebel 8.x: 

1. Log into Siebel as Administrator.

2. Go to "Site Map".

3. Go to "Administration - Server Configuration".

4. Select "Call Center Object Manager" (provided you want to enable automation for 
Call Center).

5. Under list of Components, click the Parameters tab.

6. Find EnableAutomation and AllowAnonUsers parameters and set both to TRUE.

7. Restart the Siebel Server.

12.2.4 Script Creation Techniques
The following are tips and techniques to use when creating Siebel load test scripts 
using the OpenScript application:

■ Disable browser caching to make sure the pages are returned from the server 
rather than the browser cache.

■ Record actions from login through logout to make sure parameters are passed 
properly between page navigations.
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■ Record actions slowly in the Siebel environment to make sure the recorder records 
all actions to the OpenScript script. If possible, watch as the OpenScript script 
pages are added to the script tree.

■ Siebel Popup windows may initially appear incorrect. Resize the window slightly 
to refresh the page in the popup window.

■ Do not insert Siebel Tests in Siebel popup windows unless the test is necessary.

■ Save the script in OpenScript using Save As on the File menu. When you save a 
Siebel proxy-recorded script, OpenScript automatically creates a Java Agent 
versions of the script in the workspace. Depending upon the size of the script, the 
file save operation may take some time.

12.2.5 Setting Browser Options
When recording and playing back scripts to test an application, you want to make sure 
the pages returned are from the server and not the browser cache. To verify or change 
the browser settings:

1. Open Internet Options from the Control Panel.

2. Click Settings in the Temporary Internet files section.

3. Select Every visit to the page.

4. Click View Objects in the Temporary Internet files folder section.

5. Verify that the downloaded Program files directory does not contain multiple 
versions of the Siebel High Interactivity Framework and Siebel Test Automation 
programs installed.

6. If necessary, remove the duplicate or older versions.

7. Close the Downloaded Program Files window.

8. Click OK to close the Temporary Settings.

9. Click OK to close the Internet Properties.

12.2.6 Starting the Siebel Application
When you start the Siebel application in the browser, the URL must include the Siebel 
Web Engine (SWE) command to generate the test automation framework information. 
The AutoOn Siebel Web Engine command (SWECmd) is added to the URL as follows 
(SWECmd is case-sensitive):

http://hostname/application/start.swe?SWECmd=AutoOn

where hostname is the machine name or IP address of the Siebel server and 
application is the name of the Siebel application. For example, application 
could be callcenter or callcenter_enu depending upon the Siebel version.

Enter the start URL and command into the browser address. for example:

http://siebelServer/callcenter_enu/start.swe?SWECmd=AutoOn

As you navigate pages, OpenScript records page navigation to the OpenScript script 
tree.
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12.2.7 Determining a Siebel Component Type
Siebel applications can include High-Interactivity (HI) object and 
Standard-Interactivity (SI) object types. You can use the Inspect Path feature of 
OpenScript to determine the type of an object in an application.

1. Click the Inspect Path toolbar button or the Capture button to open the Select 
Object dialog box.

2. Move the mouse cursor over the page in the Siebel application to view the 
component type. The current component is highlighted in the OpenScript browser 
and the path appears in the Select Element dialog box. Siebel HI component types 
are indicated by /siebelft:cas[ClassName= in the Path/Object fields:

3. The path to HI component types is also referred to as the Object Descriptor String 
(ODS) and is used in OpenScript to recognize applets used with the Siebel 
application.

SI component types are indicated by /web:window[index='0']... in the Path 
field.

4. Press F10 to capture the object path. You can copy the path from the dialog box 
using Ctrl-C and paste using Ctrl-V.

The following are examples of complete object paths (line breaks added for clarity):

High-Interactivity (HI) Path.

/siebelft:cas[ClassName='SiebApplication' and 
RepositoryName='Siebel Universal Agent']

/siebelft:cas[ClassName='SiebScreen' and 
RepositoryName='Web Call Center Home Screen']

/siebelft:cas[ClassName='SiebView' and 
RepositoryName='Home Page View (WCC)']

/siebelft:cas[ClassName='SiebApplet' and 
RepositoryName='Sales Message Alert List Applet Tiny']

/siebelft:cas[ClassName='SiebList' and 
RepositoryName='SiebList']

Standard-Interactivity (SI) Path:

/web:window[index='0']
   /web:document[index='10']
   /web:span[text='Search' or index='1']

or

/web:window[index='0']/web:document[index='10']
   /web:form[index='0' or name='SWEForm1_0']
   /web:input_text[id='s_1_1_16_0' or name='s_1_1_16_0' or index='1']

12.3 Recording Siebel Functional Test Scripts
The Siebel Functional Test Module records standard Siebel High Interactivity (HI) and 
Standard Interactivity (SI) components for Siebel versions 7.7, 7.8, 8.0 and 8.1 through 
integration with Siebel Test Automation CAS Library. Siebel Test Automation must be 
enabled on the Siebel server side in order to successfully record these events. The 
Recorder creates functional and regression test scripts for automating testing of Siebel 
applications. 

Siebel HI components are Active-X based controls and Siebel Test Automation 
provides the object/attribute information for OpenScript to record interactions with 
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those controls. Actions on HI controls will be captured in the test script as OpenScript 
"siebelFT" commands. Siebel SI components are standard Web controls which are 
captured as standard OpenScript "web" commands using Web Functional Test object 
attributes; however, Siebel Test Automation may provide additional attributes to 
identify SI controls which take precedence over standard Web object/attributes. Object 
Identification attributes can later be modified by users through the Preferences global 
settings for new scripts or for already recorded commands in the tree view or code 
view. Recording can be configured through Internet Explorer only as Siebel does not 
support Firefox.

The Siebel Functional Test Module provides a record toolbar button that lets you 
initiate the Siebel recorder and capture Web/Siebel page actions to the script view. The 
record toolbar includes start and stop recording toolbar buttons. OpenScript recorders 
also open a floating toolbar that can be used while recording without having to switch 
between the browser and OpenScript.

Before recording Siebel Functional test scripts, make sure the Siebel test automation 
framework is activated on the Siebel server. See Functional Testing Siebel Applications 
for details about Prerequisites and the Siebel Test Environment.

12.3.1 Setting Siebel Functional Test Record Preferences
To set Siebel Functional Test record preferences:

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu. 

3. Expand the OpenScript node and the Record category.

4. Select Siebel Functional Test.

5. Set the General and Object Identification preferences.

6. Click OK.

12.3.2 Adding/Editing SI Element and Site Map Link Paths
The  Siebel Functional Test Module can use special object identifier paths when 
recording  Standard Interactivity (SI) Web objects and Sitemap links.  The object 
identifier paths specify the element attributes to use to identify Siebel SI controls or 
Sitemap links. The Siebel attributes are RN (repository name), OT (object type) and 
UN (unique name).

To add or edit an SI element or Sitemap link path:

1. Select the OpenScript Preferences from the View menu.

2. Expand the Record node and select Siebel Functional Test.

3. Click the General tab.

4. Click Edit for SI Element path or Sitemap path.

5. Click Add or select an existing attribute and click Edit.

6. If adding a new attribute, enter a name for the attribute.

7. Add or edit attributes for the path.

For each attribute, you specify a name (typically a Siebel object attribute), an 
operator, a value and a value type. As you add attributes, OpenScript builds the 
object identifier path using logical AND between each attribute. Click Edit to 
change between logical OR and AND.
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8. Click OK. The object identifier path is updated in the record preferences.

12.3.3 Adding/Editing Object Identifiers
The Siebel Functional Test Module uses object identification to specify attributes used 
to identify High Interactivity (HI) and Standard Interactivity (SI) Web objects. The 
Siebel Functional Test Module uses the same predefined path attributes for common 
Web objects as the Web Functional Test Module; however, Siebel Test Automation may 
provide additional attributes to identify HI controls which take precedence over 
standard Web objects/attributes. Object paths are specified in XPath format. For 
example, for HI controls, the object identification path appears as follows in Java code 
commands:

/siebelft:cas[@ClassName='SiebApplication' and 
@RepositoryName='Siebel Universal Agent']

/siebelft:cas[@ClassName='SiebPageTabs' and 
@RepositoryName='SiebPageTabs']")

and for SI Web objects, the object identification path appears as follows in Java code 
commands unless special paths are enabled in the Siebel General recording 
preferences:

/web:window[@index='0']
/web:document[@index='0']

/web:form[@index='0' or @name='SWEEntryForm']
/web:input_password[@id='s_swepi_2' or @name='SWEPassword' or @index='0']

The Siebel Functional Test Module includes object identifiers that specify how the 
recorder identifies Browser and Siebel objects. You can set the default Siebel SI object 
attributes in the Siebel Functional Test Module Record Preferences. You can add object 
identifiers or edit the existing object identifiers in the Record preferences. The HI 
control identification is provided by the Siebel Test Automation CAS Library. You can 
also edit object attributes in recorded scripts in the tree view or the code view.

In addition to the predefined object identification, you can add an Object Library to the 
script to record paths into a library file. Object Library files may be shared and reused 
across other scripts. The Object Library files provide a more convenient "short name" 
for objects to provide for more convenient programming.

To add or edit an object identifier:

1. Select the OpenScript Preferences from the View menu.

2. Expand the Record node and select Siebel Functional Test.

3. Click the Object Identification tab.

4. Click Add or select an existing object identifier and click Edit.

5. If adding a new object identifier, enter a name for the object identifier.

6. Add or edit object elements for the object identifier.

For each object element, you specify a name (typically a Siebel object attribute), an 
operator, a value and a value type. As you add object elements, OpenScript builds 
the object identifier using logical OR between each object identifier element. Click 
Edit to change between logical OR and AND.

7. Click OK. The object identifier is added to the record preferences.

See the Using the Web Functional Test Module chapter for additional information about 
adding and editing Object Identifiers.
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12.3.4 Recording Siebel Functional Test Scripts
To record Siebel Functional Test Scripts:

1. Start OpenScript.

2. Select New from the File menu. 

3. Select Siebel Functional Test Script.

4. Click Next.

5. Select the Repository and Workspace.

6. Enter a script name.

7. Click Finish. A new Script tree is created in the Script View.

8. Select Record from the Script menu. The browser automatically opens when you 
start recording.

9. Load the Siebel application using the AutoOn Siebel Web Engine command 
(?SWECmd=AutoOn) in the URL into the browser.

10. Log in and navigate the web site to record page objects, actions, and navigations. 
The page objects, actions, and navigations will be added to the Run node of the 
script tree.

11. When finished navigating pages, log out and close the browser.

12. Select Stop from the Script menu or click the Stop button on the OpenScript 
toolbar.

13. Expand the Run node of the script to view the page objects, actions, and 
navigation nodes in the script tree.

You can customize the script using the menu options or the Code View for specific 
testing requirements.

12.4 Modifying Scripts
Once a script has been created/recorded, you can make modifications to customize the 
script for your specific testing needs.

12.4.1 Adding Siebel Actions
The Siebel Functional Test Module includes actions for Siebel objects that can be added 
to a script. 

To add Siebel actions to a script:

1. Record a Siebel Functional Test script.

2. Select the script node where you want to add the action.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Siebel Functional Test node.

5. Expand an action node and select the action.

Note: Do not close the script editor view or script project while 
recording or playing back scripts. Doing so could result in 
unpredictable behavior in the OpenScript application.
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6. Click OK.

The Siebel action dialog boxes let you define the action to perform during 
playback of a Siebel Functional Test script. This dialog box is used for most Siebel 
actions including Application, Button, Calculator, Calendar, Checkbox, 
Communications Toolbar, Currency, List, Menu, Page Tabs, PDQ, Rich Text, Screen 
Views, Task Assistant, Text, Text Area, Threadbar, Toolbar, Tree, and View Applets. 
Specific values may be required for specific actions. 

■ Action: Shows the action to perform. Additional values for variables or 
attributes may be required depending upon the action to perform.

■ Path: Specify the object ID of the Siebel or Web object on which to perform the 
action. You can use the Capture or Select menu options to capture or select an 
object path.

■ Value(s): Specify the variables or attributes as required for the specific action 
on an object.

7. Enter the object identification path for the object.

8. Enter any required values to use for the object action.

9. Click OK. The action node is added to the script tree.

In the Java Code view, a siebelFT.object(objectId).action() method 
will be added to the script code:

siebelFT.menu(100,"/siebelft:cas[@ClassName='SiebApplication' 
and @RepositoryName='Siebel Universal Agent']

/siebelft:cas[@ClassName='SiebMenu' 
and @RepositoryName='SiebMenu']").select("File\\\\File - Logout");

The Siebel Functional Test node includes actions for objects such as Application, 
Calculator, Calendar, Communications Toolbar, Page Tabs, Task Assistant, 
Threadbar, and View Applets, etc. Other object actions have corresponding Java 
code methods.
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13Using the Siebel Load Test Module

The Siebel Load Test Module provides support for load testing of Siebel web 
applications. The Siebel module is an extension to the HTTP Module. The OpenScript 
Siebel Load Test module includes the following features: 

■ The Siebel Load Test Script Module. The New Project wizard (Select New from the 
File menu.) includes a "Siebel Load Test Script" option to use when creating Siebel 
load testing projects in OpenScript. The Siebel Load Test Script Module records 
Siebel applications at the protocol level. OpenScript captures user actions and 
records them to the OpenScript script based upon HTTP requests and post data or 
query strings. 

■ Siebel-Specific Correlation Library. The Siebel module includes a transform library 
for automatically finding dynamic values inside recorded Siebel pages and 
substituting them into the appropriate Siebel HTTP requests.

■ Siebel-Specific Correlation Rules. These rules define various transform rules for 
automatically finding/substituting Siebel parameters into a navigation. The Siebel 
rules are specified in a Siebel-specific correlation library that is added to the 
OpenScript correlation preferences.

■ Siebel-Specific Application Programming Interface (API). The Siebel module 
includes a Siebel Module API Specification that can be used to customize 
Siebel-specific scripts.

13.1 Load Testing Siebel Applications
The following is an outline of the procedures and best practices used to load test Siebel 
applications with the OpenScript application.

13.1.1 Prerequisites
The instructions in this document assume the following prerequisites:

■ Testing hardware/environment is available.

■ The Siebel applications are installed on a Siebel Server.

■ The Oracle Application Testing Suite have been installed on a testing machine.

■ The test machine can access the Siebel applications.

■ Some steps may require system administrator level privileges for the Siebel Server.



Load Testing Siebel Applications

13-2 Oracle Application Testing Suite OpenScript User's Guide

13.1.2 Setting Up Siebel Load Test Environments
The load test environment should approximate as closely as possible a working Siebel 
deployment environment. However, hardware cost constraints may be a limiting 
factor. The following sections provide recommendations about basic test system 
configurations. Additional test system configurations can be used based upon 
hardware and network availability.

13.1.2.1 Basic Configuration
The basic n-tier configuration should consist of the following systems:

■ Web Server

■ Siebel Server

■ Database Server

■ Database Storage

See the Siebel Installation Guide in the in the Siebel document bookshelf for information 
hardware and Siebel installation and any licensing requirements.

13.1.2.2 Floating Load Balancing Test Server
In addition to the basic tier configuration, various load balancing tests should include 
another system that can be configured on a single system as a movable server between 
tiers. The floating load balancing server can be used to test fail-over of clustered 
servers and recovery of servers if one server (on any one of the tiers) in a multiple 
server configuration goes down.

A floating Server could be configured as Web Server, Siebel Server, and Database 
Server on the same machine.

13.1.2.3 Clustered Web Server Configuration
The clustered Web server configuration tests two or more Web servers accessing a 
single Siebel server. This configuration is used to test how Siebel and the database 
server handles load balancing from multiple users accessing from multiple Web 
browsers and systems.

13.1.2.4 Clustered Siebel Servers Configuration
The clustered Siebel server configuration tests two or more Siebel servers handing Web 
traffic and accessing a single database server. This configuration is used to test Web 
traffic load balancing on clustered Siebel servers and how the database server handles 
load balancing from multiple Siebel servers accessing from multiple systems.

13.1.2.5 Clustered Database Server Configuration
The clustered database server configuration tests two or more database servers 
handing Siebel data and accessing the database storage. This configuration is used to 
test Siebel data load balancing on clustered database servers and how the database 
storage handles load balancing from multiple database servers accessing from 
multiple systems.

Note: In general, Siebel applications are more memory intensive 
than CPU intensive. If trade-offs need to be made in test hardware 
decisions, memory should be given higher consideration than CPU 
speed.
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Notes:

■ Siebel web applications use Cookies to maintain the state information.

■ Each User must be logged into the same Siebel Application Server as first logged 
into.

■ Do not use round robin load-balancing for clustered Siebel servers

13.1.3 Siebel Correlation Library
OpenScript includes a Siebel Test Automation library that Oracle Application Testing 
Suite applications can communicate with when creating Scripts. The Siebel Correlation 
Library is installed automatically as part of he OpenScript installation.

13.1.4 Script Creation Techniques
The following are tips and techniques to use when creating Siebel load test scripts 
using the Oracle Functional Testing application:

■ Disable browser caching to make sure the pages are returned from the server 
rather than the browser cache.

■ Record actions from login through logout to make sure parameters are passed 
properly between page navigations.

■ Record actions slowly in the Siebel environment to make sure the recorder records 
all actions to the OpenScript script. If possible, watch as the script pages are added 
to the script tree.

■ Close the external browser window after recording.

■ Save the script. When you save a Siebel proxy-recorded script, OpenScript 
automatically creates a Java Agent version of the script in the workspace. 
Depending upon the size of the script, the file save operation may take some time.

13.1.5 Recording Scripts for Load Tests
Siebel load testing scripts are recording in an external browser window using the 
OpenScript proxy recorder. When you record a Siebel Load Test Script, OpenScript 
automatically starts the proxy recorder and opens an external browser window when 
you click the Record button on the toolbar. Once the external browser opens, you can 
load your Siebel application and start recording page navigation.

OpenScript does not support record and playback of the CTI Toolbar. URLS with the 
SWECmd=WaitForCmd are filtered out by default.

13.1.6 Starting the Siebel Application
Start the Siebel application in the browser using the start URL:

http://hostname/application/start.swe

where hostname is the machine name or IP address of the Siebel server and 
application is the Siebel application to start. For example:

http://siebelserver/callcenter_enu/start.swe

Enter the start URL and command into the browser address. As you navigate pages, 
the OpenScript proxy recorder records page navigation to the Script tree. You can view 
the nodes in the script tree and in the Java code.
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13.1.7 Playing Back Scripts
OpenScript playback provides a convenient way to test and verify the page navigation 
recorded to the script.

1. Open a Siebel load test script in OpenScript.

2. Select Playback from the Script menu or click the toolbar button to verify the 
script plays back correctly.

3. Select items in the Results view and review the tabs in the Details view to check 
for any errors. Click the Headers tab to view request and response header data.

4. Verify that the response headers do not contain content or data value errors. One 
type of content error to check for is a "204 No Content" error. For example:

HTTP/1.1 100 Continue
Server: Microsoft-IIS/5.0
Date: Fri, 20 Mar 2009 15:51:47 GMT
X-Powered-By: ASP.NET
HTTP/1.1 200 OK: 
Server: Microsoft-IIS/5.0
Date: Fri, 20 Mar 2009 15:51:47 GMT
X-Powered-By: ASP.NET
content-language: en
cache-control: no-cache
content-type: text/html;charset=UTF-8
content-length: 3762

See the Troubleshooting Load Testing Issues section in the Testing Siebel eBusiness 
Applications documentation in the Siebel document bookshelf for additional examples 
of common issues to resolve for load test scripts.

13.1.8 Resolving Script Issues
Each navigation node in the script tree shows the URL, Post Data, Recorded Headers, 
and Custom Dynamic values recorded to the script.

Expand nodes in the script tree to view the navigation sequence.

The PostData node shows the Siebel entities included in the page navigation. 
OpenScript Siebel Load Testing recorder automatically recognizes and parameterizes 
Siebel entities for Load testing. Playing back a script verifies that the recorder 
parameterized the Siebel entities properly.

The tree view nodes show the automatically created dynamic value names and Siebel 
path for parameters required for the next page. The name and Siebel path are shown as 
variable nodes under the post data node. It also shows automatically parameterized 
Siebel functions in curly braces, for example:

SWEC={{@SWECount}}

If a script does not playback correctly, or has errors, you may need to add custom 
dynamic values for Siebel parameters.

Check the PostData name/value pairs for the page navigation to verify the Siebel 
entities have been properly parameterized during recording. Any Siebel parameters 
that pass dynamic data from one page to the next should have custom dynamic values.

The PostData on the next page shows the destination of the dynamic values passed 
from the previous page.
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13.1.8.1 Siebel Entities to Parameterize
The following table shows some common Siebel commands that may appear in the 
PostData of the page navigation:

See the SWE API section of the Siebel Portal Framework Guide in the Siebel document 
bookshelf for additional information about Siebel Web Engine (SWE) commands, 
methods, and arguments.

13.1.9 Using Databanks with Siebel
Data values in Siebel post data strings can be parameterized in a script and connected 
to a Databank file that provides input data for data-driven tests. The OpenScript script 
editing options let you specify additional Siebel method names that use parameterized 
data.

1. Record or open a Siebel script in OpenScript.

2. Select Find/Replace from the Edit menu.

3. Type SWEMethod and click Find.

4. Continue clicking Find until you locate the SWEMethod that requires databanked 
values.

For example, the PostData in a script page may contain the following record data 
name=value pair:

s_1_2_49_0=doctest

The SWEMethod that posts the data is SWEMethod=Mirror Add GotoView.

To use Databank parameters for the data values:

1. Select Script Properties from the Script menu.

2. Select the Assets type.

3. Select Databanks.

4. Click Add.

5. Select the Repository from the My Repositories tree or file location from the My 
Computer tree.

Siebel Command Name

SWEACn Application Count

SWEBMC Bookmark

SWEBRS Browser Retry Sequence

SWEBID Browser ID

_sn Cookie

SWEFI Form ID

SWEVLC View Layout Cache

SWETS Timestamp

SWEC SWE Count

SWERowId, SWERowIds Row IDs

s_#_#_#_# Record Data
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6. Select the Databank file from the repository or file folder.

7. Enter an alias name to use for the Databank or leave the default alias name. The 
default alias name is the name of the .CSV Databank file.

8. Click OK.

9. Click OK to add the Databank file.

10. Right click the parameter node in the script tree that you want to substitute with a 
databank variable and select Substitute Variable.

11. If necessary expand the Databanks node and select the databank field you want to 
use as the input parameter data.

12. Click Finish.

13. The script node name/value pair changes to show the Databank alias name, field 
name, and recorded value as a variable value. For example:

SWEUserName={{siebel_data.login,sadmin}}

14. Click the Playback toolbar button to playback the script once to verify the it plays 
back correctly.

15. Click the Iterate toolbar button to playback the script with a Databank.

16. Set the Iteration count, starting record, and data usage and click OK.

17. Verify the script plays back correctly.

18. Save the script.

19. In the Oracle Load Testing application, add the script to the Scenario.

20. Double-click the script name in the Scenario to define the Scenario details for the 
script.

21. Make sure Java Client is selected as the User mode.

22. Set the Use Databanks setting is set to True (if the Use Databanks setting is not 
shown, open the Scenario Details and set the option in the Main section).

23. Click Run Test and run the load test.

See the following sections of this document for details about defining ServerStats 
metrics and running tests in the Oracle Load Testing console. See the Oracle Load 
Testing User's Guide for additional information about using the features and options in 
the Oracle Load Testing application.

13.1.10 Preparing the Siebel Server Manager Commands
The Oracle Load Testing ServerStats uses the Siebel Server Manager program to 
retrieve statistics from the Siebel Server while running Virtual Users in a load test. The 
ServerStats Metrics need to be configured to run the Siebel Server Manager with input 
commands from a batch file and a file containing the input commands. The batch file 
and command input file must be created and placed on the Siebel Server where the 
ServerStats Metrics can access and run the batch file. This section explains the basic 
requirements of the batch file and command input file.
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13.1.10.1 Creating the Batch File
Use any ASCII editor to create a batch file and a commands file to run the Siebel 
Server Manager program. The batch file name will be referenced in the Oracle Load 
Testing ServerStats metrics. You can use any name for the batch file (for example 
srvrmgr_cmds.txt).

Use the following syntax to specify the command in the batch file to start the Siebel 
Server Manager program:

\\machine IP\path to Siebel server bin\srvrmgr -g gateway -e enterprise -u 
username  p password -i input_File

For additional information about using the Siebel command-line server-monitoring 
program (srvrmgr) and command line flags, see the Siebel System Administration Guide 
Version 7.7 (or newer) documentation in the Siebel document bookshelf.

The following is an example of a command in a batch file to start the Siebel Server 
Manager:

\\10.16.111.00\c$\sea77\siebsrvr\bin\srvrmgr -g gateway -e siebel -u sadmin -p 
sadmin -i srvrmgr_cmds.txt

13.1.10.2 Creating the Command Input File
The command input file contains the commands to run in the Siebel Server Manager 
program. The command input file will be automatically run by the batch file at each 
Oracle Load Testing ServerStats Collection Interval. The example in the previous 
section uses the file name srvrmgr_cmds.txt as the input file in the srvrmgr 
command. You can use any file name as long as the batch command matches the file 
name of the input file.

Note: Starting the Siebel command-line server-monitoring program 
may require system administrator level privileges for the Siebel server. 
The Oracle Load Testing system testing the Siebel server needs the 
required user permissions to access the Siebel server and run the 
Siebel Server Manager program from the local host.

Parameter Description

machine IP The machine name or IP address or 
the Siebel Server.

path to Siebel server bin The drive and directory path to the 
Siebel Server Manager program on 
the Siebel server.

gateway The Network address of the Siebel 
Gateway Name Server machine.

enterprise Siebel Enterprise Server name.

username Siebel Server administrator 
username.

password Siebel Server administrator 
password.

input_File The name of a file containing 
commands to run in the Server 
Manager program.
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srvrmgr_cmds.txt is a text file that contains the sequence of commands to run in 
the Siebel Server Manager program. The following is an example of an input file with 
Server Manager commands:

configure list statistics show STAT_ALIAS, CURR_VAL
list statistics
quit

The configure list statistics show STAT_ALIAS, CURR_VAL command 
specifies which Siebel Statistics to return from the srvrmgr program. STAT_ALIAS, 
CURR_VAL are the column names of the data values to return. STAT_ALIAS is the alias 
for the Statistic name. CURR_VAL is the current value for the statistic. quit closes the 
Siebel Server Manager session.

The list statistics command returns the statistics to Siebel Server terminal. The 
Oracle Load Testing Data Collector uses the Regular Expressions defined in the 
ServerStats metrics to extract specific data from the statistics returned from the 
srvrmgr program.

You can configure the srvrmgr commands to provide any of the available statistics 
data that can be returned by the srvrmgr program. See the Siebel System Administration 
Guide Version 7.7 (or newer) documentation in the Siebel document bookshelf for 
additional information about Siebel Server Manager commands.

13.1.10.3 Siebel Statistics
The srvrmgr program returns the following statistics:

Name Alias Description

Average Connect Time AvgConnTime Average connect time for 
Object Manager sessions

Average Reply Size AvgRepSize Average size of reply 
messages (in bytes)

Average Request Size AvgReqSize Average size of request 
messages (in bytes)

Average Requests Per Session AvgReqs Average number of requests 
per Object Manager session

Average Response Time AvgRespTime Average Object Manager 
response time

Average Think Time AvgThinkTime Average end-user think time 
between requests

Avg SQL Execute Time AvgSQLExecTime Average time for SQL execute 
operations (in seconds)

Avg SQL Fetch Time AvgSQLFetchTime Average time for SQL fetch 
operations (in seconds)

Avg SQL Parse Time AvgSQLParseTime Average time for SQL parse 
operations (in seconds)

CPU Time CPUTime Total CPU time for component 
tasks (in seconds)

Elapsed Time ElapsedTime Total elapsed (running) time 
for component tasks (in 
seconds)
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Maximum Peak Memory 
Usage

MaxPeakMemory Peak Mem used by task. Rolls 
up differently from 
MinPeakMemory

Minimum Peak Memory 
Usage

MinPeakMemory Peak Mem used by task. Rolls 
up differently than 
MaxPeakMemory

Num of DBConn Retries NumDBConnRtrs Number of Retries due to DB 
Connection Loss

Num of DLRbk Retries NumDLRbkRtrs Number of Retries due to 
Deadlock Rollbacks

Num of Exhausted Retries NumExhstRtrs Number of Times All Retries 
are Exhausted

Number of SQL Executes SQLExecs Total number of SQL execute 
operations

Number of SQL Fetches SQLFetches Total number of SQL fetch 
operations

Number of SQL Parses SQLParses Total number of SQL parse 
operations

Number of Sleeps Sleeps Total number of sleeps for 
component tasks

Object Manager Errors Errors Number of errors encountered 
during Object Manager 
session

Reply Messages RepMsgs Number of reply messages 
sent by the server

Request Messages ReqMsgs Number of request message 
received by the server

SQL Execute Time SQLExecTime Total elapsed time for SQL 
execute operations (in 
seconds)

SQL Fetch Time SQLFetchTime Total elapsed time for SQL 
fetch operations (in seconds)

SQL Parse Time SQLParseTime Total elapsed time for SQL 
parse operations (in seconds)

Sleep Time SleepTime Total amount of sleep time for 
component tasks (in seconds)

Tasks Exceeding Configured 
Cap

TskXcdCfgCpt Number of tasks stated that 
exceeded configured capacity

Tests Attempted TestsAttempted Number of tests that were 
started

Tests Failed TestsFailed Number of tests that failed

Tests Successful TestsSuccessful Number of tests that were 
successful

Total Database Response Time DBRespTime Total Database 
Response/Processing Time 
(milliseconds)

Total Reply Size RepSize Total size (in bytes) of reply 
messages

Name Alias Description
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For additional information about monitoring Siebel servers, see the System Monitoring 
and Diagnostics Guide for Siebel eBusiness Applications Version 7.7 (or newer) 
documentation in the Siebel document bookshelf.

13.1.10.4 Batch File Location
Once you create the batch file and command input file, copy the files to the Oracle 
Load Testing local host in the C:\Oracle\DataCollector directory.

13.1.11 Defining ServerStats Metrics
Oracle Load Testing ServerStats metrics are used to collect the data from the Siebel 
Server Manager program. This section explains how to set up Virtual Agents in 
ServerStats (Oracle Load Testing) to run the Siebel Server Manager program 
(srvrmgr) from the command-line interface.

1. Start the Oracle Load Testing application.

2. Select ServerStats from the Tools menu.

3. Select the Metrics node to view the metric categories.

4. Click New.

5. Enter a name for the metric.

6. Enter a description for the metric.

7. Select Virtual Agent as the Metric type.

8. Click Next.

9. Enter the name of the batch file you created to run the srvrmgr program in the 
Command Line field.

10. Enter a Regular expression to parse the data returned from the srvrmgr program 
in the Matching Regexp field. For the Server Manager srvrmgr program 
commands:

configure list statistics show STAT_ALIAS, CURR_VAL
list statistics
quit

use the following format for the Regular Expression:

/aliasName\s+([0-9]+)/ 

For example, for the server statistic Average Connect Time, the Regular 
Expression would be as follows:

Total Request Size ReqSize Total size (in bytes) of request 
messages

Total Response Time RespTime Total Object Manager 
response time (in seconds)

Total Tasks TotalTasks Total number of tasks 
completed for server 
components

Total Think Time ThinkTime Total end-user think time (in 
seconds)

Name Alias Description
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/AvgConnTime\s+([0-9]+)/

11. Enter the Key of value to use to parse the Regular Expression. The key of value 
specifies which set of parenthesis in the Regular Expression is the value to return. 
For Siebel statistics using the above Regular Expression, set the value to 1.

12. Enter the Sample Multiplier value. The following window shows a metric 
configured to retrieve the Average Connect Time.

13. Click the Test button to get to the Test Setup window:

14. Click OK to start the test.

15. Verify the results returned the correct data value for the statistic from the Siebel 
Server Manager program and did not return any errors.

Note: Manually run the srvrmgr program and list statistics on the Siebel Server 
to verify the Regular Expression returns the correct data value/format.

16. Click Close.

17. Click Finish. The New metric appears in the Metrics tree under the User Defined 
node.

18. Repeat steps 4-17 to configure additional Siebel metrics in ServerStats.

For additional information about monitoring Siebel servers, see the System Monitoring 
and Diagnostics Guide for Siebel eBusiness Applications Version 7.7 (or newer) 
documentation in the Siebel document bookshelf.

13.1.12 Defining a ServerStats Configuration
Oracle Load Testing ServerStats configurations are used to specify which metrics to 
include when collecting the data from the Siebel Server Manager program and update 
Oracle Load Testing graphs and reports. You can also create a metric profile for Siebel 
metric and use the profile as part of the configuration. This section explains how to 
define a ServerStats configuration and add metrics to the configuration.

1. If necessary, start Oracle Load Testing and select ServerStats from the Tools menu.

2. Click the Configurations node to view existing configurations.

3. Click New.

4. Enter a name for the configuration.

5. Enter a description for the configuration.

6. Click Save. The configuration window adds new options for adding and updating 
monitors:

7. Click Add a new monitor.

8. Expand the User defined node and select a Siebel metric.

9. Click Next.

10. Set the monitored system, data collector, and collection interval.

11. Click Next. The metric is added to the list of monitors in the configuration.

12. Click Finish.

13. Repeat steps 7-12 to add additional metrics to the configuration.

14. Click Test.
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15. Verify the results returned the correct data values for the statistics from the Siebel 
Server Manager program and did not return any errors.

16. Click Close.

17. Click Update.

13.1.13 Importing Pre-Configured Metrics and Profiles to Oracle Load Testing
If you have pre-configured files for Siebel metrics and metric profiles, you can import 
the files into Oracle Load Testing rather than manually configure the metrics and 
profiles.

1. If necessary, start the Oracle Load Testing application.

2. Select Import File from the Tools menu.

3. Select the File Type. The ServerStats file types are as follows:

4. Click Browse to select the file location.

5. Select the drive and directory location.

6. Select the file to import.

7. Click Open.

8. Click Upload.

9. Click OK.

10. Repeat steps 4-9 for each file to upload.

13.1.14 Running Load Tests in the Oracle Load Testing Console
Select the script or a user-defined profile from the Select scripts & user-defined 
profiles list.

1. Select a script.

2. Click Add to scenario.

3. Set the # VUs.

4. Set the System to use to test.

5. Set the User Mode to Java Client.

6. Set the Iteration Delay to 1.

7. Set the VU Pacing (Think Time) to Recorded.

8. Click Add to Autopilot.

9. Set the Start and Stop test options.

10. Set the Virtual User Rampup.

11. Select the ServerStats configuration you defined earlier.

Type Extension

ServerStats Metric .metric

ServerStats Metric Profile .hwm

ServerStats Configuration .config
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12. Click the Run Test button.

13. Specify the Session to Save.

14. Click OK.

13.1.14.1 Viewing VU Grid
The Virtual User grid lets you view the progress of the script playback for each virtual 
user. If necessary, click the Watch VU Grid tab to switch to the grid.

13.1.14.2 Viewing ServerStats
The ServerStats display lets you view the Siebel Server statistics in real time using the 
ServerStats display window. Select ServerStats Display from the Tools menu to open 
the ServerStats display.

13.1.15 Generating Graphs and Reports Using Oracle Load Testing
You can generate graphs from Virtual User and ServerStats data during run time and 
for post testing analysis.

13.1.15.1 Creating Custom Runtime Graphs
The View Run Graphs tab lets you generate custom graphs during test runtime.

1. While the load test is running, click the View Run Graphs tab.

2. Click New Graph. A new blank graph tab is added to the Reports and Graphs 
section.

3. Scroll down to the Filters section.

4. Enter a graph name.

5. Expand ServerStats Monitors in the Available Data Series tree.

6. Select the data series to add to the graph.

7. Click Add Data Series.

8. Repeat to add other monitors to the data series.

9. Specify the Plot Data Series and Y-Axis Scaling options.

10. Click Generate Graphs. The custom graph appears as a new tab in the Reports 
and Graphs section.

13.1.15.2 Creating Custom Reports
The Create Reports tab lets you generate custom reports and graphs after the test for 
post-testing analysis.

1. Click Create Reports tab.

2. Click New Graph.

3. Select the ServerStats session as the Available Data Series.

4. Expand Available Data Series tree.

5. Select the data series to add to the graph.

6. Click Add Data Series.

7. Click Generate Graph. The custom graph appears as a new tab in the Reports and 
Graphs section.
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You can export the graph to Adobe PDF, Microsoft Excel, or Comma Separated 
Value formats.

The Create Reports tab also lets you retrieve session performance reports after the test 
for post-testing analysis.

1. If necessary, click Create Reports tab.

2. Click the Sessions tab in the Reports and Graphs section.

3. Select the Session. The report appears in the Reports and Graphs section.

You can export or print the session report.

13.2 Setting Siebel Correlation Preferences
To set Setting Siebel Correlation preferences:

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu.

3. Expand the OpenScript node and the Correlation category.

4. Expand the Siebel 7.7 library.

5. Select or clear the check boxes to enable or disable specific rules.

6. Click the Add or Edit buttons to modify rules in the library. See "Siebel Correlation 
Library" on page 13-14 for a list of correlation rules.

7. Click OK.

13.3 Siebel Correlation Library
The Siebel correlation library defines the correlation rules for Siebel (Siebel versions 
7.7, 7.8, 8.0, 8.1). The correlation rules specify the variable names and regular 
expressions to use to replace dynamic data in Siebel applications and navigations. 

The default Siebel correlation library provided with the OpenScript Siebel Module 
includes the following correlation rules:

■ Siebel SWEACn - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern SWEACn=(\d+) and replaces it with the 
variable name SWEACn in all locations.

■ Siebel SN - Variable Substitution - this rule locates text in the HTML matching 
the Regular Expression pattern _sn=((.+?))& and replaces it with the variable 
name siebelsn in the specified location. The variable name siebelsn uses the 
Regular Expression pattern name="_sn" value="(.+?)".

■ Siebel SN - Variable Substitution - this rule locates text in the HTML matching 
the Regular Expression pattern _sn=((.+?))& and replaces it with the variable 
name siebelsn in the specified location. The variable name siebelsn uses the 
Regular Expression pattern _sn=(.+?)".

■ Siebel SN - Variable Substitution - this rule locates text in the HTML matching 
the Regular Expression pattern _sn=((.+?))& and replaces it with the variable 
name siebelsn in the specified location. The variable name siebelsn uses the 
Regular Expression pattern _sn=(.+?)&.

■ Siebel SWEBID - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern SWEBID(=|%3d|%3D)((\d+)) and 
replaces it with the variable name SWEBID in the specified location. The variable 



Siebel Script Functions

Using the Siebel Load Test Module 13-15

name SWEBID uses the Regular Expression pattern navigator.id = 
([0-9]+?);.

■ Siebel SWEBID - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern SWEBID(=|%3d|%3D)((\d+)) and 
replaces it with the variable name SWEBID in the specified location. The variable 
name SWEBID uses the Regular Expression pattern navigator.id = 
&quot;([0-9]+?)&quot;.

■ Siebel SWEBMC - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern 
SWEBMC=(((|%3d|%3D)\d+([&amp;%]|$|\s))) and replaces it with the 
variable name SWEBMC in the specified location. The variable name SWEBMC uses 
the Regular Expression pattern SWEBMC(?:=|%3d|%3D)(\d+)[?&amp;?%].

■ Siebel SWEBRS - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern 
SWEBRS=(((|%3d|%3D)\d+([&amp;%]|$|\s))) and replaces it with the 
variable name SWEBRS in the specified location. The variable name SWEBRS uses 
the Regular Expression pattern &lt;input type = &quot;hidden&quot; 
name=&quot;SWEBRS&quot;\s+?value=&quot;(\d+?)&quot;&gt;.

■ Siebel SWEFI - Variable Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern 
SWEFI=(((|%3d|%3D)\d+([&amp;%]|$|\s))) and replaces it with the 
variable name SWEFI in the specified location. The variable name SWEFI uses the 
Regular Expression pattern (.)SWEFI\1(\d+)\1.

■ SWETS - Function/Text Substitution - this rule locates text in the HTML matching 
the Regular Expression pattern SWETS=((\d{13,})) and replaces it with the 
function {{@timestamp}} in the specified location.

■ SWSECancelID - Function/Text Substitution - this rule locates text in the HTML 
matching the Regular Expression pattern 
SWSECancelID=(=|%3d|%3D)((\d{10,})) and replaces it with the function 
{{@timestampsecs}} in the specified location.

■ RefID - Function/Text Substitution - this rule locates text in the HTML matching 
the Regular Expression pattern refID(=|%3d|%3D)((\d+)) and replaces it 
with the function {{@CounterRefID}} in the specified location.

■ Siebel Correlation Rule - this rule locates all Siebel SWEC and RowIDs.

■ currentDate - Substitute Recorded Date - this rule locates the date the script was 
recorded and replaces it with the function {{@today(M/dd/yyyy)}}. 

13.4 Siebel Script Functions
Dymanic values returned from a Siebel server can be replaced by Siebel-specifc 
OpenScript functions. The following script functions are available specifically for 
Siebel scripts when you substitue a variable value:

■ {{@CounterRefID,x}}: this function is used to replace the refID parameter in 
QueryString or Postdata strings. x is the recorded value.

■ {{@siebeltimestampsecs}}: this function is used to replace the Sieble time 
stamp with the script variable {{@siebeltimestampsecs}}. The value is the 
current timestamp in seconds instead of milliseconds.

■ {{@SWECount}}, {{@SWECInc(x)}}, {{@SWECSet()}}, : these functions are 
used to replace SWEC parameters in QueryString or Postdata strings.
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14Using the Utilities Module

This chapter provides instructions on using the OpenScript Utilities Module, which 
provides commonly used testing functions.

14.1 About the Utilities Module
The Utilities Module provides commonly used testing functions. The Utilities Module 
is an extension to the Basic Module. The OpenScript Utilities module includes the 
following features:

14.1.1 Key Features of the Utilities Module
■ Text File Processing. Read values from text files including CSV and XML files as 

well as copy and move files in the file system.

■ Databases. Read values from various databases such as Oracle as well as other 
JDBC-ODBC Compliant databases

■ XML XPath Expressions. Generate XPath expressions from valid XML files.

You can use the Utilities Module API to enhance recorded scripts with additional 
testing functionality. Commands that are specific to the Utilities Module are part of 
the "utilities" class.

14.2 Using Text File Processing
You can use the utilities API to read values from text files including CSV and 
XML. The following sections explain how to use the utilities API.

14.2.1 Reading Lines of Text from a File
The Utilities API includes a method for reading lines of text from a file.

To add code that reads text from a file:

1. Record a Web Functional Test script.

2. Open the Java Code view.

3. Add the readLines() method to specify the file to read. The following example 
shows how to parse the lines of text in a file and print to the OpenScript console 
view:

String[] lines = utilities.getFileService().readLines("C:/Sample.txt");
for (String line : lines) {
getLogger().info(line);
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}

14.2.2 Reading Text from a CSV File
The Utilities API includes a method for reading text from a Comma Separated Value 
text file.

To add code that reads text from a .CSV file:

1. Record a Web Functional Test script.

2. Open the Java Code view.

3. Add the loadCSV method to specify the file to read. For this example the file, 
"C:\customer.csv" contains this data:

FirstName,LastName,MiddleInitial
John,James,R
Mary,Simpson,J

The following example shows how to parse a table of text in a .CSV file and print 
values to the OpenScript console view:

Table table = utilities.loadCSV("C:/customer.csv");
Row row = table.getRow(0);
getLogger().info(row.get("LastName"));

14.2.3 Reading Text from an XML File
The Utilities API includes a method for reading text from a XML formatted text file.

To add code that reads text from a .XML file:

1. Record a Web Functional Test script.

2. Open the Java Code view.

3. Add the loadXML method to specify the file to read. For this example the file, 
"C:\oceans.xml" contains this data:

<?xml version="1.0" encoding="utf-8"?>
<Oceans>

<ocean name="Artic"/>
<ocean name="Atlantic"/>
<ocean name="Indian"/>
<ocean name="Pacific"/>
<ocean name="Southern"/>

</Oceans>

The following example shows how to parse a table of text in a .XML file and print 
values to the OpenScript console view:

XML xml = utilities.loadXML("C:/oceans.xml");
XML root = xml.getChildren()[0];
getLogger().info(root.getTagName());
XML[] oceans = root.getChildren();

for (XML ocean : oceans){
getLogger().info(ocean.getAttribute("name"));
}
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14.3 Getting Values from a Database
Getting values from a database requires a database definition, a database SQL query or 
SQL execute and a disconnect from the database.

To get values from a database:

1. Open or create a Web Functional Test script project.

2. Select the node where you want to add the database definition.

3. Select the Script menu and then select Other from the Add sub menu.

4. Expand the Database node and select Database Definition.

5. Click OK.

6. Specify the database definition information.

7. Click Test to verify a successful connection.

8. Click OK.

9. Select the node where you want to add the database connection. The OpenScript 
database connect method is optional. The database connect is invoked 
automatically when calling execute or query methods

10. Select the Script menu and then select Other from the Add sub menu.

11. Expand the Database node and select Connect. 

12. Select the database alias and click OK.

13. Select the node where you want to add the database query or execute statement.

14. Select the Script menu and then select Other from the Add sub menu.

15. Expand the Database node and select SQL Query or SQL Execute.

16. Specify the SQL statement to query or execute and click Add.

17. Specify a data type and define a name for the parameter.

18. Click OK.

19. Click OK.

20. Select the node where you want to add the database disconnect.

21. Select the Script menu and then select Other from the Add sub menu.

22. Expand the Database node and select Disconnect.

23. Select the database alias and click OK.

In the Java Code view, the utilities.getSQLService() methods will be 
added to the script code for each database script action:

utilities.getSQLService().define("oracledb ",
"oracle.jdbc.driver.OracleDriver", "00.000.000.000", "myuserID",
decrypt("ZgEQLMIUx8EVDAhfAenvyg=="));

utilities.getSQLService().connect("oracledb ");
utilities.getSQLService().query("oracledb ",

"SELECT * FROM Users where username = ?", list("testdb"));
utilities.getSQLService().execute("oracledb ", 

"SELECT * FROM Users where username = ?", list("sqlexecute1"));
utilities.getSQLService().disconnect("oracledb ");
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14.4 Using the XPath Generator
The Utilities Module includes an XPath generator utility that you can use to generate 
an XPath Expression to a selected element from a valid XML file.

To use the XPath Generator:

1. Create an XML file that contains the tags and values to use to generate the XPath 
expression. The following is an example of a simple XML file that can be used with 
the XPath Generator:

<?xml version="1.0" encoding="utf-8"?>
<Oceans>

<ocean name="Artic"/>
<ocean name="Atlantic"/>
<ocean name="Indian"/>
<ocean name="Pacific"/>
<ocean name="Southern"/>

</Oceans>

2. Create and record a test script. The Tools menu appears on the OpenScript menu 
bar for functional and load test scripts. 

3. Select Generate XPaths from the Tools menu.

4. Click Browse and select the XML file to load. 

5. Expand the XML tree under the Tags section of the XML file. 

6. Select the XML tag to use to generate the XPath. The generated XPath appears in 
the XPath Expression field in a form similar to /Oceans/ocean[1]/@name.

7. Use the Ctrl+C and Ctrl+V keyboard combinations to copy and paste the 
generated XPath to a method in the Java Code tab of the script view. 

The XPath Expression can be used in the utilities findByXPath API method, as 
follows:

utilities.loadXML("filePath").findByXPath(xpath, xml)
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15Using the Shared Data Module

This chapter provides instructions on using the OpenScript Shared Data Module, 
which allows data to be passed between scripts using a shared data queue.

15.1 About the Shared Data Module
The Shared Data Module is an extension module to the OpenScript Basic Module that 
extends the other testing modules with message queue and hash map capabilities.

The "Shared Data" is in memory space that resides in the Oracle Load Testing server 
and is managed by a "Shared Data Manager". The Shared Data Service supplies 
methods for users to store/retrieve data in a memory space that resides in Oracle Load 
Testing. The methods send messages to the Shared Data Manager in Oracle Load 
Testing through the JMS server. There are two JMS topics configured in a JMS 
configuration file for WebLogic that are used for the communication: 
"topic/requestSharedData" and "topic/responseSharedData". They are created by the 
WebLogic server startup process and destroyed once the server is stopped.

The scripts or java agents send messages to the "topic/requestSharedData" and receive 
messages from the "topic/responseSharedData". The Shared Data Manager sends to 
the "topic/responseSharedData" and receives from "topic/requestSharedData". The 
messages are serializable java objects. Agents send request messages that request data 
or request to store data. The Shared Data Manager sends response messages that 
contain the requested data.

Shared Data is typically used to pass data between load testing scripts running as 
Virtual Users in Oracle Load Testing. The Shared Data can also be used to pass data 
between functional testing scripts running from the command line.

15.1.1 Key Features of the Shared Data Module
The Shared Data module provides the following features:

■ Preferences - shared data connection preferences can be set under the OpenScript 
Playback preferences.

■ Message Queue Manipulation - create, peek, and poll message queues. 

■ Hash Map Manipulation - create, put, and get hash maps.

■ Shared Data Module API - The Shared Data Module API includes a "sharedData" 
class that provides additional programming functionality.
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15.2 Setting Shared Data Preferences
To set Shared Data preferences:

1. Start OpenScript.

2. Select OpenScript Preferences from the View menu.

3. Expand the OpenScript node and the Playback category.

4. Select Shared Data.

5. Set the Shared Data Preferences as follows:

■ OATS Credentials: Specifies the authentication credentials to use to establish 
the communication between the shared queue and the Virtual User.

– Enable global shared data access credentials: When selected, when 
selected, the shard data access credentials are enabled. Specify the 
Address, User Name, and Password.

– Address: Specifies the address of the Oracle Load Testing for Web 
Application server to use for the shared data service.

– User name: Specifies the user name to use for authentication. The default 
name is oats unless changed in the Oracle Application Testing Suite 
configuration.

– Password: Specifies the password to use for authentication. This should be 
the same password specified in the Encryption setting of the General 
preferences if the Encrypt script data setting is selected.

■ Actions on Shared Data: Specifies actions on shared data.

– Timeout: Specifies the maximum number of seconds to wait for actions on 
shared data to occur before timing out.

6. Click OK.

15.3 Using the Shared Data Service
This section describes how to enable and use the Shared Data Service.

15.3.1 Enabling the Shared Data Service
To enable the Shared Data Service:

1. Start OpenScript.

2. Open an existing script or create and record a new script.

3. Select Script Properties from the Script menu. 

4. Select the Modules category.

5. Select the Shared Data module.

6. Click OK. The Shared Data Service will be added to the script class in the Java 
Code as follows.

@ScriptService oracle.oats.scripting.modules.sharedData.api.SharedDataService 
sharedData;

Once you have enabled the Shared Data service, you can set the password 
encryption and the connection parameters and then use the Shared Data API to 
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manipulate message queues or hash maps. You use the sharedData class in the 
Java code view to create manipulate message queues and hash maps.

15.3.2 Setting the Password Encryption
The Password encryption is set in the General Preferences. To set the password 
encryption:

1. Select OpenScript Preferences from the View menu.

2. Expand the OpenScript node and the General category.

3. Select Encryption.

4. Select Obfuscate script data or Encrypt script data to make sure the connection to 
the Shared Data Service uses an obfuscated or encrypted password.

5. If you select Encrypt script data, enter a password.

6. Click OK.

15.3.3 Setting the Connection Parameters
The connection parameters specify the Oracle Load Testing server to use for the 
Shared Data Service and the authentication settings. To set the connection parameters:

1. Make sure the Shared Data Service is enabled and the password encryption is 
specified as previously described.

2. Select the script node where you want to set the connection parameters.

3. Select Add from the Script menu and then select Other.

4. Expand the Shared Data folder.

5. Select Set Connection Parameters and click OK.

6. Set the connection parameters as follows:

■ Address: Specify the address of the machine to use for the Shared Data 
Service. For example: t3://localhost:8088 or 
t3://machinename.us.oracle.com:8088.

■ User Name: Specify the user name to use for authentication. The default name 
is oats unless changed in the Oracle Application Testing Suite configuration.

■ Password: Specify the password to use for authentication. 

7. Click OK. A Connection Parameters node will be added to the script tree. 

8. In the Java Code view, the Connection Parameters consist of the code executed in 
the sharedData.setConnectionParameters procedure:

sharedData.setConnectionParameters("t3://localhost:8088", "oats",
decrypt("L4I57b+KpnI2BQSRKPG88w=="));

After setting the connection parameters, you can user the Shared Data API in the Java 
Code view to manipulate data in message queues and hash maps.

In rare cases, some users may want to use a different Oracle Load Testing controller 
machine for sending and receiving shared data. If you want to do this, you must set up 
a domain trust between the Oracle Load Testing controller machine used for running 
the load test and the Oracle Load Testing controller machine used for hosting the 
shared data. 
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To set up a domain trust: 

1. Login to the Weblogic Administrator console.

2. Click the name of the domain in the Domain Configuration panel. 

3. Open the Security: General tab in the console.

4. Click the Advanced button.

5. Check the Cross Domain Security Enabled option.

6. Enter a password for the domain in the Credential text field. Choose the password 
carefully. You should use a combination of upper and lower case letters and 
numbers. 

7. Click Save. 

8. Restart Oracle Application Testing Suite Application Service.

Perform the same procedure in any other domains in which you want to establish 
trust. Make sure their credential values are the same.

15.3.4 Using The Shared Data API
The Shared Data Module includes a script Application Programming Interface (API) 
for Shared Data actions. You can use the Shared Data API to pass data between load 
testing scripts running as Virtual Users in Oracle Load Testing. The Shared Data can 
also be used to pass data between functional testing scripts running from the 
command line. Commands that are specific to the Shared Data Module are part of the 
"sharedData" class. The Shared Data service must be enabled separately for use with 
other types of scripts. You can also leverage other commands from other enabled 
classes (services) or general Java commands in your scripts.

Some examples of the Shared Data Module API include:

■ clearMap

■ clearQueue

■ createMap

■ createQueue

■ getFromMap

■ getKeysOfMap

■ getLengthOfQueue

■ offerFirst

■ offerLast

■ peekFirst

■ peekLast

Caution: For security reasons during a load test, Oracle recommends 
running the Shared Data service on the same machine as the OLT 
controller machine. Establishing a cross-domain security trust has 
security implications documented at 
http://download.oracle.com/docs/cd/E12840_
01/wls/docs103/secmanage/domain.html.
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■ pollFirst

■ pollLast

■ putToMap

■ removeFromMap

■ setConnectionParameters

■ waitFor

The setConnectionParameters API method can be added using the script Tree View. 
Additional methods can be added using the Java Code view.



Using the Shared Data Service

15-6 Oracle Application Testing Suite OpenScript User's Guide



A

Command Line Reference A-1

A Command Line Reference

This appendix lists the parameters for running OpenScript scripts from the command 
line. All OpenScript scripts may be run from the command line assuming that:

■ All resources that the script depends on, including databank files, object library 
files, and other scripts it runs, must be accessible from the machine where the 
script is run.

■ The installed version of OpenScript or agent is newer or the same as the version 
used to create the script.

To run a script from the command line, type:

[OpenScript Install Dir]/runScript.bat Path/ScriptName.jwg 
[options]

If OpenScript is not installed, but the OATS agent is installed, type:

[OATS Install Dir]/agent/runScript.bat Path/ScriptName.jwg 
[options]

Path is the full drive and directory path of the file location. When specifying file 
paths, use forward-slash (/) instead of back-slash (\) to ensure the back-slash notation 
is not misinterpreted in Java. If you must use back-slash notation, use double 
back-slashes (\\) in the file paths. For example, [OATS Install 
Dir]\\agent\\runScript.bat.

[options] may consist of any number of agent command line settings.

A.1 Specifying Command Line Settings 
This section describes how to use the command line settings.

■ Zero or more agent command line settings may be specified using the following 
format:

-settingId settingValue

Example:

runScript 
"C:/OracleATS/OpenScript/DefaultRepository/Default!/script1/script1.jwg" 
-iterations 5 -iterationDelay 5

■ If a settingValue contains spaces, the value may be enclosed inside 
double-quotation marks.

■ If a setting specifies a boolean true/false value, and no settingValue is 
specified, then a true value is assumed.



Supported Agent Command Line Settings

A-2 Oracle Application Testing Suite OpenScript User's Guide

■ Except where specifically noted, all settingId values are NOT case-sensitive. 
For example, -iterations 10 means the same thing as -ITERATIONS 10.

■ It is possible to view all settings passed to a script by typing the following code 
inside an OpenScript script:

info(getSettings().toString());

■ Custom settings may be used in a script and specified on the command line. For 
example, consider a script with a setting "todaysURLToTest":

public void run() throws Exception {
info("Today we will test the URL " + getSettings().get("todaysURLToTest"));

}

The setting may be specified on the command line using:

-todaysURLToTest "http://www.oracle.com/"

■ The runScript program can only accept 9 command line arguments. Use the 
-propertiesPath setting to specify a file containing a larger number of 
properties.

A.2 Supported Agent Command Line Settings 
Certain settings only apply to scripts that have a particular module applied. For 
example, HTTP load test script settings do not apply to Web functional test scripts.

A.2.1 General Settings
The following table lists the General command line settings.
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Setting Description

-dboptions 
alias:index:mode:range,alias:
index:mode:range,...

Specify which databank records to use when playing 
back the script. Use

-dboptions  
alias:index:mode:range,alias:index:mode
:range,... where alias is a databank alias, 
index is the first databank record to retrieve (first 
record is 1), and mode is one of the following strings:

■ FIRST_RECORD_ONLY - The Virtual User will 
only use the first record assigned to it.

■ USE_ALL_RECORDS - Stop after all records are 
used.

■ STOP_AFTER_LAST_RECORD - Stop after the 
last record in the databank file is used.

■ LOOP_FOREVER - Loop over all records for as 
many iterations are specified in -iterations. 
This is the default mode if no mode is specified.

range (optional) specifies which range of records to 
retrieve, in the format: rangeMin:rangeMax. For 
example, 5:10 means the range of records starting at 
record 5 and ending at record 10. It not specified, 
assumes all records in the databank.

Regardless of the databank setting, the VU will never 
run for more iterations than specified in the 
-iterations setting.

Example 1: To loop over records starting at the 5th 
row in the databank with alias "fmstocks_data", use:

-dboptions fmstocks_data:5:LOOP_FOREVER

Example 2: A databank with alias "fmstocks_data" 
contains 15 records. To iterate over records 5 through 
10, starting at record 7 (i.e. 7,8,9,10,5,6,7,8,9,10,5,6...), 
for at most 100 iterations, use:

-iterations 100 -dboptions fmstocks_
data:7:LOOP_FOREVER:5:10
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-delayPercentage mode Specify how long to delay between steps in a script. 
Depending on the mode, this setting may be used in 
conjunction with other settings. mode should be one 
of the following numbers:

-2 No Delay.

1 Use Recorded Delay. Optionally specify a 
minimum and maximum amount of delay using 
-delayMinSeconds n and -delayMaxSeconds 
m, where n and m are given in seconds. If unspecified, 
the default minimum and maximum amount of delay 
to use are 0 and 5 seconds, respectively. 

-1 Delay for a random number of seconds. 
Optionally specify a minimum and maximum 
amount of delay using -delayMinSeconds n and 
-delayMaxSeconds m, where n and m are given in 
seconds. If unspecified, the default minimum and 
maximum amount of delay to use are 0 and 5 
seconds, respectively. 

0 Delay for a random number of seconds using a 
percentage threshold range around the recorded 
delay. Optionally specify a lower and upper 
percentage delay range using -delayLower p and 
-delayUpper q, where p and q are a decimal value 
between 0 and 1. If unspecified, 0 will be used for the 
percentage threshold, resulting in the actual recorded 
delay being used.

-iterationDelay n Pause for n seconds between iterations.

-iterations n Run n iterations of the script.

-loglocalvudisplay true|false Create VUDisplay.txt and VUDisplay.csv result 
output files in the folder from which the agent was 
launched. The Virtual User Display output is not 
supported by functional test modules. The 
loglocalvudisplay setting is case-sensitive and 
must be exactly loglocalvudisplay.

-noReport true|false Set to true to disable generation of the results report. 
The default is false.

-preserveVariables true|false Set to true to preserve variables between iterations, 
false to clear variables between iterations. Variables 
refer to variables set using the Variables service, i.e. 
getVariables().set(), not local Java code 
variables.

-propertiesPath path Specify the full path of a Java .properties file 
containing additional command line setting 
name=value pairs to add.

Example usage:

-propertiesPath 
"C:/additionalSettings.properties"

Setting Description
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-resultReportFolder path Specify the output folder for all result report files.

If it is not specified, the default output folder will be: 
[script folder]/SessionId

Example usage:

-resultReportFolder "C:/result"

The output folder would be: 
C:/result/SessionId

-reportName name Override the file name used when generating the 
result report HTML file. Specify the name of the 
report including an extension, but excluding any 
path information. For example:

-reportName results.html

If not specified, OpenScript will determine a 
meaningful name for the result report HTML file 
based on the type of script being run. For example, 
an HTTP load test script calls its report 
httpReport.htm. A functional test script such as a 
Web functional test script calls its report 
FTReport.htm.

-repository repositoryString Specify the physical locations of one or more named 
repositories. repositoryString takes the form 
repositoryName=fullPathToRepository,rep
ositoryName2=fullPathToRepository2,... 
This setting is required.  

When you run Version 9.0 OpenScript scripts from 
the Version 9.10 Command Line Interface, you must 
use the -repository command line argument to 
pass to the Oracle Load Testing Virtual User Agent 
all repositories used by the script. This includes all 
repositories used for all Databanks, Object Libraries, 
and Child Scripts X levels deep.

In Version 9.0, The Oracle Load Testing Virtual User 
Agent would use the default repository 
(C:/<installdir>/OFT) if the repository 
command line argument was not specified. In 
Version 9.10, the multi-user environment default 
repository changed to <yourmachinename>.<your 
username>.Default in the <user.home> location. 
This change requires that the repositoryName= 
repositoryPath string be specified as a command 
line argument for all repositories including the 
default repository.

Always specify the repositoryString inside 
double-quotes.

Example usage:

-repository 
"JohnComputer.johndoe.Default=D:/OracleATS/OFT
,SharedRepository=\\testserver/OurScripts"

-stopVUserOnFailure 
true|false

Specify whether or not the virtual user will continue 
running more iterations after a fatal error. Use the 
Error Recovery settings to control which errors 
should be fatal.

Setting Description
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A.2.2 Browser Settings 
The following table lists the Browser command line settings.

A.2.3 HTTP Settings 
The following tables list the HTTP command line settings.

A.2.3.1 Proxy 
The following table lists the proxy command line settings.

Setting Description

-browser.type type Specify the browser type to use for script playback 
where type is one of the following (use exact case 
and no spaces): 

■ InternetExplorer

■ Firefox

The default is InternetExplorer.

-browser.startupTimeout n Specify n seconds to wait for the browser to start 
before timing out. The default is 15 seconds.

-browser.overridePath path OpenScript automatically detects where Internet 
Explorer and Firefox browser processes physically 
exist in the file system. In case the path to one of 
these browsers is incorrect, specify an alternative 
path to use when launching the specified browser 
type. This setting is not intended to be used to 
specify the path to an unsupported browser.

Example usage:

-browser.pathOverride 
"D:/Programs/Firefox/firefox.exe"

-browser.extraArgs args Specify any additional startup arguments that 
OpenSript should use when launching the browser 
process on playback. The default is no additional 
arguments other than what OpenScript may require 
internally.

-browser.hide true|false For Internet Explorer browser only, specify true to 
hide the browser during playback. This setting has 
no effect on Firefox. If certain actions in the script 
require the browser to be visible, such as key presses 
and physical mouse clicks, the script will not 
playback correctly. The default is false; browser is 
visible.

Setting Description

-http.proxyHost host Set the proxy host to the specified host. If no proxy 
host is specified, then no proxy is used.

Example usage:

-http.proxyHost "proxyserver.mycompany.com"
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A.2.3.2 Compression 
The following table lists the compression command line settings.

A.2.3.3 Headers 
The following table lists the header command line settings.

-http.proxyPort port_number Set the proxy port to the specified port_number.

Example usage:

-http.proxyPort 1234

-http.proxyUsername username If the proxy host requires authentication, provide the 
username. Ignored if http.proxyHost and 
http.proxyPort are not set.

-http.proxyPassword password If the proxy host requires authentication, provide the 
password. Ignored if http.proxyHost and 
http.proxyPort are not set. The password is not 
encrypted when provided on the command line.

-http.nonProxyHosts hostsList Specify a list of host names that the agent should not 
forward through the specified proxy defined by 
http.proxyHost and http.proxyPort. Separate 
multiple host names by a | delimeter. The host name 
must match the host being requested, as seen in the 
Host HTTP request header.

Setting Description

-http.useGzip true|false Enable GZIP compression. The client will add gzip 
to every Accept-Encoding HTTP request header. If 
the server responds with GZIP-compressed data, 
OpenScript will decompress it. The default value is 
true.

-http.useDeflate true|false Enable Deflate compression. The client will add 
deflate to every Accept-Encoding HTTP request 
header. If the server responds with 
Deflate-compressed data, OpenScript will 
decompress it. The default value is false.

Setting Description

-http.userAgentHeader Browser Emulation. Specify the User-Agent header 
string to use when making requests. It is not required 
and harmless to include the User-Agent: prefix in 
the value itself. Most OpenScript scripts override this 
setting with the User-Agent header value found 
during recording. 

Example usage:

-http.userAgentHeader "Mozilla/4.0 
(compatible; MSIE 6.0; Windows NT 5.0)"

-http.language language Set the value of the Accept-Language HTTP 
header. If no value specified, the agent tries to 
determine the language header by looking at the 
system language.

Setting Description
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A.2.3.4 Connections 
The following table lists the connection command line settings.

A.2.3.5 Other 
The following table lists other HTTP command line settings.

-http.version version Specify the HTTP version string to append to each 
request, i.e. HTTP/1.1 or HTTP/1.0. If no value 
specified, agent will use HTTP/1.1

-http.accept acceptString Specify the HTTP Accept header to send by default 
for all requests.

Setting Description

-http.useKeepAlive true|false Specify whether or not to keep HTTP connections 
alive after using them. Default is true to enable 
keep-alive connections.

-http.maxKeepAliveRequests n Specify an integer n number of requests to make 
before closing a keep-alive connection. Must be used 
together with http.useKeepAlive.

-http.maxConnections n Specify an integer n maximum number of 
connections a single virtual user may have open 
concurrently before blocking (waiting) for a new 
connection to become available. This setting only 
applies in OpenScript when concurrent sections are 
used in the script. The default value if not set is 2 
connections per virtual user.

-http.connectionSpeed n Specify the number of bytes/sec n to limit the 
download speed. For example, to download at 
56KBps, specify 56000. If no value specified, or an 
empty string is specified, this method assumes true 
line speed should be used.

Setting Description

-http.ignoredUrls list_of_
urls

Specify a comma-separated list of case-insensitive 
URLs not to request during playback. The URLs only 
need to be the ENDS of URLs, not the entire URLs.

Example usage:

-http.ignoredUrls ".jpg,.gif,.css."

-http.cacheEmulation mode Specify if/how the browser should cache 
downloaded contents. Each virtual user maintains its 
own cache. The mode value is one of the following 
values:

■ 1 - Repeat User; use a cache and do not clear the 
cache after each iteration.

■ 2 - First Time User; use a cache and clear the 
cache after each iteration.

■ 3 - Do Not Cache; do not cache any contents.

The default value is 3, do not cache.

Setting Description
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A.2.3.6 Download Manager 
The following table lists the Download Manager command line settings.

-http.useCookies true|false Specify whether or not to allow the browser to 
remember and use session or persistent cookies 
during playback. The default value is true, use 
cookies.

-http.downloadLocalFiles 
true|false

Specify whether or not the agent should download 
files that exist in the local file system. When local files 
are not downloaded, the contents are not displayed 
in the Oracle Load Testing Virtual User Display, and 
it is not possible to solve variables against the 
contents, for example. The default value is false, do 
not download local files.

-http.preserveCookies 
true|false

Set to true if cookies should be preserved between 
iterations. Set to false if cookies will be cleared 
between iterations. The default value is false, do 
not preserve cookies between iterations.

-http.preserveConnections 
true|false

Set to true if the browser should attempt to reuse 
any open browser connections if possible between 
iterations. Each virtual user maintains its own set of 
connections that it never shares with other virtual 
users. The default value is true, preserve 
connections between iterations.

-http.maxContentSize n Specify the maximum number of kilobytes (KB) to 
download from a server for a given request. Set to -1 
to mean unlimited download size. The default value 
is -1, unlimited.

-http.socketTimeout n Specify the socket timeout in n seconds. The default 
value is 120 seconds.

Setting Description

-http.useDownloadManager 
true|false 

Specify if the Download manager is enabled during 
playback. The default is false.

-http.downloadManager.css 
true|false 

Specify if css resources in <Link> tags are 
downloaded during playback. The default is false.

-http.downloadManager.Image 
true|false 

Specify if image resources in <Img> tags, in the 
"background" attribute of a tag, or in <style> tags 
with "background:url" patterns are downloaded 
during playback. The default is false.

-http.downloadManager.embedob
ject true|false 

Specify if object resources in <Embed> tags or in 
<Object> tags are downloaded during playback. The 
default is false.

-http.downloadManager.script 
true|false 

Specify if script resources in <Script> tags are 
downloaded during playback. The default is false.

-http.downloadManager.applet 
true|false 

Specify if applet resources in <Applet> tags are 
downloaded during playback. The default is false.

-http.ignoredUrlRegexps 
string

Specify the Regular Expression(s) string to use to 
ignore specific resources. For example, the expression 
Login_Banner(.+?) would not download 
resources such as Login_Banner1.gif and Login_
Banner2.gif. Multiple Regular Expressions can be 
separated using a comma (,).

Setting Description
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A.2.4 Functional Test Settings 
The following table lists the functional test command line settings.

A.2.5 Oracle EBS/Forms Functional Test Settings 
The following table lists the Oracle EBS/Forms functional test command line settings.

A.2.6 Oracle EBS/Forms Load Test Settings 
The following table lists the Oracle EBS/Forms load test command line settings.

Setting Description

-ft.smartMatch format Specifies which format to use to match attributes in 
an object path. The match format can be a 
wildcard-formatted or a 
regular-expression-formatted expression. format is 
one of the following settings:

wildcard - (default) Attributes in the given path 
may contain wildcards for unknown characters. For 
example, title="Welcome, user *". An asterisk "*" 
matches any number of characters. A question mark 
"?" matches any single character.

wildcardThenRegex - Attributes in the given path 
may contain a wildcard-formatted expression, or a 
regular-expression-formatted expression. During 
playback, an attempt is first made to find the object 
assuming a wildcard format, then an attempt is made 
to find the object assuming a regular-expression 
format.

regex - Attributes in the given path may contain a 
regular expression.

-ft.smartMatch true|false When true, the OpenScript Smart Match object 
identification ranking feature is enabled. The default 
value is true, enabled.

Setting Description

-formsft.startup_timeout n Specify n seconds to wait for the Forms applet to 
start up before failing the script due to a timeout. The 
default value is 30 seconds.

-formsft.action_timeout n Specify n seconds to wait when trying to play an 
action before timing out because the object required 
could not be found. The default value is 30 seconds.

-formsft.capture_screenshot 
true|false

Set to true to capture screenshots of the Forms 
applet during playback. The default value is true.
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A.2.7 Shared Data Settings 
The following table lists the shared data command line settings.

Setting Description

-formslt.capture_message_
details true|false

Set to true to capture message details during 
playback. When true, OpenScript captures and stores 
Forms message requests, responses, and information 
about all loaded Forms components during playback. 
This information is useful to have when debugging 
the script.

OpenScript displays captured details in the 
"Messages" and "Object Details" tabs of the Details 
view. Oracle Load Testing displays this information 
in the Virtual User Display based on the "Virtual User 
Display" settings.

Capturing message details is a memory-intensive 
operation. During heavy load testing, it is 
recommended to clear this setting to reduce the 
amount of heap space required by the agent.

Setting Description

-ENCRYPTION_PROPERTIES_FILE 
path\encryption.properties

Specify the full path and file name to use for 
encrypted password authentication. The file name is 
C:\Documents and 
Settings\username\osworkspace\.metadata\.plugins
\oracle.oats.scripting.utilities\encryption.properties. 
Set the password encryption to Encrypt script data in 
the General Encryption Preferences. Generate the 
encrypted password by selecting Add from the 
Script menu, expanding the Shared Data folder and 
selecting Set Connection Parameters. Specify the 
connection parameters then specify the path and file 
name in your command line settings.

-sharedData.actionTimeout 
timeout

Specify the maximum time in seconds to wait for the 
requested data to return.

-sharedData.Address address Specify the address of the Oracle Load Testing for 
Web Application server to use for the shared data 
service. For example: t3//:localhost:8088 or  
t3://machinename.us.oracle.com:8088.

-sharedData.Password password Specify the password to use for authentication. Note 
that this is a clear text password that is not secure.

-sharedData.encryptedPassword 
encryptedPassword 
-ENCRYPTION_PROPERTIES_FILE 
path\encryption.properties 

Specify the encrypted password to use for 
authentication. Set the password encryption to 
Encrypt script data in the General Encryption 
Preferences. Generate the encrypted password by 
selecting Add from the Script menu, expanding the 
Shared Data folder and selecting Set Connection 
Parameters. Specify the connection parameters then 
copy the encrypted password from the Java Code 
view to your command line settings similar to the 
following example:

-sharedData.encryptedPassword 
gLM7NB+n7Yba0FlspMDX8A== -ENCRYPTION_
PROPERTIES_FILE path encryption.properties
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A.2.8 Web Functional Test Settings 
The following table lists the Web functional test command line settings.

A.2.9 Error Recovery Settings 
All Error Recovery settings are specified using the form:

-errorRecoverySettingId action

action is one of the following constants (case-sensitive):

■ Ignore - proceed with the script as if the error did not occur. The error will still be 
logged to the console/log file.

■ Warn - report the error, but continue running the script.

-sharedData.obfuscatedPasswor
d obfuscatedPassword

Specify the obfuscated password to use for 
authentication. Set the password encryption to 
Obfuscate script data in the General Encryption 
Preferences. Generate the obfuscated password by 
selecting Add from the Script menu, expanding the 
Shared Data folder and selecting Set Connection 
Parameters. Specify the connection parameters then 
copy the obfuscated password from the Java Code 
view to your command line settings similar to the 
following example:

-sharedData.obfuscatedPassword 
RG5CE6b1u8cG9VzbbnW6cQ==

-sharedData.UserName name Specify the user name to use for authentication. The 
default name is oats unless changed in the Oracle 
Application Testing Suite configuration.

Setting Description

-web.event_time_out n Specify the Object Timeout n in seconds. If an object 
cannot be found in n seconds, the action will fail. The 
default value is 60.

-web.capture_html true|false Specify whether or not to capture the browser HTML 
during playback.

-web.capture_screenshot 
true|false

Specify whether or not to capture screenshots during 
playback.

-web.clear_cookies true|false Specify whether or not to clear browser cookies 
between iterations.

-web.clear_cache true|false Specify whether or not to clear the browser cache 
between iterations.

-web.webdom_proxy_port n Specify the port used for communication between the 
web browser and the agent. The default value is 
7666.

-web.capture_screenshot_
interval n

Specify the number of milliseconds to wait after a 
new page is detected and the screenshot is captured. 
The default value is 500.

-web.date_format date_format_
string

Specify a date format string to override the default 
date format string used when performing date 
validation tests.

Setting Description
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■ Fail - report the error and fail the current iteration of the script.

A.2.9.1 General 
The following table lists the general error recovery settings.

A.2.9.2 Functional Testing 
The following table lists the functional testing error recovery settings.

A.2.9.3 HTTP 
The following table lists the HTTP error recovery settings.

A.2.9.4 Oracle EBS/Forms Functional Testing 
The following table lists the Oracle EBS/Forms Functional Testing error recovery 
settings.

Setting Description

err.basic.VARIABLE_NOT_FOUND Variable Not Found.

err.basic.CREATE_VARIABLE_ERROR Create Variable Failed

err.basic.FILE_NOT_FOUND File Not Found

err.basic.SEGMENT_PARSER_ERROR Segment Parser Failed

err.basic.BINARY_DECODING_EXCEPTION Binary Decode Failed

err.basic.ENCRYPTION_SERVICE_NOT_
INITIALIZED

Encryption Service Not Initialized

err.basic.GENERAL_SCRIPT_EXCEPTION Unexpected Script Error

Setting Description

err.functionalTest.FT_MATCH_ERROR Text Matching Test failed

err.functionalTest.OBJECT_TEST_ERROR Object Test failed

err.functionalTest.TABLE_TEST_ERROR Table Test failed

Setting Description

err.http.ZERO_LENGTH_DOWNLOAD Zero Length Downloads

err.http.MATCH_ERROR Text Matching Test failed

err.http.RESPONSE_TIME_ERROR Response Time error

err.http.SOLVE_ERROR Solve Variable failed

err.http.HTML_PARSING_ERROR HTML Parsing error

err.http.INTERNET_INVALID_URL Invalid URL

err.http.INVALID_HTTP_RESPONSE_CODE Invalid HTTP Response Code

err.http.KEYSTORE_LOAD_ERROR Client Certificate Keystore error

Setting Description

err.formsFT.FORMS_FT_ERROR Oracle Forms Error
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A.2.9.5 Oracle EBS/Forms Load Testing 
The following table lists the Oracle EBS/Forms Load Testing error recovery settings.

A.2.9.6 Web Functional Testing 
The following table lists the Web Functional Testing error recovery settings.

A.2.9.7 Utilities 
The following table lists the Utilities error recovery settings.

Setting Description

err.formsLT.CONNECT_ERROR Forms Connect Error

err.formsLT.IO_ERROR Forms Input/Output Communication 
Error

err.formsLT.MATCH_ERROR Forms Content Match Failed

err.formsLT.PLAYBACK_ERROR Forms Playback Error

err.formsLT.COMPONENT_NOT_FOUND Forms Component Not Found

Setting Description

err.webdom.RESPONSE_TIME_ERROR Response Time Error

err.webdom.WEBDOM_SOLVE_ERROR Solve Variable Failed

Setting Description

err.utilities.SQL_ERROR SQL Execute Error

err.utilities.XML_PARSING_ERROR XML Parsing Error

err.utilities.CSV_LOADING_ERROR CSV Loading Error
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B Error Message Reference

This appendix lists the error messages for the OpenScript Workbench Platform and 
HTTP and Siebel Modules.

B.1 Basic Module Error Messages
This section list the Error messages for the OpenScript Workbench Basic Module.

B.1.1 General Script Exceptions

B.1.2 Binary Decoding Exceptions

Error Message Description

File not found: {0} The file was not found.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: ERR_FILE_NOT_FOUND

Failed to create variable {0}, path={1} Failed to create the specified variable.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: ERR_CREATE_VARIABLE_
ERRORCODE

An unexpected exception occurred in 
the script. Script section: {0}.

Represents an unexpected exception in the user's 
script code.

Error Component ID: 
oracle.oats.scripting.modulesbasic.api

Error Code ID: ERR_GENERIC_ERROR_CODE

Error Message Description

Failed to decode character at offset {1} 
in string "{0}"

This exception may be thrown while converting a 
string into binary using the {@link 
oracle.oats.scripting.modules.basic.api.utilities.Binary
Util#hexString2Binary(String)} method.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: ERR_BINARY_DECODE
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B.1.3 Script Creation Exceptions

Error Message Description

Could not find script "{0}" in 
workspace "{1}" in repository "{2}"

Indicates that the specified script could not be found in 
the indicated workspace and repository.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: SCRIPT_NOT_FOUND

Script not found: {0} Indicates that the specified script could not be found in 
the path.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: SCRIPT_PATH_NOT_FOUND

Exception occurred while reading 
script {0}.

An exception occurred while reading the specified 
script.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: EXCEPTION_READING_SCRIPT

Failed to load script class {0}. Class 
not found.

Indicates that a script class failed to load.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: FAILED_TO_LOAD_SCRIPT_CLASS_
NOT_FOUND

Failed to load virtual user class {0}. Indicates that a virtual user class failed to load.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: FAILED_TO_LOAD_VUSER_CLASS

Failed to create instance of virtual 
user class {0}.

Indicates that an instance of a virtual user class failed 
to be created.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: FAILED_TO_CREATE_VUSER_
INSTANCE

Failed to load script class {0}. {1} Indicates that a script class failed to load.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: FAILED_TO_LOAD_SCRIPT_CLASS

Failed to create instance of script "{0}". Indicates that an instance of script class failed to be 
created.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: FAILED_TO_CREATE_SCRIPT_
INSTANCE
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B.1.4 Segment Parser Exceptions

Error Message Description

Parameter missing: {0} Indicates that a parameter was not found when 
parsing {{ }} syntax calling 
Transforms.transform(String, Variables)

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: PARAMETER_NOT_FOUND

Unknown segment type: {0} Indicates that a parameter was not recognized when 
parsing {{ }} syntax calling 
Transforms.transform(String, Variables)

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: UNKNOWN_SEGMENT_TYPE

Unexpected end of string found while 
parsing string "{0}"

Indicates that an end of string was not recognized 
when parsing {{ }} syntax calling 
Transforms.transform(String, Variables)

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: UNEXPECTED_END_OF_STRING

Unexpected parent segment type {0} 
found while parsing string "{1}"

Indicates that a parent type was not recognized when 
parsing {{ }} syntax calling 
Transforms.transform(String, Variables)

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: UNEXPECTED_PARENT_SEGMENT

Unexpected end of function found near 
character offset {0} while parsing string 
"{1}"

Indicates that a function was not recognized when 
parsing {{ }} syntax calling 
Transforms.transform(String, Variables)

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: UNEXPECTED_END_OF_
FUNCTION

Function name not registered: {0}. Indicates that a function was not registered. Use 
SegmentParser.addCustomTransformFunction(oracle
.oats.scripting.main.CustomFunction functionName) 
to register custom transform functions.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: UNREGISTERED_FUNCTION

The following characters cannot be 
escaped: {0}

Indicates that a invalid characters were found when 
parsing {{ }} syntax.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: INVALID_CHARACTERS_IN_
SEGMENT
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B.1.5 Script Service Exceptions

B.1.6 URL Encoding Exceptions

B.1.7 Variable Exceptions

B.2 Platform Error Messages
This section lists the error messages for the OpenScript Workbench platform.

Error Message Description

Failed to create script service {0} Indicates that the specified script service failed.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: FAILED_TO_CREATE_SCRIPT_
SERVICE

Error Message Description

Failed to URL-encode string "{0}" Indicates that the specified URL encoding failed.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: URL_ENCODING_EXCEPTION

Error Message Description

Variable not found: {0} Indicates that a variable could not be found when 
evaluating a string containing curly brace {{ }} 
formatted data. This exceptions is typically thrown 
when {@link 
oracle.oats.scripting.modules.basic.api.Transforms#tra
nsform(String, 
oracle.oats.scripting.modules.basic.api.Variables)} is 
invoked using a string that references a non-existent 
variable.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: ERR_VARIABLE_NOT_FOUND

Variable "{0}" not found for string: {1} Indicates that a variable could not be found when 
evaluating a string containing curly brace {{ }} 
formatted data. This exceptions is typically thrown 
when {@link 
oracle.oats.scripting.modules.basic.api.Transforms#tra
nsform(String, 
oracle.oats.scripting.modules.basic.api.Variables)} is 
invoked using a string that references a non-existent 
variable.

Error Component ID: 
oracle.oats.scripting.modules.basic.api

Error Code ID: VARIABLE_NOT_FOUND_FOR_
STRING
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B.2.1 Browser Exceptions

B.2.2 SSL Exceptions

B.2.3 TCP Exceptions

Error Message Description

Exception parsing NTLM response: {0} Indicates an error parsing the NTLM response 
authentication protocol.

Error Component ID: oracle.oats.lbrowser

Error Code ID: BROWSER_NTLM_EXCEPTION

Cache look-up error. Could not find document with host {0}, file {1} in the 
local browser cache. Indicates an error looking for a 
document in the browser cache.

Error Component ID: oracle.oats.lbrowser

Error Code ID: BROWSER_CACHE_LOOKUP_
ERROR

Too many redirects. Browser will not redirect more than {0} times. 
Comparable WinInet error code: Error 12156: 
Redirect Failed. The redirection failed because either 
the scheme changed (for example HTTP to FTP) or 
all attempts to redirect failed (default is five 
attempts).

Error Component ID: oracle.oats.lbrowser

Error Code ID: BROWSER_TOO_MANY_
REDIRECTS

Error Message Description

Error creating new SSL session. Indicates an error creating a Secure Socket Layer 
session.

Error Component ID: oracle.oats.lbrowser

Error Code ID: ERROR_CREATING_SSL_SESSION

Failed to prepare SSL socket factory. Indicates an error preparing a Secure Socket Layer 
socket factory.

Error Component ID: oracle.oats.lbrowser

Error Code ID: FAILED_TO_PREPARE_SOCKET_
FACTORY

Error Message Description

The server name {0} could not be 
resolved.

Comparable WinInet error code: Error 12007: Name 
Not resolved. The server name could not be 
resolved. This happens when Java throws an 
UnknownHostException.

Error Component ID: oracle.oats.lbrowser

Error Code ID: ERROR_INTERNET_NAME_NOT_
RESOLVED
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The attempt to connect to the server {0} 
on port {1} failed.

Comparable WinInet error code: Error 12029: Cannot 
Connect. The attempt to connect to the server failed.

Error Component ID: oracle.oats.lbrowser

Error Code ID: ERROR_INTERNET_CANNOT_
CONNECT

The request to the proxy was invalid. Comparable to WinInet error code: Error 12033: 
Invalid Proxy Request. The request to the proxy was 
invalid.

Error Component ID: oracle.oats.lbrowser

Error Code ID: ERROR_INTERNET_INVALID_
PROXY_REQUEST

Invalid response received from proxy 
server: {0}.

Comparable to WinInet error code: Error 12033: 
Invalid Proxy Request. The request to the proxy was 
invalid.

Error Component ID: oracle.oats.lbrowser

Error Code ID: ERROR_INTERNET_INVALID_
PROXY_RESPONSE

The connection with the server has been 
terminated.

Comparable to WinInet error code: Error 12030: 
Connection aborted. The connection with the server 
has been terminated.

Error Component ID: oracle.oats.lbrowser

Error Code ID: ERROR_INTERNET_
CONNECTION_ABORTED

Timeout occurred while sending request 
to server.

Comparable to WinInet error code: Error 12002: 
Timeout. The request has timed out.

Error Component ID: oracle.oats.lbrowser

Error Code ID: ERROR_INTERNET_REQUEST_
TIMEOUT

Timeout occurred while waiting for 
server response.

Comparable to WinInet error code: Error 12002: 
Timeout. The request has timed out.

Error Component ID: oracle.oats.lbrowser

Error Code ID: ERROR_INTERNET_RESPONSE_
TIMEOUT

SSL exception occurred while 
connecting to {0} on port {1}. {2}

Indicates a Secure Socket Layer exception while 
connecting to the indicated server and port.

Error Component ID: oracle.oats.lbrowser

Error Code ID: SSL_CONNECT_EXCEPTION

Failed to bind socket to local port {0} Indicates a failure to bind to the socket on the 
indicated local port.

Error Component ID: oracle.oats.lbrowser

Error Code ID: FAILED_TO_BIND

Error Message Description
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B.2.4 HTTP Exceptions

B.3 HTTP Error Messages
This section lists the error messages for the HTTP Module.

B.3.1 HTTP Service Exceptions

Error Message Description

The URL is invalid. Comparable to WinInet error code: Error 12005: 
Invalid URL. The Uniform Resource Locator (URL) is 
invalid.

Error Component ID: oracle.oats.lbrowser

Error Code ID: ERROR_INTERNET_INVALID_URL

Failed to write HTTP request header: 
{0}.

Comparable to WinInet error code: Error 12030: 
Connection Aborted. The connection with the server 
has been terminated.

Error Component ID: oracle.oats.lbrowser

Error Code ID: WRITE_REQUEST_EXCEPTION_
HEADER

Failed to write request HTTP postdata: 
{1}.

Comparable to WinInet error code: Error 12030: 
Connection Aborted. The connection with the server 
has been terminated.

Error Component ID: oracle.oats.lbrowser

Error Code ID: WRITE_REQUEST_EXCEPTION_
POSTDATA

Failed to read HTTP response header 
from server.

Comparable to WinInet error code: Error 12152: 
Invalid Server Response. The server response could 
not be parsed.

Error Component ID: oracle.oats.lbrowser

Error Code ID: ERROR_READING_HTTP_
RESPONSE_HEADER

Failed to read HTTP response contents 
from server.

Comparable to WinInet error code: Error 12152: 
Invalid Server Response. The server response could 
not be parsed.

Error Component ID: oracle.oats.lbrowser

Error Code ID: ERROR_READING_HTTP_
RESPONSE_CONTENTS

Error Message Description

Comparable to WinInet error code: Error 
12005: Invalid URL. The Uniform 
Resource Locator (URL) is invalid.

Indicates a failure when attempting to validate the 
contents of a Siebel page.

Error Component ID: 
oracle.oats.scripting.modules.http.api

Error Code ID: ERROR_INTERNET_INVALID_
URL
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B.4 Oracle Forms Load Test Error Messages
This section lists the error messages for the Oracle Forms Load Test Module.

B.4.1 Connect Errors

Invalid HTTP response code: {0} The HTTP Service browser returns this error if an 
HTTP response is received from a web server 
containing a response code greater than or equal to 
400.

Error Component ID: 
oracle.oats.scripting.modules.http.api

Error Code ID: ERROR_INVALID_HTTP_
RESPONSE_CODE

Error parsing HTML. {0} Indicates an unexpected parsing failure in the 
HTTP service while parsing HTML.

Error Component ID: 
oracle.oats.scripting.modules.http.api

Error Code ID: HTML_PARSING_ERROR

Failed to solve variable {0} Indicates a failure during a match() operation. See 
oracle.oats.scripting.modules.http.api.ThinIteratin
gVUserScript#match(String, String, String, 
oracle.oats.scripting.modules.http.api.ThinIteratin
gVUserScript.Source, boolean, boolean). The actual 
error message is defined by the script. The error 
message shown is an example default error 
message.

Error Component ID: 
oracle.oats.scripting.modules.http.api

Error Code ID: MATCH_ERROR

Error Message Description

Connection Error (Generic): "{0}" Indicates a failure when attempting connect to the 
Oracle Forms server.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONN_ERROR_GENERIC

Connection Error: Failed to connect to 
forms server at URL "{0}

Indicates a failure when attempting connect to the 
Oracle Forms server at the specified URL.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONN_ERROR_HTTP_
CONNECT_EXCEPTION

Connection Error: Failed to connect to 
forms server over socket at "{0}:{1}".

Indicates a failure when attempting connect to the 
Oracle Forms server over the specified socket.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONN_ERROR_SOCKET_
CONNECT_EXCEPTION

Error Message Description
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Connection Error: No servlet session id 
found. 

Indicates the session ID for a servlet was not 
found.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONN_ERROR_
NOSERVLETSESSIONID

Connection Error: Invalid Session Cookie 
found.

Indicates the session cookie was invalid.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONN_ERROR_NEED_COOKIE

Connection Error: Unable to initialize 
runtime process. 

Indicates the runtime process for the forms server 
could not be initialized.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONN_ERROR_FAILED_TO_
INITIALIZE_PROCESS

Connection Error: Runtime process has 
unexpectedly terminated. 

Indicates an unexpected runtime process 
termination.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONN_ERROR_PROCESS_
STARTUP_TERMINATED

Connection Error: Session migration in 
progress.

Indicates the JSessionID you are using to post 
forms navigations to the server is incorrect.

EBS/Forms module plays back a script which is a 
combination of HTTP/Forms navigations. After 
playing the HTTP navigations successfully a 
JSessionID captured from the navigation right 
before the Forms Connect statement is used as the 
URL to send Forms navigations to the server. If this 
URL is not correlated correctly you will see the 
error string.

The most common way to fix this issue is to revert 
script to recorded and re-correlate it. This should 
automatically correlate the Connect statement.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONN_ERROR_SESSION_
MIGRATION_IN_PROGRESS

Connection Error: Cannot connect to OID 
server.

Indicates a failure connecting to the Oracle Internet 
Directory server.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONN_ERROR_OID_
CONNECTION_ERROR

Connection Error: The user does not have 
proper credentials for OID.

Indicates the user does not have proper 
authentication credentials to connect to the Oracle 
Internet Directory server.

Error Message Description
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B.4.2 I/O Errors

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONN_ERROR_OID_
AUTHENTICATION_ERROR

Connection Error: SSO user information is 
invalid.

Indicates the user Single Sign On authentication 
credentials are not valid.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONN_ERROR_INVALID_SSO

Connection Error: Multiple Sessions are 
disallowed in this transaction.

Indicates that multiple session are not allows for 
the transaction attempted.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONN_ERROR_MULTIPLE_
SESSIONS

Connection Error: Could not create the 
runtime process.

Indicates a failure to create a runtime process on 
the Forms server.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONN_ERROR_RUNTIME_
PROCESS_CREATION_ERROR

Error Message Description

Unexpected exception occurred while 
serializing a Forms Message.

Indicates an error occurred while transferring an 
Oracle Forms message between the client and the 
server.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: IO_ERROR_MESSAGE_
SERIALIZATION_EXCEPTION

Failed to read more than 10 server 
messages.

Indicates failed to read server message after ten 
tries.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: IO_ERROR_FAILED_TO_READ_
TEN_DATA_STREAMS

Forms input/output exception occurred. Indicates an unexpected input/output exception 
occurred.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: IO_ERROR

Forms encryption exception occurred. Indicates an encryption exception occurred.

Error Component 
ID:oracle.oats.scripting.modules.formsLT.api

Error Message Description
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B.4.3 Match Errors

Error Code ID: IO_ERROR_ENCRYPTION_
EXCEPTION

Communication with server is broken. 
Check nohup logs for detailed error.

Indicates a communication problem with the server. 
Run the nohup (no hang up) command an view thee 
error log.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: IO_ERROR_COMM_BROKEN

Throttling requested with a non-integer 
value "{0}".

Indicates Bandwidth throttling (limiting quantity of 
data) was requested using and non-integer value.

Error Component 
ID:oracle.oats.scripting.modules.formsLT.api

Error Code ID: IO_ERROR_THROTTLING_
NUMBER_FORMAT_EXCEPTION

Failed to read message from server. Indicates an exception occurred when trying to read 
an Oracle Forms message from the server.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: IO_ERROR_MESSAGE_READ_
EXCEPTION

Failed to read terminal message from 
server.

Indicates an exception occurred when trying to read 
an Oracle Forms terminal message from the server.

Error Component 
ID:oracle.oats.scripting.modules.formsLT.api

Error Code ID: IO_ERROR_TERMINAL_
MESSAGE_READ_EXCEPTION

Error Message Description

Text Matching Test "{0}" failed. Failed to 
match "{1}". 

Indicates a Text Matching Test failure and shows the 
test name and the text to match.

Error Component 
ID:oracle.oats.scripting.modules.formsLT.api

Error Code ID: MATCH_ERROR_TEXT_FAILED_
TO_MATCH

StatusBar Text Matching Test "{0}" failed. 
Failed to match "{1}".

Indicates a Status bar Text Matching Test failure and 
shows the test name and the text to match.

Error Component 
ID:oracle.oats.scripting.modules.formsLT.api

Error Code ID: MATCH_ERROR_STATUSBAR_
FAILED_TO_MATCH

Error Message Description
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B.4.4 Component Not Found Errors

B.4.5 Playback Errors

Error Message Description

Component "{0}" does not exist. Indicates an Oracle Forms component does not exist.

Error Component 
ID:oracle.oats.scripting.modules.formsLT.api

Error Code ID: COMPONENT_DOES_NOT_EXIST

Component with handler ID "{0}" does 
not exist. 

Indicates an Oracle Forms component with the 
specified handler ID does not exist.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: MATCH_ERROR_STATUSBAR_
FAILED_TO_MATCH

Component with handler ID "{0}" does 
not exist. Last seen alert message: "{1}". 

Indicates an Oracle Forms component with the 
specified handler ID does not exist and shows the 
last alert message.

Error Component ID: 
oracle.oats.scripting.modules.formsLT.api

Error Code ID: COMPONENT_ID_DOES_NOT_
EXIST_WITH_STATUS

Error Message Description

Control "{0}" not initialized. Indicates that control between client and server 
could not be initialized.

Error Component 
ID:oracle.oats.scripting.modules.formsLT.api

Error Code ID: CONTROL_INITIALIZE_ERROR

Cannot send forms messages. Not 
connected to forms server.

Indicates no connection to the Oracle Forms server.

Error Component 
ID:oracle.oats.scripting.modules.formsLT.api

Error Code ID: NOT_CONNECTED_ERROR

Invalid state exception. Indicates an invalid state.

Error Component 
ID:oracle.oats.scripting.modules.formsLT.api

Error Code ID: INVALID_STATE_EXCEPTION

Invalid state exception. Server sent the 
client a CREATE message for a 
component that was already created. 
Component handler ID is "{0}".

Indicates an invalid state because the server sent the 
client a CREATE message for a component that was 
already created and shows the handler ID.

Error Component 
ID:oracle.oats.scripting.modules.formsLT.api

Error Code ID: INVALID_STATE_EXCEPTION_
COMPONENT_ALREADY_EXISTS
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B.5 Shared Data Error Messages
This section lists the error messages for the Shared Data Module.

B.5.1 Shared Data Exceptions

Malformed Forms message exception. 
Forms could not parse the message, 
"{0}". 

Indicates an incorrectly formed Oracle Forms 
message stream and could not parse the message, 
"<Message... />" XML.

Error Component 
ID:oracle.oats.scripting.modules.formsLT.api

Error Code ID: MALFORMED_MESSAGE_
EXCEPTION

Unexpected error occurred. {0}. Indicates any other exception error.

Error Component 
ID:oracle.oats.scripting.modules.formsLT.api

Error Code ID: UNEXPECTED_ERROR

Error Message Description

CreateDataException Indicates a failure when attempting to create a new 
queue.

Error Component ID: 
oracle.oats.scripting.modules.sharedData.api

Error Code ID: CREATE_QUEUE_EXCEPTION

CreateDataException Indicates a failure when attempting to create a new 
hash map.

Error Component ID: 
oracle.oats.scripting.modules.sharedData.api

Error Code ID: CREATE_MAP_EXCEPTION

OATSCredentialException Indicates a failure when the OATS credential is 
incorrect or not provided.

Error Component ID: 
oracle.oats.scripting.modules.sharedData.api

Error Code ID: OATS_CREDENTIAL_EXCEPTION

PutDataException Indicates a failure when adding items to a queue.

Error Component ID: 
oracle.oats.scripting.modules.sharedData.api

Error Code ID: PUT_TO_QUEUE_EXCEPTION

PutDataException Indicates a failure when  adding items to a hash 
map.

Error Component ID: 
oracle.oats.scripting.modules.sharedData.api

Error Code ID: PUT_TO_MAP_EXCEPTION

SharedDataServiceInitException Indicates a failure when initializing the service.

Error Message Description



Siebel Error Messages

B-14 Oracle Application Testing Suite OpenScript User's Guide

B.6 Siebel Error Messages
This section lists the error messages for the Siebel Module.

B.6.1 Siebel Exceptions

B.7 Web Error Messages
This section lists the error messages for the Web Functional Test Module.

B.7.1 Web Service Exceptions

Error Component ID: 
oracle.oats.scripting.modules.sharedData.api

Error Code ID: SHARED_DATA_INITIALIZE_
EXCEPTION

RequestDataException Indicates a failure when retrieving data/info from 
a queue.

Error Component ID: 
oracle.oats.scripting.modules.sharedData.api

Error Code ID: REQUEST_DATA_FROM_QUEUE_
EXCEPTION

RequestDataException Indicates a failure when retrieving data/info from 
a hash map.

Error Component ID: 
oracle.oats.scripting.modules.sharedData.api

Error Code ID: REQUEST_DATA_FROM_MAP_
EXCEPTION

Error Message Description

Siebel content failure. {0} Indicates a failure when attempting to validate the 
contents of a Siebel page.

Error Component ID: 
oracle.oats.scripting.modules.siebel.api

Error Code ID: SIEBEL_CONTENT_FAILURE

Error Message Description

Invalid object path: {0}. Indicates the object identification path is invalid, 
where {0} is the full path to the object.

Error Component ID: 
oracle.oats.scripting.modules.webdom.api

Error Code ID: ERR_INVALID_PATH

Error Message Description
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Object not found: {0}. Indicates the object identified by {0} was not found.

1. Select OpenScript Preferences from the View 
menu.

2. Expand OpenScript and the Playback section.

3. Select Web Functional and increase the Object 
Timeout value.

-or-

Verify that object path is correct.

Some window.close() actions may be triggered 
by a previous action and playback of a previous 
action may close the window automatically. You 
may need to remove the window.close() 
manually from the Java Code.

Error Component ID: 
oracle.oats.scripting.modules.webdom.api

Error Code ID: ERR_OBJECT_NOT_FOUND

Timeout occurred waiting for page to 
load.

Indicates a timeout occurred waiting for any page 
or specific page.

1. Select OpenScript Preferences from the View 
menu.

2. Expand OpenScript and the Playback section.

3. Select Web Functional and increase the Object 
Timeout value.

-or-

Change 
web.browser("<path>").waitForPage(nul
l) to a specific duration. For example, 
web.browser("<path>").waitForPage(120
) means wait for 120 seconds. Modify the <path> 
to a specific path or set it to use wait for any page.

Error Component ID: 
oracle.oats.scripting.modules.webdom.api

Error Code ID: ERR_TIMEOUT_WAITING_FOR_
PAGE

Cannot playback the {0} action on this 
element.

Indicates the action is not supported by the 
element identified by {0}.

Error Component ID: 
oracle.oats.scripting.modules.webdom.api

Error Code ID: INVALID_ACTION_ON_
ELEMENT

Failed to playback: {0}. Indicates a failure to execute an action on the object 
identified by {0}.

Error Component ID: 
oracle.oats.scripting.modules.webdom.api

Error Code ID: FAIL_TO_PLAYBACK

Failed to get a response after sending the 
message: {0}.

Indicates a failure to get a playback result from the 
browser after sending the request identified by {0}.

Error Component ID: 
oracle.oats.scripting.modules.webdom.api

Error Message Description
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Error Code ID: FAIL_TO_GET_RESULT

Launch browser timeout after {0} seconds. Indicates a failure to find a browser within the 
duration of 'Startup Timeout' setting ({0} seconds) 
in the browser preferences.

1. Select OpenScript Preferences from the View 
menu.

2. Expand OpenScript and the General section.

3. Select Browsers and increase the Startup 
Timeout value.

-or-

Check if the "Oracle Application Testing Suite 
Helper Service" is running, or restart it.

-or-

Close all browsers (IE, FF), run 
<installdir>\OpenScript\UninstallBrowserHelpers.
bat and InstallBrowserHelpers.bat.

Error Component ID: 
oracle.oats.scripting.modules.webdom.api

Error Code ID: FAIL_TO_GET_RESULT

Fail to build message: {0}. Indicates a failure to build a message specified by 
{0}. The attributes or Identification of a custom 
DOM element is not correct.

Error Component ID: 
oracle.oats.scripting.modules.webdom.api

Error Code ID: ERR_BUILD_MESSAGE

Error Message Description
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C Troubleshooting

This chapter provides information and possible solutions to known issues in 
OpenScript.

C.1 Installation
In some instances, the OpenScript Internet Explorer and/or Firefox browser plug-ins 
fail to install properly. You can manually install and uninstall Internet Explorer and/or 
Firefox browser plug-ins using batch files provided with OpenScript to resolve the 
issue.

The following batch files are located in <installdir>\OpenScript

■ InstallBrowserHelpers.bat

■ UninstallBrowserHelpers.bat

Usage: file.bat installation path [install|uninstall] [IE|FF|both]

The following example shows the usage and default values:

InstallBrowserHelpers.bat C:\OracleATS\OpenScript\ install both

See the remarks in the batch files for additional information.

C.2 OpenScript Script Execution in Oracle Test Manager
The following additional steps are required in order to run the following types of 
OpenScript scripts from Oracle Test Manager:

■ Siebel Functional

■ Oracle Forms Functional

■ Web Functional scripts that rely on system input events, such as key press or 
mouse click

Note: On Windows 2000 systems, the InstallBrowserHelpers.bat 
installation does not detect that the .NET Framework 2.0 is installed 
and will attempt to reinstall it, which may cause an installation failure 
for the .NET Framework 2.0. However, the .NET Framework 2.0 is 
installed during the initial OpenScript installation and should be 
present on the system. Check Add/Remove Programs in the Control 
Panel to verify the .NET Framework 2.0 installation.
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It is necessary to run these scripts using an interactive desktop of a named Windows 
user account that is always logged in.

1. For Siebel and Oracle Forms, the named user's account must have visited the 
Siebel or Oracle Forms site at least once to ensure that all necessary ActiveX 
controls and plug-ins are installed in the named user's browser.

2. On the Oracle Test Manager agent machine that will run the scripts, stop the 
"Oracle Agent Starter Service" and configure it to start manually.

3. On the Oracle Test Manager agent machine, login as the named Windows user 
account that will run the scripts. From a command prompt, run:

C:\OracleATS\agentmanager\bin\AgentManagerService.exe -c 
C:\OracleATS\agentmanager\bin\AgentManagerService.conf

where C:\OracleATS is the OATS installed folder.

4. The named user account must remain logged into the system at all times that 
scripts will be run.

C.3 Manual Installation of Firefox Extension
In some cases, if Firefox was installed by upgrading from previous version, when 
recording scripts of Web Functional Test with Firefox, Firefox is launched but Firefox 
does not have the Web DOM extension and Web navigation actions are not recorded. 
In this case, you may have to install the extension manually/separately.

The Firefox extension is located in 
"<installdir>\OpenScript\plugins\oracle.oats.scripting.modules.webdom.firefoxExten
sion_2.3.0.0400\xpi"

To install the FF extension by manually:

1. Go to the extension directory of the Firefox profile "default". (Usually 
C:\Documents and Settings\<username>\Application 
Data\Mozilla\Firefox\Profiles\9iusc98z.default\extensions

2. Create a file named "webdom@openscript" in the extension directory.

3. Copy the path of the Firefox extension 
("<installdir>\OpenScript\plugins\oracle.oats.scripting.modules.webdom.firefox
Extension_2.3.0.0400\xpi") as the content of file "webdom@openscript".
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DThird-Party Licenses

This appendix contains licensing information about certain third-party products 
included with Oracle Application Testing Suite 9.00. Unless otherwise specifically 
noted, all licenses herein are provided for notice purposes only.

The sections in this appendix describe the following third-party licenses:

■ Apache 2.0 (Apache BCEL, Apache Jakarta, Apache WSS4J XML, Tomcat, TrueZip, 
Xalan, XMLBeans)

■ Cryptix

■ GubuSoft Treeview Icons

■ Apache 1.1 (IBM XML Parser)

■ Intel Utilities

■ JaWin

■ JDOM

■ John McTainsh Utility

■ "Generic MIT" (MIT HTML Parser)

■ OpenSSH [IGNORE PARTS WHERE CODE ISN'T USED]

■ Pradeep Sahu Job Scheduler

■ Tanuki Java Service Wrapper

■ TidyCom

■ Tim Taylor Utility

■ Vincent Rijmen's AES Encryption

■ Xstream

■ Zlib

Apache 2.0 (Apache BCEL, Apache Jakarta, Apache WSS4J XML, Tomcat, TrueZip, 
Xalan, XMLBeans)
All recipients must receive a copy of the Apache 2.0 license (see the Appendix below 
for attachment of the license http://www.apache.org/licenses/LICENSE-2.0.html);

All distributed source code, documentation, and configuration files must retain all 
copyright, patent, trademark and attribution notices contained in the Apache 
materials;

If the Apache code retains a "NOTICE" text file, then Oracle must include in 
distributions of such Apache code the "NOTICE" text file in at least one of the 
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following locations: (i) within a"NOTICE" text file, (ii) within the source code or 
documentation if distributed with the Apache code, (iii) within a display generated by 
the distributed code in recognizable third party notice locations; and

Cryptix
"Copyright (c) 1995-2005 The Cryptix Foundation Limited. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 1. Redistributions of source 
code must retain the copyright notice, this list of conditions and the following 
disclaimer.  2. Redistributions in binary form must reproduce the above copyright 
notice, this list of conditions and the following disclaimer in the documentation 
and/or other materials provided with the distribution.  THIS SOFTWARE IS 
PROVIDED BY THE CRYPTIX FOUNDATION LIMITED AND CONTRIBUTORS ``AS 
IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT 
SHALL THE CRYPTIX FOUNDATION LIMITED OR CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE."

Doug Lea License
"The Java Software technologies are Copyright © 1994-2000 Sun Microsystems, Inc.  
All rights reserved.  This software is provided"AS IS", without a warranty of any kind.  
ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND 
WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY 
EXCLUDED.  SUN MICROSYSTEMS, INC. AND ITS LICENSORS SHALL NOT BE 
LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, 
MODIFYING OR DISTRIBUTING THE SOFTWARE OR ITS DERIVATIVES.  IN NO 
EVENT WILL SUN MICROSYSTEMS, INC. OR ITS LICENSORS BE LIABLE FOR 
ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, 
CONSEQUENTIAL, INCIDENTIAL OR PUNITIVE DAMAGES, HOWEVER 
CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF 
THE USE OF OR INABILITY TO USE SOFTWARE, EVEN IF SUN MICROSYSTEMS, 
INC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  You 
acknowledge that Software is not designed, licensed or intended for use in the design, 
construction, operation or maintenance of any nuclear facility."

GubuSoft Treeview Icons
"Copyright (C) 2006 Conor O'Mahony (gubusoft@gubusoft.com). All rights reserved. 
This application includes the TreeView script. You are not authorized to download 
and/or use the TreeView source code from this application for your own purposes. For 
your own FREE copy of the TreeView script, please visit the http://www.treeview.net 
Web site. THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE."
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Apache 1.1 (IBM XML Parser)
"This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/). Copyright © 2000-2003 The Apache Software Foundation.  
All rights reserved.  Redistribution and use in source and binary forms, with or 
without modification, are permitted provided that the following conditions are met: 1. 
Redistributions of source code must retain the notice"Copyright © 2000-2003 The 
Apache Software Foundation.  All rights reserved.", this list of conditions and the 
disclaimer below. 2. Redistributions in binary form must reproduce the 
notice"Copyright © 2000-2003 The Apache Software Foundation.  All rights reserved.", 
this list of conditions and the disclaimer below in the documentation and/or other 
materials provided with the distribution.  3. The end-user documentation included 
with the redistribution, if any, must include the following acknowledgment:"This 
product includes software developed by the Apache Software Foundation 
(http://www.apache.org/)."  Alternately, this acknowledgment may appear in the 
software itself, if and wherever such third-party acknowledgments normally appear. 4. 
Neither the component name nor Apache Software Foundation may be used to 
endorse or promote products derived from the software without specific prior written 
permission.  5. Products derived from the software may not be called"Apache", nor 
may"Apache" appear in their name, without prior written permission.  THIS 
SOFTWARE IS PROVIDED"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
ERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE."

Intel Utilities
"Copyright © 1996 Intel Corporation.  All Rights Reserved.  Permission is granted to 
use, copy and distribute this software and its documentation for any purpose and 
without fee, provided, that the above copyright notice and this statement appear in all 
copies.  Intel makes no representations about the suitability of this software for any 
purpose.  This software is provided "AS IS." Intel specifically disclaims all warranties, 
express or implied, and all liability, including consequential and other indirect 
damages, for the use of this software, including liability for infringement of any 
proprietary rights, and including the warranties of merchantability and fitness for a 
particular purpose.  Intel does not assume any responsibility for any errors which may 
appear in this software nor any responsibility to update it., this list of conditions and 
the disclaimer below in the documentation and/or other materials provided with the 
distribution."

JaWin
"This product includes software developed by the DevelopMentor OpenSource Project 
(http://www.develop.com/OpenSource).  Copyright (c) 2001 DevelopMentor.  All 
rights reserved. Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met: 1. 
Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.  2. Redistributions in binary form must 
reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the 
distribution.  3. The end-user documentation included with the redistribution, if any, 
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must include the following acknowlegement: "This product includes software 
developed by the DevelopMentor OpenSource Project 
(http://www.develop.com/OpenSource)." Alternately, this acknowlegement may 
appear in the software itself if and wherever such third-party acknowlegements 
normally appear. 4. The name "DevelopMentor" may not be used to name, endorse, or 
promote products derived from this software without prior written permission. For 
written permission, please contact opensource@develop.com.  THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED.  IN NO EVENT SHALL DEVELOPMENTOR OPENSOURCE OR ITS 
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

JDOM
"This product includes software developed by the JDOM Project 
(http://www.jdom.org/). Copyright (C) 2000-2004 Jason Hunter & Brett McLaughlin. 
All rights reserved.

Redistribution and use in source and binary forms, with or without  modification, are 
permitted provided that the following conditions are met: 1. Redistributions of source 
code must retain the above copyright notice, this list of conditions, and the following 
disclaimer. 2. Redistributions in binary form must reproduce the above copyright 
notice, this list of conditions, and the disclaimer that follows  these conditions in the 
documentation and/or other materials  provided with the distribution. 3. The name 
"JDOM" must not be used to endorse or promote products derived from this software 
without prior written permission.  For written permission, please contact <request_
AT_jdom_DOT_org>. 4. Products derived from this software may not be called 
"JDOM", nor may "JDOM" appear in their name, without prior written permission 
from the JDOM Project Management <request_AT_jdom_DOT_org>. In addition, we 
request (but do not require) that you include in the end-user documentation provided 
with the redistribution and/or in the software itself an acknowledgement equivalent 
to the following: "This product includes software developed by the JDOM Project 
(http://www.jdom.org/)." Alternatively, the acknowledgment may be graphical using 
the logos  available at http://www.jdom.org/images/logos.  THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED  WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE  
DISCLAIMED.  IN NO EVENT SHALL THE JDOM AUTHORS OR THE PROJECT 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE."

John McTainsh Utility
"Copyright 1999 © John McTainsh."
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"Generic MIT" (MIT HTML Parser)
"Copyright © <year> <copyright holders>

Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the "Software"), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, 
publish, distribute, sublicense, and/or sell copies of the Software, and to permit 
persons to whom the Software is furnished to do so, subject to the following 
conditions: The above copyright notice and this permission notice shall be included in 
all copies or substantial portions of the Software.  THE SOFTWARE IS PROVIDED "AS 
IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR 
A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL 
THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, 
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH 
THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE."

OpenSSH [IGNORE PARTS WHERE CODE ISN'T USED]
Part 1: Tatu Ylonen

"Copyright (c) 1995 Tatu Ylonen <ylo@cs.hut.fi>, Espoo, Finland.  All rights reserved/"

Part 2:  CORE SDI

"Cryptographic attack detector for ssh - source code. Copyright (c) 1998 CORE SDI 
S.A., Buenos Aires, Argentina. All rights reserved. Redistribution and use in source 
and binary forms, with or without modification, are permitted provided that this 
copyright notice is retained. THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY 
EXPRESS OR IMPLIED WARRANTIES ARE DISCLAIMED. IN NO EVENT SHALL 
CORE SDI S.A. BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY  OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OR 
MISUSE  OF THIS SOFTWARE.  Ariel Futoransky <futo@core-sdi.com>  
http://www.core-sdi.com"

Part 3:  David Mazieres

"Copyright 1995, 1996 by David Mazieres <dm@lcs.mit.edu>.  Modification and 
redistribution in source and binary forms is permitted provided that due credit is 
given to the author and the OpenBSD project by leaving this copyright notice intact."

Part 4: Vincent Rijmen (see separate summary below)

Part 5: UC  Berkeley (BSD)

"Copyright (c) 1983, 1990, 1992, 1993, 1995 The Regents of the University of California.  
All rights reserved.  Redistribution and use in source and binary forms, with or 
without modification, are permitted provided that the following conditions are met:  1. 
Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 2. Redistributions in binary form must 
reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the 
distribution. 3. Neither the name of the University nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission. THE SOFTWARE IS PROVIDED BY THE REGENTS 
AND CONTRIBUTORS "AS-IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDINGBUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED.  IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL SPECIAL, EXEMPLARY, OR 
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CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS AND SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, ARISING IN ANY WAY OUT OF THE USE OF THE 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."

Part 6: BSD-Type License

NOTE: Remaining components of the software are provided under a standard 2-term 
BSD license with the following names as copyright holders:

■ Markus Friedl

■ Theo de Raadt

■ Niels Provos

■ Dug Song

■ Aaron Campbell

■ Damien Miller

■ Kevin Steves

■ Daniel Kouril

■ Wesley Griffin

■ Per Allansson

■ Nils Nordman

■ Simon Wilkinson

"Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:  1. Redistributions of source 
code must retain the above copyright notice, this list of conditions and the following 
disclaimer. 2. Redistributions in binary form must reproduce the above copyright 
notice, this list of conditions and the following disclaimer in the documentation 
and/or other materials provided with the distribution. THIS SOFTWARE IS 
PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."

Pradeep Sahu Job Scheduler
Redistributions of source code or binary form must retain the notice"You are free to 
use the code, and modify.  Provided you don't remove this comments.  It will be great 
if you can provide your feedback."

Tanuki Java Service Wrapper
"Copyright © 1999, 2006  Tanuki Software, Inc.  Permission is hereby granted, free of 
charge, to any person obtaining a copy of the Java Service Wrapper and associated 
documentation files (the"Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, 
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sublicense, and/or sell copies of the Software, and to permit persons to whom the 
Software is furnished to do so, subject to the following conditions: The above 
copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software. THE SOFTWARE IS PROVIDED"AS IS", 
WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES 
OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE 
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright © 2001 Silver Egg Technology. Permission is hereby granted, free of charge, 
to any person obtaining a copy of this software and associated documentation files 
(the"Software"), to deal in the Software without restriction, including without 
limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, 
and/or sell copies of the Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions: The above copyright notice and 
this permission notice shall be included in all copies or substantial portions of the 
Software. THE SOFTWARE IS PROVIDED"AS IS", WITHOUT WARRANTY OF ANY 
KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE 
AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR 
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER 
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE 
USE OR OTHER DEALINGS IN THE SOFTWARE."

NOTE

Applications which are distributed with the Wrapper must include the license in a file 
called license-wrapper.txt. The file should be located in a location that is obvious to the 
user. Furthermore, the Wrapper may not be modified in a way which suppresses the 
copyright banner displayed on startup.

"Copyright © 1999, 2006  Tanuki Software, Inc.

Permission is hereby granted, free of charge, to any person obtaining a copy of the Java 
Service Wrapper and associated documentation files (the"Software"), to deal in the 
Software without restriction, including without limitation the rights to use, copy, 
modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and 
to permit persons to whom the Software is furnished to do so, subject to the following 
conditions:

The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.

THE SOFTWARE IS PROVIDED"AS IS", WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING 
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR 
OTHER DEALINGS IN THE SOFTWARE."

Portions of the Software have been derived from source code developed by Silver Egg 
Technology under the following license:

BEGIN Silver Egg Technology License --------------------------------------------------------
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Copyright © 2001 Silver Egg Technology

Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the"Software"), to deal in the Software 
without restriction, including without limitation the rights to use, copy, modify, merge, 
publish, distribute, sublicense, and/or sell copies of the Software, and to permit 
persons to whom the Software is furnished to do so, subject to the following 
conditions:

The above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.

THE SOFTWARE IS PROVIDED"AS IS", WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING 
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR 
OTHER DEALINGS IN THE SOFTWARE."

TidyCom
"Copyright © 1998-2000 World Wide Web Consortium."

Tim Taylor Utility
"Copyright © 2005 Tim Taylor Consulting <http://tool-man.org/>  Permission is 
hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the"Software"), to deal in the Software without 
restriction, including without limitation the rights to use, copy, modify, merge, publish, 
distribute, sublicense, and/or sell copies of the Software, and to permit persons to 
whom the Software is furnished to do so, subject to the following conditions:  The 
above copyright notice and this permission notice shall be included in all copies or 
substantial portions of the Software.  THE SOFTWARE IS PROVIDED"AS IS", 
WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES 
OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE 
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE."

Vincent Rijmen's AES Encryption
"rijndael-alg-fst.c. @version 3.0 (December 2000).  Optimised ANSI C code for the 
Rijndael cipher (now AES).  @author Vincent Rijmen 
vincent.rijmen@esat.kuleuven.ac.be @author Antoon Bosselaers 
antoon.bosselaers@esat.kuleaven.ac.be @author Paulo Barreto 
paulo.barreto@terra.com.br This code is hereby places in the public domain.  THE 
SOFTWARE IS PROVIDED BY THE AUTHORS"AS IS", AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHORS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMTED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
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ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE."

Xstream
"Copyright (c) 2003-2006, Joe Walnes.  Copyright (c) 2006-2007, XStream Committers.  
All rights reserved.  Redistribution and use in source and binary forms, with or 
without modification, are permitted provided that the following conditions are met: 
Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. Redistributions in binary form must 
reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the 
distribution. Neither the name of XStream nor the names of its contributors may be 
used to endorse or promote products derived from this software without specific prior 
written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT 
HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE."

Zlib
"Copyright (c) 1995-2005 Jean-loup Gailly and Mark Adler. This software is provided 
'as-is', without any express or implied warranty. In no event will the authors be held 
liable for any damages arising from the use of this software. Permission is granted to 
anyone to use this software for any purpose, including commercial applications, and 
to alter it and redistribute it freely, subject to the following restrictions: 1. The origin of 
this software must not be misrepresented; you must not claim that you wrote the 
original software. If you use this software in a product, an acknowledgment in the 
product documentation would be appreciated but is not required. 2. Altered source 
versions must be plainly marked as such, and must not be misrepresented as being the 
original software. 3. This notice may not be removed or altered from any source 
distribution. Jean-loup Gailly jloup@gzip.org. Mark Adler 
madler@alumni.caltech.edu"
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A
Additional Arguments setting, 2-5
ADF

creating new project, 3-3, 3-4
ADF Functional Test module

configuring the server, 9-2
key features, 9-2
using, 9-1

ADF Functional Test scripts
application programming interface, 9-6
playing back scripts, 9-4
playing back scripts with iterations, 9-4
recording scripts, 9-3

ADF Load Test scripts
playing back scripts, 10-3

alias, 4-3
AllowAnonUsers setting, 12-3
Apache AXIS parsers, 2-21
assets

adding to scripts, 3-14
Attachments

adding to Web Services, 11-6
authentication, 6-23

B
binary coding exceptions, B-1
Binary Decode Failed setting, 2-7
binary file data

posting, 6-18
boundary, 6-31
Breakpoint View, 1-4, 1-15
breakpoints

adding, 3-24
browser exceptions, B-5
Browsers preferences, 2-3

C
cache emulation, 6-14
callFunction statement

adding to script, 3-11
chaining scripts, 3-21
Child Script Failed setting, 2-7
clearing cache, 5-10

clearing cookies, 5-10
Client Certificate Keystore Error setting, 2-8
Close browser after playback setting, 2-10
command line settings, A-1

agent settings, A-2
browser, A-6
compression, A-7
connections, A-8
Download Manager, A-9
error recovery, A-12
functional test, A-10
general, A-2
headers, A-7
HTTP, A-6
Oracle EBS/Forms functional test, A-10
other, A-8
proxy, A-6
Shared Data Service, A-11
specifying, A-1
Web functional test, A-12

comments
adding to script results, 3-17

Component Not Found Errors, B-12
compression group, 6-14
Connect errors, B-8
connections group, 6-14
Console View, 1-3, 1-4, 1-14
cookies

adding to script, 6-27
enabling, 6-15
preserving between iterations, 6-15
removing from script, 6-27

correlation, 6-28
Create Variable Failed setting, 2-7
CSV Loading Error setting, 2-8

D
Data Driven Testing

See also parameterization, 4-1
data input parameterization, 4-1
data input sources, 4-1
data parameterization GUI view, 4-1
databank files, 4-3
databank variables

substituting, 6-25
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databanks
configuring, 4-2
definition, 1-2, 4-2
getting records, 4-3
using, 4-1

debug
setting preferences, 2-6

debug logging
enabling, 3-28

Debug View, 1-15
debugging scripts, 3-23

adding breakpoints, 3-24
adding Java exception breakpoint, 3-26
adding views, 3-24
inspecting variables, 3-27
pausing and resuming scripts, 3-26

delay
adding to script, 3-10

Details View, 1-3, 1-4, 1-13
Developer Perspective, 1-4

available options, 1-5
Breakpoint View, 1-4, 1-15
Console View, 1-4, 1-14
Debug View, 1-4, 1-15
Details View, 1-4, 1-13
Error Log View, 1-4
Navigator View, 1-4, 1-15
Package Explorer View, 1-4, 1-15
Problems View, 1-4, 1-13
Properties View, 1-4, 1-14
Results View, 1-4, 1-14
Script View, 1-4, 1-12
Variables View, 1-4, 1-15

DIME, 11-7
Direct Internet Message Encapsulation, 11-7

E
EBS/Forms Functional Test module

setting playback preferences, 2-14
setting record preferences, 2-18

EBS/Forms Load Test module
setting record preferences, 2-18

EnableAutomation setting, 12-3
encode strings, 6-31, 6-32
encoding

resetting, 6-17
encryption preferences, 2-3
Encryption Service Not Initialized setting, 2-7
Error Log View, 1-4
error recovery

adding to script, 3-17
functional testing, A-13
general, A-13
HTTP, A-13
Oracle EBS/Forms functional testing, A-13
Oracle EBS/Forms load testing, A-14
setting preferences, 2-6
utilities, A-14
Web functional testing, A-14

exceptions, 2-6
adding breakpoints, 3-26

execute code, 3-28

F
File Not Found setting, 2-7
filter

See URL filter, 6-12
Finish section

definition, 1-2
folders

managing, 3-2
for statement

adding to script, 3-11
Form Server Connect Failed setting, 2-8
Forms Component Not Found setting, 2-8
Forms Contents Match Failed setting, 2-8
Forms Input/Output Communication Error 

setting, 2-8
Forms Playback Error setting, 2-8
Function Failed setting, 2-7
function statement

adding to script, 3-11
Functional Test module

setting playback preferences, 2-9

G
General preferences, 2-2

H
Has Error control statement

adding to script, 3-20
headers group, 6-14
Hide browser during playback setting, 2-10
High-Interactivity components, 12-2
HTML Parsing Error setting, 2-7
HTTP error messages, B-7
HTTP exceptions, B-7
HTTP Get Navigation, 6-30
HTTP module

about, 6-1
key features, 6-1
setting playback preferences, 2-10, 6-13
setting record preferences, 2-16, 6-11
using, 6-1

HTTP scripts
adding a DOM variable, 6-22
adding authentication, 6-23
adding cookies, 6-27
adding Get Navigation, 6-30
adding Multipart Post Navigation, 6-31
adding Post Navigation, 6-30
adding server response tests, 6-25
adding text matching tests, 6-24
adding user agent, 6-27
adding variables, 6-22
adding XML Post Navigation, 6-32
deleting cookie, 6-27
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deleting variables from, 6-23
finding variable in, 6-23
modifying, 6-19
playing back, 6-13, 6-16
recording, 6-10, 6-12
using HTTP API, 6-33
viewing playback results, 6-16

HTTP service exceptions, B-7

I
import

REUI User Session log, 3-9
Initialize section

definition, 1-2
inspect variable, 3-27
installation, 1-2

troubleshooting, C-1
Invalid HTTP Response Code setting, 2-8
Invalid URL setting, 2-8
I/O Errors, B-10
iterations, 6-16

J
Java Code Editor, 1-5, 1-13

finish(), 1-13
initialize(), 1-13
run(), 1-13

Java Code Script
creating new project, 3-3

Java Exception Breakpoint, 3-26

L
log message

adding to script, 3-11

M
Match Errors, B-11
Menu options

Edit, 1-5
File, 1-4
Help, 1-9
Navigate, 1-9
Project, 1-10
Run, 1-8
Script, 1-6
Search, 1-6
Tools, 1-9
View, 1-7
Window, 1-10

module error messages, B-1
modules

ADF Functional Test, 9-1
Oracle EBS/Forms Functional Test, 7-1
Oracle EBS/Forms Load Test, 8-1
Oracle Fusion/ADF Load Test, 10-1
Web Functional Test, 5-1

MTOM, 11-7

Multipart Post Navigation, 6-31

N
navigation

adding, 5-8, 6-28
adding browser navigation, 5-8
adding HTTP Get, 6-30
adding HTTP Post, 6-30
adding multipart Post, 6-31
adding XML Post, 6-32

Navigator View, 1-4, 1-15
nodes

moving in a script, 3-23
Nonce, 11-6

O
Object Enumeration

setting preferences, 2-9
object identification

editing libraries, 5-18
setting preferences, 2-18, 2-19, 2-20
x,y offset, 5-17
x,y position, 5-17

object identifiers
adding/editing, 5-3

Object Not Found setting, 2-8
Object Test Failed setting, 2-7
Offset (x,y), 5-17
OpenScript

Breakpoint View, 1-15
Console View, 1-14
Correlation interface, 1-2
Databanking, 1-2
Debug View, 1-15
definition, 1-1
Details View, 1-13
Developer Perspective, 1-4
installing, 1-2
Java Code View, 1-2
menu options, 1-4
Navigator and Package Explorer Views, 1-15
preferences, 1-2
Problems View, 1-13
Properties View, 1-2, 1-14
Results View, 1-14
starting, 1-3
tool bar, 1-11
tree view, 1-2
Variables View, 1-15

OpenScript Workbench, 1-3
options

Configure Databank, 4-2
Substitute Variable, 4-2

Oracle EBS/Forms
creating new project, 3-3, 3-4

Oracle EBS/Forms Error setting, 2-8
Oracle EBS/Forms Functional Test module

about, 7-1
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adding Oracle Forms object identifiers, 7-3
editing Oracle Forms object identifiers, 7-3
key features, 7-1
prerequisites, 7-2
setting playback preferences, 2-14, 7-5
setting record preferences, 2-18, 7-3
using, 7-1

Oracle EBS/Forms Functional Test scripts
adding EBS/Forms actions, 7-6
modifying, 7-6
playing back scripts, 7-5, 7-6
playing back scripts with iterations, 7-6
recording scripts, 7-2, 7-4
using Forms Functional Test API, 7-7

Oracle EBS/Forms Load Test error messages, B-8
Oracle EBS/Forms Load Test module

Correlation Library, 8-8
key features, 8-1
prerequisites, 8-2
setting Correlation preferences, 8-8
setting playback preferences, 8-4
setting record preferences, 2-18, 8-3
using, 8-1

Oracle EBS/Forms Load Test scripts
adding Forms actions, 8-5
analyzing Message Logs, 8-12
converting Forms actions to XML, 8-6
debugging using the Message Log, 8-11
modifying, 8-5
playing back scripts, 8-4, 8-5
playing back scripts with iterations, 8-5
recording scripts, 8-2, 8-3
troubleshooting, 8-11
troubleshooting ifError messages, 8-13
using Forms Functional Test API, 8-7

Oracle Fusion/ ADF Load Test module
key features, 10-1

Oracle Fusion/ADF Functional Test scripts
adding Fusion/ADF actions, 9-5
modifying, 9-5

Oracle Fusion/ADF Load Test module
Correlation Library, 10-4
setting Correlation preferences, 10-3
using, 10-1

Oracle Fusion/ADF Load Test scripts
application programming interface, 10-5
playing back scripts, 10-3
playing back scripts with iterations, 10-3
recording scripts, 10-2

Oracle Load Testing
playing back HTTP scripts, 6-17

P
Package Explorer View, 1-4, 1-15
parameterization, 4-1, 6-28
password digest, 11-6
password text, 11-6
platform error messages, B-4
Playback Errors, B-12

Playback Failed setting, 2-9
playback HTTP scripts

using iterations, 6-16
using Oracle Load Testing, 6-17

Playback preferences, 2-4
Action Settings, 2-14
Capture Screenshot Interval, 2-16
Compression, 2-11
Connections, 2-11
Download Manager, 2-13
Error Handling, 2-5
Event Timeout, 2-14
General, 2-4
Headers, 2-11
Miscellaneous, 2-15
Object Enumeration, 2-9
Object Timeout, 2-15
Other, 2-11
setting, 6-13
SSL, 2-11
System, 2-5, 2-10

playback results
comparing, 6-17

Position (x,y), 5-17
post data variables, 6-26
Post Navigation, 6-30
preferences, 2-1

Browsers, 2-3
EBS/Forms functional test, 2-14, 2-18
EBS/Forms load test, 2-18
encryption, 2-3
error recovery, 2-6
functional test, 2-9
general, 2-4
General category, 2-2
HTTP, 2-10, 2-16
playback, 6-13
Playback category, 2-4
Record category, 2-16
repository settings, 2-4
setting, 2-1
setting project, 2-27
setting Siebel Correlation, 13-14
Siebel functional test, 2-19
Step Group category, 2-21
Web functional test, 2-15, 2-20
Web Services, 2-21

Problems View, 1-3, 1-4, 1-13
project preferences, 2-27
properties

assets, 3-8
correlation, 3-8
modules, 3-8
setting for scripts, 3-7
step groups, 3-8

Properties View, 1-3, 1-4, 1-14
proxy group, 6-13
proxy recording preferences, 6-11
Proxy Settings tab, 6-11
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R
record ADF Functional Test, 9-3
record HTTP script, 6-12
record Oracle EBS/Forms Load Test, 8-2
record Oracle Forms Functional Test, 7-2
record Oracle Fusion/ADF Load Test, 10-2
Record preferences, 2-16

EBS/Forms load test, 2-18
General, 2-16, 2-18, 2-20, 2-21
Object Identification, 2-18, 2-19, 2-20
Parser Tools, 2-21
Proxy Configuration, 2-21
Proxy Settings, 2-17
URL Filters, 2-17

record Web Functional Test, 5-2
recorded results

comparing, 6-17
repository

creating, 3-1
definition, 3-1
managing, 3-2
setting preferences, 2-4

response charset, 6-31
Response Time Error setting, 2-7, 2-8
Result Object

adding to script, 3-20
Result View

toolbar buttons, 1-14
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